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MAXON Computer End User License Agreement

NOTICE TO USER 

WITH THE INSTALLATION OF BODYPAINT 3D (THE “SOFTWARE”) A CONTRACT IS CONCLUDED BETWEEN YOU 
(“YOU” OR THE “USER”) AND MAXON COMPUTER GMBH ( THE “LICENSOR”), A COMPANY UNDER GERMAN 
LAW WITH RESIDENCE IN FRIEDRICHSDORF, GERMANY.

WHEREAS BY USING AND/OR INSTALLING THE SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. IN THE CASE OF NON-ACCEPTANCE OF THIS LICENSE YOU ARE NOT PERMITTED TO INSTALL 
THE SOFTWARE. 

IF YOU DO NOT ACCEPT THIS LICENSE PLEASE SEND THE SOFTWARE TOGETHER WITH ACCOMPANYING 
DOCUMENTATION TO MAXON COMPUTER OR TO THE SUPPLIER WHERE YOU BOUGHT THE SOFTWARE.

1. General

Under this contract the Licensor grants to you, the User, a non-exclusive license to use the Software and its 
associated documentation. The Software itself, as well as the copy of the Software or any other copy you are 
authorized to make under this license, remain the property of the Licensor. 

2. Use of the Software 

You are authorized to copy the Software as far as the copy is necessary to use the Software. Necessary copies are 
the installation of the program from the original disk to the mass storage medium of your hardware as well as the 
loading of the program into RAM. 

(2) Furthermore the User is entitled to make a backup copy. However only one backup copy may be made and 
kept in store. This backup copy must be identified as a backup copy of the licensed Software.

(3) Further copies are not permitted; this also includes the making of a hard copy of the program code on a 
printer as well as copies, in any form, of the documentation. 

3. Multiple use and network operation

(1) You may use the Software on any single hardware platform, Macintosh or Windows, and must decide on the 
platform (Macintosh or Windows operating system) at the time of installation of the Software. If you change 
the hardware you are obliged to delete the Software from the mass storage medium of the hardware used up to 
then. A simultaneous installation or use on more than one hardware system is not permitted. 

(2) The use of the licensed Software for network operation or other client server systems is prohibited if this 
opens the possibility of simultaneous multiple use of the Software. In the case that you intend to use the 
Software within a network or other client server system you should ensure that multiple use is not possible by 
employing the necessary access security. Otherwise you will be required to pay to the Licensor a special network 
license fee, the amount of which is determined by the number of Users admitted to the network. 



(3) The license fee for network operation of the Software will be communicated to you by the Licensor 
immediately after you have indicated the number of admitted users in writing. The correct address of the Licensor 
is given in the manual and also at the end of this contract. The network use may start only after the relevant 
license fee is completely paid. 

4. Transfer

(1) You may not rent, lease, sublicense or lend the Software or documentation. You may, however, transfer all 
your rights to use the Software to another person or legal entity provided that you transfer this agreement, the 
Software, including all copies, updates or prior versions as well as all documentation to such person or entity and 
that you retain no copies, including copies stored on a computer and that the other person agrees that the terms 
of this agreement remain valid and that his acceptance is communicated to the Licensor. 

(2) You are obliged to carefully store the terms of the agreement. Prior to the transfer of the Software you should 
inform the new user of these terms. In the case that the new user does not have the terms at hand at the time of 
the transfer of the Software, he is obliged to request a second copy from the Licensor, the cost of which is born 
by the new licensee. 

(3) After transfer of this license to another user you no longer have a license to use the Software. 

5. Updates

If the Software is an update to a previous version of the Software, you must possess a valid licence to such 
previous version in order to use the update. You may continue to use the previous version of the Software only to 
help the transition to and the installation of the update. After 90 days from the receipt of the update your licence 
for the previous version of the Software expires and you are no longer permitted to use the previous version of 
the Software, except as necessary to install the update.

6.  Recompilation and changes of the Software 

(1) The recompilation of the provided program code into other code forms as well as all other types of reverse 
engineering of the different phases of Software production including any alterations of the Software are strictly 
not allowed. 

(2) The removal of the security against copy or similar safety system is only permitted if a faultless performance of 
the Software is impaired or hindered by such security. The burden of proof for the fact that the performance of 
the program is impaired or hindered by the security device rests with the User. 

(3) Copyright notices, serial numbers or other identifications of the Software may not be removed or changed. 
The Software is owned by the Licensor and its structure, organization and code are the valuable trade secrets of 
the Licensor. It is also protected by United States Copyright and International Treaty provisions. Except as stated 
above, this agreement does not grant you any intellectual property rights on the Software. 

7. Limited warranty

(1) The parties to this agreement hereby agree that at present it is not possible to develop and produce software 
in such a way that it is fit for any conditions of use without problems. The Licensor warrants that the Software will 
perform substantially in accordance with the documentation. The Licensor does not warrant that the Software 
and the documentation comply with certain requirements and purposes of the User or works together with 



other software used by the licensee. You are obliged to check the Software and the documentation carefully 
immediately upon receipt and inform the Licensor in writing of apparent defects 14 days after receipt. Latent 
defects have to be communicated in the same manner immediately after their discovery. Otherwise the Software 
and documentation are considered to be faultless. The defects, in particular the symptoms that occurred, are to 
be described in detail in as much as you are able to do so. The warranty is granted for a period of 6 months from 
delivery of the Software (for the date of which the date of the purchase according to the invoice is decisive). The 
Licensor is free to cure the defects by free repair or provision of a faultless update. 

(2) The Licensor and its suppliers do not and cannot warrant the performance and the results you may obtain by 
using the Software or documentation. The foregoing states the sole and exclusive remedies for the Licensor’s or 
its suppliers’ breach of warranty, except for the foregoing limited warranty. The Licensor and its suppliers make 
no warranties, express or implied, as to noninfringement of third party rights, merchantability, or fitness for 
any particular purpose. In no event will the Licensor or its suppliers be liable for any consequential, incidental 
or special damages, including any lost profits or lost savings, even if a representative of the Licensor has been 
advised of the possibility of such damages or for any claim by any third party. 

(3) Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or special 
damages, or the exclusion of implied warranties or limitations on how long an implied warranty may last, so 
the above limitations may not apply to you. In this case a special limited warranty is attached as exhibit to this 
agreement, which becomes part of this agreement. To the extent permissible, any implied warranties are limited 
to 6 months. This warranty gives you specific legal rights. You may have other rights which vary from state to 
state or jurisdiction to jurisdiction. In the case that no special warranty is attached to your contract please contact 
the Licensor for further warranty information. 

The user is obliged to immediately inform the transport agent in writing of any eventual damages in transit and 
has to provide the licensor with a copy of said correspondence, since all transportation is insured by the licensor if 
shipment was procured by him.

8. Damage in transit

You are obliged to immediately inform the transport agent in writing of any eventual damages in transit and you 
should provide the Licensor with a copy of said correspondence, since all transportation is insured by the Licensor 
if shipment was procured by him. 

9. Secrecy

You are obliged to take careful measures to protect the Software and its documentation, in particular the 
serial number, from access by third parties. You are not permitted to duplicate or pass on the Software or 
documentation. These obligations apply equally to your employees or other persons engaged by you to operate 
the programs. You must pass on these obligations to such persons. You are liable for damages in all instances 
where these obligations have not been met. These obligations apply equally to your employees or other persons 
he entrusts to use the Software. The User will pass on these obligations to such persons. You are liable to pay the 
Licensor all damages arising from failure to abide by these terms.



10.  Information 

In case of transfer of the Software you are obliged to inform the Licensor of the name and full address of the 
transferee in writing. The address of the Licensor is stated in the manual and at the end of this contract. 

11. Data Protection

For the purpose of customer registration and control of proper use of the programs the Licensor will store 
personal data of the Users in accordance with the German law on Data Protection (Bundesdatenschutzgesetz). 
This data may only be used for the above-mentioned purposes and will not be accessible to third parties. Upon 
request of the User the Licensor will at any time inform the User of the data stored with regard to him. 

12. Other

(1) This contract includes all rights and obligations of the parties. There are no other agreements. Any changes 
or alterations of this agreement have to be performed in writing with reference to this agreement and have to be 
signed by both contracting parties. This also applies to the agreement on abolition of the written form. 

(2) This agreement is governed by German law. Place of jurisdiction is the competent court in Frankfurt am Main. 
This agreement will not be governed by the United Nations Convention on Contracts for the International Sale of 
Goods, the application of which is expressly excluded. 

(3) If any part of this agreement is found void and unenforceable, it will not affect the validity of the balance of 
the agreement which shall remain valid and enforceable according to its terms. 

13. Termination

This agreement shall automatically terminate upon failure by you to comply with its terms despite being given an 
additional period to do so. In case of termination due to the aforementioned reason, you are obliged to return 
the program and all documentation to the Licensor. Furthermore, upon request of Licensor you must submit 
written declaration that you are not in possession of any copy of the Software on data storage devices or on the 
computer itself. 

14. Information and Notices

Should you have any questions concerning this agreement or if you desire to contact MAXON Computer for any 
reason and for all notifications to be performed under this agreement, please write to: 

MAXON Computer GmbH, Max-Planck-Str. 20, D-61381, Friedrichsdorf, Germany.

or for North and South America to:

MAXON Computer, Inc., 2640 Lavery Court Suite A, Newbury Park, CA 91320, USA.

or for the United Kingdom and Republic of Ireland to:

MAXON Computer Ltd, The Old School, Greenfield, Bedford MK45 5DE, United Kingdom.

We will also be pleased to provide you with the address of your nearest supplier. 
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Starting BodyPaint 3D
To start BodyPaint 3D, do one of the following:

-  Double-click on the program’s icon.

-  Double-click on a scene file.

-  Use the Start menu (Windows).

Alternatively, drag-and-drop one or more BodyPaint 3D files from Explorer (Windows) or 
Finder (Mac OS) onto the BodyPaint 3D application icon or directly into the program.

Template.c4d

If the BodyPaint 3D root folder contains a scene named “Template.c4d”, this is loaded 
during startup and all the settings defined there become effective.

Quitting BodyPaint 3D
File > Quit quits the program. If there are unsaved changes, a dialog will appear to give 
you the opportunity to save them. Clicking on Cancel in this dialog returns you to the 
program.

 To save the layout automatically each time you quit the program, open the Preferences 
and on the Common page enable the Save Layout At Program End option.

Mouse techniques
BodyPaint 3D gives you these extra mouse features:

-  To simulate the right mouse button on the Macintosh, hold down the Command key. 
Alternatively, use a two-button mouse with the appropriate driver.

-  If you want to drag an object onto a window displayed as a tab but the window is 
concealed, drag and hold the object over the window’s tab. After a short delay, the 
window will be activated and you can drop the object on the target.

-  If you are using a wheel mouse, you can rotate the wheel to scroll sliders (such as a 
material’s color and brightness sliders). You can also use the wheel to increment and 
decrement numbers in numerical text boxes.

1 Getting to Know BodyPaint 3D
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Graphics Tablet
BodyPaint 3D supports all graphics tablets which conform to the WinTab standard, such 
as the Wacom range. The pen pressure, pen tilt, pen direction and pen finger wheel are 
all supported. For details on how to link these input methods to your brush settings, see 
“Effectors” on page 136.

Hotkeys 1 to 7
To use a hotkey, hold down the key and drag the mouse. The default hotkeys for the view 
panel are:

Result Action
Move camera left/right/up/down 1 + drag
Move camera forwards/backwards 2 + drag
Zoom camera (focal length) 2 + right-drag (Windows) or 2 + Cmd-drag (Mac)
Rotate camera (X and Y axes) 3 + drag
Rotate camera (Z-axis) 3 + right-drag (Windows) or 3 + Cmd-drag (Mac)
Move selected objects 4 + drag
Scale selected objects (animation) 5 + drag
Rotate selected objects 6 + drag
Scale selected objects (modeling) 7 + drag
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The User Interface
BodyPaint 3D’s user interface offers many advanced features that you won't find in the 
Windows or Mac OS GUI:

-  You can dock all windows into the main window.

-  When you move a docked window, the surrounding windows are resized to make 
space.

-  You can display windows as tabs to conserve display space.

2

3

4

1

5 6 7

8

1. Toolbar,  2. 3D view,  3. Local menu,  4. Texture view,  5. Material manager,  6. Object manager,  
7. Attribute manager,  8. Tabs.

BodyPaint 3D’s GUI is freely configurable. You can create your own toolbars and edit the  
menus. You can also create and save your own layouts such as a layout for editing UVs.

The quickest way to switch layouts is to click the icon at the top of the left toolbar and 
choose the desired layout from the list that appears. You can also add your own layouts 
to the list.
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To switch to different layout, click the top 
icon in the left toolbar and choose the desired 
layout from the list that appears.

The “BP UV Edit.l4d” layout.
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A Quick Tour
In these pages you’ll find details on the various parts of the program which appear when 
you start BodyPaint 3D for the first time. If you want to know more about a particular 
part of the program, look it up in the relevant chapter of this manual.

Managers
Managers are the main program elements in BodyPaint 3D. Each manager has its own 
window and runs alongside the other managers. This means that each manager can 
operate independently, so that it is multi-threaded. This makes it possible — among 
other things — to render a picture in the Picture manager while you are working in the 
3D view. The managers are able to operate independently but also update each other 
when relevant. For example, if you paint brushstrokes in the 3D view they will appear 
automatically in the Texture view as well.

Windows
Each manager has its own window. You can position the windows freely or dock them 
into BodyPaint 3D’s main window. In the default layout, most managers are docked. 
If you change the size of a docked window, the neighboring windows will be resized 
automatically to make space or avoid a gap.

To undock a window, click its pin icon and select Undock from the menu that appears. 
To dock a window, drag-and-drop its pin icon onto the main window. A black line will 
indicate the insertion position. To resize a window, first move the mouse pointer over the 
window’s border; the pointer will change into a double arrow to indicate the direction 
(vertical or horizontal) in which you can drag the border. Drag the window as required. 
The neighboring windows will adapt to the change.

Menu bars
Each manager has a local menu bar. Menu bars have the following features:

-  Submenus.

-  Commands that cannot be chosen are grayed out.

-  Enabled options are indicated by a check mark.

-  All shortcuts, including your own, are shown to the right of the menu option.
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If there isn’t enough space to display the entire menu bar, you’ll see a black triangle 
appear. Click the triangle to reveal the remaining menu entries as a drop-down list.

Icon palettes
The default layout includes several icon palettes (aka “toolbars”) containing the most 
popular commands as icons. In the bottom right corner of some of these icons you’ll 
notice a small black triangle, which indicates a folded group of commands. To show the 
group of commands, click and hold the left mouse button on the icon. Note that the icon 
shown before unfolding the group is the most recently used command (provided Lock 
Icon is disabled on the folded group’s context menu).

Tabs
You can display windows and icon palettes as tabs. For example, the Object manager, 
Structure manager and Browser are displayed as tabs in the default layout. This saves 
display space and helps you to reach a manager or icon palette quickly. If there is not 
enough display space to show all of the tabs, you’ll see a torn tab appear. To scroll the 
tabs, click the left or right arrow icon in the top right of the window or drag a tab left or 
right.
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For more information, see “Tabs” on page 35. For details on a particular manager, please 
refer to the chapter for that manager.

Context menus
To open a context menu, right-click (Windows) or Command-click (Mac OS).

Input boxes
Input boxes with two arrowheads (one pointing up, the other pointing down) offer the 
following features:

-  Click an arrowhead to increment or decrement the value by one.

-  Drag an arrowhead to increase or decrease the value rapidly.

-  Rotate the mouse wheel in a numerical text box to increase or decrease the value.

In addition, you can enter mathematical operators into numerical text boxes. See the 
Appendix.

View panel
The View panel is a collection of up to four viewports and is the heart of the program. 
This is where you can paint and render your 3D models.

Texture view
Here you can view and paint your textures in two dimensions. In addition, the Texture 
view enables you to view and edit UV mesh.

Material manager
The Material manager contains all the materials in your scene. If you double-click a 
material icon, the Material Editor will open; here you can edit the material. To assign a 
material to an object, drag the material’s thumbnail from the Material manager and drop 
it onto the object.
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Color manager
Here you can choose the foreground and background colors that are used by the paint 
tools and commands.

Active Tool manager
This is where you’ll find settings for the active tool. For example, if you select the brush 
tool, the manager gives you access to the brush settings.

Object manager
This manager lists each object that is present in the scene. Here you can group objects 
together and select objects that you want to edit (most of BodyPaint 3D’s commands and 
tools affect the selected objects only). To select an object, click its name or icon in the 
Object manager. The name will turn red to indicate that the object is selected.

In the Object manager you can also add tags to the objects to assign them additional 
properties such as Phong shading.

Attribute manager
The Attribute manager lets you edit the properties of the selected elements (objects, 
materials, tags, etc.).
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You can open as many view panels (aka views) as you like. Each view panel has its own 
display settings. A view panel can display up to four viewports (views of a scene) and 
each of these viewports also has its own display settings.

Viewport icons

There are four icons in the top right corner of each viewport. The right-most icon toggles 
the active view (see “Toggle Active View” on page 24). The remaining icons move, zoom 
or rotate the camera (drag an icon to see its effect).

2 Views and Viewports
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Edit Menu

Undo View, Redo View

Each viewport has its own Undo View/Redo View commands (the Undo/Redo commands 
on the main window have no effect on editor cameras, i.e. those in viewports).

 The short-cuts for Undo View and Redo View are Ctrl+Shift+Z and Ctrl+Shift+Y 
respectively.

Frame
Frame Selected Elements

The camera will move so that the selected elements (e.g. objects, polygons) fill the 
viewport and are centered.

Frame Active Objects

The camera will move so that the active objects fill the viewport and are centered.

Frame Scene Without Camera/Light

The camera will move so that all objects apart from lights and cameras fill the active 
viewport and are centered.

Frame Scene

The camera will move so that all objects including lights and cameras fill the active 
viewport and are centered.

Frame Default

This command resets the view’s camera to the default values, as if you had just started 
BodyPaint 3D.

Use As Render View
If this option is enabled, the viewport’s active camera will be used when you render to 
the Picture Viewer.
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Redraw
This command redraws the scene. Usually, BodyPaint 3D updates viewports 
automatically. Sometimes this is not possible, such as when you have used several CPU-
intensive commands in quick succession or aborted an action.

Configure
If you choose Edit > Configure from the viewport’s menu, the Configure Viewport dialog 
will open.

Active Object

Display

Display sets the display mode (e.g. Gouraud shading, Wireframe) for the active object, 
although see “Use Shading Property” below.

Use Shading Property

If this option is enabled, the active object will use the display mode defined in its Display 
tag (if it has one) instead of the setting defined here in the Configure Viewport dialog.

Show Normals

If you enable this option, surface normals will appear when you select polygons. These 
are small auxiliary lines which are perpendicular to the polygons. The direction of a 
normal represents the direction in which its polygon points.
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For example, backface culling checks the direction of each normal to determine whether 
its polygon should be drawn — if the normal points away from the camera, the surface is 
not drawn (the surface is assumed to point away from the camera, just like its normal).

X-Ray Effect

To switch on X-ray mode, enable this option. If the active object is a polygon object, it 
will become semi-transparent and you’ll be able to see all of its points and edges.

Show Animation Path

Enable this option to see the active object’s animation path in the viewport as a yellow 
curve. Edit the animation path as you would a spline, i.e. drag curve points to new 
positions and edit their tangents.

Inactive Object

Display

Display sets the display mode (e.g. Gouraud shading, wireframe) for the inactive objects 
in the scene.

Use Shading Property

If this option is enabled, the inactive objects will use the display mode defined in their 
display tags (if present) instead of the general display mode.

View Settings

Projection

You can use this setting to change the projection type (e.g. to Perspective, Bird, 
Dimetric).

Disable Textures

To switch off the display of textures in the viewport, enable this option.

Disable Backface Culling

You can enable this option to switch off backface culling.

 Backface culling merely hides an object’s concealed points and edges. If you disable 
backface culling in wireframe mode, you’ll still be able to see objects that are behind 
other objects.
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Show Safe Frames

Render Safe

Action Safe

Safe frames are areas which will be in full view when played back on the target medium. 
To display safe frames, enable this option and in the preferences, on the Viewport page, 
enable the desired safe frames (Render Safe, Action Safe, Title Safe).

Background

Show Picture, Horizontal/Vertical Offset, Horizontal/Vertical Size

 Use background pictures as a modeling aid to help you “trace” (naturally, you are unlikely 
to do much modeling in BodyPaint 3D and therefore this feature is generally of little use). 
The picture will not be rendered. If you want a background picture to be rendered, use a 
Background object instead.

Show Picture allows you to use a picture as background in a planar view. Click the Path 
button and use the dialog that opens to load the picture. Next, enable the Show Picture 
option. You can reposition and scale the picture using the Offset and Size settings. You 
can use a different picture in each planar view.
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Cameras Menu
Each viewport has its own independent camera, called the editor camera. The editor 
camera is active by default, but you can create and activate your own cameras. Unlike the 
editor camera, your own cameras are shown as objects in the Object manager.

Scene Cameras
To activate your own camera, choose it from this list. For more details on creating and 
using your own cameras, see “Cameras” on page 400.

Link Active Object
Choose this command to view the scene from the origin of the active object. Your view 
will point in the direction of the object’s Z-axis. This command can be useful, among 
other things, for checking which objects a light source can see. Keep in mind that in 
some display modes your view may be blocked by the active object’s surfaces.

Editor Camera
This command activates the editor camera.

Projections
Here you choose the projection mode for the camera. You can choose from over a dozen 
modes. An example of each projection mode is shown in the following pictures.

 The camera’s position may change when you change the mode. To avoid this, select the 
desired view (e.g. View 3) from the View menu. 

Perspective: The default projection 
mode for the viewport. It shows 
you the scene as though looking 
through a conventional camera.

Parallel: The vanishing point is 
infinitely distant. All lines are 
parallel.
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Left: The YZ view. Right: The ZY view. Front: The XY view.

Back: The YX view. Top: The XZ view. Bottom: The ZX view.

Military: X:Y:Z = 1:1:1. Frog: X:Y:Z = 1:2:1. Bird: X:Y:Z = 1:0.5:1.

Gentleman: X:Y:Z = 1:1:0.5. This is 
a popular choice for architecture.

Isometric. A popular choice for 
technical subjects (e.g. machinery). 
The X:Y:Z format is 1:1:1.

Dimetric. Similar to Isometric, but 
with an X:Y:Z format of 1:1:0.5.
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Display Menu
This contains display-related options such as the shading mode. 

 To switch on realtime antialiasing, enable Antialiased Lines in the preferences on the 
OpenGL Shading page.

Level of Detail
Choose from Low, Medium or High. The setting affects the amount of detail shown on 
each object for the selected display type – the lower the detail, the faster the display.

Use Render LOD For Editor Rendering

Enable this option if you want rendering in the viewport to be as detailed as rendering to 
the Picture Viewer. For example, suppose you’re using a HyperNURBS model and you’ve 
set its Subdivision Editor value to 2 and Subdivision Renderer value to 5. If you render 
in the viewport with the option enabled, the Subdivision Renderer value will be used 
instead of the Subdivision Editor value.

Default Light

This command opens the Default Light manager. Using this manager, you can quickly 
light the selected objects from any angle without having to create light source objects. 
Each view has its own default light which is saved with the scene.

To use the manager, first select the objects that you want to be illuminated (select them 
in the view panel or in the Object manager). Next, in the Default Light manager click 
and hold down the mouse button on the sphere and drag to change the direction of the 
default light. BodyPaint 3D will switch on Quick Shading automatically and the selected 
objects will be illuminated using the default light.

To reset the default light to its original angle, in the Default Light manager right click 
(Windows) or Command-click (Mac OS) on the sphere. To switch off the default light and 
use your scene’s lights instead, choose Display > Gouraud Shading.
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The default light will also be used if you render and there are no lights in your scene. 
However, note that the default light used for rendering is different to the one used for 
viewport shading.

This is because the default light for viewport shading is made up of two light sources 
that are opposite each other (this helps reveal the shape and structure of the objects 
while you are modeling) whereas the default light for rendering is a single light source 
(this helps to ensure fast rendering — a single light is rendered faster than two).

Shading modes
Gouraud Shading
The highest quality display mode for viewports. All objects are shaded with 
smoothing and light sources are taken into account. The redraw rate is 
affected most by processor speed and graphics card speed — the faster your 
CPU and graphics display card, the faster scenes will redraw. If the display 
update becomes too slow, try reducing the size of the viewport.

Quick Shading
This is almost identical to Gouraud Shading. The difference is that the auto 
light is used instead of the scene’s lights to calculate the shading. You’ll find 
the auto light option on the Options page of the render settings. This can 
lead to a faster redraw rate since only a single light source (the auto light) 
needs to be evaluated.

Wireframe
Objects are shown as lines. The display is much faster than with Gouraud 
and Quick Shading. Wireframe is suitable for complex scenes, especially with 
Backface Culling switched on (see “Disable Backface Culling” on page 22).

Isoparms
This mode displays isoparm lines for objects that use them (e.g. NURBS 
objects). Other objects, such as polygon objects, will be displayed in 
wireframe. The isoparm display mode is very fast and particularly suited to 
complex scenes.
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Shaded Box
This mode displays each object as a shaded box. Each box has the same 
dimensions as the object it represents. This is a fast display mode that is 
suited to large scenes.

Box
This mode displays each object as a wireframe box. Each wireframe box has 
the same dimensions as the object it represents. Box is the second fastest 
display mode available, making it useful for extremely demanding scenes.

Skeleton
This is the fastest display mode of all. It is only suitable for hierarchical 
structures. Each object origin is shown as a small dot and the dots are 
connected according to the hierarchy.

Use Shading Property
If this option is enabled, objects use the display mode defined in their Display tags (if 
present). Objects without a Display tag continue to use the viewport’s shading mode.

Disable Backface Culling
Use this option to switch backface culling on and off. This can speed up the display and it 
also makes the scene easier to understand and edit. With backface culling, all concealed 
surfaces are hidden. A backface is a surface which points away from the camera. 

BodyPaint 3D is able to work out which direction a polygon points in by checking the direction 
of its surface normal. If the surface normal points towards the camera, the surface is a front 
face. If the surface normal points away from the camera, the surface is a backface and is not 
drawn when Backface culling is enabled. Figure 1 demonstrates the backface principle.
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Figure 1. Figure 2.

By convention, the normals should point outwards from their surfaces, as in Figure 1 above. Objects with 
inwardly-pointing normals may show display errors. To remedy, reverse the normals, as illustrated in 
Figure 2 (see “Reverse Normals” on page 286).

The following picture shows how backface culling hides concealed surfaces (backfaces). 
The object on the left does not use backface culling, the object on the right does.
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Disable Textures
Controls whether textures are shown in the viewport. You can switch textures on or off 
for individual objects using Display tags.

Use Textures enabled in the Display tag (Attribute manager).

X-Ray

X-ray mode off. X-ray mode on.

To activate the X-ray effect, enable this option. If the active object is a polygon object, it 
will become semi-transparent and you’ll be able to see its concealed points and edges.
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View Menu
Each view panel can have up to four viewports. Each of these viewports may have its 
own camera, projection type and display mode.

Viewport arrangement

You can choose a single-view mode or all-views mode. Choose from:

Single View 3 Views Left Split 4 Views Left Split

2 Views Stacked 3 Views Right Split 4 Views Right Split

2 Views Side By Side 4 Views 4 Views Stacked

3 Views Top Split 4 Views Top Split 4 Views Side by Side

3 Views Bottom Split 4 Views Bottom Split

Each viewport may have its own camera, projection type and display mode.

 These settings are saved automatically when you save the document.

Toggle Active View
This option toggles between the single-view mode and the all-views mode. When you 
want to toggle from all-views to a single view, choose the Toggle Active View command 
from the viewport that you want to use in single-view mode.

Views
Here you can switch between the single-views and the all-view mode. You can change 
each view’s projection type via its Cameras menu. The default projections are:

   View 1 F1 perspective
View 2 F2 top
View 3 F3 right
View 4 F4 front
All Views F5  all views
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Texture View

In contrast to the 3D view, the Texture view enables you to view and paint textures in 
two dimensions. Sometimes you’ll find it easier to paint an effect in the Texture view 
instead of in the 3D view. For example, suppose you want to paint a ring of flowers 
around the neck of a vase. In the 3D view, you would have to keep rotating around the 
vase as you paint. But in the 2D view, you could paint the entire band without having to 
stop to navigate to a new position.

To display a texture in the Texture view, do one of the following:

-  Create a new texture or load an existing texture from the Texture view’s File menu.

-  Click the desired objects, tags, materials, layers in the Object manager or Material 
manager.

You can paint on the texture as soon as it appears in the window. Note that you paint 
exclusively to the active layers of the active channels — each active layer is indicated by 
a red frame in the Material manager; each active channel is indicated by a colored pencil 
icon. Only one channel can be displayed at a time in the Texture view. When using a 
multibrush, keep in mind that you are painting to channels that are not displayed as well 
as the channel that is displayed.

The Texture view also lets you edit UVs thanks to its powerful integrated UV editor. See 
“UV Tools” on page 257.
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View Menu
Fit To Screen

Zooms the texture and UV polygons to fill the Texture view. 

Zoom 100%

The texture is displayed at its actual size. 

Zoom In, Zoom Out

Zooms in or out on the texture by 25%.

Set Zoom

Here you can enter the zoom factor manually as a percentage (100% represents the 
texture’s actual size), or you can click the triangle right of the box to open a menu of 
various zoom factors.

Close
Closes the Texture view.
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UV Mesh Menu
Show UV Mesh

To display the UV mesh while you are using the paint tools, enable this option. The UV 
mesh is displayed automatically when the UV Polygons tool or UV Points tool is selected.

Objects, Texture Tags, UV Tags
These menus give you a quick way to choose which UV mesh is shown. You can choose 
to display the UV mesh for any object, Texture tag or UV tag which belongs to the active 
material.

Textures Menu
Empty Canvas
This command removes the active texture from the Texture view and replaces it with a 
neutral gray background. This makes it easier to see your UV mesh.

To display the active texture again, double-click the texture in the Material manager. The 
Empty Canvas option will be disabled automatically.

Textures List
Here you’ll find a list of all textures currently in RAM. Choose a texture from this list to 
display it in the Texture view (the texture will be activated automatically in the Material 
manager).

Locking the Texture View
You can open multiple Texture views. To lock a Texture view to display the same texture 
no matter which object is selected, click the lock icon in the top right corner of the 
Texture view.
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BodyPaint 3D has hundreds of commands and a freely customizable GUI. This means 
that there are many settings also. To keep BodyPaint 3D easy to use, we have placed the 
settings in various places where they make the most sense. This chapter shows you where 
to find these settings and how to use them. Some of the settings are described in other 
chapters. Where this is the case, you’ll see a reference to the relevant page.

Configuration dialogs
Preferences
These settings control the general behavior of BodyPaint 3D. For example, you can 
change the background color for viewports. To access the preferences, choose 
Edit > Preferences from the main menu. See page 46 onwards for a full description of 
the preferences.

Viewport settings
Here you control aspects of viewport display such as the shading modes for active and 
inactive objects. Each viewport has its own settings. To access the viewport settings, in 
the viewport choose Edit > Configure. The viewport settings are saved when you save 
the scene. See “Configure” on page 15 for a full account of the viewport settings. 

Render settings
These settings define how the active scene will be rendered. For example, you 
can set the save path and output resolution. To access the render settings, choose 
Render > Render Settings from the main menu. The render settings are saved when you 
save the scene. See “Render Settings” on page 304.

Import / Export settings
These settings affect file import and export. For example, 3ds files can be scaled up by a 
factor of ten on import. To access the import/export settings, choose Edit > Preferences 
from the main menu. See page 64 onwards for descriptions of the import/export 
settings.

Browser settings
These settings give you control over the thumbnails which are displayed in the Browser, 
such as their size and which file formats shown. To access the browser settings, choose 
Edit > Preferences from the Browser’s menu. The browser settings are saved when you 
save the scene. See “Preferences” on page 94.

3 Configuration
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 To prevent the Browser from loading the settings, disable the Load Manager Settings 
option on the Document page of the preferences.

Configuration managers
Command manager
Use this manager to create or edit palettes and to create or edit short-cuts. To access 
the Command manager, choose Window > Layout > Command Manager from the main 
menu. The Command manager settings are saved when you quit BodyPaint 3D. See “The 
Command Manager” on page 40.

 Short-cuts are saved automatically when you quit BodyPaint 3D.

Menu manager
Here you can create your own menu structure for each manager. To access the Menu 
manager, choose Window > Layout > Menu Manager from the main menu. The Menu 
manager’s settings are saved when you quit BodyPaint 3D. You can also save the settings 
by clicking the Save All Changes button in the Menu manager. See “The Menu Manager” 
on page 42.

Other settings
There are many settings in addition to those mentioned above; for example, there are 
settings which enable you to choose the size of the thumbnails displayed in the Material 
manager.
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Graphical User Interface
This section shows you how to configure BodyPaint 3D’s GUI. Among other things, you 
can tab windows, create your own icon palettes and change the menu structure.

Windows
Arranging

 You can load a previously saved layout or revert to the default layout at any time. See 
“Working with Layouts” on page 91.

To change the position of a window, drag the window’s pin icon to the new position. A 
dark line appears while you drag to indicate the new location.

Resizing

Before moving the window’s edge.    After moving the window’s edge.

To change the width or height of a window, first move the mouse pointer to a window 
border; the mouse pointer changes to a double arrow to indicate the direction (vertical or 
horizontal) in which you can drag the border. Drag the border to resize. The neighboring 
windows are resized automatically to make room.
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Undocking

 You can insert a window or a icon palette into an undocked window to form a new GUI 
group. This is especially useful if you are using more than one monitor.

To undock a window, click its pin icon and choose Undock from the menu that appears. 
The window becomes freestanding and floats above the main window.

Choose Undock. Undocked window.

Undocked windows are fully functional. The advantage of docked windows is automatic 
justification when you resize a window.

Docking
New windows are undocked by default. To dock a window, drag its pin icon to the 
docking position. A dark line appears while you drag to indicate exactly where the 
window will be inserted.

To test docking, first add a new view panel (main menu: Window > New View Panel). Drag 
the new view panel’s pin to the desired insertion position, such as between the Object 
manager and Attribute manager (wait for the dark line to appear before you release the 
mouse).

New view, still undocked. The new view after docking.

To remove a window, click the window’s pin, choose Undock, click the pin once more and 
this time choose Close.

Naming
The Rename command on the pin’s menu enables you to name a window or icon palette. 
An icon palette’s name is only shown if the palette is displayed as a tab.
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Tabs
 When you drop a pin onto another pin, both become tabs, even if the target was not a 

tab.

You can display a window or icon palette as a tab. To create the tab, click the pin icon 
and select Make Tab. To move a tab from one group to another, drag the tab’s pin onto 
a tab or pin in the target group. The mouse pointer changes to a hand to indicate when 
insertion is possible.

Insertion is possible when the 
pointer changes to a hand.

Icon palettes makes great tabs too.

If you drop the tab onto a pin, it is inserted after the tab that owns the pin. If you drop 
the tab on to a tab, it is inserted before the tab that owns the pin provided that you 
released the hand icon on the left half of the tab; otherwise, it will be inserted after the 
tab. Keep in mind that you can use the icon palettes as tabs as well.

Converting tabs to windows
To convert a window displayed as a tab to a freestanding window, drag the tab’s pin 
slightly to the left and release the mouse button.

The Object manager is in the process of being 
undocked.

The undocked Object manager.
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Icon Palettes
 An undocked palette is a window in its own right. For example, it can contain several icon 

palettes and windows. This is especially useful if you are using more than one monitor.

Icon palettes, also known as toolbars, may contain any command that can be selected 
from a menu. Commands in palettes can be shown as icons, text, or as icons and text. 
Icon palettes help you reach important commands quickly. You can edit the existing 
palettes and you can create new palettes as well as dock them into the layout.

To access commands for saving, loading and changing the appearance of icon palettes , 
right-click (Windows) or Command-click (Mac OS) on the icon palette.

Creating a new icon palette

New icon palette, still empty.

To create a new (empty) icon palette, do one of the following:

-  Choose Window > Layout > New Icon Palette (main window).

-  Click the pin of any window (near the window’s top-left corner) and choose New Icon 
Palette from the pin’s menu.
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-  Right-click (Windows) or Command-click (Mac OS) on an existing icon palette to open 
the icon palette’s context menu and choose New Icon Palette.

You can only add commands when the Edit Palettes option is enabled. You can add 
commands to the palette in two ways: drag commands from an existing palette into the 
new palette or drag commands from the Command manager into the new palette. Once 
Edit Palettes is enabled, drag the first command onto the Empty Palette box of the new 
palette. When you drag further commands onto the palette, a dark line appears to show 
where the command will be inserted.

Add a command to the new palette. From left to right: icons only, text only, icons and text.

Changing the sequence
To move a command to a different location in the palette, drag the command to the new 
position (a dark line indicates the insertion position).

Icons or text?

Enable the Icons option to shown the commands as icons; enable the Text option to show 
the commands as text; enable both options to show text and icons for the commands. 
Enable the Vertical option to show text below each icon instead of to the right (provided 
Icons and Text are enabled).

Saving an icon palette
Save Toolbar As saves an individual palette. The file extension “.l4d” is added automatically.

To save the entire layout instead including the toolbar, choose Save Layout As or 
Save As Startup Layout from the Window > Layout menu. To save the layout and custom 
palettes automatically when you quit BodyPaint 3D, enable Save Layout At Program End in 
the preferences (Common page).
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Loading an icon palette
Use the Load Toolbar command to load a previously saved icon palette. The toolbar 
appears as a freestanding window which you can integrate into the layout as desired.

Vertical or horizontal?
Choose Transpose to toggle between vertical and horizontal alignment of commands.

Rows and columns

The values you select for Rows/Columns defines the number of rows or columns used for 
a palette. If Transpose is set to Vertical, this setting refers to the number of columns. If 
Transpose is set to Horizontal, this setting refers to the number of rows.

Think of this as the number of lines. For example, if you have 20 icons, setting this value 
to 2 will create two lines with 10 icons in each line. A value of 3 would create three lines, 
this time with seven icons in the first two lines and six in the third line.

Icon size
Choose the size of icons from the Icon Size sub-menu: Small (16x16 pixels), Medium 
(24x24 pixels) or Large (32x32 pixels).

Small
16 x 16 pixels.

Medium
24 x 24 pixels.

Large
32 x 32 pixels.

The original icon sizes are defined in the icon resource file (“Resource/icons/c4d_
icons.res”). The original sizes usually correspond to Large icons.

Creating folded command groups
You can group commands to form a folded palette. To do this, ensure that the Edit 
Palettes option is enabled, then position the mouse pointer over a command and right-
click (Windows) or Command-click (Mac OS) to open the context menu. From this menu, 
choose Fold Palette. Now only one command is visible. This is called the visible command. 
The small arrow near the bottom right corner of the icon indicates that it contains other 
commands.
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Next, disable the Edit Palettes option. Click and hold down the mouse button on the 
visible command. The folded palette appears. Either release the mouse button and select 
the desired command or position the mouse pointer over the desired command before 
you release the mouse button. Note that the visible command is also a hidden command.

If Lock Icon is disabled on the context menu, the visible command is the most recently 
selected command. For example, if the visible command is Cube and you select the 
hidden Cone command, the Cone command becomes the visible command. The order of 
the commands in the folded palette corresponds to their order before they were folded. 
Therefore usually you’ll want to arrange the commands before you fold them.

You can drag a visible command onto another palette. This enables you to use several 
folded command groups within the same palette. To create a palette with several folded 
command groups, firstly create two empty icon palettes. Use the first palette to create a 
folded command group, then drag the folded commands (i.e. the visible command) onto 
the second palette. Next, create the second folded group in the first palette and drag it 
onto the second palette, and so on. Once you’re done, close the redundant palette.

You can also use text-only display with folded palettes.

Unfolding command groups
You can unfold a folded group of commands into a palette of individual commands. 
Right-click (Windows) or Command-click (Mac OS) on the visible command to open its 
context menu. From this menu, choose the Unfold command. You can only choose this 
command when the Edit Palettes option is enabled.

The lock icon
If the Lock Icon option on the context menu is disabled, the visible command for a folded 
group of commands is always the most recently selected command. For example, if the 
visible command is Cube and you select the hidden Cone command, the Cone command 
becomes the visible command. If this option is enabled, the current visible icon will be 
locked, meaning that no matter which tools you then use from the folded palette the 
visible command remains the same. This command can be selected only when the Edit 
Palettes option is enabled.

Deleting commands from palettes
To delete a command from a palette, position the mouse pointer on the command and 
right-click (Windows) or Command-click (Mac OS) to open the context menu. From 
this menu, choose Delete Command. This command can be selected only when the Edit 
Palettes option is enabled.

Editing a palette
Commands can only be added when the Edit Palettes option is enabled. Position the 
mouse pointer on a command and right-click (Windows) or Command-click (Mac OS). 
Choose Edit Palettes to enable or disable the option.
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The Command Manager
The Command manager lists all the commands available in BodyPaint 3D. Use this 
manager to drag commands in order to create your own icon palettes or submenus (see 
“The Menu Manager” on page 43). You can also use the Command manager to define 
short-cuts.

Inserting commands into palettes
First, enable the Edit Palettes option. Next, drag-and-drop commands onto the palette. 
A dark line indicates where a command will be inserted. You can also drag separators 
onto palettes to visually separate commands into logical groups. Separator 1 is a line, 
Separator 2 is a space. Again, a dark line indicates the insertion point.

Use the drop-down list right of the pin to choose which command category is displayed 
in the list. Each category refers to a particular menu or manager. Note that some 
commands do not have icons.

Assigning short-cuts

 Do not assign short-cuts that are already used by OS commands.

You can assign a short-cut (for example, press Ctrl+B to open the Render Settings dialog) 
to any command. Use the Command manager to allocate the short-cuts. You can also use 
the Command manager to define a second short-cut for the same command. This can 
be useful when two keys are logical alternatives for a particular command. For example, 
the delete and backspace keys are both short-cuts for the Delete command. The second 
short-cut is also useful for standard commands that have different short-cuts under 
Windows and Mac OS.

 Some keys are reserved and you cannot assign them as short-cuts (e.g. left arrow).
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To create a short-cut

-  In the Command manager, click a command in the list to choose it.

-  Click in the Assign text box and press the desired short-cut.

-  Click the green check mark right of the text box. The short-cut appears in the Current 
box. To remove the short-cut, click the red cross icon.

Valid short-cuts are a single key, a combination of a key and Ctrl, Alt or Shift, or a 
combination of these.

 The short-cuts are saved in the “c4d_shortcuts.res” file, which is stored in the “prefs” 
folder.

BodyPaint 3D’s built-in hotkeys are extremely useful. For example, if you hold down the 
“1” key you can move the camera no matter which tool is active. These hotkeys come at 
a price — you cannot use them as short-cuts, even if you combine them with Ctrl/Alt/
Shift. If a short-cut has already been assigned, the command which uses the short-cut is 
displayed below the text boxes. You should remove the short-cut before reassigning it. 
To remove the short-cut, select the command which it is already assigned to and click the 
red cross.



42 • CHAPTER 3 CONFIGURATION • 43

The Menu Manager

Use the Menu manager to edit submenus and drop-down lists. You can also add new 
submenus. The Menu manager and the Command manager enable you to configure 
BodyPaint 3D’s interface freely to the way you like to work.

The menus
BodyPaint 3D has dozens of menus. Use the drop-down list at the top of the manager to 
choose which menu is shown in the list. Submenus are prefixed with Submenu. To open 
or close a submenu, double-click it.

Inserting commands

The Command manager lists all of BodyPaint 3D’s commands. You can drag-and-drop 
commands from the Command manager into the Menu manager. The mouse pointer will 
change form to indicate the insertion mode.
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Copy, Paste, Delete/Cut

Use these commands to copy, paste or delete the selected command.

Rename

Use this command to rename a submenu that you have created.

Move Up, Move Down, New Submenu

Use these commands to move the selected menu entry one position up or down the list 
and insert a new submenu above the selected entry. You can add commands or further 
submenus.

Apply, Save All Changes, Revert To Saved, Revert To Original

Apply applies the changes. Save saves all menu changes. Revert To Saved discards all 
settings and reverts to the most recently saved menu structure. Revert To Original 
reactivates the standard menu settings, which are permanently stored in the program 
(the factory settings).
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The Pin’s Menu
Each manager has a pin icon near its top left corner. Earlier in this chapter we explained 
how the pin is used to combine and arrange managers (see “Graphical User Interface” on 
page 33). The pin also has a menu, the commands of which are described below.

Undock

Removes the current manager from the main window. The manager becomes a 
freestanding window which floats above the main window.

Undock a tab to convert a manager to a floating window.

Rename

Use this command to rename a window or a tab. When renaming an icon palette, keep in 
mind that the name will only appear if the icon palette is displayed as a tab.

Make Tab

Converts the window or manager to a tab.

New Icon Palette

Creates an empty icon palette. Use the Command manager to add commands to the 
palette.
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New Group Window

A group window is a window which may contain multiple GUI elements such as a 
mutliple managers, view panels and toolbars. The command creates an empty group 
window into which you can dock elements.

Close

Closes the manager. To open the manager again, choose its name from the main Window 
menu.
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Preferences
 To reset BodyPaint 3D to its factory settings, quit BodyPaint 3D and delete all files in 

BodyPaint 3D’s “prefs” folder. Warning: if you also delete the “.b3d” files from the “prefs” 
folder, you’ll lose your custom presets for colors, brushes and gradients.

In the preferences you can change the editor’s appearance and change the way in which 
commands operate. To open the preferences dialog, choose Edit > Preferences.

Common

Language 

Chose a language for BodyPaint 3D’s interface from the installed language sets. After 
quitting and re-launching BodyPaint 3D all messages, menus and dialogs will change to 
the new language.

Scheme

Choose an installed schemes from this drop-down list.

Adapt Thread Priority 

If this option is enabled, your computer system will assign a low priority (i.e. less 
processor time) to BodyPaint 3D when you render to the Picture viewer. Enable the 
option if you have other processor-intensive programs running at the same time as 
BodyPaint 3D, such as if you are watching a movie while your picture is being rendered...
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Use QuickTime

 QuickTime may crash if you use damaged image files; this is not due to BodyPaint 3D and 
hence we offer the option to disable QuickTime.

If you enable this option BodyPaint 3D uses QuickTime provided it is installed on your 
computer system. Additional file formats will then be available to you. If the option is 
disabled, the Browser will scan faster because it has less file formats to check. 

Graphic Tablet, Use Hi-Res Coordinates

If you experience problems when using a graphics tablet with BodyPaint 3D, enable the 
Graphics Tablet option. If you still experience problems and you’re using the latest driver 
for the tablet, disable Use Hi-Res Coordinates to use the tablet in mouse mode. Although 
you’ll lose some of the tablet’s resolution, you should barely notice the difference.

Save Layout At Program End

 Always save a new layout using a unique name, even if you intend for it to be your normal 
layout. To save the layout, choose Window > Layout > Save Layout As.

If this option is enabled, the current layout will be saved when you quit BodyPaint 3D and 
restored when you restart the program.

Realtime Spinner

Disable this option to switch off realtime refresh in the viewport while you change the 
values of parameters in the Attribute manager. In other words, if you disable this option 
the viewport will only be refreshed once you’ve released or mouse button or stopped 
dragging a slider. This helps to prevent the viewport from slowing down when you are 
working with complex scenes.

Realtime Manager Update (During Animation)

 This function has an effect only if you are using the BodyPaint 3D module with 
CINEMA 4D. Please refer to the Configuration chapter in your CINEMA 4D reference 
manual for details.

Center Point Editing Axis

If you select points, edges or polygons when this option is enabled, a temporary axis 
system appears in the center of the selection.

Recalculate Scene On Rewind

 This function has an effect only if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see the Configuration chapter in your CINEMA 4D reference manual.
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Reverse Orbit

This option reverses the camera’s rotation when you navigate using the mouse such as 
when you drag with the ‘3’ key held down. This useful if you commonly use another 3D 
application such as 3ds max or Maya where the camera rotates in the opposite direction 
to BodyPaint 3D’s camera.

Render Threads

Use this drop-down list to manually set the number of render threads (the number of 
render lines in the viewport or Picture Viewer). On single-processor systems, there is 
little point in using several threads because this may reduce render performance and the 
threads may be assigned different portions of render time (unequal distribution in the 
viewport).

Choose from Optimal (BodyPaint 3D chooses the number of threads), 1 (switches off 
multithreading on multi-processor systems), 2, 4 or 8.

Attribute Manager Limit

Here you can define the maximum number of elements (objects, keys, etc.) whose 
properties are displayed in the Attribute manager.

For example, if you set the value to 15 and select 35 materials, the Attribute manager 
will give you access to the first 15 materials only. Any changes you make in the Attribute 
manager will affect these first 15 materials only.

Macintosh (Mac OS only)

Exchange CTRL <–> COMMAND-key

BodyPaint 3D uses the Ctrl (Control) key as the default modifier key. The Command key is 
used for simulating the right mouse button (Command-click). If you want it the other way 
round, enable this option.

Deny Power Cycle

Switches off your Mac’s power cycle.
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Interface
This tab lets you adjust the look-and-feel of BodyPaint 3D’s user interface.

Dialogs
Use Style to control the order of the OK and Cancel buttons within dialogs. Windows 
uses OK on the left and Cancel on the right, while the reverse is true under Mac OS. 
Choose whichever you feel comfortable with on your platform. Use Alignment to choose 
the alignment of the OK and Cancel buttons: left-aligned, centered or right-aligned. 

Help Text
If the Help Text In Statusbar option is enabled, hover the mouse pointer over an icon 
to display a description for the icon in the status bar at the bottom of the screen. If the 
Bubble Help option is enabled, help information appears next to the mouse pointer when 
you hover the mouse pointer over an icon. 

Menus
Here you can choose whether, in addition to the normal command descriptions for menu 
items, BodyPaint 3D displays icons (Show Icons enabled) and/or keyboard short-cuts 
(Show Short-cuts option enabled). 

Look & Feel
In this part of the dialog you can modify the look-and-feel of the program’s interface. 
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Fonts 

 The font changes will be effective only after you quit and restart BodyPaint 3D. 

Here you can choose which font is used for BodyPaint 3D’s menus, dialogs, and so on. 
Choose the desired font from the drop-down list and click the F button. In the dialog 
that opens, choose the font and its size. Clicking the R button reverts to your active 
system font.

Delays

If you are a Windows user you may have noticed that windows and menus open much 
faster in BodyPaint 3D than on your desktop. You can use the options under Delays to 
simulate this delayed reaction for various actions within BodyPaint 3D. Choose the action 
from the drop-down list. Set the delay for this action in the text box to the right.

Colors

Using the settings on this page, you can change the color of nearly all GUI elements in 
BodyPaint 3D.

Live Refresh

The colors are changed in realtime. If this slows down your computer system, disable the 
option and the color will be changed after you’ve released the mouse button.

RGB

Defines the color of the GUI element using RGB sliders.

Bitmap

Enables you to load a 2D image as a background for the interface.
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Reference

Choose Reference to open a list of presets for the GUI elements. In the list, click a preset’s 
name to enable its settings.

Viewport

Options
BodyPaint 3D shades (i.e. draws) the objects in the viewport using one of two modes: 
Software Shading or OpenGL Shading. In Software Shading mode, BodyPaint 3D uses its 
own optimized viewport shading engine. In OpenGL mode, your graphics card’s OpenGL 
feature accelerates viewport shading (provided that your card supports OpenGL). 
Which of the two modes is the fastest depends entirely on your hardware setup — use 
a complex scene and test both modes. You’ll find options for these two modes on the 
Software Shading and OpenGL Shading pages.

View

Refresh Active View Only (Modeling / Animation)

 This function has an effect only if you are using the BodyPaint 3D module with 
CINEMA 4D. Please refer to the Configuration chapter in your CINEMA 4D reference 
manual for details.

3D Grid

Controls whether the viewport grid is drawn in 3D (option enabled) or as a 2D grid 
behind the objects (option disabled).
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Use Draw Cache

Enable this option to speed up viewport shading. Keep in mind that the RAM required 
will rise slightly when you enable this option.

Redraw Limit

This process enables you to work smoothly in the viewports. With some complex scenes, 
you may be unable to move objects smoothly in the viewports with full shading due to 
hardware limitations such as processor speed. To help resolve this issue, BodyPaint 3D 
estimates how long it will take to refresh the viewports. If the estimated time exceeds 
the redraw limit specified here, a faster display mode will be used automatically. For 
example, Quick Shading will be reduced to Wireframe. Or if the wireframe mode is still 
too slow, Box will be used instead.

The default value is 600 milliseconds. To prevent a less detailed display mode from being 
used, set Redraw Limit to a very high value such as 10,000 milliseconds.

Editor : Pixel

These values specify the ratio of a pixel’s on-screen width to its on-screen height. The 
pixel ratio for most monitors is 1:1. However, some display media use a pixel ratio other 
than 1:1. This will lead to distortion unless the pixel ratio is adjusted accordingly. For 
example, circles will appear to be ellipses. To calculate the pixel ratio manually, expand 
the editor window to fill the entire screen. Select the side view and create a cube. 
Measure the width and height of the cube with a ruler and enter these values into the 
corresponding boxes.

Render Safe

 You can set this option separately for each viewport using the viewport settings, which 
apply to the active viewport only. (See “Configure” on page 15.)

If this option is enabled, the boundaries of the film format are shown in the viewport.

Action Safe

 You can set this option separately for each viewport using the viewport settings, which 
apply to the active viewport only. (See “Configure” on page 15.)

If this option is enabled, a frame appears in the 3D view to mark out the region in which 
it is safe for action to take place so that it will be in full view when played back on the 
target medium (monitor, TV screen, movie theatre screen). To adjust the size of the 
frame, enter a new percentage value into the box to the right. The percentage is based 
on the film format selected in the render settings.

If you’re a frequent moviegoer, you may have noticed that the screen’s curtains are pulled 
closer or further apart depending on the movie’s format. Even with TV screens, part of 
the picture may be lost. Use Action Safe to ensure the viewer sees all that matters.
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Title Safe

 You can set this option separately for each viewport using the viewport settings, which 
apply to the active viewport only. (See “Configure” on page 15.)

If this option is enabled, a frame is shown in the 3D view. To change the size of the 
frame, enter a new percentage value into the box to the right. The percentage is based 
on the film format selected in the render settings. Title Safe marks out a region in which 
it is safe to place opening credits, final credits and other text, where there will be a 
minimum of distortion when the movie is played back on the target medium.

Many television sets have a dome-shaped picture-tube whose curvature increases 
towards the edges. Pictures displayed on these sets tend to distort at the edges. Avoid 
placing text such as film titles in these areas.

Semi-Transparent Axes

If this option is enabled, the axes of objects are semi-transparent. Enter the transparency 
strength into the box to the right. If the option is disabled, the axes are opaque.

Scale Axes

If this option is enabled, when you scale an object its axes as seen in the viewport are 
scaled also. However, large or small axes make it difficult to perform quick actions (move, 
scale, rotate) by dragging a particular axis. If this option is disabled, the object axes retain their 
size when the object is scaled.

Colors

Use this page to define the viewport colors. Choose which element whose color you want 
to adjust from the list and use the sliders or system color dialog to change its color.
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To reset the colors to the default settings, delete the “CINEMA 4D.prf” file (or 
“CINEMA 4D” file if extensions are not displayed) from BodyPaint 3D’s “prefs” 
folder. When you next start BodyPaint 3D, the default colors will be used and a new 
“CINEMA 4D.prf” file will be created automatically.

OpenGL Shading

Refresh

Smart Window Refresh

 The Smart Window Refresh function is not supported by all OpenGL cards. If display 
errors appear with the option enabled, your card does not support Smart Window 
Refresh.

When enabled, this option accelerates window refresh under OpenGL if, for example, you 
move an undocked manager over the viewports. If the option is disabled, OpenGL must 
refresh the entire screen each time.

Smart Live Selection

 The Smart Live Selection function is not supported by all OpenGL cards. If display errors 
appear with the option enabled, your card does not support Smart Live Selection.

If this option is enabled, live selection under OpenGL is accelerated — the selected 
polygons or points are redrawn instead of the entire screen.
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Textures

Use Textures

 You can work more smoothly in the viewports if you disable this option.

This option defines whether textures are displayed when the Gouraud Shading mode is 
activated. This setting is applied globally, i.e. it affects all viewports. You can define this 
option separately for each viewport using the viewport settings (see “Configure” on page 
15), which apply to the active viewport only.

Texture Interpolation

Texture Interpolation set to Nearest (top right) and Linear (bottom right).

Texture Interpolation controls which method is used to interpolate textures when you 
zoom objects in the viewport: Nearest or Linear. Nearest uses the color of the nearest 
pixel in the texture, causing hard transitions in the zoomed texture. Linear uses linear 
gradients (i.e. linear interpolation) to create smooth or blurry transitions in the zoomed 
texture.

Extensions
These settings enable you to optimize OpenGL for BodyPaint 3D. The best settings 
depend on your system’s hardware and drivers. Try each option for optimum 
performance.

Allow Dual Planes, Use OpenGL ARB extension For Dual Planes

Enable Allow Dual Planes for faster refresh when moving objects. BodyPaint 3D will 
refresh the relevant parts of the image only, speeding up shading. Some graphics cards 
do not support this feature.

The Use OpenGL ARB Extension for Dual Planes option switches to an alternative method 
for displaying dual planes. Depending on the hardware, this method may provide faster 
viewport refresh. Some drivers do not support this feature, in which case this option will 
be grayed out.
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Use Line Polygons

Enable this option for faster wireframe display. It affects wireframe display only.

Use OGL Points For Handles

Enable this option for faster display of object points (the points that are displayed when 
you select the Points tool). Some graphics cards do not support this feature.

Open GL Hardware Lighting

 You can test the performance of your graphics card using CINEBENCH 2003, the free 
benchmarking tool based on CINEMA 4D. Check out cinebench.com.

If this option is enabled, OpenGL will light your scene instead of the software shading. 
This usually speeds up the viewport display. OpenGL lighting supports the following:

Environment Object

- Environment color.

- Fog (3D view only).

Light

- Light types: Omni, Spot, Distance, Parallel.

- Color and brightness.

- The No Diffuse and No Specular options.

Materials

- Luminance.

- Specular, incl. Width and Height.

- Specular Color.

- Texture in the Color channel with Specular.

Restrictions:

- Some light parameters are not supported.

- Only the first eight light sources are used.

Antialiased Lines

If this option is enabled, lines are smoothed (antialiased) by the OpenGL implementation 
provided the mode is supported by your graphics card.
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Software Shading

Textures

Use Textures

 You can work more smoothly in the viewports if you disable this option.

This option defines whether textures are displayed when the Gouraud Shading mode 
is activated. This setting is applied globally, i.e. it affects all viewports. You can define 
this option separately for each viewport using the viewport settings, which apply to the 
active viewport only (see “Configure” on page 15).

Perspective Correction 

If this option and Use Textures are both enabled, all material previews are corrected for 
perspective in the viewports.
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BodyPaint

Default Texture Format

 In contrast to previous versions of BodyPaint 3D, the default format is now “TIFF.”

Defines the default format used when you create a new texture. You can change the 
texture format at any time using the Save As command.

Undo Buffer For Textures

Max Memory Usage

Defines the maximum amount of RAM reserved by BodyPaint 3D for undoing changes to 
texture bitmaps. 

At Least

Defines the minimum number of changes stored in RAM that can be undone regardless 
of how much RAM is required. This parameter has a higher priority than Max Memory 
Usage.

Brush

Show Brush Shape While Mouse Move, Show Brush Shape While Painting

To view BodyPaint 3D’s brush cursor while you move the mouse or paint, enable these 
options.
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3D View Texture Interpolation

Shading

If this option is enabled, the texture will be interpolated in shading/raybrush mode.

Projection Painting

Pixel Border Around UV Polygon

When you are using projaaection painting, a pixel border is created for the projection 
each time you paint over the edge of a UV polygon. This setting defines the width of the 
pixel border in pixels.

A pixel border is created to bridge the gap between the UV polygons.

The pixel borders — marked in the illustration above — help to prevent seams on the 
textured object when you render. In previous versions of BodyPaint 3D, these seams were 
mostly caused by gaps between the UV polygons.
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Tile U, Tile V

When you apply paint to an edge of the texture, sometimes the projected paint may spill 
over the edge and also appear on the opposite side of the texture. This mostly happens 
when you are using a high Pixel Border va;ue and when there are UV polygons at the 
edges of the textures. To prevent the paint from seeping over the edge onto the other 
side, disable the appropriate option.

Project On Invisible Parts

If this option is enabled, you can also paint onto invisible parts of the object such as the 
reverse side of a cube.

Border On Same Object

This option helps to prevent seams at the edges of UV polygons when you are using 
projection painting. It works by projecting the texture not only onto the visible parts of 
the object, but also onto the border areas, i.e. the parts which are just out of view.

Bitmap Filter

Here you can define default settings for the filters (see Chapter 13, Filter Menu).

Preview Width, Preview Height

The width and height of the preview which appears when you use a filter.

Show Source Preview

Select this option to show a preview, as well as the original, in the filter dialogs.

Live Action

If this option is enabled, the filter is applied in real-time when you move the area in the 
preview window. Changes made using the sliders are also applied in realtime. Disable the 
option if you want to speed up the preview.
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Wrap Texture

Enable this option if you want the texture to be tiled. Suppose you want to apply a blur 
filter to your texture with a blur radius of 20 pixels. What should the filter do at the edges 
of the texture? Usually, the edge pixel is repeated multiple times in the blur calculation 
to make up the numbers. This tends to create unwanted seams if the texture is tiled. 
However, when the Wrap Texture option is enabled, the filter borrows pixels from the 
other side of the texture to prevent seams.

Document Preview

This option shows a preview of the filter in the view panel and Texture view. The preview 
may take a few moments to appear.

Use Photoshop Filters, Plugin Folders

BodyPaint 3D enables you to use Photoshop filters provided Photoshop is installed on 
your computer system. Here, choose folder which contains the Photoshop plugins folder 
(also, the path will be located automatically when you start BodyPaint 3D for the first 
time).

Some Photoshop plugins may not work due to issues with the Photoshop SDK, depending 
on which version of Photoshop is installed. In general, most third-party Photoshop filters 
are compatible.

 If you set a path directly to the third-party filters, only the ones which work will be listed 
on the Filters menu.

If you don’t want to use Photoshop filters, disable the Use Photoshop Filters option. The 
drop-down list enables you to choose which path is used if more than one version of 
Photoshop is installed. Use the Add and Remove buttons to add or remove paths.
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Document

Save RTTM Textures

If you have enabled realtime texture mapping (i.e. the Disable Textures option in the 
Configure Viewport dialog is off), small temporary textures will be created so that you can 
see the textures in the viewports. These RTTM textures take a noticeable time to create and 
they must be calculated each time you load the scene. To speed up the loading process, 
enable Save RTTM Textures. The RTTM textures will then be saved within the scene file.

Save Particles

 This function has an effect only if you are using the BodyPaint 3D module with 
CINEMA 4D. Please refer to the Configuration chapter in your CINEMA 4D reference 
manual for details.

Create New Objects In View Center

By default, BodyPaint 3D creates all new objects at the origin of the world coordinate 
system. However, If the origin is off-screen, a newly created object may be out of sight. 
If this option is enabled, new objects are created in the center of the active view instead, 
i.e. always within view.

Generate Backup Copies

 This command saves backup copies of the scene only; it does not backup your textures.

When you save a scene with a filename which already exists in the destination folder, the 
original scene will be overwritten by default. If this option is enabled, BodyPaint 3D will 
rename the original file before creating the new file.

Backup Copies

This setting defines the maximum number of backup copies which can be saved for a 
scene (provided Generate Backup Copies is enabled).
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Undo Depth

Determines the maximum number of changes you can undo in a row. (See “The undo 
buffer” on page 163.)

Recent File List

Controls the maximum number of files shown on the File menu’s Recent Files list.
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Import/Export
 Some of the import/export filter options are for animation only. These functions only have 

an effect you are using the BodyPaint 3D module with CINEMA 4D.

3D Studio R4 Import/Export

Scale

 This option is for import and export.

Determines whether and by how much 3ds files are scaled when loaded or saved.

Adapt Textures

 This option is for import only. Only the name is changed. You still need to convert the 
image.

3D Studio does not support as many graphics file formats for textures etc. as 
BodyPaint 3D. Its main format is TIFF. If you enable this option, all texture filename 
extensions are changed to the one specified in the Suffix box (for example “frame.jpg” 
becomes “frame.tif”).

Biovision BVH Import
 This imort filter is only of use if you are using the BodyPaint 3D module with CINEMA 4D. 

Please refer to the Configuration chapter in your CINEMA 4D reference manual for details.

CINEMA 4D XML Export
XML is a standardized language for file exchange. This export is targeted mainly at plug-
in developers, to help them better integrate their extensions into the file. For details on 
this format, visit www.xml.org.
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DEM Import

DEM files are often used for landscapes.

Factor

Determines whether and by how much DEM files are scaled when imported.

DXF Export

Scale

Determines whether and by how much DXF files are scaled when saved.

Export Type

The DXF standard offers several options for saving an object. Here you can choose the 
type into which the object is converted when being saved. The choices are Polyline, Solid 
and 3DFace.
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DXF Import

BodyPaint 3D can work with DXF files of all versions. It can correctly interpret the 
following elements: SOLID, 3DFACE, LINE, POLYLINE, CIRCLE, ARC, POINT and TRACE. All 
three-dimensional data is read in accurately. All documented POLYLINE combinations as 
well as height and elevation data are supported. The same is true of element coordinate 
systems, layer names and various line thicknesses.

Scale

Determines whether and by how much DXF files are scaled when loaded.

Circle Subdivision

Determines the number of polygon segments used for subdividing circle segments.

Connect

DXF files often consist of many small elements. During loading, BodyPaint 3D attempts to 
combine elements of the same color (By Color), layer (By Layer) or not at all (No).

Frozen Layers

Enable this option if you want to convert frozen layers when loading. Many CAD 
programs offer the option to freeze (i.e. hide) temporary or unused layers.

2D Elements

Specifies whether two-dimensional DXF elements should be converted.

Align Normals

BodyPaint 3D assumes all surfaces of an object are uniformly aligned. This is not 
necessarily the case with DXF files. If adjacent surfaces are differently aligned, their 
normal vectors point in different directions. During rendering, this can result in unwated 
color banding. BodyPaint 3D uses this option to realign adjacent surfaces.
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Triangulate Polygons

DXF files may contain three-dimensional polygons. BodyPaint 3D can triangulate 
these if this option is enabled. This means that the inscribed surface is generated as a 
3D object. This is useful in most cases and therefore is the default setting. Unless the 
option is disabled, polygon lines are converted, which is useful for further processing in 
BodyPaint 3D.

Direct3D Export
 DirectX can only process graphics measuring 2n pixels (textures need to be 2x2, 4x4, 8x8, 

16x16, 32x32, 64x64, 128x128, 256x256 and so on).

Scale

Determines whether and by how much Direct3D files are scaled when saved.

Format

Direct3D is a text format. To facilitate manual editing of the file, this option formats the 
whole file automatically. This increases the file size.

Save Templates

When enabled, the template header is written to the file.

Export Textures

When enabled, all texture information is saved for all objects. This includes creating UV 
coordinates for each object.
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Adapt Textures

 Only the name is changed. You still need to convert the image.

DirectX uses mainly the PPM (portable pixel map) graphics format, but also BMP 
(Windows bitmap). BodyPaint 3D does not recognize the former, which means that 
textures need to be converted. This can easily be done using most image editors. But 
what about adapting the names?

If you enable this option, all texture filename extensions of scene materials are 
automatically changed when exported. For example, “image.jpg” becomes “image.ppm”. 
This means you do not need to check whether a change of name is required for each 
material and attribute.

Save Normals

If this option is enabled, normal vectors are created for all surfaces Otherwise Direct3D 
will calculate the normals.

Generate Mesh

Direct3D works with two types of model: Frame and Mesh. Frames, as with 
BodyPaint 3D, consist of objects arranged in a hierarchical structure. Objects remain 
encapsulated. In a mesh, on the other hand, all objects are on the same level..

Illustrator Import

If you want a 2D vector graphic (e.g. a company logo) to become three-dimensional, 
then import it in the Illustrator format. Also vector graphics from other programs, such 
as Macromedia Freehand or CorelDraw, can be imported if saved in Illustrator format.

Scale

Determines whether and by how much Illustrator files are scaled when loaded.

Connect Splines

If this option is enabled, shapes are imported as a single, connected Spline object.

Group Splines

Imports each line as a separate Spline object.
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LightWave Import

When opening a LightWave file, not only the object geometry is imported but also the 
rest of the scene including the camera’s focal length (especially useful when used with 
3D camera tracking software such as MatchMover or 3D-Equalizer), texture maps and 
bones information. Additionally, UV coordinates and weight maps of LightWave are 
imported.

Scale

Determines whether and by how much LightWave files are scaled when loaded. The 
default value is 10 (LightWave uses a smaller construction scale than BodyPaint 3D).

Textures

If enabled, LightWave object’s texture information is also loaded.

Lights

LightWave object’s light source information is also loaded when this option is enabled.

Split Selections

LightWave supports double sided polygons. When opening such an object BodyPaint 3D 
creates double polygons, which may lead to rendering artifacts. If you have such objects 
in your LightWave scene, enable this option. Two grouped objects are created, one of 
which may be deleted if no longer required.
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Monzoom Import

This import filter enables you to load objects, materials, textures, light sources and 
the cameras of a Monzoom/Reflections scene. Scale determines whether and by how 
much Monzoom files are scaled when loaded. The earliest versions of Reflections are 
not supported. In these cases load the file into a more recent version of Reflections or 
Monzoom and save it out as a new file.

In Reflections/Monzoom, Phong shading can be assigned to individual polygons. For 
this reason you can choose when the imported objects are given a Phong shading tag: 
always, never, when most of the polygons are smoothed or when at least some of the 
polygons are smoothed. In most cases, Majority Of Faces is the best setting.

QuickDraw 3D Export

Scale

Determines whether and by how much QuickDraw 3D files are scaled when saved.

Save Textures

If this option is enabled, all objects are saved with their textures (including UV 
coordinates if present). If this option is disabled, objects are saved with basic color 
information only (i.e. without textures).

Maximum Size

You can use any size of texture provided your system has sufficient memory. However, 
avoid large textures since they add to the loading time. This option restricts the size of 
QuickDraw 3D files. Textures are scaled to the specified value in pixels.
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QuickDraw 3D Import

Scale

Determines whether and by how much QuickDraw 3D files are scaled when loaded.

NURBS Subdivision

Specifies whether and to what extent QuickDraw 3D NURBS are triangulated during 
loading.

Sphere Subdivision

Specifies whether and to what extent QuickDraw 3D spheres are triangulated during 
loading.

Cone/Cylinder Subdivision

Specifies whether and to what extent QuickDraw 3D cones and cylinders are triangulated 
during loading.

STL Import / Export

The STL format is mostly used in the field of rapid prototyping to design moulds. The 
geometry is described as triangles.

Scale

Determines whether and by how much STL files are scaled when imported or exported.
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VRML 1 Export

Scale

Determines whether and by how much VRML 1 files are scaled when saved.

Format

VRML is a text format. To facilitate manual editing of the file, this option carries out 
automatic formatting on the entire text file during export.

Backface Culling

This option enables an attribute on all exported objects which switches off drawing of 
the non-visible sides of all objects in the web browser. This gives a much faster display.

Textures

This menu specifies the action BodyPaint 3D is to take when exporting textures. None 
ignores the textures and saves only color information. Referenced means objects are saved 
with the paths to the textures. With File saves all textures directly in the VRML file (called 
inline textures). Any UV coordinates are also saved.

Maximum Size

BodyPaint 3D allows you to use any size of texture — provided of course you have plenty 
of memory. However, when viewing a scene it can be irritating to wait for large textures 
to load. This option enables you to limit the size of VRML files. The material images are 
scaled to the specified value (in pixels); the proportions remain intact.
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VRML 1 Import

Scale

Determines whether and by how much VRML 1 files are scaled when loaded.

Optimize Hierarchy

If Optimize Hierarchy is enabled, the scene structure is optimized once the VRML1 file 
has been loaded. Superfluous dummy objects are removed and the object hierarchy is 
optimized. This creates a clearer overview, helping you to work more quickly.

Import Normals

Some NURBS modeling applications tend to export mesh which is prone to shading 
errors. You can combat this problem by enabling this option and by enabling vertex 
normals in your modeling appliaction (vertex normals are normals for points).

Depending on the number of surfaces, a point may have several normals. BodyPaint 3D 
is able to use these normals to produce high quality shading despite the sub-optimized 
mesh. The vertex normals are stored in a Normal tag, which appears in the Object 
manager and looks as follows:

Keep in mind that if you edit the points of such an imported object, the Normal tag 
will no longer work properly, which may lead to shading anomalies. Moving, scaling or 
rotating the object is fine, however. If you delete the Normal tag, the standard shading 
will be used instead.
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VRML 2 Export

Scale

This is for specifying whether and to what degree VRML 2 files are scaled when saved.

Format Text

VRML is a text format. To facilitate manual editing of the file, this option carries out 
automatic formatting on the entire text file during export.

Backface Culling

This option enables an attribute on all exported objects which switches off drawing of 
the non-visible sides of all objects in the web browser. This gives a much faster display.

Save Animation, Keys/Second

 These feature only have an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see your CINEMA 4D reference manual for details.

Textures

This drop-down list specifies the action BodyPaint 3D takes when exporting textures. 
None ignores the textures and saves only color information. Referenced means objects 
are saved with the paths to the textures. With File saves all textures directly in the VRML 
file (called inline textures). UV coordinates are also saved if present.

Maximum Size

VRML 2 provides two options for making textures available to their objects. The first 
option is identical to the one used in BodyPaint 3D — a reference to the texture file is 
saved along with the VRML scene. If you want to go with this option, specify the value 0. 
The second option integrates the graphics data directly into the VRML 2 file.
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Since the texture is written uncompressed, in text format, a texture of 1000x1000 pixels 
quickly reaches a file size of 4MB. To avoid such large files, specify a value (larger than 
0) to limit the size of textures. The materials are then scaled to this value (in pixels). The 
proportions remain intact. For example, if you have a texture of 800x600 pixels and 
you set a maximum value of 100, the texture is proportionally scaled down to a size of 
100x75 pixels before it is saved.

VRML 2 Import

Scale

This specifies whether and to what extent VRML 2 files are scaled when loaded.

Optimize Hierarchy

If Optimize Hierarchy is enabled, the hierarchy is optimized once the VRML 2 file has been 
loaded. Superfluous dummy objects are removed and the object hierarchy is optimized. 
This creates a clearer overview, helping you to work more quickly.

Optimize Structure

Enable this option to optimize the scene’s structure during import.

Import Normals

Some NURBS modeling applications tend to export mesh that is prone to shading errors. 
You can combat this problem by enabling this option and by enabling vertex normals in 
your modeling appliaction (vertex normals are normals for points).

Depending on the number of surfaces, a point may have several normals. BodyPaint 3D 
is able to use these normals to produce high quality shading despite the sub-optimized 
mesh. The vertex normals are stored in a Normal tag, which appears in the Object 
manager and looks as follows:
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Keep in mind that if you edit the points of such an imported object, the Normal tag 
will no longer work properly, which may lead to shading anomalies. Moving, scaling or 
rotating the object is fine, however. If you delete the Normal tag, the standard shading 
will be used instead.

Wavefront Import / Export

Factor

This specifies whether and to what extent Wavefront files are scaled during import and 
export.

Import Normals (import only)

Some NURBS modeling applications tend to export mesh that is prone to shading errors. 
You can combat this problem by enabling this option and by enabling vertex normals in 
your modeling appliaction (vertex normals are normals for points).

Depending on the number of surfaces, a point may have several normals. BodyPaint 3D 
is able to use these normals to produce high quality shading despite the sub-optimized 
mesh. The vertex normals are stored in a Normal tag, which appears in the Object 
manager and looks as follows:

Keep in mind that if you edit the points of such an imported object, the Normal tag 
will no longer work properly, which may lead to shading anomalies. Moving, scaling or 
rotating the object is fine, however. If you delete the Normal tag, the standard shading 
will be used instead.
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Texture Paths

BodyPaint 3D searches for texture files in the following locations: in the same folder as 
the scene; in the scene’s “Tex” folder, in BodyPaint 3D’s “Tex” folder and in the Texture 
Paths specified on this page. If a texture is in any of these folders, add the texture’s folder 
to this dialog.

You can specify up to ten paths. Each path is searched recursively, i.e. sub-folders are also 
searched. Type the path name directly into a text box. Alternatively, click a Path button, 
guide the system dialog that opens to the texture’s folder and click Open (Windows) or 
Choose (Mac OS). If a texture still cannot be found after all the texture paths have been 
serached, BodyPaint 3D will report a texture error.

Units

Display Units

Values are displayed together with their unit of measurement by default. If this option is 
disabled, the unit of measurement is not be displayed.
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Use HPB System

You may find this option useful if you are an experienced animator. If this option is 
disabled, the active object rotates about its local axes or the world axes when you use 
the mouse. 

If, on the other hand, you enable this option, the active object rotates about the HPB 
angles when you use the mouse. In other words, you rotate the object using the heading, 
pitch and bank of the object’s parent system. Only experienced animators should use this 
option, since it requires a great deal of abstract thought.

Basic Units

Here you determine the basic unit of measurement in BodyPaint 3D. Choose from pixels, 
kilometers, metres, centimeters, millimeters, micrometers, nanometers, miles, yards, feet 
and inches.

For example, if you select Centimeter as the basic units, position values will be stated in 
cm. Note that if you change units the numerical values will not be converted. However, 
you can enter values in different units. For example, if the basic units are cm and you 
type “5 km” into a dialog, the value will be converted to 500,000 cm.

If you set the basic units to Pixel, the unit of measurement will not be specified. It is then 
up to you to decide how to interpret the values. You can use the following abbreviations 
for units when entering values:

Abbreviation Units
no units 
specified

pixels

km kilometers
m meters
cm centimeters
mm millimeters
um micrometers
nm nanometers
mi miles
yd yards
ft feet
in inches
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Animation Units

 This feature only has an effect if you are using BodyPaint 3D as a module with 
CINEMA 4D. Please see your CINEMA 4D reference manual for details.

Color Chooser

Color System C4D, Color System BP

There are many places in BodyPaint 3D where you can choose a color. Use Color System 
C4D and Color System BP to specify which type of color chooser appears in parts of the 
program related directly to normal functions or directly to painting respectively. You can 
select from the following types of color chooser (after selecting a type of color chooser, 
you’ll see its preview appear at the bottom of the dialog).

RGB Only RGB Colored

.

HSV Only HSV Colored

Color Box Color Table

RGB Range, Hue Range, Sat/Val Range

You can use these three range menus to define the units and range of the RGB and HSV 
color systems. Choose from:

• 0 - 255

• 0% - 100%

• 0 - 65535

• 0° - 360° (“H” only - Hue)
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Quick Storage / Mixing Panel

1. Quick Storage, 2. Mixing Panel.

Quick Storage

Enable this option to display a row of color swatches. These are useful for storing and 
reselecting colors that you will need to select frequently.

To save the active color to the quick storage row, do one of the following:

-  Drag and drop the active color preview onto a swatch in the quick storage row.

 - Ctrl-click on a swatch in the quick storage row.

Mixing Panel

If this option is enabled, a mixing panel with be displayed. This mixes together four base 
colors to produce a range of colors. Click on the panel to choose the color at that point.

A large swatch is displayed in each corner of the mixing range for the four base colors. To 
choose a new base color, do one of the following:

-  Click on a base color swatch. This replaces the color in the swatch with the active color.

-  Drag and drop the active color preview onto a base swatch. Again, this replaces the 
color in the swatch with the active color.

-  Drag and drop a color from the quick storage row onto a base color swatch.

Other color chooser functions
To choose a color:

-  Click on a color range.

-  Drag the color sliders.

-  Enter color values into the text boxes.

The HSV sliders, RGB sliders and text boxes react to each other in realtime.
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The color box (Color System set to “Color Box”) gives you a quick way to choose colors 
and adjust their saturation and brightness. Click and hold down the mouse button on the 
color box and drag to adjust the color. The sliders — including those for saturation and 
brightness — will be updated in realtime.

If you click the preview left of the color box, your computer system’s color chooser will 
open. Choose the desired color.

If you click the triangle underneath the preview, the following menu will appear:

Here you can choose to display a different color chooser instead of the default one 
defined in the preferences. The change is temporary — the next time you start 
BodyPaint 3D, the default color chooser will be used again.

A good choice of colors is essential for consistent photorealistic results. Photorealism is 
often a yardstick for programs such as BodyPaint 3D.

The human eye can see several hundred thousand colors in the spectral range between 
400 nm (blue) and 700 nm (red). This color sensitivity is the result of many thousands of 
receptors on the retina. Not all of these are equally sensitive, and not all are sensitive to 
the same range of wavelengths. Some of the receptors are particularly sensitive within 
the blue range, around 440 nm; others are far more sensitive in other ranges, while yet 
others are particularly receptive in the green range, around 540 or 580 nm.

The eye therefore has three different types of receptors for the primary colors red, 
green and blue. The spectral sensitivity and overlapping of the sensitive ranges make 
characterization of colors extremely difficult (see Figure 1, below).

The color which the human eye perceives as white does not contain equal parts of red, 
green and blue light — this would be called chromatic — but must, in accordance with 
the overlapping sensitivity ranges, be made up of varying proportions of these colors. 
Only then does the eye see white. This is what we call achromatic light.

Typical output devices for color are printers, imagesetters and computer screens. The 
first two use the subtractive method of color mixing (CMY) and will not be part of our 
discussion here. Most important for BodyPaint 3D is the additive method of color mixing, 
which is the one used for representing colors on monitors. BodyPaint 3D characterizes all 
colors by using three numerical values.
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Two different color models are used, which you can easily toggle between. Probably the 
best known model is RGB, which is used by most graphics applications because it is best 
suited to the hardware components for image and color output. The most commonly 
used output device is the computer screen, which has a grid consisting of fine dots, made 
up from a red, a green and a blue point. These points can be addressed by an electron 
beam. By aiming the beam at not just one color dot, but for example the red and the 
green, the added color value is yellow.

Figure 1: The spectral sensitivity and overlapping of 
the sensitive ranges make characterization of colors 
extremely difficult.

Figure 2: By beaming different intensities at the three 
dots it is possible to generate many colors mixed from 
these basic primary colors.
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Figure 3: The colors which can be displayed can be 
represented in a three-dimensional coordinate system.

Figure 4: Less technical than the RGB model, and better 
suited to painters and artists, is the HSV system.

The color pigments for the screen dots have been selected in such a way that when 
equal parts are added they result in a white which comes closest to what the human eye 
perceives as a pure white. By beaming different intensities at the three dots it is possible 
not only to generate the eight basic colors (black, red, green, yellow, blue, magenta, 
cyan and white) which are the result of mixing the three primary colors, but many, many 
mixed colors (Figure 2, above).

The number of colors possible is determined by the number of gradations in the intensity 
of the electron beam. Using four gradations per primary color results in 4 x 4 x 4 = 64 
colors. The standard is 256 gradations per primary color, which gives 256 x 256 x 256 = 
16,777,216 colors. These colors can be represented in a three-dimensional coordinate 
system (Figure 3, above). The coordinate axes are formed by the three primary colors. 
Black is at the origin. Mixed colors between red and green form the base plane. Moving 
upward, more and more blue gets mixed in, until white is reached at the front corner of 
the cube. All white shades lie on the line connecting the origin with this corner.

Less technical, and therefore better suited for painters and artists, is the HSV model 
(Figure 4, above). H is the hue, S the saturation, V the color value.

The six basic colors (red, yellow, green, cyan, blue, magenta) form a hexagon around 
the color white, together with the color black. The hue is the angle: starting with 0° for 
red, through 180° for cyan, to 300° for magenta. The saturation (S) is measured radially 
towards the outside. On the inside, along the black/white axes, its value is 0.0, outside, 
at the hexagon’s edges, it is 1.0. The greater the saturation, the more intense the hue. 
The value (V) is measured in the direction of the black/white axis. At the height of white 
it has the value 1.0; downwards it decreases until reaching the value 0.0 for black. The 
color value lets you darken the hue.
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There are many features in BodyPaint 3D which help you to work more quickly, i.e.  
improve your workflow. These include:

-  To move, zoom or rotate a camera, use the icons at the top right of the viewport (drag 
the desired icon). The fourth, right-most icon toggles the active view panel between 
single-view and all-views.

-  Define short-cuts for the commands you use the most. Also, create an icon palette 
and populate it with the commands. You’ll then be able to reach the commands more 
quickly.

-  Many commands can be performed with a quick drag-and-drop rather than a trek 
through the menus. For example, to assign a material, drag it from the Material 
manager and drop it onto an object in the Object manager or viewport.

-  What if the Object manager is not the active tab when you drag-and-drop a material 
from the Material manager? Simply drag the material on to the Object manager’s tab. 
After a short delay, the Object manager will become the active tab and you can drop 
the material onto the object.

-  There is no need to lock axes in order to move, scale or rotate an object along a specific 
axis. Instead, drag the small handle — an arrowhead, cube or sphere depending on 
whether the move, scale or rotate tool is selected — at the end of the desired object 
axis. You can also drag these handles to move, scale or rotate selected polygons, points 
or edges.

-  To select several points or polygons, don’t click them one by one. Instead select the 
Live Selection tool and paint over the points or polygons to select them. Note that you 
can hold down the 9 key to temporarily select the Live Selection tool. As soon as you 
release the 9 key, you’ll be returned to the previous tool.

Besides the workflow tips above, there are many other ways to improve your workflow. 
Work through this reference manual whenever you have a spare moment and you’ll 
discover a wealth of workflow tips too numerous to mention here.

4 Workflow
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New workflow enhancements
BodyPaint 3D’s new workflow enhancements enable you to work more quickly than ever 
before.

General
This latest version of BodyPaint 3D offers you hundreds of workflow enhancements 
which are described in the appropriate parts of this manual. Below you’ll find a list of just 
some of these improvements.

-  Many tasks have been automated. For example, to load a texture or UV mesh into the 
Texture view, simply click on an object, texture, UVW tag, etc.

-  It’s now much easier to paint on several objects at the same time thanks to the new 
projection painting mode (see “Projection Painting” on page 288). Projection painting 
also offers you distortion-free painting.

-  You can now edit UV polygons directly in the 3D view. The texture will be updated in 
realtime.

-  You can now select object polygons and UV polygons using the same selection tools in 
the 3D view and in the Texture view.

-  The shape of the brush is now displayed, both in the 3D view and in the Texture View.

-  Drag-and-drop functionality has been extended yet again. For example, you can drag 
textures from the browser and drop them into the Object manager, Texture view, 
Material manager and so on.

-  Fast navigation in the 3D view: OpenGL is switched on temporarily when you move, 
rotate or zoom the camera.

Asynchronous access to parameters
Nearly all parameters for objects, tags, materials and shaders can now be accessed 
and edited interactively using the new Attribute manager). Unlike previous versions of 
BodyPaint 3D, you no longer need to click an OK button to assign the changes.

Object parameters can now be adjusted interactively with the mouse, i.e. with visual 
feedback in the viewport. Drag an arrowhead up or down to adjust its parameter. You’ll 
see the change take place in the viewport in realtime.
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Selection rays
You now select objects in the viewport with the help of a selection ray. A ray is sent into 
the scene from the point where you click to register all objects that are under the mouse 
pointer. With the help of the selection ray you are able to choose which one of these 
objects you want to select.

To select using the selection ray, do one of the following:

-  In the viewport, position the mouse pointer over the object you want to select. Double 
right-click or Shift-right-click (Windows) or Shift-Command-click (Mac OS) to open a 
selection window containing all objects hit by the selection ray. Choose the object that 
you want to select from this list.

-  In the viewport, position the mouse point over the object you want to select. Click 
multiple times to cycle through the objects hit by the selection ray.

To select multiple objects, hold down Shift while you select each object. To remove an 
object from the selection, Ctrl-click the object.

When you drag a material onto objects that overlap in the viewport, you can choose 
which object receives the material. Ctrl-drag (Windows) or Command-drag (Mac OS) the 
material from the Material manager onto the object in the viewport. A selection window 
will appear containing a list of the objects hit by the selection ray. Choose an object from 
this list and the material will be assigned to it.

Smartpointer
Referencing now takes place using a smartpointer. Previously, if you changed the name 
of the object being referenced, the reference would be lost. For example, if you were 
using a target light and you changed the name of the target, the light would lose the 
target and no longer point at it when moved. Now you can change object names without 
losing references.

In addition, you can now create references via drag-and-drop. For example, to assign a 
light’s target expression to point at a particular object, drag the object’s name into the 
target expression’s Target Object box (Attribute manager).

Multiple selection
You can now select multiple objects. In the Object manager, Shift-click each object that 
you want to select. To remove an object from the selection, Ctrl-click the object.
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Multiple selection is especially useful when used with the Attribute manager. For 
example, suppose you want to set several objects all to the same height. Select the 
objects in the Object manager and in the Attribute manager change the Y value for 
position to the desired height. All selected objects will then move to this new value. 
Using the Attribute manager together with multiple selection, you are able to set the 
selected objects all to the same values. For example, you can:

-  Hide all selected objects.

-  Set all selected objects to the same position.

-  Move all selected objects by the same distance.

-  Rotate all selected objects about their individual axis systems.

-  Rotate all selected objects about a common axis.

Further enhancements
Further new workflow enhancements include:

-  More context menus. Wherever you are in the program, check if there’s a context menu 
by right-clicking (Windows ) or Command-clicking (Mac OS).

-  OpenGL performance is faster in the viewports (access the new OpenGL settings via the 
preferences).
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Working with Layouts
You can configure the layout to best match the way you like to work. For example, you 
can reposition toolbars, choose which managers should be open and which should be 
tabbed together in the same window. Configuring the layout is the key to working faster.

To load and save your layouts, use the commands on the Window > Layout submenu.

Window > Layout sub-menu
Load Layout
Loads a previously saved layout. Use the system dialog that opens to choose the layout 
file (layout files have a “.l4d” extension).

Reset Layout

 Save your customized layout if necessary before you reset it. Use the Save Layout As 
command.

Resets the layout to the default settings. This is especially useful if you’ve accidentally 
altered the layout and want to return to the default or if you need to contact technical 
support by phone (so that our technicians can advise you based on the standard layout).

Save As Startup Layout

 If you want the layout to be saved automatically when you quit BodyPaint 3D, open the 
Preferences and on the Common page enable the Save Layout At Program End option.

Saves the current layout in a special file. The next time you start BodyPaint 3D, the layout 
will be loaded automatically as the new default.

Save Layout As
Saves the current layout. Layout files are given the extension “.l4d” automatically. If you 
want your layouts to be listed in the Window > Layout submenu, and also be accessible 
from the Layout icon, save your layouts in the application’s “prefs” folder or “library/
layout” location.

Other menu items
At the bottom of the Layout submenu you’ll find a list of all layout files which are in the 
application’s “prefs” folder and “library/layout” location. To load one of these layouts, 
choose its name from this list.
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The Browser

The Browser is a powerful control center and is ideal for managing your 3D projects. 
With it you can create thumbnails for all your digital assets — such as BodyPaint 3D files, 
2D textures, 3D models, movies, scene files — and save them as catalogs. Using these 
catalogs you can quickly locate your assets.

Creating a catalog
To create a catalog file:

-  In the Browser, choose File > Import Directory.

-  Use the system dialog that opens to choose the folder which contains the files you want 
to catalog. The Browser automatically generates thumbnails for all files in this folder 
which it recognizes.

-  Once the Browser has created the data for the catalog you are free to add personal 
notes, comments, copyright notices and so on to the individual files. Click a thumbnail 
to select it (its sides will turn red) and choose Function > Info. Enter the text into the 
text box and click OK. The information you entered will appear in the status bar.

-  Choose File > Save Catalog As. You’ll be able to reload this catalog at a later date via 
the Open Catalog command.
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Drag-and-drop with the Browser

You can drag almost anything from the browser and drop it into the appropriate 
manager. The cursor will change to stop sign or a plus sign (see above) to indicate 
whether the element can be dropped into the manager.

Further browser functions
-  Double-click a picture file (usually a texture) to display the picture in the Picture 

Viewer.

-  Double-click an animation or sound file to play it.

-  Double-click a scene file to load it.

-  Double-click a material to add it to the scene.

-  Right-click (Windows) or Command-click (Mac OS) on a preview picture to open a 
context menu.

File Menu
New Catalog
Creates a new, empty catalog. Any existing catalog in the Browser will be replaced with 
the new one.

Open Catalog
Loads a previously saved catalog into the Browser.

Import File, Import Directory
Loads and adds a file or directory (folder) of files to the current catalog. Depending on 
the Browser’s preferences, sub-folders are either searched or ignored.

Save Catalog
Saves the current catalog. The catalog is saved using the name specified in the Save 
Catalog As dialog. This name also appears in the Browser’s title bar. If your catalog 
doesn’t have a name yet (in which case the Browser title bar will show 'Untitled'), the 
Save command acts in the same way as Save Catalog As (see below).
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Save Catalog As, Make Catalog Relative
Save Catalog As always opens the File selector. The name you enter here will appear in 
the title bar of the Browser window. BodyPaint 3D always adds the extension “.cat” to 
the catalog’s filename. If Make Catalog Relative is enabled, then complete paths are no 
longer saved; instead only the relative paths are used, starting from the catalog folder. 
From this location the current catalog folder and its sub-folders are scanned.

Close
This command closes the Browser. The current catalog is removed from memory.

Edit Menu
Delete
Removes all selected thumbnails from the catalog. The originals on the system disk 
remain unaffected.

Select All, Deselect All
Selects and deselects all thumbnails in the current catalog.

Preferences
Choose this command to open the browser’s preferences.

Thumbnail Size

Defines the size of the thumbnails (in pixels) in the Browser. The changes are immediate, 
although actual recalculation does not occur until later. The thumbnails are simply scaled 
up or down. If you need to physically change the sizes, use Render All from the Function 
menu (see below).

Recurse Folders

If this option is enabled, sub-folders are also scanned for scene elements and displayed 
as thumbnails in the Browser.

QuickTime Recognition

If this option is enabled, QuickTime is used to load the files you add to the catalog. This 
can be useful because QuickTime enables BodyPaint 3D to load files it wouldn’t be able 
to recognize otherwise. However, disable this option if you wan the catalog to be created 
as quickly as possible — with the option disabled, catalogs are created up to 40 times 
faster.
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Pictures, Movies, Sounds, Scenes

If these options are enabled, thumbnails for pictures, movies, sounds and scenes are 
displayed in the Browser. File formats unknown to BodyPaint 3D are ignored.

Function Menu
Render All
Recalculates the catalog’s thumbnails. This is necessary, for example, if you change 
the thumbnail size in the preferences or add or change files in the folders. To abort 
recalculation, press Esc.

Info

 If the Browser finds a text file named “Readme.txt” when scanning a folder, its contents 
will be transferred automatically to the information dialog of each thumbnail picture of 
the folder, space permitting.

Opens an information window for the selected thumbnail which displays information 
including the complete location, picture resolution and color depth. You can use the text 
box on the right to enter comments.

Search For
The Browser enables you to scan for filenames and/or comments. Enable the relevant 
options and enter the text and/or value you wish to search for in the field to the right. 
Thumbnails which match the find will be outlined in the catalog.

Sort By
Use the sub-entries of this menu to define the sort sequence of the current catalog in the 
Browser. Alternatively you may sort according to filename or file size. Items are sorted in 
ascending order, i.e. the list starts with the smallest images and ends with the largest.
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Initialization Files
BodyPaint 3D loads several initialization files during startup. The content of these files is 
integrated into the layout.

template.c4d
During startup, BodyPaint 3D checks its root folder for a file called “template.c4d”. If 
the file is present, its settings are loaded and used as default values. This can be very 
effective if you keep using the same scene-specific settings (e.g. several different render 
settings).

new.c4d
When you create a new file (main menu File > New), BodyPaint 3D checks its root folder 
for a file called “new.c4d”. If the file is present, its settings are loaded and used as default 
values. For example, to activate antialiasing permanently, create a new file, change 
the values in the render settings accordingly and save the file in the same folder as the 
BodyPaint 3D program under the filename “new” (the “.c4d” file extension is appended 
automatically). 

template.cat
During startup, BodyPaint 3D checks its root folder for a file called “template.cat”. If 
the file is present, it is loaded into the Browser automatically. This can be useful, for 
example, when you are working on a large project and want all associated textures and 
scenes available immediately after startup. In this case, create a catalog which displays 
thumbnails for these files and save the catalog in BodyPaint 3D’s root folder under the 
name “template” (BodyPaint 3D appends “.cat” automatically). The Browser will load the 
catalog automatically each time you start BodyPaint 3D.

template.l4d
During startup, BodyPaint 3D checks its root folder for a file called “template.l4d”. If the 
file is present, it is loaded and used as the active layout. You can create the file in one of 
two ways:

-  In the preferences, on the Common page, enable Save Layout At Program End. The 
template layout will be created automatically when you quit BodyPaint 3D.

-  Create the template layout manually using Window > Layout > Save As Startup Layout 
from the main menu.
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If you’re like most people, you probably can’t wait to start painting directly onto your 
3D models. However, before you can paint your models, you need to prepare them for 
painting.

This is where the Paint Setup Wizard comes in. Quite simply, it prepares your models for 
painting. It can set up multiple objects with multiple textures at the same time, assign 
optimized UV maps and much more. With this powerful wizard, setting up your models 
for painting is a breeze.

The Paint Setup Wizard

Quickstart

 For full details on using the Paint Setup Wizard, see the following sections. 

-  Load the objects that you want to paint.

-  Select the Paint Setup Wizard tool from the Tools menu or from the left toolbar.

-  In the dialog that opens, select which objects or materials you want to paint on and 
click Next.

-  Leave the parameters set to their default values. If you want a separate texture to be 
created for each object, disable Single Material Mode. Click Next.

-  Again, leave the parameters set to their default values. Enable each material channel 
that you want to paint on and click Finish. The Paint Setup Wizard will create all the 
materials and textures which are required to complete the setup — this may take a few 
moments depending on the size of the textures and so on.

-  Select the brush tool from the Tools > Paint Tools menu or from the left toolbar and 
paint the objects.

 UVs cannot be recalculated for parametric objects. Make the parametric objects editable 
(select the objects and press the ‘c’ key).

General
The Paint Setup Wizard is a recent addition to BodyPaint 3D. In previous versions before 
you could paint even the first brushstroke, you had to carry out the following steps for 
each and every object you wanted to paint on:

-  Create a material.

-  Assign the material to the object.

-  Create a texture for each material channel that you want to paint on.

5 First Steps
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-  Remap the UV mesh.

Of course, the more objects you wanted to paint on, the longer this manual setup would 
take. With the new Paint Setup Wizard, you can prepare objects for painting in three 
quick and easy steps. You can move back and forth between the steps by clicking the 
Previous and Next buttons.

And there’s more! The Paint Setup Wizard can also:

-  Add missing materials and textures.

-  Scale multiple textures automatically (to an exact size if desired).

-  Delete textures from specific channels. For example, you can delete all bump channel 
textures.

Step 1

Select all the objects or materials or both that you want to paint on. To the right of each 
object or material you’ll see either a green check mark or a red cross. This indicates the 
selection status. A green check mark means the object or material is selected, a red check 
mark means it isn’t. Click on a check mark or cross to toggle the selection status.

A semi-transparent check mark or cross means the object itself cannot be painted on  but 
its children can (for example, if the parent is a camera, you can’t paint on it because it 
has no surfaces).

A combined check mark and cross means the object has some children which are 
selected, and some which are not. Click the parent’s check mark/cross to set the children 
all to the parent’s status.

In the bottom part of the dialog, you’ll see information on how many paintable objects 
are selected.
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Objects

If this option is enabled, all objects in the scene are listed. Select each object that you 
want to paint on.

Materials

Enable this option to list all the materials in the scene which already exist. Here you can 
select which materials will be considered by the Paint Setup Wizard.

Select All, Deselect All

Selects (green check mark) or deselects (red cross) all geometric objects/materials.

Next

Click this button to proceed to Step 2.

Step 2

In Step 2, you choose how the UV mesh should be recalculated (if at all). You can also 
choose whether the objects or materials should share the same texture or each be 
assigned their own separate texture.

Recalculate UV

Disable this option if the objects already have UVs suitable for painting. Otherwise leave 
the option enabled and the Paint Setup Wizard will optimize the UVs.
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Optimal Cubic Mapping, Optimal Angle Mapping, Realign, Relaxation

 The Realign algorithm only works for objects which already have a UV mesh assigned. 

These four algorithms enable you to choose how the UV mesh will be optimized. They 
will only have an effect if Recalculate UV is enabled. These algorithms are also available 
in the UV Mapping manager, where they are called: Optimal (Cubic), Optimal (Angle), 
Realign and Relaxation Steps. See Chapter 15, UV Edit Menu, for details on these 
algorithms.

Single Material Mode

Single Material Mode was enabled to share one material between four objects.

Enable this option if you want the objects to share the same material. This is especially 
useful if you are designing characters for games where you need to be as efficient as you 
possibly can with the textures. Each object will be assigned its own UV mesh and portion 
of the texture. You’ll still be able to paint the objects separately even though they share 
the same material (see the picture above).

If on the other hand you want a separate material assigned to each object, disable the 
option. The materials and textures will be named according to the names of the objects.

Previous, Next

Click Previous to go back to Step 1 or click Next to proceed to Step 3.
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Step 3

In this third and final step, you choose which channels you are going to paint on, their 
initial fill colors and which textures should be scaled (if any).

Create Missing Materials

If this option is enabled, the Paint Setup Wizard will create a new material for each object 
you selected in Step 1 which doesn’t have a material yet. If the option is disabled, no new 
materials will be created and the setup will affect existing materials only.

Create/Delete Channels

Enable this option if you want new textures to be created or existing textures to be 
deleted or both. Choose the desired channels from the Channels list below. You can 
choose a background color for each channel using the color boxes. Click a color box to 
open your computer system’s color chooser.

Channels List

Below the Create/Delete Channels option, you’ll see a list of material channels displayed. 
These represent each material channel which may contain a texture. Enable the channels 
that you want to paint on and ensure that all other channels are disabled. The more 
channels you enable, the more RAM is required. Therefore you should only enable the 
channels that you actually want to paint on. If you change your mind later on, you can, 
after all, add the new textures in seconds.

The channels list also supports the “tri-state” status: . If you see this icon appear, it 
means textures exist in some channels but not in others. Click the tri-state icon to set 
them all to the same state.
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Rescale Existing Textures

If you want existing textures to be resized, enable this option and use the Texture Size 
settings to specify the new size.

Automatic Mapsize Interpolation

BodyPaint 3D can intelligently choose the size of the textures for you within the limits 
defined by Minimum and Maximum.

Suppose you want to paint on a model which is made up of 24 objects, where each 
object is a different size. If the textures for these objects were all the same size, chances 
are you’d run into problems when you paint, even if using projection painting.

For example, we created two cubes as show above: a small cube and a much larger cube. 
In the picture, the blue area is part of the large cube’s front face.

The small cube is ten times smaller than the large one. Even though we have used 
projection painting mode, the end result is poor because the blue texture is too small 
relative to the texture for the small cube.

This is where Automatic Mapsize Interpolation comes in. It intelligently chooses the size 
of the textures for you taking into account the size of the objects relative to each other.

You can define the minimum and maximum size for the textures using Minimum and 
Maximum. Minimum specifies the texture size for the smallest objects, Maximum does 
the same but for the largest objects.
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The Quantize value gives you a further way to control the size of textures. It defines a 
step size. In other words, the width and height of each texture will be a multiple of the 
Quantize value. For example, if Quantize is set to 100, you’ll get a texture size of 200x300 
instead of, say, 213x323. Or 800x600 instead of 817x643, and so on.

Fixed Texture Size

If you want the textures all to be the same fixed size, disable Automatic Mapsize 
Interpolation and enter the desired width and height in pixels into the Width and Height 
text boxes.

Previous, Finish

Click Previous to go back to Step 2 or click Finish to complete the setup. After clicking 
Finish, you’ll see the following dialog appear. This tells you the steps the wizard has taken 
in order to prepare the objects for painting.

The dialog is no-modal so you can keep it open if you wish — you can even click the 
Previous button to go back to Step 3 and change the setup. To close the dialog, click the 
Close button. You are now ready to paint your objects, but first we recommend you save 
the scene and materials using File > Save Project from the main menu.

Why not paint your model using projection painting mode? See “Projection Painting” on 
page 288.
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Tweaking the UV Mesh
The Paint Setup Wizard is a great help when it comes to preparing objects for painting, 
and UVs are no exception. The wizard is able to create and optimize UVs automatically. 
However, for best results, you may need to tweak the UVs. This is because the Paint Setup 
Wizard cannot possibly know exactly how to intend to paint the objects.

Consider the following scenario: you want to paint on the head shown in Figure 1. You 
have used the Paint Setup Wizard to create a material, texture and UVs for the head. The 
texture is just large enough for you to paint sufficient detail when the whole of the head 
is displayed in the view.

Figure 1: Here we’ve used the Paint Setup Wizard to prepare the head for painting. 

You then spend hours painting the head (we’ve kept our head gray for illustration 
purposes). You’re almost done and then you have an idea. Wouldn’t a filigree earring 
look great?

You zoom in on the left ear and start painting but there is a problem: the brushstroke 
is very pixelated (see Figure 2). This is because the ear’s UVs cover only a relatively small 
texture area. The ear needs more pixels. And BodyPaint 3D has a neat trick to help you 
add extra pixels without ruining the painting you have already done.

Figure 2: The strokes are 
pixelated because there are not 
enough pixels for the ear.

Figure 3: Follow the steps 
below to assign more texture 
pixels to the ear.
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Here’s how you could solve the ear problem:

1 Ensure that UV polygons mode is enabled. In the 3D view, select the ear’s polygons.

2 Choose UV Edit > Optimal Mapping from the main menu. The UV manager will open. 
In the UV manager, select Optimal (Cubic) or Optimal (Angle) and click Apply.

3 In the Texture view, drag the optimized (and still selected) UV polygon groups right of 
the texture.

4 Choose UV Edit > Fit Canvas To UV from the main menu. Fill the pixels if necessary to 
match the color of the rest of the canvas.

For illustrative purposes we have colored the selected UV polygons black.

The ear’s UVs now cover plenty more texture pixels and you can paint the filigree earring 
without pixelation.

This technique will solve many of the problems you’ll encounter when working with UVs. 
The procedure is always the same:

-  Select the problem area.

-  Choose a new projection (use Optimal Mapping or the Projection tab in the UV 
manager).

-  Move the remapped UVs to a free part of the texture if there is space, or move the UVs 
to the side of the texture and choose UV Edit > Fit Canvas To UV.
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Texturing Made Easy
In this section, you’ll learn how to texture objects in seconds using the cut and paste 
commands in projection painting mode. Is this cheating? Who cares!

Suppose you’ve created a head and a UV mesh to go with it. You follow these steps:

-  Choose File > Open and use the dialog that opens to load a bitmap texture. The 
bitmap will appear in the Texture view.

-  In the Texture view, select part or all of the bitmap (we selected a face) and choose 
Edit > Copy from the main menu.

-  In the 3D view, ensure that Gouraud shading is enabled and choose Edit > Paste from 
the main menu.

The 3D view switches to projection painting mode. The copied pixels are pasted onto 
the object and the Transform Bitmap tool is selected.

 For details on using the Transform Bitmap tool, see “Transform Bitmap” on page 250.

Figure 1: Transform the copied pixels 
to fit the object.

Figure 2: The end result: a 
textured face in seconds!

-  Use the Transform Bitmap tool to fit the copied pixels to the object. Double-click to 
apply the transformation.

This cut and paste technique has its limitations because it is based on a type of frontal 
projection. Even so, you’ll find it’s the quickest way to put a face on a head, a logo on a 
jacket, posters on a wall, ...
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The Color manager

The Color manager is the main area in BodyPaint 3D where you choose colors for the 
paint tools. Here you can also save colors and patterns as presets.

 To access the color presets quickly, click the color preview in the Color manager’s top left 
corner (see “The Color Presets” on page 122).

You can use the tabs at the top of the manager to choose which parameter groups 
are displayed. These tabs work in the same way as those in the Attribute manager. See  
“Navigating the Attribute Manager” on page 670.

6 Color
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Channels
The Foreground and Background Colors

Click the front rectangle or back rectangle to choose a new foreground color or 
background color respectively for the paint tools. When using the brush tool, drag to 
paint with the foreground color or right-drag (Windows) or Command-drag (Mac OS) to 
paint with the background color. The same also applies to the fill bitmap tool, draw line 
tool and draw text tool.

In the left toolbar you’ll find a preview for the active channel’s foreground 
and background colors.

Multi Channel Mode

This mode allows you to paint on multiple material channels at the same time. You can 
paint a different color or pattern to each enabled material channel.

For example, you can paint blue to the color channel and black to the bump channel 
simultaneously. The black color in the bump channel causes the blue strokes to look as 
though they are sticking out.
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If the multi channel mode button is disabled:

the brush (or any other painting tool) will paint to the active material channel only, which 
is indicated by a small colored pencil icon. The small rectangles show you the foreground 
and background colors or patterns.

If the multi channel mode button is enabled:

you can paint to several channels at once. 

The material channels in the multi channel palette are: 

-  Color (C)

-  Diffusion (D)

-  Luminance (L)

-  Transparency (T)

-  Reflection (R)

-  Environment (E)

-  Bump (B)

-  Alpha (A)

-  Specular Color (S)

-  Displacement (D) 

For details on each material channel, see Chapter 23, Material Manager. 

Active channels (i.e. the material channels which you can paint on) are marked by a 
colored pencil icon in the multi channel palette. To activate or deactivate a channel, click 
the grayed out pencil icon. Note that the Material manager also uses a pencil icon to 
indicate the (same) active channels — the selection is linked. 

You can use a different color or pattern in each channel. Click on the channel icons one 
by one and each time choose the desired color or pattern. The active channel is indicated 
by a red frame. 

Once you have activated all the channels you want to paint on, you can paint to the 
channels simultaneously (assuming you have created textures for them — see Chapter 5, 
First Steps. A preview if shown for each channel.
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Blending Mode
The Blending Mode slider controls the strength (i.e. opacity) of the color or pattern. You 
can also enter the strength value numerically using the box right of the slider. You can set 
values from 0% to 100%. A value of 100% will apply the color or pattern at full strength.

If Texture Paint is enabled, the texture will be applied in the ratio of 1:1. The lower you 
set the strength value, the more transparent the color or pattern will be. The drop-down 
list on the right defines the blending mode itself. These modes, such as Darken and 
Multiply, work in just the same way as they do in most 2D paint programs.

The following terms are used below to help describe the effect of the blending modes: 

-  original color — i.e. a pixel’s color before you painted over it. 

-  painted color/pattern — the color or pattern you are painting. 

-  resultant color — the pixel’s final color, i.e. its color after you have painted over it. 

The blending modes you can choose from are: 

Normal

Each pixel you paint over takes some or all of its color from the painted color/pattern 
according to the brush pressure value. The greater the brush pressure value, the more 
opaque your brushstroke becomes. 

Dissolve

 This mode is useful for simulating dirt effects. 

This mode uses a random command to generate an (almost) random distribution of the 
color or pattern while you paint. Dissolve depends on the brush pressure and it frays 
the edges.

Difference

With this mode, the resultant color of each pixel is the difference between its original 
color and the painted color. For example, painting red onto black results in red. This 
is because black’s RGB values are 0,0,0, so the difference corresponds to the painted 
color (red). A more practical example is to use a soft brush to paint onto a non-black 
background — this will create surreal edges. 

Lighten

BodyPaint 3D compares the brightness values of the original color with the painted 
color at the pixel level. If the original color is brighter, the pixel’s color remains 
unchanged. If the original color is darker, the pixel becomes the same color as the 
painted color.
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Darken

BodyPaint 3D compares the brightness values of the original color and the painted 
color at the pixel level. Where the background color is darker, the pixel’s color remains 
unchanged. Where the background color is brighter, the painted color is used.

Multiply

The resultant color is a mix of the original and painted colors divided by pure white. 
The more you paint over an area in this mode, the darker the area becomes.

Screen

Screen has the opposite effect of Multiply. It multiplies the inverted values for the 
original and painted colors divided by pure white. (To invert a color, subtract it 
from pure white.) The more times you paint over a pixel in this mode, the brighter it 
becomes.

Add

The resultant color is the original color added to the painted color. For example, 
painting red (255,0,0) onto green (0,255,0,) results in yellow (255,255,0). 

Exclusion

This mode is similar to Difference except that it creates a softer effect. 

Erase

 If the Background layer is active, the Erase mode paints the color white instead of 
transparency.

This mode erases pixels in the active layer — the erased areas become transparent and 
the layer underneath shows through.

Color

Solid Color

 You can also choose colors using the eyedropper tool or the Color Presets.

This is where you choose the color that is displayed in the left middle preview picture 
(click on the preview picture to open the color chooser for your computer system).
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Texture Paint

Enable this option if you want to paint textures on the object. You can use the 
eyedropper tool to pick the texture:

-  Select the eyedropper tool.

-  In the Active Tool manager, select Texture.

-  Click in the Texture view or 3D view to use the active layer as the texture.

You can use the eyedropper between all open scenes.

Preset Patterns

You can select a preset pattern by clicking on the triangle to the right of the material 
preview. You can add your own bitmaps to the list by placing them in BodyPaint 3D’s 
“library / pattern” location. You can use any graphics format recognized by BodyPaint 3D, 
such as tif, bmp and jpg. Often, you will use your own paint patterns, which you can pick 
using the eyedropper tool.

You’ll also find two commands on the drop-down list:

Load From Disk

This enables you to load a texture from a storage medium. You will be asked if the 
texture should be copied to the “pattern” folder. Click Yes if you want the pattern to be 
made available permanently. 

Reload Directory

If you have copied any bitmaps to the “pattern” folder during the current work session, 
select this command to add the new patterns to the list.
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Source X/Y

 If you picked the texture using the eyedropper tool, these values define the position on 
the texture where you clicked.

This defines which pixel in the texture will be painted first. For example, if the values are 
set to 0 and 0, the texture’s top-left pixel will be painted first. 

Tiling

If this option is enabled, the pattern will be tiled. 

Dest. X/Y

Dest. stands for Destination. You can enter values only if the painting mode is locked (see 
below); otherwise, the boxes are grayed out. If you set the Dest. X/Y values to the same 
values as Source X/Y, the pattern will be painted without an offset — enter different 
values to offset the texture. For example, to offset the texture 20 pixels lower, subtract 
20 pixels from the second box.

Painting mode

Locked

This mode paints the texture with an offset as defined by the Source X/Y and Dest. X/Y 
settings. This enables you to clone a texture and paint it to another position with an 
offset. For example, if you paint using the Fill Bitmap tool, the texture will be offset 
over the entire layer — or if you use a brush, the texture will be offset in the areas 
where you paint.

Mouse Hit

This mode is similar to Locked but with the following difference: if you release the 
mouse button and start to paint from a new position, the texture is painted starting 
from the texture pixel defined by Source X/Y. This is similar to the rubber stamp tool 
which you’ll find in most paint programs.
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Brush Pos.

This stands for Brush Position. Each movement during the brush stroke paints the 
texture on top of all previous movements in the stroke. This tends to create fragments 
of the texture that are very close to each other. If you select rotation (select the Rot. 
option) and couple its effector (see below) with the Draw Direction method, the 
pattern will rotate according to the direction in which you are painting. This is useful 
for painting curved textures such as fur and wool.

Scale

Enable this option if you want to scale the painting pattern. For example, if the original 
texture size is 300x300 pixels, you can resize it to 150x150 pixels by entering a value of 
50%. A value of 200% would resize 300x300 pixels to 600x600 pixels (although keep in 
mind that scaling up is likely to cause pixelation).

Rot.

This stands for Rotation. It lets you rotate the painting pattern by any angle from -180˚ 
to 180 .̊ This can be useful, for example, if you have imported a texture and picked it 
using the eyedropper tool — sometimes the texture is rotated by 90˚ in the process. In 
this case, use Rot. to correct the texture’s orientation.
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Effectors

To access the effectors for Scale or Rot,:

-  Enable and then click on Scale or Rot.

An effector enables you to change a parameter dynamically using an input method. For 
example, you can rotate the mouse wheel to change a texture’s Scale while you paint. 

Most input methods have a graph which lets you fine-tune the effect. Eight different 
input methods are available. You can assign as many methods as you wish to the same 
effector. For example, you can change the texture’s Scale value using the mouse wheel or 
the draw distance. Also, you can link the same input method to more than one effector. 
For example, you can rotate the mouse wheel to change both the Size and Rot. values for 
the texture.

Pen Pressure

This adjusts the setting based on how hard you push down the pen on the graphics 
tablet. The graph to the right defines exactly how this input method affects the setting 
(the graph is straight by default). 

Pen Tilt

This method controls the setting based on how you tilt the pen. If the pen is at a right-
angle to the graphics tablet, the tilt is 0 .̊ If the pen is resting on the tablet, the tilt is 90 .̊ 
The graph to the right defines exactly how this input method affects the setting (the 
graph is straight by default). 

Pen Direction

Adjusts the setting based on the pen’s rotation. The graph to the right defines exactly 
how this input method affects the setting (the graph is straight by default). 
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Pen Finger Wheel

This adjusts the setting based on the angle of the finger wheel. The graph to the right 
defines exactly how this input method affects the setting (the graph is straight by 
default). 

Draw Direction

This method changes the parameter based on the direction of your brushstroke. For 
example, if you activate this input method for the Rot. effector, the texture will rotate 
automatically to follow your brushstroke. The graph to the right defines exactly how this 
input method affects the setting (the graph is straight by default). 

Distance

Controls the setting based on how far you have dragged the mouse.

Mouse Wheel

Changes the setting based on the angle of the mouse wheel. The graph to the right 
defines exactly how this input method affects the setting (the graph is straight by 
default). 

Randomness

Adjusts the setting randomly. You can enter minimum and maximum values (Min and 
Max).

Wallpaper
 Do not shy from experimenting with combinations of color, wallpaper and blending 

mode. A vast array of effects awaits you!

Click the triangle to choose a wallpaper from a list of patterns. These are the bitmaps in 
BodyPaint 3D’s “library / pattern” location. To blend a color with the wallpaper, define a 
color in the color pane and use the slider in the Wallpaper pane to set the blend strength. 
Also, you can choose from the full complement of blending modes — see “Blending 
Mode” on page 114 for more details.
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Ignore Filter

If you select the brush tool, in the Attribute manager you’ll find various filters for the 
brush on the Filters page. These include effects such as Wet Edges, Smudge and Burn. 
Use the Ignore Filter option to switch the filter on or off for the active material channel.

File Menu
You can use these commands to save colors or patterns as presets. Once you have saved 
a color preset, you can select it later — click the color preview in the top left corner of 
the Color manager to open the color presets and choose the desired preset.

Add Single Channel Preset

Saves the current color or pattern settings as a color preset.

Add Multi Channel Preset

In contrast to the previous command, here you can save several channels — each with 
its own color or pattern — as a preset. When you later select this preset and paint with 
it, all of these material channels will be painted at the same time (provided the object’s 
material has textures for these channels).

Overwrite Preset

Overwrites the active color preset with the current color settings. 

Close

Closes the Color manager.

Edit Menu
Copy

Copies the active color to the clipboard. 

Paste

Copies the color stored in the clipboard to the active material channel (see “Copy”, 
above).
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The Color Presets

 We recommend you use the presets in the following way: whenever you have a color or 
pattern that you might want to use again, save it as a color preset. When painting, have 
the 3D view (including the object to be painted) in one window and the Color manager 
in another. Choose a brush, click on a color preset (click on the top left preview in the 
Color manager to display the presets) and paint in the 3D view. When you want to change 
the pattern, select a new preset and paint again. If you work in this way, you will move 
frequently and swiftly between the two windows and your object should be painted in 
minimal time.

 Right-click (Windows) or Command-click (Mac OS) on a color preset to define it as the 
background color. 

You can use this manager to access preset colors or patterns including any you have 
created and saved.

To open the Color presets, do one of the following:

-  Choose Window > Color Presets.

-  In the Color manager, click the color preview in the top left corner.

To access menu commands for these presents, right-click (Windows) or Command-click 
(Mac OS) on a preset. These menu commands are described below.
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File Menu
New Group

 To view the presets as names instead of icons, on the View menu enable As List.

Over time, the number of color presets will grow as you add to them. This command 
enables you to create and name groups to help you better organize your presets.

Revert To Default

This command reverts the color presets to the default settings. As a precaution, you will 
be prompted for confirmation. 

Save As Default

Suppose you have created some presets but you then quit and restart BodyPaint 3D but 
the new presets have gone missing. When this happens, it means you forgot to save the 
presets using the Save As Default command. Don’t worry if you are forgetful because 
BodyPaint 3D will prompt you to save unsaved presets when you quit.

Import

This command enables you to use BodyPaint 3D patterns created by other artists. The file 
selector will open. Choose any file exported from BodyPaint 3D to add its presets.

Export Selection

 You can only export patterns that are in BodyPaint 3D’s “library / pattern” location. So, 
for example, you cannot export a color if the pattern was created in BodyPaint 3D and 
picked using the eyedropper tool.

This command saves your BodyPaint 3D patterns so that other artists can use them. The 
file selector will open. Choose a destination and a filename for the selected presets or 
group of presets. The file takes the extension “b3d”. In addition, a “pattern” folder is 
created for the textures used by the presets.

Export Visible

Exports all visible presets. 

Close

Quits the Color manager and closes its window. 

Edit Menu
Rename

You can use this command to rename the active preset or active group.
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Duplicate

Duplicates the active preset or group.

Delete

Deletes the active preset or group.

Group
If you choose All Presets, all color presets are displayed. If you choose a different group 
from the list, only the presets belonging to the group are displayed. 

View
As List

If this option is enabled, the icons are displayed as a vertical list and their names are 
specified. The active icon is indicated by a red frame. 

To change the order of the icons, drag-and-drop within the list. While you drag, a dark 
line will appear to indicate the insertion position.

You can move presets from one group to another to help you better organize them. For 
example, you may want to create a group for wood patterns. To move a preset to a new 
group, drag the preset’s icon onto the center of the group icon. The mouse pointer will 
turn into an arrow that points downwards.

The small + icon to the left of the group icon indicates the group is closed. To open the 
group, click on the + icon. Once the group is open, a small - icon appears. Click on this 
icon to close the group.

As Icon

If this option is enabled, the icons are displayed in rows and columns instead of as a 
vertical list. The names of the presets are not shown in this mode. The active icon is 
indicated by a red frame.
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Small Icons. Medium Icons, Large Icons

 You can drag-and-drop to change the order of the icons.

Choose the size of the icons: small, medium or large.
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Brush Settings

BodyPaint 3D offers you complete control over brushes. When the brush tool is selected, 
the brush settings will appear in the Active Tool manager. In these pages, you’ll find 
descriptions for these settings.

You can use the tabs at the top of the manager to choose which parameter groups 
are displayed. These tabs work in the same way as those in the Attribute manager. See  
“Navigating the Attribute Manager” on page 670.

A preview for the brush is displayed in the top left corner of the manager. Click on this 
preview to access the brush presets. Below this preview you’ll find a larger preview, 
which is a sample paintstroke.

Left of each parameter you’ll see a blue circle. If a circle is filled, it means an effector is 
enabled for the parameter such as pen pressure or pen tilt. Effectors are described later 
in this chapter.

7 Brushes
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Brush Shape

Defines the shape of the brush. To view the brush cursor while you move the mouse or 
paint, enable Show Brush Shape While Mouse Move or Show Brush Shape While Painting 
in the preferences on the BodyPaint page.

Store Color

Enable this option to blend the active color in the Color manager with the brush preview. 
If you then save the brush settings as a brush preset, the color will be saved together 
with the brush settings. If Store Color is disabled, only the brush settings will be saved. 

This has implications for painting. Suppose you have picked a color in the Color manager 
and a brush in the Brush Presets. Suddenly, a different color replaces your chosen color 
in the Color manager — here, the brush you picked has a stored color which replaced the 
active color. Therefore only enable this option if you want the brush to always paint with 
the same color, such as a brush for painting rust.

Add Preset

This saves the current brush settings as a brush preset in the Brush Presets. Enter the 
name for the brush in the dialog that opens. Also, keep in mind that it will be easier to 
change the color used by the brush if Store Color is disabled.
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Generic Brush Type
The Type drop-down list (next to the brush preview) defines the brush type: Generic or 
Bitmap. The tip of the generic brush is defined by means of options and sliders. These 
are: 

Shape

Choose from two basic brush shapes: circle or rectangle. The settings below refine the 
basic shape. 

Profile

Round. Linear.

Needle. Nozzle.

The profile defines the pressure gradient for the brush tip. The graphs should help to 
clarify. Each graph describes the brush pressure over brush radius.



132 • CHAPTER 7 BRUSHES • 133

If you select the User Defined option, you can create your own pressure gradient for the 
brush tip. Click the blue circle next to Profile to open the following window.

The Y-axis corresponds to the brush strength (i.e. pressure) and the X-axis represents 
the brush radius. The curve is linear by default. Click on the first point of the curve. The 
point will turn red to indicate that it is selected. Drag the point and notice how the two 
realtime previews to the right of the graph update in realtime. The upper preview shows 
you the brush profile, the lower preview shows the brush itself.

Click anywhere inside the graph (i.e. other than on a point) to create a new point. The 
curve will adjusts itself to run through the new point. You can add any number of new 
points.

To delete a point, click on the point to select it and press the Backspace key or drag the 
point out of the window. You can use the Strength and Radius boxes to read or enter 
values for the selected point.
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If you click the triangle in the top left corner of the dialog, a menu will open with the 
following commands:

Copy Curve

Copies the active curve to the clipboard. Once you have copied the curve, you can use 
the Paste Curve command to paste it into an effector’s graph. An effector enables you 
to change a brush parameter dynamically by means of an input device. For example, 
if you have a graphics tablet, you can use the pen direction to change the brush size 
while you paint. 

Paste Curve

This command is only available if you have copied a curve to the clipboard. It pastes the 
curve stored in the clipboard into the graph.

Reset to Default

Restores the curve to its default shape (a straight line). 

Flip Horizontal, Flip Vertical

These commands flip (mirror) the curve horizontally or vertically.

Size

 The Hardness slider is grayed out if the brush has a user-defined profile. In this case, 
the transparent areas of the brush are defined by the profile curve itself, therefore the 
Hardness slider is not required.

 When projection painting mode is switched on, the size of the brush corresponds directly 
to the pixels on screen.

0% Hard. 100% Hard.

This defines the overall size of the brush. You can edit the value using the slider or you 
can enter the value numerically into the box right of the slider. The value defines the 
diameter of the brush in pixels. You can set the value from 1 to 200 pixels. 

Pressure

This slider defines the brush pressure. The lower you set this value, the more transparent 
the brushstroke becomes. The maximum value of 100% defines an opaque brushstroke. 
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Hardness

This determines how much of the brush is hard as a percentage. The lower you set this 
value, the softer the brush becomes at the edge and the more its edge will blend with 
the background color. If Hardness is set to the maximum value of 100% the brushstroke 
will not blend with the background color at all.

Spacing

High Spacing value.

If you enable this option you can define the distance between brushmarks in the stroke. 
A large value will result in a trace of brush marks that follow the cursor. A low value will 
produce the effect of a continuous brushstroke. If Spacing is disabled, the continuity of 
the brushstroke will depend on the speed of your computer — a rapid brushstroke may 
lead to fragmentation.

Jitter

Linear brushstroke with Jitter enabled. The curve above right was drawn with a straight brushstroke!
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Jitter and Randomness enabled.

The Jitter option causes the paint to be applied at a certain distance from the brush tip.

Squeeze

0% Squeeze. 100% Squeeze.

Here you can squeeze (i.e. narrow) the brush tip. A value of 100% leaves the brush in its 
original shape (circular or rectangular). The lower you set the value, the narrower the tip 
becomes.

Rotation

You can rotate the brush tip by moving the slider or by entering a rotation angle in the 
input box.
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Effectors

You can enable an effector for each of the following brush settings: Size, Pressure, 
Hardness, Jitter, Squeeze and Rotation. To open the effector for a parameter, click the 
blue circle next to the parameter’s name. If the circle is filled, it means the parameter has 
an effector enabled; if the circle is not filled, no effectors are enabled for the parameter.

An effector enables you to change the parameter dynamically by means of a specified 
input method. For example, you can use the pen pressure to change the brush size while 
you paint. Most of the input methods have a graph that you can edit to fine-tune its 
behavior.

Eight different input methods are available. You can assign as many of the methods as 
you wish to the same effector. For example, you can change the brush size value using 
the pen finger wheel as well as the distance. Also, you can use the same input method 
with more than one effector. For example, you can change the brush Size and Pressure 
values using the pen pressure.

Pen Pressure

 The pen pressure is the most popular input method with graphics tablet users. You may 
wish to assign it to the Size or Pressure brush setting. 

This adjusts the setting based on how hard you push down the pen on the graphics 
tablet. The graph to the right defines exactly how this input method affects the setting 
(the graph is straight by default).

Pen Tilt

This method controls the setting based on how you tilt the pen. If the pen is at a right-
angle to the graphics tablet, the tilt is 0 .̊ If the pen is resting on the tablet, the tilt is 90 .̊ 
The graph to the right defines exactly how this input method affects the setting (the 
graph is straight by default). 
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Pen Direction

 If you assign this method to the Rotation brush setting, a narrow brush will paint a stroke 
similar to that of a calligraphy pen. 

Adjusts the setting based on the pen’s rotation. The graph to the right defines exactly 
how this input method affects the setting (the graph is straight by default). 

Pen Finger Wheel

 You may wish to assign this to the brush Pressure so that you can adjust the setting 
comfortably while you paint. 

This adjusts the setting based on the angle of the finger wheel. The graph to the right 
defines exactly how this input method affects the setting (the graph is straight by 
default). 

Draw Direction

This method changes the parameter based on the direction of your brushstroke. For 
example, if you activate this input method for the Rot. effector, the texture will rotate 
automatically to follow your brushstroke. The graph to the right defines exactly how this 
input method affects the setting (the graph is straight by default). 

You can create some interesting effects with this function, especially if you assign it 
to the Rotation brush setting. For example, choose a rectangular brush, set Spacing to 
about 130% and set Rotation to 90 .̊ Assign Draw Direction to the Rotation brush setting 
to create the effect shown above.
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Distance

 You can use Distance with large bitmaps too — you can enter values up to 100,000 
pixels.

This function’s speciality is fading brushstrokes — assign Distance to the Pressure brush 
setting and your brushstrokes will fade gradually. Pixel Length defines the effector’s area 
of influence. For example, if the Pixel Length is set to 200 the curve will be evaluated over 
the first 200 pixels of the brushstroke. So, if the default (straight) curve is used with the 
example, the Pressure will be 100% at the start of the brushstroke and 0% by the time 
the stroke is 200 pixels long.

You can also enter a value in the Loops box. This determines the maximum number of 
times the curve can be repeated if the brushstroke is longer than the Pixel Length value. 
You can also use Distance to create wobbly lines. To add a wobble to your brushstroke, 
assign Distance to the Size brush setting and define a curve similar to the one below.

Note the large number of loops in the example. This lets you paint (almost) as long a 
brushstroke as you wish without the wobble effect diminishing.
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Mouse Wheel

Changes the setting based on the angle of the mouse wheel. The graph to the right 
defines exactly how this input method affects the setting (the graph is straight by 
default). For example, if you assign this to the Pressure brush setting, you can use the 
mouse wheel to adjust the brush pressure while you paint with the mouse. Alternatively, 
you may prefer to use both hands: one hand paints with a graphics pen while the other 
uses the mouse wheel to adjust the Size or Pressure brush setting. 

Randomness

 Randomness behaves differently when assigned to the brush’s Rotation parameter. In this 
case the Randomness value is added to the base Rotation value.

This function assigns random values to the setting. You can specify minimum and 
maximum values (Min and Max). For example, suppose you have set Size to 50 pixels. 
In the effector for Randomness, you leave the Min and Max values set to 0% and 100% 
respectively. If you paint with this brush, the Size will alter randomly between 0 and 50 
pixels. If on the other hand you set Min to 50% and leave Max at 100%, the width of the 
brushstroke will vary between 25 and 50 pixels.

The effect above was achieved by assigning Randomness to the Size, Pressure, Hardness 
and Jitter brush settings.
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Bitmap Brush Type

This mode enables you to use any bitmap in BodyPaint 3D’s “library / pattern” location as 
the brush tip. Keep the following in mind:

BodyPaint 3D handles all bitmaps in the “pattern” folder as grayscale images. You can 
still use RGB Color bitmaps, but BodyPaint 3D will convert them in memory to grayscale. 
Black areas of the bitmap are transparent and white areas are opaque. Gray tones vary in 
transparency accordingly — tones closer to black are more transparent than tones closer 
to white. 

Bitmap

If you click on the triangle, a menu opens with the commands Load From Disk and Reload 
Directory, as well as a list of all bitmaps in BodyPaint 3D’s “pattern” folder. 

Load From Disk loads a bitmap from a storage medium. Once you have chosen the 
bitmap, BodyPaint 3D will ask if it should be saved to the “pattern” folder. If you decline 
this request, the bitmap is loaded into memory temporarily and you can work with it in 
the usual way. However, the bitmap is lost the moment you quit BodyPaint 3D. To prevent 
this from happening, agree to the dialog’s request instead.

Reload Directory updates the list of bitmaps. This is useful is you have copied any bitmaps 
to the “pattern” folder since starting the program, because they will appear in the list 
only once you have used this command.

Choose any bitmap in the list. It becomes the new brush tip (as confirmed by the 
preview) and its name is shown in the box right of the triangle.

The bitmap brush has fewer settings than the generic brush — Shape, Profile, Hardness 
and Squeeze are all absent because these properties are defined by the bitmap itself.
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The Size, Pressure, Spacing, Jitter and Rotation parameters have exactly the same effect 
as with the generic brush type — see “Generic Brush Type” on page 131 for details.

Filter

Filters add effects to the brush such as painting with watercolors and smudging.

Filter set to Wet Edges. Filter set to Smudge.

Wet Edges

This filter generates a watercolor effect. The brushstroke is slightly transparent and 
paint accumulates at the edges (i.e. the edges are less transparent than the center).

Smudge, All Layers, Color Mix

 Set Spacing to a lower value if the smudge effect is too coarse. This will produce a softer 
effect.

If All Layers is enabled, all layers will be considered when you smudge the active layer.

The Color Mix slider controls the extent to which the active color or pattern (i.e. the 
one in the Color manager) is applied to the smudge. If the slider is set to 0%, no new 
paint is applied and you’ll smudge the existing colors only. As you increase the slider’s 
value, so more and more of the active color or pattern is applied to the smudge. In 
addition, you can enable an effector for the Color Mix value.

Dodge, Burn, Saturate, Desaturate

For details on these filters, see “Dodge” on page 244, “Burn” on page 245 and 
“Sponge” on page 245.
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The Brush Presets

 We recommend you use the presets in the following way: whenever you have a brush 
that you might want to use again, save it as a preset. When painting, have the 3D view 
(including the object to be painted) in one window and the Color manager in another. 
Choose a brush, click on a color preset (click on the top left preview in the Color manager 
to display the presets) and paint in the 3D view. When you want to change the pattern, 
select a new preset and paint again. If you work in this way, you will move frequently and 
swiftly between the two windows and your object should be painted in minimal time.

You can use this manager to access brush presets including any you have created and 
saved.

To open the brush presets, do one of the following:

-  Choose Window > Brush Presets.

-  Select the brush tool and in the Active Tool window, click the brush preview in the top 
left corner.
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To access menu commands for these presents, right-click (Windows) or Command-click 
(Mac OS) on a preset. These menu commands are described below.

File Menu
New Group

The number of brush presets will grow over time as you add to them. This command 
enables you to create and name groups so that you can store your presets in a more 
organised manner.

New

This creates a new preset using the current brush parameters in the Active Tool manager.

Revert to Default

This command reverts to the default brush presets. You will lose any presets you have 
created and saved. As a precaution, you will be prompted for confirmation. 

Save As Default

Suppose you have created some presets but you then quit and restart BodyPaint 3D but 
the new presets have gone missing. When this happens, it means you forgot to save the 
presets using the Save As Default command. Don’t worry if you are forgetful because 
BodyPaint 3D will prompt you to save unsaved presets when you quit.

Import

This command enables you to use BodyPaint 3D brushes created by other artists. When 
the file selector opens, choose the BodyPaint 3D file to add its presets to the Brush 
Presets. 

Export Selection

This command enables you to save your BodyPaint 3D brushes so that other artists 
can use them. The file selector will open. Choose a destination and a filename for the 
selected presets (or group of presets). The file takes the extension “b3d”. In addition, a 
folder named “pattern” is created for any textures used by bitmap brushes. 

Export Visible

This command exports all visible presets. 

Close

This command quits the Brush Presets and closes its window. 
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Edit Menu
Edit

This command opens the brush settings in the Active Too manager for the active preset. 

Rename

You can use this command to rename the active preset or group. 

Duplicate

Duplicates the active preset or group. 

Delete

Deletes the active preset or group. 

Group Menu
If you choose All Presets, all brush presets are displayed. If you choose a different group 
from the list, only the presets belonging to that group are displayed. 

View menu
As List

If this option is enabled, the icons are displayed as a vertical list and their names are 
specified. The active icon is indicated by a red frame. To change the order of the icons, 
drag-and-drop within the list. While you drag, a dark line will appear to indicate the 
insertion position.

You can move presets from one group to another to help you better organize them. To 
move a preset to a new group, drag the preset’s icon onto the center of the group icon. 
The mouse pointer will turn into an arrow that points downwards. The small + icon to 
the left of the group icon indicates the group is closed. To open the group, click on the + 
icon. Once the group is open, a small - icon appears. Click on this icon to close the group. 

As Icon

If this option is enabled, the icons are displayed in rows and columns instead of as a 
vertical list. The names of the presets are not shown in this mode. The active icon is 
indicated by a red frame.

Small Icons. Medium Icons, Large Icons

 You can drag-and-drop to change the order of the icons.

Choose the size of the icons: small, medium or large.
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Brush Groups
 If you change the brush presets, a dialog will appear when you quit BodyPaint 3D to 

check if you want to save the current brush presets as the default — click Yes if you want 
to overwrite the old settings. A more cautious approach is to change duplicates of the 
original brushes.

In the Brush Presets you’ll find over a dozen groups offering a wealth of ready-to-use 
brushes presets. Note that you need to paint to several material channels at the same 
time for a realistic effect. A brush which paints to more than one material channel 
simultaneously is called a “multibrush” — you’ll find a selection of such brushes in the 
MultiBrushes folder.

 To learn how to create your own multibrushes, see “Creating a Multibrush” on page 146.

There are two types of brush presets:

-  Brushes which paint on the active material channel only.

-  Brushes which paint on multiple channels simultaneously (multibrushes).

The simplest way to judge the effect of a brush preset is to try it. For this reason, only a 
few of the presets are described below.

Oil (soft) brush. Metal 4 brush. Beard brush.
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Creating a Multibrush
In this tutorial, you’ll learn how create a brush that paints multiple to channels to form 
the effect shown in the example picture below. We’ve simply used a cylinder here, but if 
you have a spaceship handy instead, all the better.

This multibrush will paint a rusty red. It will paint a rusty color to the color channel and 
rust-like bumps to the color channel. The brush will have a soft edge.

To create the brush:

-  In the Color manager, enable the multi channel button (the brush needs to paint to 
the color and bump channels simultaneously) — a green check mark indicates that the 
mode is enabled.

-  Check if there is a small colored pencil in the C (Color) channel icon. If the pencil is 
grayed out, click on the pencil to make it colored.

-  Pick a reddish-brown color (RGB 145, 37, 15).

-  Load the Granite texture into the Wallpaper pane using the triangle. (Granite is suitable 
because it has a rust-like bumpy structure.)

-  Still in the Wallpaper pane, set Strength to 100% and Blending Mode to Multiply. This 
blends the granite pattern with the reddish-brown color.
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-  Now for a rusty bump channel: check for a colored pencil icon in the B (bump) channel. 
If the pencil icon is grayed out, click it to make it colored. There are now two pencils in 
the multi channel palette, that you can use the current brush to paint to two channels 
simultaneously.

-  Choose the granite pattern once again and set Strength to 100%. This time, set 
Blending Mode to Normal. 

-  Ensure that the brush tool is selected (left toolbar) and in the Active Tool manager,  
enable Store Color. The preview updates to incorporate the rust color and the granite 
pattern.
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-  Set Hardness to about 20% to create the softness we require for this brush.

-  Choose any Size setting you like and set Pressure to 100%.

-  The default Spacing value (20%) is fine.

-  Still in the Active Tool manager, click the Add Preset button, enter a name for your new 
brush into the dialog that opens and click OK.

Congratulations! You’ve just created and saved your first multibrush. Try painting with 
the new brush preset if you haven’t already done so. To use the brush at a later date, click 
on its icon in the Brush Presets and paint away. 

If you can’t see the bump clearly, in the Material editor increase the material’s Strength 
setting on the Bump page.
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To start BodyPaint 3D, do one of the following:

-  Double-click on the program icon.

-  Double-click on a scene file.

-  Drag one or more BodyPaint 3D files in the Explorer (Windows) or the Finder (Mac OS) 
onto the BodyPaint 3D icon (drag-and-drop).

template.c4d
During startup, BodyPaint 3D checks its root folder for a file called “template.c4d”. If 
the file is present, its settings are loaded and used as default values. This can be very 
effective if you keep using the same scene-specific settings (e.g. several different render 
settings).

new.c4d
When you create a new file (main menu File > New), BodyPaint 3D checks its root folder 
for a file called “new.c4d”. If the file is present, its settings are loaded and used as default 
values. For example, to activate antialiasing permanently, create a new file, change the 
values in the Render Settings accordingly, then save the file into the same folder as the 
BodyPaint 3D program under the filename “new” (the ‘“c4d” file extension is appended 
automatically).

New

This command opens a new document and makes it the active (current) document. Until 
you save the new document and give it a name, the title bar of the document window 
will show “Untitled”. If you have several documents open you can switch quickly between 
them using the main Window menu.

8 File Menu
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Open

This command loads a file (a scene, a material, etc.) from a storage device (such as a hard 
disk) into memory and opens it in a new document window. If the current document 
window is empty, this is used instead. BodyPaint 3D can import the following formats:

-  BodyPaint 3D scenes (“.c4d”), catalogs (“.cat”), preferences (“.prf”)

-  3D studio R4 (“.3ds”) (including materials, light sources, textures and animation)

-  DEM scenery files (“.dem”)

-  DXF to AutoCAD R12

-  Illustrator paths as polygons (“.ai”, “.art”, “.eps”)

- LightWave 3D (.lwo, .lws), LightWave [6] objects (including textures, UV coordinates, 
weight maps) and scene files (including lights, camera focal length)

-  QuickDraw 3D (“.3dm”) (binary only, not ASCII)

-  VRML V1 and V2 (“.wrl”)

-  Wavefront (“.obj”)

These formats are recognized automatically. Filename extensions (Windows) are 
superfluous, as are types and creators (Macintosh). You can also use this command to 
view images or load other settings. Alternatively, you can open a file by dragging it from 
Explorer (Windows) or Finder (Mac OS) onto a viewport.

Merge

This command lets you add scenes, objects, materials, etc. to the active document.

Revert To Saved

This command reverts the scene to its most recently saved version (including all saved 
textures used in the scene). You will lose any changes made to the current document and 
textures since you last saved; therefore, a dialog will ask you to confirm the action.
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Close

Closes the active document. If it contains any unsaved changes, a dialog opens to check if 
you want to save the scene before closing it.

Close All

Closes all open documents. If you have made changes to the scene or textures, a dialog 
will check if you want to save these changes.

Save

This command saves your document without first opening the file selector. The scene is 
saved using the name chosen when you selected the Save As command (i.e. the name 
that appears in the title bar). If this is the first time you are saving a new document and it 
does not have a name yet, then the Save command behaves just like Save As.

Save As

Save As always opens the system file selector. The filename you enter here will be 
displayed in the document window’s title bar. BodyPaint 3D automatically appends the 
appropriate extension (“.c4d” for scenes) to the filename.
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Save All

This command saves all open documents and textures. If you are saving a scene or 
texture for the first time, a file selector will open to enable you to choose a name and 
path for the file.

Save Project

Transferring scenes from one computer to another is always challenging for a project 
leader. BodyPaint 3D helps you to build complete scenes. Selecting this command 
opens the usual system file selector for saving files. Choose a folder and enter a name. 
BodyPaint 3D creates a new folder in the specified path and saves the scene there. In 
addition, it creates a sub-folder, named Tex, into which it copies all the pictures and 
textures necessary for rendering the scene. You can now move the project to another 
system with confidence.
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New Texture

The following window opens when you choose New Texture:

You can now do one of two things: you can either create a new texture (specify the 
dimensions, color mode, etc.), or you can load an existing texture from a storage medium 
(e.g. hard disk). 

New Texture

You can type a name for your texture into the top input box. This name will be used to 
refer to the texture in the Attribute manager and it is also used to form the filename 
when you save the texture (although you may opt to specify a different filename at save 
time). 

Width, Height

These fields define the width and height of your new texture. Select the unit of 
measurement using the drop-down lists to the right. You can choose pixels (the default), 
inches or cm.

Resolution

In most cases, the default resolution of 72 pixels/inch (dpi) is appropriate because this is 
the resolution used by most monitors.
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Exception: you may need to change the default resolution if you want to print out the 
texture and you have specified the dimensions (Width and Height) in inches or cm. 

Mode

This is where you choose the color mode used by the texture — either RGB 24 Bit (3 Byte/
Pixel) or Grayscale 8 Bit (1 Byte/Pixel).

Color

This defines the texture’s background color. You can choose one of four options:

Background

The current background color is used.

Foreground

The current foreground color is applied.

Color

Use the color chooser to pick a color for the texture’s background.

Transparent

This allocates a transparent background to the texture.

The Max. Memory/Layer value, near the bottom of the window tells you the maximum 
RAM required for each layer. 

Once you have set the parameters as required, click OK to create the new texture. The 
window will close and you’ll see the new texture appear in the Texture view. 

Assigning a texture to a material channel

To assign a texture to a material channel, do one of the following:

-  Double-click on the material in the Material manager to open the Material Editor. In the 
Material Editor, activate the material channel to which the texture should be assigned. 
Next, click the triangle right of the Image button. From the menu that opens, choose 
the desired texture from the Bitmaps sub-menu. All bitmaps in RAM are displayed on 
this menu.

-  When you create a new material channel in the Material manager, the New Texture 
dialog opens. Enter the name of the texture into the box right of the Name button and 
click OK.
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Open Texture
 Although you can open a QuickTime or AVI movie, you cannot paint on it. Also, you 

cannot paint on materials which contain animation (movies, picture sequences).

A dialog opens when you select this command. Use the dialog to select the bitmap file 
you wish to load. You can use the following formats as textures in BodyPaint 3D:  B3D 
(the native BodyPaint 3D file format), PSD (Photoshop files including all layers), TIFF, PICT, 
BMP, JPEG, TARGA, IFF-ILBM and RLA/RPF (without 3D information). Additional formats 
may be available if QuickTime is installed on your computer system. See the Appendix for 
further details.

Revert Texture To Saved

This command reverts the current texture to its last saved state. Any changes made to 
the texture since it was last saved will be lost; a dialog will ask you to confirm the action. 

Close Texture, Close All Textures
 Call this command before you render to prevent possible render errors. The renderer 

uses the textures in their current state. Therefore you should avoid editing textures while 
rendering is in progress or errors are likely.

  

These commands remove either the active texture or all textures from RAM. If a texture’s 
current state has not been saved, a dialog will appear to offer you the chance to save it.
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Save Texture, Save Texture As
 Textures are saved separately from scenes in BodyPaint 3D. Save textures in the same 

folder as the scene to which they belong, or in a Texture Paths location (preferences), 
otherwise BodyPaint 3D will be unable to find the textures the next time you load the 
scene. To save the scene itself, choose File > Save as from the main menu.

 

Save Texture will save your texture without a dialog appearing. That is, unless you are 
saving the texture for the first time, in which case a dialog opens so that you can specify 
the filename and folder for the texture

When you select Save Texture As, a small dialog will open.

Use Save File As to specify the texture’s file format. Choose from B3D (BodyPaint 3D’s 
native format), PSD (Photoshop files complete with layers), TIFF, PICT, BMP, JPEG, TARGA, 
IFF and RLA/RPF (without 3D information) as well as any formats installed on your system 
under QuickTime.

Once you have chosen the file format and clicked OK, a dialog will open to allow you to 
specify the filename and save path.

Save Texture As Copy

You can use this command to save a copy of the current texture. Note that the current 
texture’s name in RAM and in the material channel is not changed in the process. This is 
in contrast to Save Texture As. 
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Save All Textures

Use this command to save all the textures. If any of the textures are being saved for the 
first time, the following process is repeated for each new texture:

-  A dialog opens. Use the dialog’s drop-down list to specify the file format for the 
texture and click OK.

-  A dialog will open to allow you to specify the filename and save path. 

Send Scene Back

If you are using BodyPaint 3D with 3ds max, LightWave or Maya, this command sends the 
painted scene back to that application.

Export
A scene can also be exported to a foreign file format for subsequent work in other 3D 
software. The file types described below are available. BodyPaint 3D automatically adds 
the relevant file extension to the file. Each 3D program works differently, therefore it 
is not always possible to convert all information within a scene. Further, the result will 
always differ according to the materials and lighting used, so a manual re-working may 
be necessary.

 For more details on the following and other formats, see “Import / Export” in Chapter 3. 

3D Studio R4 (.3DS)
Common data format under DOS/Windows. 3D Studio was the predecessor to 3D 
Studio MAX. The last freely available file format is release 4; the MAX data format is not 
available to other manufacturers. In principle the MAX format is not generally readable 
since MAX (like BodyPaint 3D) uses parametric objects, which are useless without their 
associated specific algorithm. For example a teapot is not saved with points and surfaces, 
but only with the dimensions and the subdivision value.

CINEMA 4D XML
XML is a standardized language for file exchange. It is especially useful for plugin 
developers who want to better integrate their extensions into the file. For more details 
on this format, see www.xml.org.
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Direct3D / DirectX (X)
Direct3D is a Microsoft-specific 3D format, which is used by Windows (provided DirectX 
is installed). This export module is particularly useful to game developers.

DXF (DXF)
One of the most common graphics file formats, nearly all professional 3D packages 
support DXF. BodyPaint 3D splines are generally written as polylines, independent of the 
surface settings for polygons.

QuickDraw 3D (3DM)
The standard format for three-dimensional graphics on the Apple Macintosh.

STL (STL)
Commonly used in the field of rapid prototyping to create moulds.

VRML 1 (WRL)
The Virtual Reality Modeling Language lets you create platform-independent 3D objects 
and scenes for the Internet. It is also a useful file format for exchanging data between 3D 
programs because  it contains more file information than the much-used DXF format.

VRML 2 (WRL)
Version 2 of the standard format for 3D graphics files on the Internet enables you to 
display animation sequences. The advantages for data exchange with CAD software 
mentioned above also apply to VRML 2.

Wavefront (OBJ)
A common 3D data format in the UNIX world, developed by Alias.

Recent Files
BodyPaint 3D remembers which files you last opened and lists them here for quick 
access. There are two lists: one for scenes and one for textures. Define the maximum 
number of files listed in Edit > Preferences.

Quit
This command quits BodyPaint 3D.
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The Edit menu contains some of the most frequently used commands in BodyPaint 3D 
such as Undo and Redo, hence you’ll find these commands on most local Edit menus.

The undo buffer
 Some commands, such as Save and General Settings, are not recorded in the undo buffer 

and subsequently cannot be undone.

BodyPaint 3D’s multiple undo enables you to undo not just the last change you made but 
up to as many changes as RAM permits. The maximum number of undos is defined by 
the Undo Depth on the Document page of the preferences — the default it 10.

BodyPaint 3D differentiates between memory-intensive actions and non-memory-
intensive actions. Examples of memory-intensive actions include deleting an object 
and moving an object’s points. Non-memory-intensive actions include selecting and 
renaming objects. Non-memory-intensive actions can be recalled 10 times more than the 
Undo Depth value in the preferences. For example, with Undo Depth set to 12 you can 
undo 12 delete object actions or 120 select object actions. You can also mix both types of 
action, e.g. you can undo 6 delete object actions and 60 select object actions.

When you perform an action in BodyPaint 3D, information about that action is written 
to an area of memory called the undo buffer. The Undo and Redo commands use the 
information in the undo buffer to undo changes.

Example

-  You load an object and change its scale to (400/400/400) units. You move the object to 
coordinates (100/-300/0).

-  At this point, the undo buffer contain the following action history:

   1. Create object at position (0/0/0).

   2. Scale object to (400/400/400) units.

   3. Move object to position (100/–300/0).

-  The buffer’s current state is step 3, the move action. If you use the Undo command, 
BodyPaint 3D undoes the current state (move) then sets the current state to step 2 
(scale).

-  If you use the Undo command again, the scale action is undone and the current state is 
set to step 1 (create).

9 Edit Menu
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-  Throughout the process the buffer content itself is not altered — nothing is deleted. 
This enables you to restore the changes with the Redo command. Use Undo to move 
backwards through the undo buffer (i.e. the changes) and Redo to advance through 
the buffer.

-  Although nothing is deleted from the buffer, the buffer’s size must be prevented from 
taking up too much memory. This is the purpose of Undo Depth in the preferences — it 
specifies the maximum number of actions that can be undone.

Undo, Undo View

 Undo View affects the editor camera only. It has no effect on your own camera objects.

Undoes the last change, restoring the scene to its previous state. For example, if you 
accidentally move an object, choose Undo to restore the object to its correct position. 
Choose Undo repeatedly to undo the previous changes on by one. By default, you can 
undo a maximum of 10 changes. The maximum number of changes that can be undone 
is defined by Undo Depth in the preferences (Document page). Note that the Undo 
command from the menu of a viewport undoes changes to the editor camera only. You 
can undo a maximum of 500 editor camera changes.

Redo, Redo View

 Undo View affects the editor camera only. It has no effect on your own camera objects.

Redo redoes a change. Select Redo repeatedly to continue restoring the changes. You can step 
through the changes made to your scene using Undo to step backwards and Redo to step 
forwards. Naturally, the number of steps you can redo cannot possibly be greater than the 
number of actions you have undone. Therefore, there is no separate setting for the redo depth 
in the preferences. In a viewport, Redo View redoes changes to the editor camera only. You 
can redo a maximum of 500 editor camera changes.

Undo (Texture)

Undoes the last change made to a texture, such as a brushstroke or a filter effect. Note 
that this type of undo shares the same buffer as the standard Undo command.
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The clipboard
When you use the Cut or Copy commands, the selected objects or elements are copied into 
a structure in memory known as the clipboard. When you select the Paste command, the 
data in the clipboard is inserted into the current scene. For example, to copy an object from 
one scene to another scene; open both scenes, activate the scene that contains the object, 
copy the object, activate the other scene and then paste.

The size of the clipboard is determined by the size of the data stored there. If, for 
example, you copy an 18MB object, the clipboard will use 18MB of memory. You may 
want to purge the clipboard to free up memory, especially before you render. To purge 
the clipboard, cut a null object. The null object wastes only a few bytes.

Cut

Deletes the selected objects or elements from the current scene and copies them (including 
materials) to the clipboard. The objects can be copied back from the clipboard with the Paste 
command.

Copy

 You can copy and paste objects using drag-and-drop in the Object manager. Ctrl-drag 
one of the selected object’s names to a new position within the Object manager.

Copies the selected objects or elements (including materials) to the clipboard. The 
objects can be copied from the clipboard to the active scene with the Paste command. 
You can paste repeatedly to create additional copies.

Copy Merged

In contrast to Copy, this command commands not just the active layer but all layers 
merged together. The selection therefore applies to all layers. Hidden layers are ignored.
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Paste

Inserts the contents of the clipboard (i.e. the last objects that were cut or copied there) into 
the active scene.

Paste Into Selection

Pastes the contents of the clipboard into the selection.

Delete

Deletes the selected objects or elements from the current scene without copying them to 
the clipboard.

Fill Layer

Fills the selection — or the entire layer if there is no selection — with the active color.

Tile U, Tile V

Tiling enables you to paint over the edges of a texture in the Texture view — the 
brushstroke will continue from the opposite edge. Enable Tile U and Tile V for tiling in the 
horizontal and vertical directions respectively.
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Multi Channel Mode

Toggles multi channel mode on and off.

Display Selected Channel

 This mode does not work if the UV Points tool or UV Polygons tool is selected.

This mode lets you to display individual material channels on your object. The active 
channel is temporarily displayed as a color channel.

For example, if you activate the transparency channel, you’ll see the channel displayed on 
the object as a grayscale texture. You can then manipulate the grayscale texture in the 
usual way, such as by painting on it with the brush tool.

Once you are done editing the single channel, disable the option to display all material 
channels once again in the usual way.

Preferences

Here you can define global values for commands and the editor’s appearance  See 
“Preferences” on page 46.
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What are Textures?

The textures used by BodyPaint 3D are, without exception, bitmaps. A bitmap represents 
an image by means of a grid of small squares called pixels. Each pixel has its own color 
and  position in the grid. The bitmap’s picture quality and its size in bytes (i.e. how much 
storage space it requires) are affected by its dimensions, resolution, color depth and the 
data compression method employed.

The RGB color model is the most common way in which colors are defined in the 
computer world. The RGB color model defines colors in terms of red, green and blue 
brightness components. These components are combined to form a particular color.

The term “True Color” refers to 256 brightness values per color component. The value of 
256 was not chosen at random. It arises because with True Color each color component 
is specified in a computer byte. Since a byte is composed of 8 bits, the total number of 
possibilities per color component is 28 bits = 256. Therefore, a color component may 
have any integer value between 0 (no brightness) and 255 (full brightness) inclusive.

Each True Color pixel requires 24 bits of storage space (8 bits x 3 color components). 
It follows, then, that a True Color image of size 600 x 600 pixels requires 600 x 600 x 
24 bits = 8,640,000 bits of storage space, which is about 1 MB (8640000 bits / 8 = 
1080000 bytes / 1024 = 1054 KB / 1024 = 1.03 MB).

Compression formats such as JPEG enable the bitmap to be saved to a storage medium 
with a much-reduced file size. However, some image quality is lost in the process unless a 
non-lossy compressor is used. Compressed files may reduce the strain on your hard disk, 
but do not make the common mistake of thinking that a compressed file takes up less 
space in BodyPaint 3D than an equivalent uncompressed file. BodyPaint 3D always works 
with bitmaps so a 600 x 600 JPEG takes up just as much RAM as, say, an uncompressed 
colour TIFF image of the same dimensions.

In addition to the three color components, bitmaps may have an alpha channel. This is 
usually an integrated 8-bit grayscale image used for masking. If you load such a bitmap 
into BodyPaint 3D, the alpha channel will be implemented as a layer mask.
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 You can paint finer details on your object by using a bigger texture (i.e. a texture with 
more pixels).

The main disadvantage of larger textures is that they consume more RAM. The demand 
on RAM increases sharply if you are painting on multiple material channels in projection 
painting mode or raybrush mode. Avoid using textures that are much larger than they 
need to be — they need only be as large as they will be in the rendered image.
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Image Menu Commands
Most of these commands affect the active texture of the active material channel only, i.e. 
the texture displayed in the Texture view.

Texture Size
 This command also gives you a quick way to set all textures to the same size. This is 

especially useful if you want to paint on the textures with a multibrush (multibrushes only 
work if he textures are the same size).

You can use this command to scale the textures of the individual material channels. When 
you select the command, the Scale Texture dialog opens.

Current Size
All material channels are listed on the left — unused channels are grayed out. Select the 
channels you want to scale from the list. The current texture size is listed next to each 
channel.  

New Size

User Defined Size, Width, Height, Lock Aspect Ratio

Enter the new size into the Width and Height boxes. If Lock Aspect Ratio is enabled, the 
width to height ratio is maintained.
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Maximum Size, Average Size, Minimum Size

These mode set the Width and Height values to the largest, smallest or average size of 
the textures.

Interpolation
When bitmaps are scaled, pixels must be added or removed and new color values 
calculated. The new color values can be calculated using one of two interpolation types: 
Nearest Neighbor or Bilinear.

Nearest Neighbor

This mode gives you fast results but the quality is relatively poor.

Bilinear

Bilinear takes longer to calculate than Nearest Neighbor, especially if you are scaling 
multiple textures. But it gives the best results.

Canvas Size

Current Size
Select the channels you want to resize — unused channels are grayed out.
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Add Borders
Use the top four boxes in the Add Borders pane to enter the size of the border (in pixels) 
to be added to each side. If Symmetric is enabled, any border value you enter is copied to 
the other three boxes.

Transform UVW
Enable this option if you want to fix the UV polygons to the canvas pixels they currently 
cover. This prevents the UV polygons from venturing into the new border(s).

Crop Texture
 You can crop any shape of selected pixels, not just rectangles. For example, you can crop 

a circular selection made using the Select Circle tool. An invisible rectangle will be fitted 
to the selection and the texture will be cropped using this invisible rectangle. The cropped 
texture will still be rectangular regardless of the shape of the selection.

This command is only available when pixels are selected.  If you create a rectangular 
selection and call the command, parts of the texture outside the rectangle will be 
cropped.

After you choose the command, a dialog will open; use this dialog to choose in which 
material channels the cropping should be applied. If you enable Transform UVW, the UV 
coordinates will be adapted to fit the cropped texture (this option is only available if all 
textures are the same size).
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Rotate Texture

This command rotates the active texture by a specified angle. Keep in mind that the size 
of the texture will be changed for rotations other than 90 ,̊ 180˚ and 270 .̊

Current Size
Select the channels you want to rotate — unused channels are grayed out.

Rotate Texture
You can select a rotation value of 90 ,̊ 180 ,̊ 270˚ or Free. If you choose Free, you can 
enter your own rotation value in the Angle box. Enter positive or negative values to 
rotate clockwise or anti-clockwise respectively.

Interpolation

Nearest Neighbor

This mode gives you fast results but the quality is relatively poor.

Bilinear

Bilinear takes longer to calculate than Nearest Neighbor, especially if you are scaling 
multiple textures. But it gives the best results.
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Transform UVW

 You can select Transform UVW only if the textures in the channels to be rotated are all 
the same size.

Enable this option if you want to rotate the UV polygons as well as the texture.

Flip Texture Horizontal/Vertical

Current Size

Select the channels you want to mirror.

Transform UVW

 You can select Transform UVW only if the textures in the channels to be rotated are all 
the same size.

Select Transform UVW if you want to mirror the UV mesh as well.

Convert To Grayscale

This converts the active texture including all layers to grayscale (8-bits).
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Convert To RGB

You can use this command to convert the active texture from grayscale (8-bits) to RGB 
(24-bits). Convert To RGB will not restore color to a black-and-white image, but it does 
enable you to paint colors on the channel.

Bitmap Properties
To display the bitmap properties in the Attribute manager, select a texture or layer in the 
Material manager or Layer manager. You can adjust some of these properties directly in 
the Material manager or Layer manager.

Layer properties

Name

The name of the layer. Change the name if you wish.

Preview

This preview shows you the current state of the layer taking into account all parameters 
except the blend mode.
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Visible

This option enables you to hide or show the layer. This has the same effect as clicking on 
the layer’s eye icon in the Material manager or Layer manager.

Blend Mode

 For descriptions of the blend modes, see “Blending Mode” on page 114.

Defines the layer’s blend mode, i.e. how the layer interacts with the layers underneath it.  

Opacity

You can set values from 0% to 100%. If you set the value to 0%, the layer will be 
completely transparent. If you set the value to 100%, the layer will be completely 
opaque. Intermediate values produce a semi-transparent layer. Exception: transparent 
areas within the layer itself do, naturally, remain transparent regardless.

Offset X, Offset Y

You can use these settings to move the active layer. Enter offset values (in pixels) 
into X and Y — use negative values if you want to reverse the direction of the offset. 
Alternatively, move the layer using the move layer tool. One advantage of using Offset as 
opposed to the move layer tool is that you can move the layer back to its original position 
at any time by entering a value of zero into both boxes.

Info

Here you’ll find details on the width, height, memory usage, texture name and color 
mode.
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Texture properties

Preview

Shows a composite preview of the texture.

File Format

If the texture is unsaved, here you can choose which file format will be used when you 
save. Otherwise the setting displays the texture’s current file format.

Filename

This is the texture’s save path including its filename.

Info

Here you’ll find details on the width, height, memory usage and color mode.
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Initially a texture has just one layer: the background layer. Think of the background layer 
as your canvas. Just like a real canvas, you can paint on the background layer and, just 
like a real canvas, it can be difficult to remove unwanted effects that you painted some 
time ago. The solution to this problem is to use layers. Layers are like sheets of acetate 
stacked above the background — you can paint on each layer and where there is no paint 
on a layer, the layer below shows through. By painting an effect on a layer other than the 
background, the effect remains independent and you can remove it at any time simply 
deleting the layer.

You can also select, transform and paint the layer independently of the background and 
other layers. In addition, each layer has a Blending Mode and Strength setting, which 
makes it much easier for you to create and adjust effects compared with a single layer.

Most of the commands on the Layer menu affect the active layer only (this is the layer 
with a bright red frame in the Material manager). For details on how layers are organized 
in the Material manager, see Chapter 23, Material Manager.

 To display alpha channels and layer masks in the Material manager, choose one of the 
Layer Manager display modes from the Material manager’s Edit Menu, such as Layer 
Manager (compact).

 You can also access most of the following layer commands from the context menu. To 
open the context menu, right-click (Windows) or Command-click (Mac OS) on a texture 
or layer in the Material manager.

New Layer

This creates a transparent layer above the active layer. The new layer is activated 
automatically. You can create as many layers as RAM allows.

Duplicate Layer

This command creates a copy of the active layer.

11 Layer Menu



184 • CHAPTER 11 LAYER MENU • 185

Delete Layer

 The only way to delete a layer mask is to use this command.

This deletes the active layer.

Merge Layer Down

 You can select this command only if both the layers are visible.

This command merges the active layer with the layer below to form a single layer. This 
frees RAM and simplifies the layer stack, hence you should merge layers once you have 
finished editing them.

You can also merge layer masks with this command. There are two outcomes depending 
on whether the layer or the layer mask is active:

-  Layer Mask Active. The layer mask is merged with its layer — the masked areas in the 
layer become genuinely transparent rather than masked and the layer mask is deleted.

-  Layer Active. The layer mask is merged with the layer as described above. Next, the 
layer down is merged with its layer mask — again, as described above. Finally, the two 
layers are merged to form a single layer.

Flatten Visible Layers

This command merges all visible layers to form a single layer. Invisible layers remain 
unchanged.

Flatten Layers

This command merges all the layers to form a single layer. Invisible layers are deleted in 
the process and any transparent areas in the flattened layer are filled with white.
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Add Layer Mask

 A layer mask masks the layer, it does not alter it.

This command creates a layer mask for the active layer. If no pixels are selected when 
you choose this command, the layer mask is filled with white; otherwise, the layer mask 
is white within the selection and black outside the selection. In this way, the selection 
defines which parts of the layer are visible.

You can edit a layer mask in much the same way as you would a normal layer: click on the 
layer mask icon to activate it and paint on the layer mask using the brush or any other 
paint tool. To apply the layer mask permanently, right-click (Windows) or Command-click 
(Mac OS) on the layer mask and choose Merge Layer Down.

Add Selection To Layer Mask

This command paints the selection white in the layer mask. As a result, the corresponding 
parts of the layer will be visible.

Subtract Selection From Layer Mask

When you choose this command, the selection is filled with black in the layer mask. The 
corresponding parts of the layer will be transparent.

Fill Polygons

Fills the selected UV polygons with the active color. This command works on the active 
layer only.
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Outline Polygons

Strokes the edges of the selected UV polygons with the active color and brush. This is 
useful for marking out the positions of the UV on the texture. This command works on 
the active layer only.

New Alpha Channel

If you choose this command, a new alpha channel is created for the material channel or 
texture based on an existing selection. If there is no selection, the alpha channel is filled 
with white and the entire channel will be visible.

You can also use this command to save selections. To restore a saved selection, activate 
the alpha channel and choose Select > Selection From Layer from the main menu.
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The Layer Manager

The Layer manager displays all layers for the texture that is currently displayed in the 
Texture view. You’ll rarely need to use this manager because all of its functions are 
integrated into the much more powerful Material manager.

The only time you are likely to need the Layer is when you are editing bitmaps that are 
not assigned to a material, i.e. when you are using BodyPaint 3D as a 2D image editor.

To learn how to use the Layer manager, see “Layer Manager (expanded/compact) mode” 
on page 452.

View
Use this menu to choose the size of the layer previews or close the manager.

Functions
These commands are described earlier in this chapter and in Chapter 10, Image Menu.
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These selection tools are indispensable for your day-to-day work in BodyPaint 3D. They 
restrict the effect of tools to the selected pixels and enable you to cut, copy and move 
parts of the bitmap. There are two main types of selection tool in BodyPaint 3D:

-  Polygon and UV polygon selection tools.

-  Bitmap selection tools.

In these pages you’ll learn how to use the bitmap selection tools. Some of these tools 
select pixels according to color differences (such as the Magic Wand) while others allow 
you to draw a selection shape (such as Select Circle and Select Polylines).

Bitmap selections appear as moving dotted lines in both the Texture view and the 3D 
view. To move a selection, move the mouse pointer inside the selection and drag the 
selection to the desired position (in the 3D view, projection painting must be enabled for 
this to work).

Common Active Tool manager selection options

Shape

Choose the shape of the selection: circle, rectangle, polylines or freehand.

Antialiasing

Antialiasing enabled. Antialiasing disabled.

Enable the Antialiasing option if you want to smooth the edges of the selection. The 
advantage of this option becomes apparent when you copy a selection to a new position 
on a different background color — antialiasing softens the color transition between the 
selection’s edges and the background.

Feather

A feather value of 20.

Feather defines the size of the transition between the selection and the background.
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New Selection, New Inverse Selection

New Selection creates a new selection; existing selections are deleted in the process. If 
New Inverse Selection is enabled, everything you select is deselected. This is useful when 
you want to remove areas from the selection.

Add To Selection, Subtract From Selection

Add to Selection. Subtract from Selection.

If Add to Selection is enabled, the selection will be added to the existing selection. This 
has the same effect as holding down the Shift key while you select (in the 3D view, 
projection painting must be enabled for this to work). Enable the Subtract From Selection 
option if you want to subtract the selection from an existing selection (or hold down the 
Alt key while you select; if you are selecting in the 3D view, projection painting must be 
enabled for this to work).

Select All, Deselect All, Invert All

  

These commands enable you to select or deselect the entire texture or invert the existing 
selection.



192 • CHAPTER 12 SELECT MENU • 193

Select Circle

This tool gives you three ways to create circular and elliptical selections.

Box. Center. Diameter.

Active Tool manager options

Box, Center, Diameter

With Box enabled, drag a marquee to define the area inside which the circle or ellipse will 
be fitted. With Center, click to define the center of the circle and drag to define its radius. 
If you enable Diameter, you can drag to define the circle’s diameter and rotate the circle 
around the point where you clicked.

Shape, Antialiasing, Feather, New Selection, New Inverse Selection, Add to 
Selection, Subtract from Selection

See “Common Active Tool manager selection options” on page 191.
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Select Rectangle

This tool gives you three ways to create rectangular selections

Box. Center. Diameter.

Active Tool manager options

Box, Center, Diameter

With Box enabled, drag to define the rectangle’s top-left corner and the bottom-right 
corner. With Center enabled, click to set the center of the rectangle and drag to define 
the distance from the centre to the edges — you can rotate the rectangle while you 
do this. With Diameter enabled, drag to define the diameter. Again, you can rotate the 
rectangle while you drag.

Shape, Antialiasing, Feather, New Selection, New Inverse Selection, Add to 
Selection, Subtract from Selection

See “Common Active Tool manager selection options” on page 191.
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Select Polylines, Select Freehand

 

Box.

With the Select Polylines tool, you can select pixels by drawing a polygonal shape that 
encloses them. Click to create the polygon’s starting point. Continue clicking to create 
successive corner points. When you are ready to finish the shape, double-click on the last 
point to connect it to the starting point.

 If you hold down Shift while you create the polygon outline, the lines will be constrained 
to angles of 45˚.

Select Freehand is the most flexible selection tool, but you’ll need a steady hand to use 
it accurately. Drag to draw a freehand outline. As soon as you release the mouse button, 
the two ends will be connected by a straight line.

 If you hold down Shift during the freehand selection, straight lines will be drawn. These 
straight lines will be constrained to angles of 45˚.

Active Tool manager options

Shape, Antialiasing, Feather, New Selection, New Inverse Selection, Add to 
Selection, Subtract from Selection

See “Common Active Tool manager selection options” on page 191.

Magic Wand

In contrast to the selection tools described above, the magic wand selects pixels 
according to their color. Contiguous pixels that are similar in color to the pixel you clicked 
will be selected.



196 • CHAPTER 12 SELECT MENU • 197

Active Tool manager options

All Visible Layers

If this option is enabled, the selection will be based on the composite image of all visible 
layers. With the option disabled, the selection will be based on the active layer only.

Tolerance

The Tolerance value defines how similar contiguous pixels must be in color compared 
with the pixel you clicked in order to be selected. You can set values from 0% to 100%. If 
you set Tolerance to 0%, only pixels of identical RGB color to the pixel you clicked will be 
selected. With a Tolerance of 100%, all pixels will be selected.

New Selection, New Inverse Selection, Add to Selection, Subtract from Selection

See “Common Active Tool manager selection options” on page 191.

Select Color Range

This tool is the same as the magic wand except the selection is not restricted to 
contiguous pixels.

All Visible Layers

If this option is enabled, the selection will be based on the composite image of all visible 
layers. With the option disabled, the selection will be based on the active layer only.

Tolerance

The Tolerance value defines how similar contiguous pixels must be in color compared 
with the pixel you clicked in order to be selected. You can set values from 0% to 100%. If 
you set Tolerance to 0%, only pixels of identical RGB color to the pixel you clicked will be 
selected. With a Tolerance of 100%, all pixels will be selected.

New Selection, New Inverse Selection, Add to Selection, Subtract from Selection

See “Common Active Tool manager selection options” on page 191.
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Feather

 This command feathers the existing selection. To apply feathering at the same time as you 
create a selection, use the Feather setting in the Active Tool manager instead.

Feather softens the edges of an existing selection. A dialog appears when you select the 
command. Enter the width of the feathering — you can enter values from 0 to 1,000. 
Click OK to apply the feathering.

Grow Selection, Shrink Selection

  

These commands expand or contract the selection by a specified number of pixels. A 
window opens when you select the command. Enter a value from 1 to 100 and click 
OK to expand or contract the selection by that number of pixels. Note that you cannot 
expand the selection past the texture’s edges.

Selection From Layer

This creates a selection from the active layer. The example above shows how the 
command has been used to select the text. Everything non-transparent is selected.

Selection From Layer (Add)

This command adds all non-transparent areas to the existing selection.
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Selection From Layer (Sub)

This command removes all non-transparent areas from the existing selection.

Create Mask From Selection

This command creates a bitmap selection from an existing UV or object polygon 
selection.

Hide Selection

Hides or shows the lines of the selection.

Edit Selection Mask

 If you enable this mode and no pixels are selected, the entire selection mask will be 
transparent.

The edit selection mask mode enables you to edit a bitmap selection using the paint tools 
and filters by means of a temporary mask. There are three main steps involved:

-  Enable Edit Selection Mask. This bitmap selection changes to a selection mask and the 
bitmap selection’s dotted line is replaced by a red overlay (the selection mask).

-  Use the paint tools and filters to edit the selection mask.

-  Disable Edit Selection Mask. The selection mask is converted to a bitmap selection.

This raises the question: “If you start with a bitmap selection and you end up with a 
bitmap selection, what is the point of this mode?” The advantage of the edit selection 
mask mode is that you can call upon (almost) all the paint tools and filters to create your 
select. In short, it enables you to create complex selections with relative ease.
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By convention, the selection mask appears as a red overlay. Selected areas are 
transparent, unselected areas are red. The red areas are slightly transparent to allow 
you to see through to the image. Even though the mask is shown in red, internally it 
is actually a grayscale image. Use white to paint a transparent (i.e. selected) region, or 
black to paint a red (i.e. unselected) region. Use grays for semi-transparency (i.e. partial 
selection).

Once you have finished editing the selection mask, disable the mode and the mask will 
be converted to a bitmap selection.
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 To reapply the last filter used, choose Filter > Execute Last Filter.

Filters enable you to apply effects to your textures such as Noise, Blur, Sharpen and 
Invert. These filters affect the active layer only. If pixels are selected when you call the 
command, only the selected pixels will be affected, otherwise the effect will be applied 
to the entire layer.

Original image. Blur. Gaussian Blur. Motion Blur.

Radial Blur. Selective Blur. Smooth. Gamma Correction.

Levels. Magnifying Glass. Waves. Whirl.

Despeckle. Distribute Pixels. Noise. Deinterlace.
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Invert. Matrix. Oil Painting. Mosaic.

Sharpen. Unsharp Mask. Difference Operators. Emboss (Matrix).

Emboss (Texture). Enhance Details. Enhance Structures. Texture Blend.

To apply a filter to a layer, activate the layer and choose the filter from the Filter menu. A 
dialog will open — use the parameters in the dialog to control the filter’s effect and click 
OK or Cancel to apply or abort the effect.
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In the filter’s dialog you’ll see a preview for the filter’s effect applied to part of the 
texture. This interactive preview and it will update as you adjust the filter’s settings. To 
zoom the preview, click the magnify icons. To scroll the preview, click and hold down the 
mouse button on the preview and drag.

Below the preview you’ll see various settings which are specific to the filter you are using. 
Most filters have a Blend slider which controls the strength of the filter’s effect. You can 
choose values from 0% (no effect) to 100% (full effect).

Some of the filters have a Wrap Texture option; enable this if you want the texture to 
be tiled. Suppose you want to apply a blur filter to your texture with a blur radius of 20 
pixels. What should the filter do at the edges of the texture? Usually, the edge pixel is 
repeated multiple times in the blur calculation to make up the numbers. This tends to 
create unwanted seams if the texture is tiled. However, when the Wrap Texture option is 
enabled, the filter borrows pixels from the other side of the texture to help avoid seams.

Some filters have a Document Preview option. Enable this if you want the preview for the 
effect to appear in the 3D view and Texture view as well as in the filter’s dialog.
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Photoshop Filters
If Photoshop is installed on your computer system, you can access Photoshop filters from 
the Filter menu. If you see “(PS)” next to the name of a filter on the menu, it means the 
filter is from Photoshop. You’ll find settings for the Photoshop filters in the preferences 
on the Bitmap Filter page (see Chapter 3, Configuration).
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BodyPaint 3D works with polygons (surfaces), points, UV polygons and UV points. In 
BodyPaint 3D, polygons can be triangles or rectangles. The commands on this menu 
relate to polygons, UV polygons, points and UV points. Note that some of the commands 
do not work when you are in UV points mode or points mode and will be grayed out.

Polygon fundamentals

A polygon is a triangle or a quadrangle. A triangle has the points A, B and C; a 
quadrangle has the points A, B, C and D. So-called perfect polygons, like the one in 
Figure 1, are rare because you can move the points freely in 3D space. This is not a 
problem if the points are planar — i.e. if they all lie on the same plane, as in Figure 2. 
If the quadrangle’s points are not on the same plane, the quadrangle is said to be non-
planar (Figure 3) and during rendering, non-planar polygons must be rendered as two 
triangles.

Figure 1: A “perfect” polygon. Figure 2: The quadrangle is no 
longer a rectangle. However, all the 
points are on the same plane — the 
quadrangle is still planar.

Figure 3: Point B has been moved 
into the depth plane. Now, the 
polygon is non-planar.

Figure 4: The angle at point B is 
greater than 180° — the polygon 
overlaps itself.

Figure 5: All the points for this 
polygon are on a line.

Figure 6: Polygons in BodyPaint 3D 
have their own coordinate system.

14 Select Polygon Menu
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If the angle at points B or D is greater than 180°, problems can occur when rendering 
— this is because the polygon overlaps itself, as in Figure 4. Another problem arises if all 
of the polygon’s points are on the same line. In this case, a surface normal cannot exist 
and the polygon is called a degenerated polygon, illustrated in Figure 5.

What is a UV polygon?

Each object polygon has a corresponding UV polygon (provided that the object has a 
UVW Tag or is parametric). A UV polygon defines which part of the texture is mapped to 
its object polygon.

Making parametric objects editable

BodyPaint 3D allows you to create parametric objects – objects that can be defined 
mathematically. Such objects include Cube and Cylinder from the Tools > Objects 
menu. Parametric objects have no polygons or points. Instead, the surface is defined 
mathematically and is only converted to polygons when rendered.

In order to make parametric objects editable, i.e. to convert them into polygons or 
points, choose Structure > Make Editable. 

An icon like this in the 
Object manager means 
the object is a polygon 
object.

Click this icon to make an 
object editable.

Select All, Deselect All

With these commands you can select or deselect all elements for the current editing 
mode. For example, to select all points, select the points tool and choose Select All.
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Invert All

This command inverts a selection. All selected elements are deselected and all deselected 
elements are selected. Hidden elements are not inverted.

Select Connected

Selects all elements connected to the selected element. For example, if you select a UV 
polygon and choose this command, the entire group of UV polygons will be selected.

Grow Selection

The initial selection. Adjacent polygons are now also selected.

Adds adjacent elements to the selection.
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Shrink Selection

Before using Shrink Selection. After using Shrink Selection.

This command shrinks the selection — the outer selected elements are deselected.

Convert Selection

Using this command, you can convert any type of selection to a point, edge or polygon 
selection. The conversion is one-way only — you cannot convert to a UV polygon 
selection or a UV point selection. After choosing the command, the Convert Selection 
dialog opens. You’ll find two columns in the dialog. The left column defines what 
you’re converting from and the right column what you’re converting to. For example, to 
convert a point selection to a polygon selection, enable Points in the left column, enable 
Polygons in the right column and click OK. BodyPaint 3D will switch to polygon mode 
automatically so that you can see the new polygon selection in the viewport.

The two options named Current represent the current selection mode. This can be points, 
edges or polygons depending on whether the points, edges or polygons tool is selected. 
For example, if the left column is set to Current and the right to Polygons, the following 
applies:

-  If the points tool is selected, the point selection is converted to a polygon selection.
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-  If the edges tool is selected, the edge selection is converted to a polygon selection.

If the Tolerant option is enabled, all neighboring elements are selected. Suppose 
you’ve selected a point on a cube and you want to convert this to a polygon selection. 
If Tolerant is enabled, all polygons which use this point will be selected. If Tolerant is 
disabled, no polygons will be selected.

Hide Selected

Hides the selected elements (points, edges or polygons). If you hide selected polygons, 
their points are hidden also. However, in point mode, only the selected points are hidden, 
not the edges or polygons attached to them.

Hide Unselected

This command hides all unselected elements. If you hide unselected polygons, their 
points are hidden also. However, in point mode, only the deselected points are hidden, 
not the polygons attached to them.

Unhide All

This command makes all hidden elements visible again.

Invert Visibility

Visible elements are hidden and hidden elements are made visible.
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Set Selection
 You can change the name of a set or “frozen” selection in the Attribute manager on the 

Basic Properties page; see “Attribute manager commands”, below.

Here you can store selections and restore them as and when needed. You can store either 
point, edge or polygon selections. You can manipulate frozen selections at any time 
using these tags in the Object manager.

Point 
Selection 
tag.

Edge 
Selection 
tag.

Polygon 
Selection 
tag.

To set or “freeze” a selection

-  Select the elements (points, edges or polygons) that you want to freeze.

-  If you want the selection to replace an existing selection tag, select the tag in the 
Object manager. Otherwise, ensure that no selection tags are selected.

-  Choose Selection > Set Selection.

Attribute manager commands
To display a selection tag’s commands in the Attribute manager, select the tag in the 
Object manager.

Tag Properties

Restore Selection

Restores the frozen selection. Other elements are deselected.



214 • CHAPTER 14 SELECT POLYGON MENU • 215

Select And Hide Others

Selects the frozen selection and hides all other elements (points, edges or polygons).

Select Points/Edges/Polygons

The frozen selection is added to the existing selection.

Deselect Points/Edges/Polygons

The frozen selection is deselected.

Hide Points/Edges/Polygons

All elements of the frozen selection are hidden.

Unhide Points/Edges/Polygons

All hidden elements become visible.
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 To open the default layout for UV editing, choose Window > Layout > BodyPaint UV 
Edit.l4d.

The default layout for UV editing.

The Texture view boasts a powerful integrated UV editor which enables you to create a 
high quality UV mesh for any shape of object.

Before you can edit the UVs, though, you must ensure the object actually has UVs (you 
can have BodyPaint 3D generate these if required). Also, the object’s texture must use  
UVW mapping.

Two key advantages of UVW Mapping are:

-  UVW Mapping prevents texture slippage so that when you deform such as a flag 
flapping in the wind the texture will keep in place.

-  UVW Mapping, in conjunction with the UV editor, offers the most advanced way to 
paint your textures. You can see and edit the UV mesh in two dimensions. You can 
select the UV polygons that make up the UV mesh and edit them as required. 

15 UV Edit Menu
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For example, suppose you want to paint a moustache on a head model. However, the 
UV polygons are too small (i.e. cover too few texture pixels) to allow you to paint hair 
without pixelation. One solution is to select the UV polygons for the moustache, move 
them to an unused part of the texture and scale them up. The UV polygons will then 
cover more texture pixels, enabling you to paint more detail than was possible in the 
previous position on the texture.

There are also commands which enable you to optimize the UV mesh and rid it of 
overlapping. In short, the UV editor offers all the tools you need to create a superb UV 
mesh for trouble-free painting.

What is a UV mesh?
If your object has UV coordinates, a UV polygon is assigned to each object polygon. 
The UV polygons have their own independent coordinates (on the texture bitmap) and 
together they form a UV mesh.

When setting up a texture on an object, consider the projection mode carefully. Figures 
1 and 2 below show two cubes, one with spherical mapping (UV Mapping manager: 
Projection > Sphere), the other with cubic mapping (UV Mapping manager: Projection > 
Cubic).

Figure 1. The 3D view and the Texture view for a 
cube with spherical mapping. Some of the object 
polygons are selected.

Figure 2. The 3D view and the Texture view for a 
cube with cubic mapping. Again, object polygons 
are selected.

Note how each polygon is allocated its own UV polygon in the Spherical Mapping 
example. As a result, you can paint each side of the cube separately.

In Figure 2 (Cubic Mapping), you can see that there are no separate UV polygons; the 
sides cannot be painted separately, because the texture has been applied six times, 
once to each side. Brushstrokes applied to one side are applied to the other sides 
automatically. 

However, the example exposes one of the shortcomings of Spherical Mapping: the UV 
mesh is heavily distorted near the top and bottom. These areas are at the poles of the 
spherical projection.
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This distortion is caused by the fundamental principle of projection: a two-dimensional 
surface (texture) must be placed onto a 3D object. Distortion is inevitable. Think of trying 
to wrap your child’s favorite Pokemon™ sticker around a baseball. Maps of the world face 
the same problem. For example, Greenland appears to be larger than the United States 
on a map. In reality, the United States is more than three times  larger than Greenland. 
Distortion happens when a sphere’s surface (such as that of the Earth) is represented in 
two dimensions. 

Nonetheless, you can paint your object free of distortion using projection painting (see 
page 288).

Troubleshooting: UV mesh display

I can’t see the UV mesh in the Texture view.

-  Ensure that the UV Points or UV Polygons is selected (you’ll find these tools on the 
Tools > UV Tools menu).

-  Click the object or tag whose UV mesh you want to be shown.

I can’t edit the UV mesh.

If the UV mesh is black, it means you cannot edit it.

-  Make parametric objects editable (select them and press the ‘c’ key)

-  Convert NURBS objects to polygons (select them and press the ‘c’ key).

-  Create a UVW tag if there isn’t one already (Object manager: Texture > Generate UV 
Coordinates).

-  Select the UVW tag and in the Attribute manager, ensure that Lock UVW is disabled.
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The UV Manager

Even the best paint tools won’t help if your model’s UVs aren’t up to scratch. In this 
manager, you’ll find several powerful UV editing tools which you can use to optimize 
your UV mesh to allow for distortion-free painting. In particular, use these tools to avoid 
overlapping UV polygons (a common problem with complex objects).
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Mapping
These commands attempt to optimize the UV mapping while avoiding overlapping 
polygons. Depending on which settings you choose, the UV mesh will be separated into 
various groups of UV polygons with gaps between them.

You can choose one of three algorithms:

-  Optimal (Cubic) takes a cubic projection of your model and separates the UVs based on 
the polygons facing each side of that cubic projection.

-  Optimal (Angle) separates the UVs based on the direction of the surface normals.

-  Realign takes all existing UV mesh groups and realigns them.

Optimal (Cubic)

Optimal (Cubic) places a cube around the object and separates the UVs based on which 
side of the cube they face.

In the pictures below, the torus has been “observed” from six sides. Ten UV polygon 
groups in total have been created: one group as seen from the top of the cube, another 
as seen from the bottom of the cube, and two groups for each of the cube’s four sides 
(this is because the torus has two sides when seen from the side: an inside and an 
outside).

Preserve Orientation

Preserve Orientation disabled (left) and enabled (right).

Enable this option to prevent BodyPaint 3D from arranging the polygon groups in the 
optimal horizontal direction. This saves time when the positions of the UV polygons are 
calculated.
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Stretch To Fit

Stretch To Fit disabled (left) and enabled (right).

If this option is enabled, the UV polygon groups will be stretched in the U and V 
directions to cover the entire bitmap taking into account the Spacing value.

2D

If this option is enabled, a different algorithm is used (Max Area Factor no longer has 
an effect). The algorithm checks if the first UV polygon overlaps any of the other UV 
polygons. If it is overlapping, a new UV polygon group is created and the following UV 
polygons are added to the group. If it isn’t overlapping, no action is taken. The algorithm 
repeats the check for all UV polygons.

Max Area Factor

This factor only has an effect if 2D is disabled. It defines the lower limit of a range within 
which UV polygons are added to existing groups, even though by definition (see the cube 
mentioned above) they should not be added to the groups.

More precisely, Max Area Factor defines how much smaller in percent the polygons may 
be than the average surface area.

Spacing

Defines the size of the gaps between the separated UV polygon groups. Use low values, 
otherwise the UV polygons will be scaled down to fit the texture.
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Optimal (Angle)

Preserve Orientation, Stretch To Fit, Spacing

See “Optimal (Cubic)”, above.

Maximum Distortion

If the angle between two connected object polygons is less than or equal to the 
Maximum Distortion value, their UVs are placed in the same group; otherwise, they are 
placed in different groups.

In general, set Maximum Distortion to a low value, otherwise the changes to the UV 
map will be minimal. Lower values mean more UV polygon groups will be formed. The 
lowest value, 0, means each UV polygon is separated from its neighbors. A value of 100% 
corresponds to a 90° angle between the object polygons, 50% corresponds to 45°, and 
so on.

Realign

This algorithm realigns existing UV mesh groups. No new UV groups are created. The UVs 
remain in the same groups.

 Realign is applied automatically when you apply Optimal (Cubic) or Optimal (Angle).

Preserve Orientation, Stretch To Fit, Spacing

See “Optimal (Cubic)”, above.
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Relax UV

Relax UV gives you a different approach for optimizing the UV mesh. Unlike Optimal 
Mapping, which splits the UV mesh into groups of UV polygons, Relax UV attaches 
invisible springs that pull on the UV mesh to straighten it out and prevent overlaps. Click 
Apply repeatedly to pull harder on the UV mesh.

The command is applied to the selection or to the entire UV mesh if no UVs are selected. 
In the example below you can see part of the UV mesh for a head. This UV mesh was 
created based on cylindrical mapping.

Before using Relax UV (left) and after (right).

The UV polygons are distorted and overlap in the areas for the nose, eyes and ears (left 
picture above). As it stands, this UV map is almost useless.

This is where Relax UV comes in. After clicking Apply three times, the UV mesh is now 
suitable for painting (right picture above). The distortions are greatly reduced.

Fix Border

The UV points at the edge of the selection are fixed in place.

Keep Neighbors

UV points connected to unselected polygons are fixed in place. This enables you to 
untangle part of the UV mesh, such as the ear, without it being separated from the rest 
of the mesh. “Free” points at the edge of the selection are not fixed in place.
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The original UV mesh (center), both options disabled (top right), 
Keep Neighbors enabled (bottom left) and Fix Border enabled (bottom right).

 If both options are disabled, the UV mesh will shrink each time you click Apply.

Projection

Here you can change the projection simply by clicking on the appropriate button such as 
the Sphere button for spherical projection. 
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From top left to bottom right: Sphere, Cylinder, Frontal, Flat, Cubic, Cubic 2, Box, Shrink.

For details on each type of projection, see “Types of Mapping” on page 661.

Here you will also find two new types of mapping:

-  Cubic 2: an invisible cube is placed around the selected areas; the selected areas are 
then “photographed” from each of the cube’s six sides. The cube is unfolded and the 
corresponding UV mesh is displayed.

-  Box: The same as Cubic 2 except the texture is distorted less.
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How the algorithm works

First a bounding box is placed around the selected UV polygons (or object polygons). 
This bounding box will represent the texture later on. If Fit To Selection is disabled, the 
bounding box will enclose the entire object.

You can choose how the bounding box is aligned using the drop-down list. Choose from 
Object System (the texture’s axes run parallel to the object’s axes), World System (the 
texture’s axes run parallel to the world system’s axes) or Average Normal (the texture’s Z-
axis points in the average direction of the normals).

Weight Normal can only be selected if the drop-down list is set to Average Normal. It 
defines how the average normal is calculated. If the option is enabled, the normals are 
weighted according to the size of the polygons; otherwise, the arithmetic average is 
calculated.

As with most UV commands, the best setting depends on the nature of the object.

Transform

You can apply precise transformations to the selected UV polygons by entering values 
into these boxes.

Position

You can move the UVs a certain number of pixels along the X and Y axes from their 
current position using these values. X represents the horizontal direction, Y the vertical 
direction. You can also enter negative values to move the UVs in the negative direction of 
the axes.

Scale

Here you can enter a scaling factor for the UVs in the X and Y directions. Values less than 
1 shrink the UVs, values greater than 1 expand them.

Rotate

Rotates the UVs by the specified angle.
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UV Commands

Store UV

Stores the current positions of the UV coordinates. You can use the following two 
commands, Restore UV and Remap, to access the stored positions.

Restore UV

Restores the UV mesh to its stored state (see “Store UV”, above). These commands allow 
you to experiment with the UV mesh and return to a previous state if things go wrong.

Remap

 Remap enables you to move and scale part of the texture so that finer details can be 
added.

Until now, all you have edited in the UV editor are UV polygons and UV points. This 
command enables you to edit the bitmap itself.
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First, store the UV coordinates (UV Edit > Store UV). Next, select the UV polygons that 
are over the part of the texture you want to move. Move the selected UV polygons to an 
empty part of the texture. If you call Remap now, the bitmap will be copied (or cut and 
pasted) from the original position of the UV polygons to their new position.

Channels

Use the list of material channels in the left part of the dialog to choose which channels 
should be remapped.

Cut

Viewport with a polygon (over the 
‘C’) selected.

The polygon has been moved and 
scaled up without the Cut option.

The polygon has been moved and 
scaled up with the Cut option enabled.

If you enable the Cut option the bitmap will be cut rather than copied from the original 
position of the UV polygons.

Oversampling

If you scale up a UV polygon before using Remap, the corresponding part of the bitmap 
is scaled up too and interpolated according to the Oversampling value.

Realign, Relax UV, Optimal Mapping
See “Mapping” on page 223 and “Relax UV” on page  226.

Fit Canvas To UV

When you move UV polygons in the Texture view, you are free to place them outside the 
texture. Exactly what is then mapped to the associated polygons depends on the object’s 
Texture tag. If Tile is enabled, the texture will be tiled; otherwise, a neutral gray color will 
be mapped to the polygons.
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But if you’re like most people, chances are you’ve moved UV polygons outside the texture 
because you want to increase the size of the texture. In such cases, choose Functions > 
Fit Canvas To UV. The texture will be resized to fit the UV and the new pixels will be filled 
with the background color. See “Tweaking the UV Mesh“ on page 106 for an example of 
this technique.

UV Terrace

The algorithm attempts to connect the UV polygons of neighboring object polygons 
together by scaling and moving them. See the example below for clarification.

Example:

In the left picture above, we added three new object polygons to create the middle row. 
You can see clearly that each of these new polygons has the entire texture mapped to it. 
This is because when you create a new polygon, its UV polygon covers the entire texture.

Now look what happens after we call the UV Terrace command (right picture above). The 
UVs for the new polygons are scaled and moved to become connected to the UVs for the 
neighboring object polygons. The connection isn’t perfect, as you can tell from the slight 
distortions, and tweaking may be required. Even so, this command does most of the 
work for you.

Keep in mind that UV Terrace is a processor-intensive command and may take several 
minutes to complete.
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Copy UV Points, Paste UV Points

 

What’s happening in the illustration above? First we selected the top left polygon and 
chose Copy UV Points. This copied the polygon’s UV coordinates to the clipboard. We 
then selected the bottom right polygon and chose Paste UV Points. This applied the 
UV points stored in the clipboard to the bottom right polygon. Now the bottom right 
polygon displays exactly the same part of the texture as the top left polygon.

Clear UV

This command deletes the selected UV polygons. Object polygons without UVs will be  
assigned the color of the texture’s top left pixel.
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UV Sequence Up, UV Sequence Down

 

Moves the sequence of the points for the selected UV polygons up or down one position. 
Things will still look the same in the Texture view, but on the mapped object the content 
of the selected polygons will be rotated (either clockwise or anticlockwise depending on 
which command you choose).

Flip Sequence

Reverses the sequence of the points for the selected UV polygons. On the mapped 
object, the content of the selected UV polygons is mirrored.
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MAX UV

Scales each selected UV polygon to fit the texture. On the mapped object, each selected 
polygon will display the entire texture.

Fit UV To Canvas

Scales the selected UV polygons as a group to fit the texture.
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Mirror U, Mirror V

 

You can use these commands to mirror the selected UV polygons horizontally (U) or 
vertically (V). The mirror axis runs through the common center of the UV polygons.

Transform

See “Transform” on page 229.

Start Interactive Mapping

This command provides a quick way to alter the mapping for the selected UV polygons. 
For example, suppose you want to change the mapping for the left ear of a head mesh.

-  Select the UV polygons for the left ear.

-  Choose Start Interactive Mapping.

-  A Texture dialog will appear in the Attribute manager which relates to the selected 
Texture tag or the Texture tag belonging to the selected UVW tag. You can change 
the mapping parameters as desired. By default, the projection changes from UVW 
Mapping to Flat. In most cases, this is the best setting. However, you can choose your 
own projection setting if you wish. 

-  The texture axis tool is activated automatically. Drag in the 3D view to move the texture 
axis until the texture is in a suitable position over the selected polygons.

-  Choose Stop Interactive Mapping.

The texture moves over the entire object in the viewport. Ignore this temporary effect — 
the new mapping affects the selected polygons only.
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Stop Interactive Mapping

Select this command to stop the interactive mapping process. New UV coordinates will 
be assigned to the selected UV polygons and the tool active prior to interactive mapping 
will be activated once more.
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Paint Tools
3D Painting Mode

Switch on 3D painting mode when you want to use a paint tool. You can paint in the 
normal shading mode, in raybrush mode or in projection painting mode. 

Move Layer

To move the active layers (including linked layers) or selection using this tool, in the 
Texture view click and hold down the mouse button and drag the layer/selection to the 
desired position. Parts you drag outside the texture area will be cut off.

In the Active Tool manager, you’ll find an Auto Select Layer option. If this option is 
disabled, the active layer will be moved. Otherwise BodyPaint 3D will choose which layer 
is moved based on which material channel is active, which layer has paint on it, and 
where the mouse pointer is when you click at the start of the move layer action.

The following move layer modes are available:

-  Drag outside the selection: moves the entire layer including the selection.

-  Shift-drag outside the selection: moves all layers including the selection.

-  Drag inside the selection: moves the selection and its contents.

-  Alt-drag inside the selection: copies the content and moves the copy.

Magnify

Drag a rectangle with this tool selected to zoom the texture in the Texture view. To zoom 
out, Shift-drag or right-drag.

16 Tools Menu
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Eyedropper

You can use this tool to pick a color or a texture — click on the corresponding position 
in the 3D view (the active material channel will be taken into account) or in the Texture 
view. Click with the left mouse button to define the color/texture as the foreground 
color, or right-click to define the color/texture as the background color.

Active Tool manager options

Solid Color

 You can also pick the color by clicking on the object in the 3D view (provided the object’s 
material is enabled for painting).

This option loads the color you click on into the Color manager.

Texture

If you enable this option, the texture you click on is loaded into the Color manager. You 
can paint this texture using a paint tool.

All Visible Layers

If this option is enabled, the color you click on in the Texture view or 3D view is picked. 
With the option disabled, the color in the active layer is picked — this may be completely 
different from the composite color you see in the Texture view. Therefore in general, keep 
the option enabled.

Sample Radius

This option applies to Solid Color mode only. Rather than pick the color of the exact 
pixel you click on, this option picks the average color of all pixels within the specified 
radius. You can enter values from 0 to 100 pixels. For example, if you click on the border 
between a black column and a white column with a large Sample Radius, the color picked 
will be a medium gray. 

Brush

See Chapter 7, Brushes.
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Clone

 You can use the clone tool in multi channel mode as well.

Use this tool to clone parts of your texture. When you select the tool, the mouse pointer 
changes to a pipette (press the Ctrl key if it doesn’t). Move the pipette to the region you 
want to clone and click the mouse button. The pipette changes to a brush and stamp. 
Drag to paint the clone.

To clone a new region, Ctrl-click. Otherwise the clone tool works in the same way as the 
brush tool. In the Active Tool manager, you’ll find all the brush settings that are described 
in Chapter 7, Brushes. However, ignore the Bitmap option. Brush effects such as Spacing 
and Jitter are evaluated — you’ll probably want to disable these effects when cloning.

Active Tool manager options

All Visible Layers

If this option is enabled, the composite image (i.e. the image you see in the Texture view) 
is cloned; otherwise, only the pixels in the active layer are cloned.

Relative

This option corresponds to the Painting Mode setting in the Color manager (see “Painting 
Mode” on page 117). In short, it defines whether each new brushstroke is cloned from 
the same source position.

Scale, Rotation

These settings control the scale and rotation of the cloned texture areas.
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Eraser

 In projection painting mode, the eraser affects the projected layer only (see “Projection 
Painting” on page 288).

If you use the eraser tool on the background layer, the erased pixels are painted black. 
If you use the eraser tool on any other layer, the erased pixels are made transparent. 
The eraser tool adopts the parameters in the brush settings in the Active Tool manager, 
including filters.

Smear

This tool enables you to smear on the active layer.

Active Tool manager options
The same settings are available as for the brush tool (see Chapter 7, Brushes) except there 
is also an All Visible Layers option. If this is enabled, the smear tool will take the color of 
all visible layers into account. However, the smearing itself will be applied to the active 
layer only — the other layers remain unaffected by the tool.

Dodge

This tool comes from the tried and trusted world of photography. It helps you build tonal 
variation by brightening up the areas you paint on.

Active Tool manager options
The same settings are available as for the brush tool (see Chapter 7, Brushes) except the 
following settings are also available:

Shadows, Midtones, Highlights

Choose whether you want the tool to brighten up dark, medium or bright areas.
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Max Exposure

This parameter defines the strength of the effect. The more you paint over the same 
pixels, the brighter they become (provided you keep releasing the mouse button 
between brushstrokes).

Burn

This tool is the opposite of dodge and also helps you to build tonal variation. It darkens 
the pixels you paint on.

Active Tool manager options
The same settings are available as for the brush tool (see Chapter 7, Brushes) except the 
following settings are also available:

Shadows, Midtones, Highlights

Choose whether you want the tool to burn dark, medium or bright areas.

Max Exposure

This parameter defines the strength of the effect. The more you paint over the same 
pixels, the darker they become (provided you keep releasing the mouse button between 
brushstrokes).

Sponge

This tool lets you adjust the saturation of the pixels you paint on.

Active Tool manager options
The same settings are available as for the brush tool (see Chapter 7, Brushes) except the 
following settings are also available:

Desaturate, Saturate

Here, choose whether the tool should saturate or desaturate the pixels you paint on.
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Max Exposure

This parameter defines the strength of the effect. The more you paint over the same 
pixels, the more saturated or desaturated they become (provided you keep releasing the 
mouse button between brushstrokes).

Fill Bitmap

Click on a pixel with this tool selected to fill all contiguous pixels with the active color.

Active Tool manager options

All Visible Layers

Enable this option is you want to fill all like-colored pixels in the composite image. If the 
option is disabled, only the like-colored pixels in the active layer are considered. Note 
that, even if this option is enabled, the color is painted on the active layer only.

Tolerance

The tolerance, which can be set to values from 0% to 100%, defines how similar in color 
a pixel must be compared with the pixel you click in order to be filled. A value of 0% will 
fill only those contiguous pixels of exactly the same RGB color. 100% will cause all pixels 
to be filled.

Gradient

Use this tool to paint gradients. As with the other paint tools, you’ll find various settings 
in the Active Tool manager.

In the top left in the Active Tool manager, you’ll see a small preview of the gradient. Click 
on the preview to access the gradient presets. You can add your own gradients to these 
presets. To access a menu for the gradient presets, right-click (Windows) or Command-
click (Mac OS) on a gradient preset.
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This is the same menu that is available for other presets such as the color presets. For 
details on this menu, see ”The Color Presets” on page 122.

To paint a gradient, click-drag in the 3D view or Texture view. The position where you 
click marks the start of the gradient and the position where you release the mouse 
button marks the end of the gradient. If you want to restrict the gradient, create a 
bitmap selection before you use the tool.

Active Tool manager options

Type

Various types of gradient are available. See the pictures below.

Linear. Reflective. Radial. Circle.

Blend Mode

Defines the blend mode for the gradient. For details on these modes, see “Blending 
Mode” on page 114.
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Strength

This slider defines the opacity of the gradient.

Add Preset

You can use this button to save the gradient as a preset. Click the button and in the 
dialog that opens, enter a name for the preset and click OK. The gradient is now saved 
as a preset. To access this gradient and the other gradient presets, click on the gradient 
preview in the top left corner of the Active Tool manager.

The gradient

The gradient is similar to gradients in other applications that you have probably seen 
before. The handles on the bottom of the gradient, known as knots, are used to set the 
color and position of colors in the gradient. To add a knot just click in an empty area 
below the gradient and a knot of the color at that position will be added. To remove a 
knot just click on it and drag it away from the gradient. To change the color of a knot 
double-click on it and the color chooser dialog will appear. The handles on the gradient 
are bias handles and they pull the interpolation of the color knots from side to side for 
more control over how the gradient changes.

Interpolation

Use this drop-down list to select the type of interpolation. Choose from:

Cubic Knots

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots).

Cubic Bias

Uses a Bezier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control).

Smooth Knot

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value.

Linear Knot

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value.
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Linear

Linear falloff/growth between the knots. No bias handles.

None

Uses the color of the left-most knot for the entire gradient. All other knots are ignored.

Pos

The position of the currently selected knot or bias handle on the gradient. You can type a 
value in the edit text field or drag the up/down arrows at the right to move the currently 
selected knot or bias handle.

Intensity

A measurement for the intensity of the currently selected knot.

Edit Alpha, Display Result

With these, you define not just one gradient but two. One gradient sets the color, the 
other — called the alpha gradient — controls its opacity. For example, to fade out the 
gradient,  set the alpha gradient to run from white (opaque) to black (transparent).

This means there are three different gradients in all (color, alpha, result), although only 
one gradient is shown at a time. Use the Edit Alpha and Display Result options to control 
which gradient is shown. To show and edit the color gradient, disable both options. To 
show and edit the alpha gradient, enable Edit Alpha and disable Display Result.

To show the result, enable Display Result. A checkered pattern is placed behind the 
gradient so that you can see the opacity clearly. Note also that you can edit the alpha 
gradient while the result is displayed (the alpha gradient’s knots and handles will still be 
visible).

The gradient’s context menu

Three commands are available for gradients via a context menu. To access the context 
menu, right-click the gradient (Windows) or Command-click the gradient (Mac OS).

Invert Knots

Reverses the direction of the gradient.

Double Knots

Doubles the number of knots.

Reset

Sets the gradient to a uniform color (white) with no knots.
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Color Chooser

See “Color System C4D, Color System BP” on page 79.

Noise Variation, Noise Scale

These settings enable you to add noise to the gradient.

Noise Variation defines how harmonious the gradient is. Low values lead to smooth color 
transitions while high values generate bands of color.

Noise Scale defines the number of disruptions applied to the gradient. A value of 0% 
means no disruptions, i.e. a smooth gradient. The higher you set the value, the more 
color bands you’ll see appear in the gradient.

Dithering

Dithering is a process that adds a random pattern to colors to prevent color banding. 
Although dithering enhances image quality, it increases file size also. For web graphics in 
particular, you may want to disable dithering to reduce image file size.

Use Alpha, Invert

Use Alpha switches the alpha on or off for the gradient. Invert inverts the alpha. See 
“Edit Alpha, Display Result”, above.

Transform Bitmap

Using this tool, you can transform the active texture by scaling, rotating, or shearing it 
and so on. The starting point for this tool can be:

-  a selection or

-  depending on which layer is active, when you click on the tool the transformation 
frame is fitted automatically to the content of the layer (including linked layers).

A rectangular frame will appear when you select the tool. The frame has five handles: 
one in the center and one in each corner. Each handle can be moved separately. To move 
the entire frame, drag the center handle. The other handles will move, scale, rotate, add 
perspective or shear depending on which option is enabled in the Active Tool manager: 
Move, Scale, Rotate, Perspective or Shear.
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Move. Scale. Rotate. Perspective. Shear.

Note that only the frame is transformed in realtime — transform the frame as you intend 
the active layer to be transformed, then click on the Apply button (or double-click inside 
the frame) to transform the active layer.

Keep in mind that Transform Bitmap affects the active layer only. If you attempt to 
activate another layer (by clicking it) while the frame is active, a warning dialog will open. 
Click Yes to apply the transformation or Cancel to abort it.

Flip Horizontal, Flip Vertical

Using these buttons, you can flip the texture horizontally or vertically.

Draw Line

This tool enables you to draw straight lines. Drag in the Texture view or 3D view to define 
the start and end of the line.

Active Tool manager options (Filled mode)

Endings

Here you can choose the shape of the ends. For example, choose Arrow if you want to 
draw arrows.

Line Width

This is the line’s width in pixels — enter a value from 1 to 100.

Feather

This setting defines the width of the transition between the line and the background. 
Enter a value from 0 to 50 pixels.

Antialiasing

Enable this option to smooth the edges of the line. Antialiasing helps to avoid or reduce 
staircasing effects (jagged edges).
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Active Tool manager options (Stroke mode)

This mode gives you access to the same settings as the brush tool (see Chapter 7, 
Brushes). The line is stoked using these parameters.

Draw Text

This tool paints text on your layers/objects. You can use any TrueType font installed on 
your system.

Active Tool manager options (Filled mode)
Type the text into the text box. The text can span several lines and you can also paste text 
from the clipboard. Once you have entered the text, drag in the Texture view or 3D view 
to move or rotate the text. As soon as you release the mouse button, the text is fixed in 
place. Parts of the text outside the texture will be discarded.

Font

Click this button to choose your font from the Font dialog. If you are using Windows, you 
can also set the font style here, such as Bold and Italic.

Size

This is where you define the size of the text. Enter a value from 1 to 1,000.

Align

Choose the alignment for the text: Left, Center or Right. For example, if you set Align to 
Left, your first mouse click defines the left-hand edge of the text.
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Move

If this option is enabled, you can drag in the Texture view to create and move the text. 
The text will be fixed in place as soon as you release the mouse button — a second drag 
will create and move a new copy of the text.

Rotate

If this option is enabled, you can drag in the Texture view to create and rotate the text 
around the point where you clicked. The text is fixed in position the moment you release 
the mouse button. The next time you drag, a new copy of the text will be created and 
rotated.

Antialiasing

Enable this option if you want the edges of the text to be smooth.

Feather

This feature is more or less enhanced antialiasing. Enter a value from 0 to 50 pixels to 
specify the size of the blending region between the text and the background. 

Active Tool manager options (Stroke mode)

This mode gives you access to the same settings as the brush tool (see Chapter 7, 
Brushes). The text is stoked using these parameters.
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Draw Polygon Shape

You can draw certain polygon shapes using this tool. Drag in the Texture view or 3D view 
to set the position and size of the shape. You can rotate the preview while you drag — 
hold down Shift at the same time to constrain the rotation to angles of 45 .̊  When you 
release the mouse button, the shape will be filled with either the foreground color (drag 
with left mouse button) or the background color (drag with right mouse button).

Active Tool manager options

Edit

Click the Edit button to edit the shape. A window opens. Ignore all parameters that do 
not relate directly to the shape — this window originates from CINEMA 4D, the program 
on which BodyPaint 3D is based.

Shape

Circle

Use this shape to draw rings or circles. If Ring is enabled, you can enter a value under 
Inner Radius. Drag to define the position and outer radius (the inner radius is drawn 
automatically using the Inner Radius value).

Rectangle

To round the corners of the rectangle, enable the Rounding option and type the size of 
the rounding (in pixels) into the adjacent box.

4-Sided

Select this shape if you want to draw a diamond, kite, parallelogram or trapezium 
— make your choice using Type. If you set Type to Parallelogram or Trapezium, you can 
also enter a value in the top Angle box.

n-Sided

Enter the number of sides into the Sides box. If you want to round the corners, enable 
the Rounding option and type the radius of the rounding into the Radius box.

Star

The Twist and Points parameters determine the star’s appearance. Twist rotates the 
star’s arms, Points defines the number of arms.
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Cog Wheel

Enter the number of teeth into the Teeth box and type the degree of bevel into the 
Bevel box.

Flower

This shape draws flowers. Type the number of petals into the Petals box.

Profile

Here you can choose one of several profile shapes. You can adjust the shape using the 
parameters Type, Height, b, s and t.

Filled Mode

Box

Drag to define the top left and bottom right corners of a rectangle inside which the 
polygon shape will be fitted.

Center

Drag to define the center and radius respectively of a circle inside which the polygon 
shape will be fitted.

Diameter

Drag to define the diameter of a circle inside which the polygon shape will be fitted.

Antialiasing

This option softens the edges of the polygon shape. This prevents a staircasing effect 
(jagged lines).

Feather

You can use the slider to alter the size of the blending region between the polygon shape 
and the background. This is more or less enhanced antialiasing.
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Stroke mode

This mode gives you access to the same settings as the brush tool (see Chapter 7, 
Brushes). The shape is stoked using these parameters.

Brush Shortcuts
You can use the following shortcuts with all tools which use the brush settings, such as 
the brush tool, eraser tool and dodge tool:

Result Action

Increase brush size “]”

Decrease brush size “[”

Increase brush hardness Shift + “]”

Decrease brush hardness Shift + “[”

Increase brush pressure Ctrl + “]”
Decrease brush pressure Ctrl + “[”
Rotate brush clockwise Alt + “]”
Rotate brush anticlockwise Alt + “[”
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UV Tools
UV Points

With Edit Points, the UV coordinates are displayed as points which you can select and 
modify using the tools described in the following pages. If you select points in the 3D 
view, the corresponding points in the Texture view become selected and vice versa.

UV Polygons

This is one of two modes for editing the UV mesh. It enables you to select and modify UV 
polygons using the tools described in the following sections. The other mode, UV Points, 
is described above.

Selection Tools

Live Selection.  Rectangle Selection.     Polygon Selection.    Free Selection.

You can select UV points or UV polygons in the Texture view or in the 3D view. The 
selected elements will be displayed in both views.

The following applies to all selections tools: hold down Shift to add to an existing 
selection. Hold down Ctrl to subtract from an existing selection. Selected points or 
polygons are colored red. 

Live Selection

To use this selection tool, hold down the mouse button and drag over the UV points/
polygons you want to select.

In the Active Tool manager, the Live setting determines the diameter of the Live Selection 
brush. You can set values from 0% to 10%.
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If Only Select Visible Elements is enabled, you can only select elements which are visible, 
i.e. not behind other elements. For example, you can select the polygons at the front a 
sphere but not the polygons at the back.

Rectangle Selection

To make a selection using this tool, hold down the mouse button and drag a rectangle 
over the UV points/polygons you want to select.

In the Active Tool manager, if Tolerant is enabled all UV points/polygons that are inside 
the marquee or intersected by the marquee are selected; If Tolerant is disabled, only the 
UV points/polygons that are fully enclosed by the marquee are selected.

If Only Select Visible Elements is enabled, you can only select elements which are visible, 
i.e. not behind other elements. For example, you can select the polygons at the front a 
sphere but not the polygons at the back.

Polygon Selection

The Polygon Selection tool enables you to draw a polygon around UV points/polygons 
in order to select them. Your first mouse click creates the starting point and subsequent 
clicks create new corner points. To complete the selection, either click on the starting 
point or click the right mouse button (Windows) or Command-click (Mac OS)

In the Active Tool manager, if Tolerant is enabled all UV points/polygons that are inside 
the marquee or intersected by the marquee are selected; If Tolerant is disabled, only the 
UV points/polygons that are fully enclosed by the marquee are selected.

If Only Select Visible Elements is enabled, you can only select elements which are visible, 
i.e. not behind other elements. For example, you can select the polygons at the front a 
sphere but not the polygons at the back.

Free Selection

With this tool, you select UV points/polygons by dragging a lasso around the polygons. 
To complete the selection, release the mouse button. The two ends of the loop are joined 
automatically. 

In the Active Tool manager, if Tolerant is enabled all UV points/polygons that are inside 
the marquee or intersected by the marquee are selected; If Tolerant is disabled, only the 
UV points/polygons that are fully enclosed by the marquee are selected.

If Only Select Visible Elements is enabled, you can only select elements which are visible, 
i.e. not behind other elements. For example, you can select the polygons at the front a 
sphere but not the polygons at the back.
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Editing UV polygons
Each object polygon has a UV polygon on the texture to control which part of the texture 
is mapped onto the object polygon. Because each object polygon has a UV polygon, the 
number of UV polygons equals the number of object polygons. If you delete an object 
polygon, its UV polygon is also deleted. 

The UV polygon is otherwise independent and can be moved, scaled and rotated. In 
other words, no matter how you move, scale and rotate the UV polygon, the position, 
size and direction of the object polygon remains unchanged. All that changes is which 
part of the texture gets mapped to the object polygon. 

For example, suppose a UV polygon is over a black part of the texture. As a result, the 
object polygon is black. Next you move the UV polygon to a red area of the texture. The 
object polygon itself is not moved, but turns red. 

 To display textures in the view panel, ensure that Disable Textures is disabled on the 
Display menu and choose a shading mode (i.e. Gouraud Shading or Quick Shading). 

You can, if you wish, place UV polygons on top of one another. All UV polygons can 
occupy the same part of a texture, in which case each object polygon would receive the 
same part of the texture. Take a look at the following examples.

Figure 1 shows a 2x2 plane with four polygons. Although the texture contains the letters 
A, B and C, the UVs for the polygons are all over the letter A (Figure 2) and hence all four 
polygons display the letter A.

Figure 1: Viewport view. Figure 2: Texture view.
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For the next example, all four UV polygons were placed over the A, then one of the UV 
polygons was scaled, rotated and moved over the B.

Figure 3: Viewport view. Figure 4: Texture view.

Figures 5 and 6 below highlight the flexibility offered by UV editing. Figure 6 shows 
how the UV mesh has been edited to form the name “BODYPAINT 3D”. First, the UV 
mesh, which originally covered the entire texture, has been scaled down and moved to 
an empty, black part of the texture. The UV polygons of the second row have each been 
scaled back up and placed over the appropriate letter to spell out “BODYPAINT”, while 
two polys from the fourth row have been scaled up and placed over the “3” and the “D”.

Figure 5: Viewport view. Figure 6: Texture view.
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Move
 This description applies to points mode, edges mode and polygons modes. For UV points 

mode or UV polygons mode, see “Editing UV Polygons” on page 259.

You can use this tool to move the selected UV polygons: click anywhere in the Texture 
view and hold down the mouse button while you move the mouse. 

Active Tool manager Options tab

Keep Face Neighbors

If this option is enabled, the selected UV polygons will remain attached to their 
neighbors. You can still move the selection freely, but the neighboring UV polygons will 
distort to accommodate the move. This is, in principle, similar to moving object polygons 
in the 3D view. 

Clip UV Coordinates (0..1)

When enabled, this option prevents you from placing UV polygons outside the texture. 
This is achieved internally by restricting the UV coordinates to values between 0 and 1. If 
you try to move the UV polygons outside the texture, they will be squashed up against 
the edge. 

Magnet

If the Magnet Use option is enabled, UV polygons outside the selection (but within the 
Distance value of the selection) are pulled along when the selection is moved. The further 
away a UV polygon is from the selection, the weaker the pull. There is a Magnet tab to 
control this option (see “Active Tool manager Magnet tab” on page 265). 
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Active Tool Manager Snapping tab

Snapping

 Point and edge snapping can be enabled at the same time. Point snapping takes priority.

The Snapping options determine whether the UV polygons you move snap to other UV 
polygons. A cross will appear in a corner of one of the selected UV polygons according 
to where you click with the mouse. Keep the mouse button held down and drag to move 
the selection.

If the Point option is enabled, the cross will snap to UV points. If Edge is enabled, the 
cross will snap to UV edges. Radius determines how close the cross must be to a point or 
edge before it snaps to it. You can set Radius to a value between 0% and 10%. If you set 
it to the maximum of 10%, free movement will be limited severely and the cross will snap 
from one point or edge to the next.

Quantize

The Quantize options provides further ways to restrict movement. If you enable the Move 
option (or Scale or Rotate for the other tools), you will only be able to move the selected 
UV polygons in steps of the value entered. For example, if the value is set to 10%, 
the distance between each step corresponds to 10% of the texture’s width or height. 
Taking this example further, if the texture is 300 pixels wide and 500 pixels high, the UV 
polygons can be moved 30 pixels horizontally and 50 pixels vertically.

Active Tool manager Colors tab

You can use this tab to assign any color to the following mesh elements: Ghosted 
Polygons, Inactive Polygons, Active Polygons, Inactive Points, Active Points. To change 
the color for an element, click on its color box and pick the color using the dialog that 
appears.
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Scale
 If you have selected a single UV point instead of a UV polygon, you will be unable to scale 

since UV points have no spatial dimensions. You can only scale if at least two UV points 
are selected, in which case they will be scaled from their common center.

This tool scales the selected UV polygons uniformly about the UV coordinate closest to 
the pointer, which is represented by a cross.

Scaling a grid of 5x5 points, showing the small 
black cross which represents the common center.

Active Tool manager options
The same options apply as for the move tool except that the point and edge snapping 
options have no effect. The Scale option under Quantize has the advantage that you can 
scale a UV polygon safe in the knowledge that you can return it to its exact original size 
later on.

Non-Uniform Scale

Non-uniform scaling works as described above for the scale except that scaling is non-
uniform and in the direction in which you drag.
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Active Tool manager options
The same options apply as for the move tool except that the point and edge snapping 
options have no effect.

Rotate

This tool rotates the selected UV polygons about the UV coordinate closest to the 
pointer. Click anywhere in the Texture view and drag horizontally.

Active Tool manager options
The same options apply as for the move tool except that the point and edge snapping 
options have no effect.

Shear U, Shear V

These commands shear the selected UV polygons about the UV coordinate closest to the 
pointer. You can shear horizontally (Shear U) or vertically (Shear V).

Active Tool manager options
The same options apply as for the move tool except that the point and edge snapping 
options have no effect.

Magnet

This tool enables you to edit a UV mesh by pulling it around. Drag in the Texture view to 
pull the UV polygons. UV polygons closest to the Magnet will be pulled the most. If UV 
polygons are selected, the magnet will pull those UV polygons only. 
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Active Tool manager Magnet tab

Nearest Point Method

If this option is disabled (the default), the Magnet will only pull if you click directly on a 
UV polygon. If the option is enabled, the Magnet will deform no matter where you click. 
In this case, the nearest UV point is chosen as the center of deformation.

Radius

This is where you define the magnet’s sphere of influence.

Type

Constant. Linear. Dome.

Bell. Circle. Needle.

Width

This parameter determines how hard or soft the magnet’s sphere of influence is.
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C4D Tools
Most of these tools are of little use when you are working in 3D painting mode or in 
projection painting mode. Rather, they enable you to move objects, edit the objects in 
polygon, edge or point mode or adjust the texture axes.

Move

This tool lets you place the selected object or element anywhere in a viewport, subject 
to other options like snap, the mouse grid, whether certain axes are locked, etc. When 
moving objects, BodyPaint 3D distinguishes between the world coordinate system 
and the local object coordinate system. This distinction is particularly noticeable when 
movement takes place in different axial systems and only the X-axis is activated, say.

Let’s assume you are moving a cuboid which is positioned somewhat askew relative to 
the world coordinate system and you have locked the Y-axis and Z-axis for movement. If 
you move within the world coordinate system the cuboid moves parallel to the X-axis of 
the world system, as illustrated in Figure 1.

Figure 1. Figure 2.

If, on the other hand, you select the object coordinate system, the cuboid moves along 
its own (the object’s) X-axis, which results in a quite different behavior as you can see 
in Figure 2. Both can be useful but you should always be aware which you are currently 
using (check on the Tools menu — if Coordinate System W is enabled, world coordinates 
are in use).

 If you want to move an object across a plane hold down the Shift key and click on the axis 
perpendicular to this plane. For example, if your object needs to be moved across the XY 
plane, drag the Z-axis while holding down the Shift key, and so on.
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The X, Y and Z icons enable you to lock specific axes. This can be useful, for example, 
when you have constructed an object that is at floor level. If you now move it in one of 
the perspective views, it automatically changes its Y value and could, in the worst case, 
end up below the floor. By taking the precaution of locking the Y-axis the object remains 
on the floor and moves only in the other directions.

A left/right movement of the mouse while holding down the mouse button moves the 
object horizontally on the screen; an up/down drag moves it vertically. Dragging left 
and right with the right mouse button (Windows) or Command key (Mac OS) held down 
moves the object into the screen and out of it.

 To constrain movement to one axis only, drag the arrowhead at the end of the desired 
axis. This saves you from having to lock axes manually.

 To move the selected object without its children, Ctrl-drag the object in the viewport.

When editing textures, mouse movements have a somewhat different effect. A left/
right drag of the mouse moves the texture along its X-axis, an up/down drag moves the 
texture along its Y-axis.

Moving multiple objects
When multiple objects are selected, a shared axis system appears in the viewport 
between the selected objects. You can move the objects using the shared axis system or 
you can move the objects using any one of their object axis systems.

When multiple objects are selected, a shared 
axis system appears in the center.

Click the origin of the object whose axis system you 
want to use; this object’s axis system then appears.

To move multi-selected objects using the shared axis system

-  Ensure the move tool is selected. If you want to move the objects freely, drag from an 
empty space within the viewport. If you want to constrain movement to a particular axis, 
drag the appropriate arrowhead of the shared axis system. For example, to move along 
the X-axis only, drag the red arrowhead. 
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To move multi-selected objects using one of their object axis systems

-  Ensure the move tool is selected and click the origin of the object whose axis system 
you want to use. This object’s axis system appears in place of the shared axis system, 
as shown below (we clicked the pyramid’s origin). Note that all three objects are still 
selected (indicated by their red frames).

-  If you want to move the objects freely, drag from an empty space within the 
viewport. If you want to constrain movement to a particular axis, drag the appropriate 
arrowhead of the object axis system. For example, to move in the direction of the Z-
axis only, drag the blue arrowhead.

Scale

 When scaling objects, note that you can either use the model tool or the object tool. Use 
the model tool when you are modeling scale and the object tool when you are animating 
scale. See “The difference between the object tool and the model tool” on page 278 for 
details.

With this tool you can resize the selected objects or elements. When in Scaling mode, 
BodyPaint 3D distinguishes between the world coordinate system and the local object 
coordinate system. The difference between the systems becomes particularly clear if you 
activate only the X-axis.

Imagine you scale a cuboid, which lies inclined in the world coordinate system. If you 
choose the world coordinate system for scaling, the cuboid becomes larger/smaller 
parallel to the X-axis of the world coordinate system and is therefore distorted, as 
illustrated in Figure 1, below.

Figure 1. Figure 2.

If, on the other hand, you select the object coordinate system of the cuboid when 
scaling, the cuboid becomes larger/smaller along its own X-axis and does not distort, as 
illustrated in Figure 2.
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Scaling is performed by left/right movement of the mouse while holding down the left 
mouse button (a “drag”). When editing textures, mouse movements have a somewhat 
different effect. A left/right drag of the mouse resizes the texture along its X-axis, an up/
down drag re-scales it along its Y-axis.

The default size of the Y-axis in the object system is 1.0. For example, if you resize 
the X-axis from 1.0 to 2.0, the object doubles in size along the X-axis. This results in 
a distortion of the object system, making precise construction more difficult since all 
local positions are now also distorted and no longer correspond to the length units of 
the world system. Therefore we recommend that you do not scale using the object tool 
during the modeling process. Use the model tool instead.

 When using the model tool and scale tool, some object types such as parametric 
primitives can only be scaled uniformly. To scale these objects nonuniformly, either enter 
the new size in the Attribute manager or use the object tool.

 To constrain scaling to one axis only, drag the box at the end of the desired axis. This 
saves you from having to lock axes manually.

 If you want to scale an object across a plane hold down the Shift key and click on the axis 
perpendicular to this plane. For example, if your object needs to be scaled across the XY 
plane, drag the Z-axis while holding down the Shift key, and so on.

Scaling multiple objects
When multiple objects are selected, a shared axis system appears in the viewport 
between the selected objects. You can scale the objects using the shared axis system or 
you can scale the objects using any one of their object axis systems.

When multiple objects are selected, a shared 
axis system appears in the center.

Click the origin of the object whose axis system you 
want to use; this object’s axis system then appears.

To scale multi-selected objects using the shared axis system

-  Ensure the scale tool is selected. If you want to scale the objects freely, drag from an 
empty space within the viewport. If you want to constrain scaling to a particular axis, 
drag the appropriate red, green or blue box at the end of the axes. For example, to 
scale along the X-axis only, drag the red box. 
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To scale multi-selected objects using one of their object axis systems

-  Ensure the scale tool is selected and click the origin of the object whose axis system 
you want to use. This object’s axis system appears in place of the shared axis system, 
as shown below (we clicked the pyramid’s origin). Note that all three objects are still 
selected (indicated by their red frames).

-  If you want to scale the objects freely, drag from an empty space within the viewport. 
If you want to constrain scaling to a particular axis, drag the appropriate box of the 
object axis system. For example, to scale in the direction of the Z-axis only, drag the 
blue box.

Rotate

This tool rotates the selected objects or elements when you drag the mouse from an 
empty space within the viewport. When rotating objects, BodyPaint 3D distinguishes 
between the world coordinate system and the local object coordinate system and you 
can choose to rotate in either system. As long as the object lies parallel to the axes of 
the world coordinate system you will not notice a difference when you rotate in either 
system. But when the object is askew, there can be large differences between rotating in 
the world or object systems.

Drag left or right to rotate the object about its Y-axis. An up/down drag rotates it around 
its X-axis, and right-drag (Windows) or Command-drag (Mac OS) rotates about the 
Z-axis.

 To constrain rotation to one axis only, drag the small sphere at the end of the desired axis. 
This saves you from having to lock axes manually.

The behavior of the rotation is entirely different if you have switched on the HPB system 
(Use HPB System enabled on the Units page of the preferences). A left/right drag will 
now change the heading, an up/down drag changes the pitch and right-dragging 
(Windows) or Command-dragging Mac OS) left or right will change the bank. The HPB 
angles here refer to the object’s parent system i.e. if the object being rotated is within a 
hierarchy, the parent object functions as the world coordinates.

 If you are using HPB for rotating the rotation axes behave according to the HPB 
designators (see “Use HPB System” on page 78).

Virtual Rotation Circle

When rotating an object you can also use the virtual rotation circle. It is displayed as a 
yellow circle which is always parallel to the view plane. Drag from an empty part within 
the circle to rotate in any direction or from an empty part outside the circle to rotate on 
the same plane as the circle (rather like the circle is a spinning potter’s wheel).
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Rotating multiple objects
When multiple objects are selected, a shared axis system appears in the viewport 
between the selected objects. You can rotate the objects using the shared axis system or 
you can rotate the objects using any one of their object axis systems.

When multiple objects are selected, a shared 
axis system appears in the center.

Click the origin of the object whose axis system you 
want to use; this object’s axis system then appears.

To rotate multi-selected objects using the shared axis system

-  Ensure the rotate tool is selected. If you want to rotate the objects freely, drag from 
an empty space within the yellow circle (the virtual rotation circle). If you want to 
rotate the objects using the virtual rotation circle, drag from an empty space outside 
the yellow circle. If you want to constrain rotation to a particular axis of the shared 
axis system, drag the appropriate red, green or blue sphere at the end of the axis. For 
example, to rotate about the X-axis only, drag the red sphere. 

To rotate multi-selected objects using one of their object axis systems

-  Ensure the rotate tool is selected and click the origin of the object whose axis system 
you want to use. This object’s axis system appears in place of the shared axis system, 
as shown below (we clicked the pyramid’s origin). Note that all three objects are still 
selected (indicated by their red frames).

-  If you want to rotate the objects freely, drag from an empty space within the viewport. 
If you want to constrain rotation to a particular axis, drag the appropriate sphere of the 
object axis system. For example, to rotate around the Z-axis only, drag the blue sphere.

Move, Scale and Rotate with mouse and keyboard

Moving, scaling and rotating with the mouse

 To move, scale or rotate the selected objects without their children, hold down Ctrl while 
you drag.
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You can use the mouse for moving, scaling and rotating. A left/right drag manipulates 
the X-axis while a back-and-forth drag controls the Y-axis. For the Z-axis you have to use 
the right mouse button. Macintosh users; as usual, use the Command key to simulate the 
right mouse button. You can toggle instantly between the left and right mouse buttons. 
If you are currently pressing the left button, press the right one before releasing the left 
and vice versa.

Moving, scaling and rotating with the cursor keys
On the keyboard, use the cursor keys for moving, scaling and rotating.

Move/Scale/Rotate along... Cursor key

Positive X-axis Right

Negative X-axis Left

Positive Y-axis Up

Negative Y-axis Down

Positive Z-axis Shift + Up or Right

Negative Z-axis Shift + Down or Left

If you are working with the Camera tool selected, it is the camera that is affected. In all 
other cases the object currently selected is moved, scaled or rotated.

Moving, scaling and rotating with the hotkeys
Using the built-in hotkeys you can move, scale or rotate either the camera or the selected 
objects.

Result Action

Move camera left/right/up/down 1 + drag

Move camera forwards/backwards 2 + drag

Zoom camera (focal length) 2 + right-drag (Windows) or 2 + Command-drag (Mac OS)

Rotate camera (X & Y axes) 3 + drag

Rotate camera (Z-axis) 3 + right-drag (Windows) or 3 + Command-drag (Mac OS)

Move selected objects 4 + drag
Scale selected objects (animation) 5 + drag
Rotate selected objects 6 + drag
Scale selected objects (modeling) 7 + drag
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Magnify

Use the Magnify command to zoom in on a particular region of the work area. To define 
that area, drag a rectangle around it. Alternatively, click to zoom in by 25% or Ctrl-click 
to zoom out by 25%. You can also zoom in and out using the ‘+’ and ‘-’ keys.

Selection tools
 When using the Move, Scale or rotate tools, you can click to select individual points.

Live Selection. Rectangle Selection. Freehand Selection. Polygon Selection.

The four selection tools on the Tools menu — Live, Rectangle, Freehand and Polygon 
Selection — enable you to select points, edges and polygons in various ways. The 
following applies:

Adding to or removing from the selection:

-  To add an element to the selection, hold down Shift while you select.

-  To deselect a selected element, hold down Ctrl while you use the selection tool.

In the viewports:

-  In polygon mode, selected polygons have red edges.

-  In edge mode, selected edges are red.

-  In point mode, selected points are red and are larger than unselected points.

Live Selection
Live Selection is like a paintbrush mode where you paint over the points, edges or 
polygons that you want to select. Set the size of this selection brush using the Radius 
setting in the Active Tool manager. You can increase and decrease this radius with the 
“+” and “-” keys. If you are using a trackball, you can use the wheel to adjust the radius. 

Rectangle Selection
This tool enables you to select points, edges or polygons by dragging a frame over the 
elements.
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Freehand Selection
Freehand selection behaves like a lasso. Drag to draw a loop around the elements 
you want to select. As soon as you release the mouse button, the loop is closed 
automatically. 

Polygon Selection
This selection tool enables you to draw an n-sided shape to frame the elements that you 
want to select. The first click defines the starting point of the n-side and subsequent 
clicks define the n-side’s corners. To complete the n-side, click the starting point or right-
click (Windows) or Command-click (Mac OS).

Selection options in the Active Tool manager

Tolerant Selection

This option makes sense only in polygon mode. Enabling this option means that a 
polygon is selected as soon as a corner point of the polygon is within the selection 
marquee. If this option is disabled, a polygon is included only if all corner points of the 
polygon are within the marquee.

Only Select Visible Elements

 When using the Live Selection tool, keep in mind that it uses more RAM when Only Select 
Visible Elements is disabled. Therefore, only disable this option when necessary.

If Only Select Visible Elements is enabled, you can only select elements which are visible, 
i.e. not behind other elements. For example, you can select the polygons at the front a 
sphere but not the polygons at the back.

Another way to prevent polygons at the back from being selected is to switch on 
backface culling, which hides these polygons from the viewport. In addition, you can also 
hide polygons to prevent them from being selected using the Hide Selected and Hide 
Unselected commands from the Selection menu. Lastly, set an object’s top visibility dot 
to red to hide that object and to prevent its elements from being selected. (You’ll find 
the visibility dots in the Object manager, just to the right of the object’s icon.)

Radius

This determines the radius of the Live Selection brush. You can increase this radius 
with the ‘+’ key and make it smaller with the ‘-’ key. With a trackball the radius can be 
changed with the wheel.

Vertex Painting

 This feature only has an effect if you are using BodyPaint 3D with CINEMA 4D. See the 
CINEMA 4D reference manual for details.
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HyperNURBS Weights

See “HyperNURBS” on page 381.

Camera

With this tool you work with the camera that is being used in the active viewport. All 
subsequent actions affect the camera in this viewport. In the planar viewports (XY, ZY, 
XZ) you can move and magnify the displayed area; in the 3D viewport you can change 
the Editor camera or the Object camera. You can move in the following ways.

Keyboard short-cuts

Action Result

1 + drag Move camera left/right/up/down.

2 + drag Move camera forwards/backwards.

2 + drag Zoom by moving camera.

2 + right-drag (Windows)
2 + command-drag (Mac OS)

Zoom by changing focal length.

3 + drag Rotate camera (X and Y axes)

3 + right-drag (Windows)
3 + command-drag (Mac OS)

Rotate camera (Z-axis)

Moving the camera
To move the camera, select the move tool and drag from an empty space within 
the viewport. To move the camera backwards or forwards, right-drag (Windows) or 
Command-drag (Mac OS) left and right.

The camera always moves in the opposite direction to the mouse. For example, when you 
move to the left, this will shift the camera to the right. This is the most intuitive method 
and easiest to learn.

When moving objects you can choose which axis system you wish to use. Normally, this 
will have no effect, since the X, Y and Z symbols are all selected. However, if you switch 
certain axes on or off, you will observe that certain actions will show different results. If 
for example you have activated the X symbol only and you are working with the world 
coordinate system, the camera will move parallel to the X-axis of the world system. If on 
the other hand the object system is selected, the camera will move left and right within 
its own camera coordinate system.
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No grid is applied for the camera or the visible section of the document so that you 
can reach any position, even if a motion grid is active. Movements, scaling and rotation 
processes may be cancelled at any time by pressing the Esc key.

Zooming the camera
You can zoom the viewport in one of two ways: by changing the camera’s focal length 
(just like a real camera’s zoom — note that the perspective will change) or by moving the 
camera forwards or backwards (just like you might move closer to or further away from 
the subject that you’re photographing or filming).

To zoom by moving the camera forwards or backwards

-  Select the scale tool and drag left or right.

To zoom by changing the focal length

-  Select the scale tool and right-drag (Windows) or Command-drag (Mac OS).

Rotating the camera

 The 2D viewports cannot be rotated.

To rotate the camera, select the rotate tool and drag. To rotate about the camera’s Z-axis 
(its Bank value), right-drag (Windows) or Command-drag (Mac OS). 

If an object is selected, the camera also changes its position while it rotates. This occurs 
in such a way that the centre of the selected object remains in the same position on the 
screen. This is especially useful when you want to move around an object. If no objects 
are selected, rotation is about the world origin.

Object
 Only use this tool if you are using the BodyPaint 3D module with CINEMA 4D and you 

are animating the object. In all other cases, use the model tool instead. See also ‘The 
difference between the object tool and the model tool’ on page 278.

Select this tool when you want to move, scale or rotate an object during the animating 
stage only. If you want to move, scale or rotate during the modeling stage, use the model 
tool instead.

To move, scale or rotate the selected object, select the move, scale or rotate tool from 
the Tools menu (or click the appropriate icon on the left toolbar) and drag from an empty 
space within the viewport. You can also move, scale or rotate by entering new values for 
these parameters in the Coordinate manager or the Attribute manager.
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Note that when you scale with the object tool, the object’s axis system is scaled. This is in 
contrast to the model tool, which scales the surfaces.

 To avoid problems, always make it a habit to use the object tool when animating.

Points

Select this tool when you want to edit an object’s points. All subsequent actions such as 
rotation and scaling will affect the points. In addition, the Delete command in the Edit 
menu now refers to the points of the object rather than to the object itself. As soon as 
the tool is selected, all points of the object are represented by small squares. Selected 
points are highlighted in color.

You can select points using the selection tools in the Tools menu or by clicking the points 
one by one. To add points to the selection in this way, hold down Shift while you click the 
points. To remove points from the selection, Shift-click the points again.

Edges

Click this tool when you want to edit the edges of polygons. Selected edges are red. You 
select and edit edges in much the same way as you do points.

To select an edge, drag over the edges with the Live Selection tool, just as you would to 
select points (or use any other selection tool). To add edges to the selection, hold down 
Shift while you select. To remove edges from the selection, hold down Ctrl while you 
select.

You can use the move, scale and rotate tools to edit the selected edges. And to delete 
the selected edges (including their polygons) press Delete.

Polygons

BodyPaint 3D works with two types of polygon: triangle and quadrangle. Polygons are 
edited in much the same way as points and edges. As soon as you activate the polygon 
tool, the polygons of the selected object are displayed. Select a polygon by clicking on it 
with the mouse; selected polygons have red edges.
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To select multiple polygons (or to add to the selection), Shift-click each polygon that 
you want to select. Shift-click a polygon a second time to deselect it. Or select polygons 
using a selection tool such as Live Selection from the Tools menu.

To delete the selected polygons, use either the Delete command from the Edit menu or 
press the Del key or Backspace key.

Object Axis

The Object Axis tool enables you to modify the axes of the selected object without 
affecting the object’s points or polygons. In particular, you can use this tool with the 
move tool to reposition the origin. This can make it easier to rotate the camera around 
the selected object (the camera rotates around the object’s origin).

Model

Select this tool when you want to move, scale or rotate an object during the modeling 
stage. To move, scale or rotate the selected object, select the move, scale or rotate tool 
from the Tools menu (or click the appropriate icon on the left toolbar) and drag from an 
empty space within the viewport. You can also move, scale or rotate by entering new 
values for these parameters in the Coordinate manager or the Attribute manager.

The difference between the object tool and the model tool
There are two very similar tools which can both be used to move, scale and rotate 
objects. One is called the model tool and the other one is the object tool. Before you 
start animating it is important that you understand the difference between the two and 
when to use which.

The rule of thumb is this: The model tool is for modeling, the object tool is for animation.

You notice the difference only when scaling an object, but if you do use the wrong tool, 
the result can be puzzling. When scaling an object with the object tool, you are not 
only scaling the geometry, you are also scaling its axes. And, especially when scaling an 
object’s axes non-uniformly (stretched more on one axis than another), the result is that 
child objects get squashed or stretched when you rotate them and you may begin to 
wonder what is happening to your objects.

If something strange happens to your objects when you rotate them, then there are most 
likely scaled axes involved. So when modeling, use the model tool.
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 If your model distorts, you can repair the damage with the Reset System tool.

It is different for animation, however. If you want to animate the size of an object over 
time, you need to use the object tool.

Example

Figure 1. Figure 2.

Figure 3. Figure 4.

Consider a scene with two objects, a (polygon) sphere and a cube (Figure 1, above). The 
cube is a child (sub-object) of the sphere. The axial length of both objects is 1/1/1 (the 
default).

-  Now choose the object tool. Select the sphere. In the Coordinate manager’s  Size 
column, set the drop-down list to Scale and set X (Scale) to 2. As we would expected, 
both the sphere and cube are distorted, as illustrated in Figure 2.

-  Select the cube. Choose the rotate tool to select the rotate tool. Disable the X and Y 
axes by clicking their icons in the top toolbar. Now drag from an empty space within 
the viewport to rotate the cube about its Z-axis. The cube distorts when rotated 
(Figure 3).

The points of the cube no longer obey a circular trajectory while they are rotated in the 
XY plane. Instead, the distorted parent system causes this movement to be elliptical. 
And here we have the classic distortion problem. It invariably occurs when objects exist 
in a distorted parent system. Effects of this type are encountered by each and every 3D 
application, since it is a fundamental problem.
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To prevent this problem, simply use the model tool for scaling the sphere. If the damage 
is already done, choose Reset System and select the two options, Normalize Axes and 
Offsets. In either case, the cube will then rotate without distortion (Figure 4).

Texture

 You can edit one texture at a time only. If multiple Texture tags are selected, the grid lines 
will not appear and cannot be edited.

This enables you to edit the active texture. As soon as you choose this tool the texture of 
the object is shown and cyan grid lines appear. The mapping (i.e. the type of projection) 
is taken into account (see “Types of mapping” on page 661).

 The grid lines will not appear if the selected object uses UVW mapping and textures in 
the viewport are switched on (you’ll find the Disable Textures option on the viewport’s 
Display menu).

The grid lines are drawn according to the type of projection chosen, e.g. spherical 
mapping is shown with a spherical cyan grid. An exception is UVW mapping. Here the 
grid is displayed over the entire viewport.

 If the texture uses UVW mapping, you’ll be unable to move, scale or rotate the texture. 
For advanced UVW editing, the optional BodyPaint 3D module is available. BodyPaint 3D 
provides ultimate control over the surfaces of your 3D object because you can paint them 
right on the model.

The texture axes of the object are shown with an envelope on whose surface the texture 
can be moved by using the familiar move and scale tools. However, note that if you want 
to rotate the texture, you must use the texture axis tool instead of the rotate tools.

A left/right drag of the mouse will move the texture along its X-axis, an up/down drag 
will move it along its Y-axis. The scale tool uses the same principle, only here the texture 
does not get moved but resized.

The data for X and Y — referring to the positioning and dimensions of the texture in 
the Coordinate manager — are always given as percentages, since the actual size is 
irrelevant. A size of 100% for both coordinates means that the texture covers the surfaces 
completely.
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Texture Axis

 You can edit one texture at a time only. If multiple Texture tags are selected, the grid lines 
will not appear and cannot be edited.

This tool enables you to edit the texture axes of the active texture. As soon as you select 
the tool, the texture of the object is shown and the texture envelope appears. You can 
move, scale and rotate the envelope in the usual fashion (by dragging with the move, 
scale or rotate tool selected).

 The grid lines will not appear if the selected object uses UVW mapping and textures in 
the viewport are switched on (you’ll find the Disable Textures option on the viewport’s 
Display menu).

The difference between Edit Texture and Edit Texture Axes is illustrated in the following 
pictures. In both cases, the movement is along the X-axis; in Figure 1, using the Edit 
Texture tool the texture is moved on its envelope; in Figure 2, by using Edit Texture Axes 
the envelope itself is moved.

Figure 1. Figure 2.

UV Points, UV Polygons
See “UV Points” and “UV Polygons” on page 257.
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The Axes

Using these options, you can restrict movement, scaling or rotation to specific axes. For 
example, to allow movement along the Y-axis only, enable Y-axis and disable X-axis and 
Z-axis. Now, when you drag with the move tool selected, the movement will be along the 
Y-axis only.

Use the Coordinate System setting (see below) to choose whether the angles refer to the 
world coordinate system or the object coordinate system.

If Use HPB System is enabled in the preferences (Units page), the HPB designators apply. 
(The letters HPB stand for heading, pitch and bank.)

For each type of operation, BodyPaint 3D remembers the state of the axes (locked or 
unlocked). For example, if you have made a movement along the Y-axis while X and Z 
were locked, and subsequently change to rotate, all axes are unlocked again. When you 
change back to move, the program remembers that only the Y-axis was unlocked.

Coordinate System

Here you decide in which coordinate system an operation will take place. Not all options 
work with both systems. Scaling of object axes for example can occur only within the 
object coordinate system. The object coordinate system is the local system of an object, 
shown in the viewports by the colored axes; X (red), Y (green) and Z (blue). Each object 
has its own object coordinate system.

If HPB System is enabled in the preferences (Units page), HPB angles will be used for 
the rotation, independently of the axis system chosen. Internally BodyPaint 3D works 
exclusively in the HPB system. HPB is an abbreviation for heading, pitch and bank.
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You may have come across the terms heading, pitch and bank in connection with aircraft. 
An aeroplane rotates left or right to change its heading; up or down to changes its pitch; 
and rolls to changes its bank. When you are changing angles you may find it helpful to 
think of an aeroplane.

Use Generators, Use Deformers
 The drawing pipeline — and the enabling or disabling of its various elements — is of little 

importance when you are working with BodyPaint 3D.

A short explanation of the drawing pipeline: it defines whether generators, animation, 
expressions and deformers are evaluated for CINEMA 4D scenes. For example, by 
disabling Use Generators, you can switch off all HyperNURBS objects in the scene. For 
more details on the drawing pipeline, please refer to your CINEMA 4D reference manual.

Objects
You can create various types of object in BodyPaint 3D. For details on these objects, see 
Chapter 22, Objects.
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Structure
The commands on the Structure menu affect one object only — child objects are not 
affected.

The following applies to most of these commands: if there is a selection, the command 
affects the selection only. If there is no selection, the command is applied to the entire 
object.

Make Editable

Primitive objects are parametric, i.e. they have no points or polygons and are instead 
created using math formulae and parameters. Since these objects have no points or 
polygons, you can’t edit them in the same way you can normal polygon objects and 
splines. For example, you can’t select and move points.

However, you can edit these objects if you first convert them to points and polygons. To 
do this, select the desired primitives and choose Make Editable. Note that, other than 
using the Undo command, this conversion is one-way only. You cannot edit the points 
and then convert back to a primitive object.

Align Normals

When creating surfaces you may sometimes inadvertently create surfaces whose normals 
point in the wrong direction. Using Align Normals, you can quickly correct the direction. 
When you use Align Normals BodyPaint 3D will adjust and re-align the incorrect surface 
normals to the correct direction. BodyPaint 3D adjusts the orientation of the normals 
according to the normal direction of the first surface of the currently selected group of 
surfaces. If no surfaces are selected then all normals are aligned.

Why exactly are these normals needed? BodyPaint 3D cannot easily recognize an object’s 
inner and outer surface without extra information. A basic sphere has an inner and 
an outer side, but only one surface level, which can be confusing. We need a better 
definition. Let’s define this single surface level to have an inner and an outer property. 
Outer designates, in principle, the direction in which the surface normals point and inner 
is therefore the opposite direction. This plays a role with texture projection, where you 
can project textures from only the front or the back.
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So, if as many normals point one way as the other way, how do we decide which is the 
outer surface? We could either choose randomly or, perhaps, look at the first polygon in 
the sequence and use its normal as the basis of our calculation — BodyPaint 3D does the 
latter.

Why change the direction of the normals? As described above, the direction of the 
normals defines the interior and the exterior of an object. This is important, among other 
things, for displaying an object in the viewport. Occasionally, when building certain 
objects, a situation can arise in which some polygons seem invisible. This can happen 
if backface culling is on and the reason is as follows. To save on processor performance 
you may have enabled backface culling for your scene; this is where only the polygons 
visible from the front of an object are displayed in the viewport. The polygons positioned 
directly at the back of an object are not drawn.

When displaying a sphere and other volume objects in the Gouraud Shading mode you 
may notice no difference, simply because you do not see the back of the sphere anyway. 
But should you select all the polygons of this sphere and reverse the normals (see next 
section), you will now see only the back of the sphere; the front is now transparent since 
you have inverted the sphere. The inside is now the outside, and this becomes invisible 
because of the backface culling.

Should you find yourself in a situation like this switch off backface culling and reverse the 
normals of these polygons.

Another important factor is smoothing with the Phong tag. BodyPaint 3D calculates 
whether edges are to be rounded by considering the angle of the surfaces to each other. 
If two surfaces with differently aligned normals lie next to each other, BodyPaint 3D 
calculates the wrong angle information — thus causing unwanted, often ugly, results 
when smoothing:

Also, when using the Displacement material channel, the angle of the normals plays an 
important role.
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Reverse Normals

This command is similar to Align Normals. Here, however, the normals are reversed. If no 
polygons are selected, all of the object’s normals are reversed. With an active selection 
only the normals of the selected surfaces are considered.

Optimize

If an object is made up of many triangles and quadrangles, very often some points and 
surfaces will be duplicated. For example, the parametric primitives can contain some 
duplicate points after being converted into polygon objects. You can eliminate these 
double elements with the Optimize command. The appearance of the object will not 
change, or only slightly change, when using this command.

Caution is required with objects that intentionally contain these double points in certain 
places. Such points can be intended, for example, to produce hard edges despite an 
active Phong tag or in connection with a HyperNURBS object .

The selected elements to be optimized can be points, edges or polygons. If you select 
polygons or edges, then the associated points are also considered. If you select points 
only, then just the points are considered. This tool can be applied to splines also. In this 
case, however, only the points can be optimized, since a spline has no surfaces.

Polygons

When enabled this will eliminate one- or two-point surfaces.

Unused Points

Enable this option if you want unused points to be deleted.



286 • CHAPTER 16 TOOLS MENU • 287

Points

Specifies whether duplicated points are to be eliminated.

Tolerance

When eliminating points you may enter a tolerance value. This defines the maximum 
distance that must lie between the two coinciding points for them to be deleted when 
optimizing. If points are closer to each other than this value, then they are merged into 
one point. If polygons become redundant (e.g. if all three corner points of the polygon 
occupy the same point), BodyPaint 3D will automatically delete them.

Triangulate

Triangulate converts all of the object’s quadrangles to triangles. The entire object is 
triangulated. However, keep in mind that quadrangles tend to shade better.

Untriangulate

If you have an object built only of triangles (e.g. imported from another program), 
BodyPaint 3D can try to convert the triangles into quadrangles. This works only as long 
as the triangles that you want to convert will result in a planar quadrangle. Triangles 
that cannot be converted are left in their original state. So, Untriangulate works only for 
triangles which result in planar quadrangles. If Evaluate Angle is disabled BodyPaint 3D 
tries to convert all triangles into quadrangles. This can result in unwanted edges and 
shading errors. In such cases, enable Evaluate Angle.

Paint Setup Wizard
See Chapter 5, First Steps.
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Projection Painting
The advantages of projection painting
Constant brush size

Projection painting is your best friend when it comes to painting objects without 
distortion. Take a look at the picture below. The top object was painted in the normal 
painting mode — not how the brushstroke is massively distorted. Contrast this with 
the perfect brushstroke on the bottom object, which we painted in projection painting 
mode.

Projection painting mode off (top) and on (bottom)..

However, even projection painting won’t save you if the UVs are completely out of 
shape. Therefore you should create at least a reasonably good UV mesh before you 
switch on projection painting. You’ll be pleased to know this is an easy task thanks to 
BodyPaint 3D’s powerful suite of UV editing tools — see Chapter 15, UV Edit Menu. 

Painting on multiple materials and objects

Another advantage of projection painting is that it lets you to paint on several materials 
or objects at the same time, even if their textures are different sizes. You can even smear 
over multiple textures and objects!
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How projection painting works
When you paint in the viewport using projection painting, a virtual projection layer is 
created perpendicular to the camera. This projection layer is in turn projected onto the 
objects you want to paint on.

Projection painting is based on a planar projection.

The main downside to projection painting is that it requires plenty of RAM. The larger the 
view and the more material channels you are painting, the more RAM projection painting 
needs. You can work out exactly how much RAM is needed using the following equation:

RAM needed (in bytes) = height * width of view (in pixels) * 8 * number of material 
channels to be painted.

For example, suppose your 3D view is 700 x 600 pixels and you are using a multibrush to 
paint on the Color, Diffusion, Specular Color and Bump channels. The amount of RAM 
required is 700 * 600 * 8 * 4 = approx. 13 MB.

There’s a further downside to projection painting: it can take a while for the projection 
layer to be projected onto the objects. The bigger the textures and the more channels 
you are painting on, the longer this process will take.

Even so, these disadvantages are a small price to pay indeed for the excellent results you 
can achieve with projection painting.
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Using projection painting
Switching on projection painting

To switch on projection painting, activate the view you want to paint in (click in the view 
or click the view’s title bar) and enable the 3D painting mode icon on the left toolbar. 
You’ll see a green outline appear in the view to indicate that projection painting mode is 
switched on for this view. You can now paint.

 You can switch projection painting on for one view at a time only.

Initially the paint is applied onto a projection layer, not onto the textures. To apply the 
projection layer onto the textures, do one of the following:

-  In the left toolbar, click the projection painting mode icon (this also switches off the 
mode).

-  Choose the Apply Projection command (see below).

-  Move or rotate the camera, select a different layer, render, save, etc.

You may notice a delay while the projection is applied. Do not be concerned. Keep in 
mind that many calculations are necessary, especially if you are using large textures.

Apply Projection

This command projects the projection layer onto the scene and its textures. The 
projection layer is then cleared.

Discard Projection

This command clears the projection layer. The projection is not applied to the scene. Even 
Undo won’t restore a projection layer once you have deleted it.
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Toggle Fore-/Background

This command enables swaps the foreground and background colors for all material 
channels. You can also swap the colors by clicking the small arrow in the bottom left 
corner of the material channel icon.
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Plugins are auxiliary modules which extend the function range of a program. In 
BodyPaint 3D, plugins are able, for example, to automate particular functions, to make 
new tools available to extend import and export filters or to add new shaders. For this 
purpose BodyPaint 3D includes a powerful programming language, C.O.F.F.E.E., available 
to both developers and end-users.

C.O.F.F.E.E. is an object-oriented programming language closely related to C++ and Java. 
Full information and the SDK is available at www.plugincafe.com, where you’ll also find 
links to many plugins.

 Plugins can be developed freely by anyone and offered for sale. However, MAXON, as 
the manufacturer of BodyPaint 3D, has no influence on the quality of these plugins and 
you should assure yourself as to the value-for-money and usefulness of a plugin before 
purchase.

 We give as much support as possible to all vendors and developers of plugins — however, 
if a problem should arise with one of these products, please contact the manufacturer 
of the plugin directly. Please understand that MAXON can give no information on, or 
provide technical support for, products from other manufacturers.

As already mentioned, plugins can solve many diverse tasks and therefore, after 
installation, your new plugin may appear in different places within the BodyPaint 3D 
menu structure. Please always consult the vendor’s documentation that was supplied 
with your plugin. If there is no special information to be found in the documentation, a 
plugin will usually be found on the Plugins menu.

Execute Last Plugin
This command gives you a quick way to call the last plugin that you used, especially is 
you assign a shortcut to this command using the Command manager.

SpaceMouse (Windows only)
The SpaceMouse is a mouse designed for use with 3D applications. Choose this command 
to access its settings.

17 Plugins Menu
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The Render menu contains all the options you need to render a picture including the 
commands for raybrush mode. You can define several render presets such as for preview 
and for final rendering; this saves you having to change the settings one by one each 
time. Using the render settings, you can also switch on effects such as multi-pass 
rendering.

Render Alerts

Missing textures
If BodyPaint 3D is unable to find any textures when you render, an alert will appear. If 
you choose to continue rendering, the materials will be used without the missing texture 
maps. BodyPaint 3D searches for textures in the following locations: in the scene’s folder; 
in the scene’s “Tex” folder; in BodyPaint 3D’s “Tex” folder; in the Texture Paths (and sub-
folders) specified in the preferences.

Raybrush Mode
The raybrush mode enables you to paint in a pre-rendered view in realtime and in three 
dimensions. You can view the following channels simultaneously:

-  Color

-  Diffusion

-  Luminance

-  Transparency

-  Reflection

-  Bump

-  Specular Color

The raybrush mode is relatively close to rendering in terms of image quality. However, 
a few restrictions are made so that a reasonable display speed is maintained. Note that 
these restrictions apply to the raybrush mode only. Also, some of the restrictions apply 
to imported CINEMA 4D scenes only.  When you render proper, BodyPaint 3D uses the 
full power of CINEMA 4D’s rendering engine (BodyPaint 3D is based on CINEMA 4D 
technology). 

18 Rendering
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Raybrush Mode Restrictions
-  CINEMA 4D’s Sky, Foreground and Background objects cannot be painted. 

-  Post-processing effects such as glow, lens effects, depth of field and motion blur are 
not displayed. 

-  Anti-aliasing is not shown. 

-  Textures are not interpolated (e.g. there is no SAT and MIP interpolation). 

-  Only the raytracing mode can be used (e.g. you cannot use Cel-Render Color mode). 

-  Objects with Visibility tracks in the Timeline cannot be displayed (only relevant when 
running CINEMA 4D with BodyPaint 3D).

-  Imagine that you have assigned three materials to an object and you are editing the 
second material. Only the materials above this material are shown. 

-  Irregularities may appear at the edges of textures (e.g. if you tile them). 

-  Fresnel reflections with transparent objects are not shown. 

-  You cannot paint objects that are behind transparent, refractive objects. 

-  You can paint transparency and reflection, but only as a rough approximation of 
the rendered result. Also, double transparencies cannot be displayed. For example, 
consider a tin: if you paint transparency to the front and back of the tin, only the front 
will become transparent. 

-  Transparency and reflection are not taken into account when you paint to the bump 
channel. 

 The more light sources you use, the more processing time is required when you paint to 
the bump channel. Likewise, the processing time increases with the use of Tube and Area 
lights. 

Raybrush Render View
Choose this command to raybrush render (i.e. pre-render) the active view. The raybrush 
render will take a few moments. Once it has completed, you are in raybrush mode and 
you can paint in the view. 

The raybrush mode is deactivated the moment you move, scale or in any way change the 
view or object. 

Raybrush Render Active Objects
Only the selected objects and their children are raybrush rendered. All other objects are 
ignored. 
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Raybrush Render Region
After activating this command, drag a frame in the 3D view (or a 2D view). Only the 
framed region will be raybrush rendered, although you will be able to paint outside the 
region (in which case, the view’s shading mode is used). 

Render View

 If you want to save the picture, you must render to the Picture Viewer instead. If an alert 
appears when you render, see “Render Alerts” above.

Use this command to render the scene in the active viewport. A render progress bar will 
appear in the bottom left corner of the view panel. To cancel rendering, press Esc or click 
the mouse button. To access the options that control rendering, choose Render > Render 
Settings from the main menu.

Render Active Objects

 If you want to save the picture, you must render to the Picture Viewer instead. If an alert 
appears when you render, see “Render Alerts” above.

This command renders the selected objects and their children in the active viewport. 
A render progress bar will appear in the bottom left corner of the screen. To cancel 
rendering, press Esc or click the mouse button. To access the options that control 
rendering, choose Render > Render Settings from the main menu.

Render Region

 If you want to save the picture, you must render to the Picture Viewer instead. If an alert 
appears when you render, see “Render Alerts” above.

Use this command to render a region in a viewport. Once you have chosen the command, 
drag a box in a viewport to define the region that you want to be rendered. A render 
progress bar will appear in the bottom left corner of the screen. To cancel rendering, 
press Esc or click the mouse button. To access the options that control rendering, choose 
Render > Render Settings from the main menu.
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Render To Picture Viewer

 The Picture Viewer includes display options such as the ability to switch off specific color 
channels and the ability to change the viewing size.

This command renders the scene to the Picture Viewer. If you want to save the picture, 
enter a filename in the render settings before you use this command. Once rendering 
starts, a progress bar appears at the bottom left of the window. The bar shows the time 
elapsed since the render started.

 If an alert appears when you render, see “Render Alerts” above.

To cancel the rendering, press Esc. To access the options that control rendering, choose 
Render > Render Settings from the main menu.

Render Settings

 See also “Render Settings” on page 304.

A project can have several render settings. This command opens the active settings 
(indicated by a check mark on the Render menu). For details on using multiple settings, 
see “New Render Settings”, below.

New Render Settings

 To add default render settings, start a new scene and use New Render Settings to create 
the settings. Save this empty scene in BodyPaint 3D’s root folder using the filename 
“template.c4d”.

You can use this command to create new render settings. The Render Settings dialog 
opens. On the General page, enter a name for the new settings into the Name box 
— enter a name that will make it easy to distinguish these settings from others on the 
Render menu. Once you have finished creating the settings, the new name will appear in 
the lower section of the Render menu.
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You can create settings for a variety of purposes. Perhaps you will create settings with 
low antialiasing, no reflections and no shadows for preview rendering, called “Preview”. 
You might also create settings with high antialiasing, reflections and shadows called 
“Final Rendering”. You can create as many settings as you like. To choose which settings 
are active, select the corresponding name from the Render menu. The check mark will 
then appear in front of that name.

Delete Render Settings

This command deletes the active render settings (the active settings are indicated by a 
check mark on the Render menu). The name of the settings will be removed from the 
Render menu.
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Render Settings
 These settings in this dialog control many aspects of the rendering process; be sure to 

check all the values before you commit to a final render of your scene.

 The render settings are saved automatically with the scene.

General

Name

Enter a name for the settings. This name will appear in the Render menu so that you 
can switch between different settings. Choose a name that will distinguish the settings 
clearly from any other settings on the Render menu.

Antialiasing

Sets the antialiasing mode. You’ll find further antialiasing settings on the Antialiasing 
page.

Filter

This sets the filter mode for antialiasing. You can set the filter on the Antialiasing page 
also.



304 • CHAPTER 18 RENDER MENU • 305

Transparency

None. No Refraction. With Refraction.

None

Transparency and alpha channels will not be rendered.

No Refraction

 If you have placed a transparent object inside another object, the inner object may be 
black when rendered. To remedy, increase the Ray Depth value on the Options pages.

Transparent materials will be rendered without refraction. If you are working with 
alpha channels, use No Refraction — otherwise, the surfaces will be opaque when 
rendered.

With Refraction

Allows transparent materials to refract. Refraction is essential for realistic glass 
and water. Any refraction in the render will increase the render time. If there is no 
refraction in the render, the render time will not increase, even when this setting is 
selected.

Reflection

None. Floor & Sky Only. All Objects.

None

Reflections will not be rendered.
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Floor & Sky Only

Only the floor and sky objects in the scene will be reflected. This allows for much faster 
rendering than All Objects and is a good compromise between no reflections and full 
reflections for time-critical projects.

All Objects

All objects in the scene can be reflected in a relevant reflective object. If there are no 
reflective objects in the scene, the render time will not increase, even when this setting 
is selected.

Shadow

None. Soft Only. All Types.

None

Shadows will not be rendered. Note that without shadows the scene may lack contrast 
and depth.

Soft Only

Soft shadows will be rendered. Hard shadows and area shadows will be ignored. 
Soft shadows render extremely quickly and look natural — often more so than hard 
shadows, which take longer to render.

All Types

All shadow types — soft, hard and area — will be rendered. Additional rays must be 
calculated for hard shadows and area shadows.

Render As Editor

If this option is enabled, the scene will be rendered exactly as it appears in the viewport. 
For example, you can render wireframe pictures when this option is enabled.
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Output

The settings on the Output page refer to rendering in the Picture Viewer only. These 
settings have no effect on rendering in the viewports. You must render to the Picture 
Viewer if you want to save the rendered image.

Resolution

Defines the size of the rendered image. Choose the resolution from the drop-down list 
or enter your own values in the two input boxes to the right. The drop-down list includes 
most common video formats. If you enter custom values, the drop-down list is set to 
Manual. 

Film Format

The film format corresponds to an image’s X:Y ratio. Photographic studios, the movie 
industry and the TV industry often use ratios that differ from that of a computer screen. 
Choose the film format from the drop-down list or enter your own values in the two 
input boxes to the right. The drop-down list includes most common video formats. If you 
enter custom values, the drop-down list is set to Manual. 

The Resolution and the Film Format settings are linked. If you change Film Format, 
Resolution is adjusted automatically in the Y direction.

 Select a resolution of 320 x 240. This is the same as a computer’s 4:3 ratio. Change the 
film format to 70 mm (cine format) — the resolution changes to 320 x 145 automatically 
(it is scaled in the Y direction to match the format).

The default setting for the film format is Automatic. This means that images will be 
rendered in the specified resolution independently of any particular ratio.

Two lines are shown in the 3D view to frame the area that will be rendered.
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Pixel

The two values specified here define the ratio of a pixel’s on-screen width (left box) to 
its on-screen height (right box). The pixel ratio for most monitors is 1:1, so usually you 
do not need to change this setting. However, some display media use a pixel ratio other 
than 1:1 and the setting must be adjusted to avoid distortions such as circles appearing 
as ellipses.

If you need to calculate the pixel ratio manually, expand the side viewport to fit the entire 
screen and create a cube. Using a ruler, measure the cube’s width and height and enter 
these values in the two input boxes for Pixel.

Frame, Field Rendering, Frame Rate

These features only have an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see the CINEMA 4D reference manual for details.
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Save

Save Image, Path

Enable the Save Image option if you want the image to be saved automatically after 
rendering to the Picture viewer. Choose the save path and filename using Path. You can 
type in the entire path or you can click on Path to open a system dialog for selecting the 
folder. If you enter a name without a path, the picture will be saved in the active scene’s 
folder.

Format

BodyPaint 3D supports many common file formats. Supported still formats are TIFF, 
TARGA, BMP, PICT, IFF, JPEG, RLA, RPF and Photoshop PSD. The animation formats 
QuickTime (Windows and Mac OS) and AVI (Windows only) are also supported. However, 
if you choose an animation format, after rendering to the Picture Viewer you’ll simply 
have a movie with the same picture in each frame.

QuickTime 4 upwards supports the following single picture formats: BMP, Photoshop 
PSD, SGI, JPEG, PICT, PNG, TIFF and QuickTime Image. It also supports any new codecs 
you have added to it. If you are using Windows, install QuickTime to take advantage of 
these features.

Options

This button is ghosted unless Format is set to AVI Movie (Windows) or QuickTime Movie 
(Windows and Macintosh). If you click this button, a dialog opens that gives you access 
to various codecs and their settings. If the dialog does not open, check that you have the 
latest version of QuickTime installed (visit www.quicktime.com).
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Depth

Defines the bit depth per color channel. Choose either 8 bits per channel (for 24-bit 
color) or 16 bits per channel (for 48-bit color). File formats that support 16 bits per 
channel are TIFF, PSD, RPF, RLA and B3D.

Name

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Many editing programs accept picture sequences. However, they tend to use different 
naming conventions. Some programs expect the filename to end with a number, others 
an extension. Some programs can cope only with three-digit numbers. Use this menu 
to set the sequential numbering and/or lettering style required by your editor. In the 
example names below, “0000” represents any sequential number, “TIF” represents any 
three-letter extension.

Example name Example result
Name0000.TIF Test1234.JPG
Name0000 Test1234
Name.0000 Test.1234
Name000.TIF Test123.TGA
Name000 Test123
Name.000 Test.123

DPI

Use this setting to choose the DPI (dots per inch) for the following picture formats: BMP, 
TIF, PICT. The DPI affects a picture’s print size and, in certain applications, its display size. 
The DPI setting does not affect a picture’s Resolution (Output tab); the picture’s pixel 
dimensions remain the same, only the calculation regarding how many of those pixels 
(dots) should be printed or displayed per inch is changed.

 You render a picture that is 720 x 900 pixels. If you save the picture with 72 DPI, the print 
size will be 10 in x 12.5 in (25.4 cm x 31.75 cm). If you save the picture with 300 DPI, 
the print size will be 2.4 in x 3 in (6.1 cm x 7.62 cm). To calculate the print size in inches, 
divide the pixel dimensions (Resolution on the Output page); multiply the inches by 2.54 
to get the print size in centimeters.

Alpha Channel

 The entire alpha channel is masked if you use a Sky, Floor, Foreground or Background 
object in your scene. Do not use any of these objects if you need the alpha channel.
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If you enable this option, a pre-multiplied alpha channel will be calculated during 
rendering. The alpha channel is a grayscale image of the same resolution as your color 
picture. Pixels in the alpha channel are either black or white. A white pixel in the alpha 
channel indicates the presence of an object at that position in the image while a black 
pixel indicates no object.

You can use the alpha channel for compositing in video programs. For example, suppose 
you have scanned a photograph of an airfield and you want to render an aircraft and 
place it on the runway. Render the aircraft with an alpha channel in BodyPaint 3D, then 
use that alpha channel in your compositing program to cut out the non-aircraft parts of 
the render so that the airfield shows though. The edges of the alpha channel picture are 
antialiased to ensure a soft transition in the composited picture.

Pre-multiplied alphas have one particular shortcoming, illustrated below.

From left to right: the rendered image, the alpha 
channel, the result.

In the illustration above, the alpha channel causes a dark seam. This is because both 
the picture and the alpha channel were rendered with antialiasing. By definition, the 
color picture and the alpha channel must be multiplied and so the black is calculated 
twice. You can avoid this dark seam by using the Straight Alpha option instead. Note 
that straight alphas are suitable for compositing only; they are unusable as conventional 
pictures.

Alpha channels are integrated automatically for TARGA, TIFF, PICT, PSD and QuickTime 
Movie formats. If you have enabled Separate Alpha or if you have chosen a different 
picture format, the alpha channel is saved separately to the color picture. These files are 
indicated by an “A_” before the filename, e.g. “A_room.tif”. Separate alphas are saved in 
the TIFF format.
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Straight Alpha

 The entire alpha channel is masked if you use a Sky, Floor, Foreground or Background 
object in your scene. Do not use any of these objects if you need the alpha channel.

You can use this option if straight alphas are supported by your compositing program to 
avoid the dark seam associated with pre-multiplied alphas. Note that straight alphas are 
suitable for compositing only; they are unusable as conventional pictures.

From left to right: the rendered image, the alpha 
channel, the result.

Alpha channels are integrated automatically for TARGA, TIFF, PICT, PSD and QuickTime 
Movie formats. If you have enabled Separate Alpha or if you have chosen a different 
picture format, the alpha channel is saved separately to the color picture. These files are 
indicated by an “A_” before the filename, e.g. “A_room.tif”. Separate alphas are saved in 
the TIF format. The alpha channel can be integrated into a movie only if alpha channels 
are supported by the chosen codec.

Separate Alpha

Alpha channels are usually integrated into TARGA, TIFF or PICT pictures — that is, they 
are saved as part of the image file. However, if you want to save the alpha channel as a 
separate file, enable this option. In addition to your color picture (e.g. “room.tif”), you 
will also have a file containing the alpha channel (e.g. “A_room.tif”). Alpha channels are 
always saved in the TIFF format.

24 Bit Dithering

Dithering is a process that adds a random pattern to colors to prevent color banding. 
Although dithering enhances image quality, it increases file size also. For web graphics in 
particular, you may want to disable dithering to reduce image file size.

After Effects Project File

 This feature is only useful if you are using the BodyPaint 3D module with CINEMA 4D. 
Please see the CINEMA 4D reference manual for details.
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Antialiasing

Antialiasing removes jagged edges from your images. It works by breaking down each 
pixel into sub-pixels; rather than calculate just one color for a pixel, several color values 
are calculated and averaged to produce the final color for the pixel.

Using the settings on the Antialiasing page, you can remove jagged edges. The top 
right inset box shows jagged edges without antialiasing, the bottom right inset box 
shows the smoothed result of applying antialiasing.
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Antialiasing

None. Geometry. Best.

None

Switches off antialiasing. Rendering is exceptionally fast but edges are jagged.

Geometry

The default antialiasing mode. Object edges are smooth when rendered.

Best

Switches on color antialiasing. Antialiasing softens color contrasts such as shadow 
edges. Object edges are smoothed also.

Filter

The antialiasing will be blurred or sharpened according to your choice. Unless you have 
special requirements met by another filter, choose Animation or Still Image.

Still Image. Animation. Blend.

Sinc. Area 10%, Area 100%. Cone 10%, Cone 100%.
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Catmull. PAL/NTSC.

Still Image

The default filter. It ensures sharp edges and is best suited to still images.

 For crisp, sharp stills, keep in mind that you may need to change the Sampling setting of 
materials. Although the default Sampling setting, MIP, is a good choice for materials on 
objects that extend towards the horizon — such as a floor — for things like bottle labels 
you’ll get a much sharper picture by changing Sampling to Square, Alias 1, Alias 2 or 
Alias 3.

Animation

Blurs the antialiasing to produce smooth results and prevent flicker for film/video.

Blend

Enables you to customize the softness of the antialiasing. Enter a value from 0% to 
100% into the Softness box (see also “Softness”, below).

Sinc

Produces better antialiasing than Still Image but takes longer to render.

Area

Calculates an area (defined by Softness) around the current pixel that is used for the 
antialiasing.

Cone

Set the size of this cone filter using Softness. Still Image, Animation, Blend and Sinc all 
produce better antialiasing than Cone.

Catmull

Produces lower-quality antialiasing than Still Image, Animation, Blend and Sinc.

PAL/NTSC

 For S-VHS, use the Animation filter.
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This very soft filter is suitable for VHS.

Softness

Defines the softness of antialiasing for the Blend, Area and Cone filters.

Threshold

Neighboring pixels that differ in color by the Threshold value or more are antialiased. The 
default Threshold value is 10%. Depending on your scene, you may need to lower the 
Threshold to about 3%.

Min Level, Max Level

 If artefacts appear (e.g. small shadows become absorbed), either reduce the Threshold or 
increase the Min Level. If areas of high contrast are jagged — such as at shadow edges, 
edges behind transparent objects or within textures — increase the Max Level setting.

BodyPaint 3D uses adaptive antialiasing — pixels that need slight antialiasing use the 
Min Level setting; pixels that need strong antialiasing such as hard shadow edges use the 
Max Level setting. The default values for Min and Max Level are 1x1 and 4x4. Note that 
the Min / Max Level settings apply to raytraced pixels only (see “Antialiasing and adaptive 
raytracing”, below).

If jaggies appear behind transparent 
objects, increase the Max Level 
setting.

Edges of hard shadows can also be 
smoothed by increasing the Max 
Level setting.

Use Object Properties

If this option is enabled, you can specify the Min/Max Level and the Threshold separately 
for each object using Compositing tags.

MIP Scale

Scales the MIP/SAT strength globally. For example, a MIP Scale of 200% doubles the MIP/
SAT strength for each material.
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Antialiasing and adaptive raytracing
BodyPaint 3D is an adaptive raytracer, meaning that it only uses raytracing for the pixels 
that really need it. All pixels that show reflections, transparencies or refractions are 
raytraced. All other pixels are rendered using much faster scanline rendering. 16x16 
antialiasing (i.e. a grid of 16 sub-pixels by 16 sub-pixels) is always used for scanline 
rendering. For raytracing, the Min/Max Level settings are used.

Radiosity, Caustics
These settings will be available only if you are using BodyPaint 3D with the Advanced 
Render module. For information on the Advanced Render module, contact your local 
MAXON representative or visit www.maxon.net. In particular, Advanced Render helps 
you to create natural lighting for your scenes, for pictures that look truly photographic.
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Effects

Use this page to control which post effects are rendered. To choose a post effect, click 
the Post Effect button in the top right corner of the dialog and choose the desired effect. 
The effect will then be added to the list below the Enable Post Effects option.

To remove post effects from this list, select those that you wish to delete (using Shift-
click) and press the Backspace key. You can also delete effects using Remove Selected 
and Remove All (Post Effect button).

To switch off a post effect, click its check mark. Click the check box to switch the effect 
back on.

 The order of the post effects is important. For example, if you sharpen before you soften, 
the result is different to softening first. To move a filter up or down the list, select the 
filter’s name in the list then click the up or down arrowhead near the top right corner of 
the dialog.

Click the up or down arrowhead to move the selected filter up or down the list.

 Post effects are generated after the image has been rendered. Therefore you won’t see 
the effect until the image is fully rendered.

Object Glow

 Glow effects are post processed effects, they are applied only after the picture is fully 
rendered; so you cannot see glow effects in reflections or through transparent objects.

Glow effects will be rendered if they are used in your scene.
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Lens Effects
Lens effects will be rendered if they are used in your scene. 

Remote
Use Remote if you want the picture to be passed to another application automatically. If 
you are using Windows, you can use a batch file with command parameters. If you are 
using a Macintosh, use AppleScript. Click the button with three dots to open a system 
dialog. Use this dialog to select the program to which the picture should be passed.

Median Filter
Removes peaks in color values from the image. Use Strength to increase or decrease the 
effect.

Sharpen Filter
This filter emphasizes transitions in the image. This reinforces the edges. Use Strength to 
increase or decrease the effect. Try using the filter with 30% strength for stills.

Soft Filter
Each pixel is balanced with its neighbor to produce a softer transition. Use Strength to 
increase or decrease the effect.

Object Motion Blur

 Use scene motion blur instead if you want to blur shadows, reflections and so on. Object 
motion blur does not blur these features.

   

With a real-life camera, motion blur arises when an object flies past the camera at great 
speed (object motion blur) or when the camera pans rapidly (scene motion blur). The 
advantages of object motion blur (OMB) are that the effect is rendered quickly and there 
are no stroboscope effects. For an object to have motion blur in the render, this setting 
must be enabled and the object must have a Motion Blur tag.
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Use the Strength value to define the intensity of blurring for all objects. The value can 
range from 0% to 200%.

Object motion blur is limited to a maximum frame size of 2,000 x 2,000 pixels and is 
automatically disabled at resolutions higher than this. Also note that particles cannot be 
blurred. Furthermore, avoid using OMB with post-processing effects (e.g. lens flares), 
since this may lead to unexpected results.

Scene Motion Blur

 Scene motion blur will also blur shadows, reflections and so on. Object motion blur, on 
the other hand, does not blur these.

With a real-life camera, motion blur arises when an object flies past the camera at great 
speed (object motion blur) or when the camera pans rapidly (scene motion blur). This 
motion blur helps to create the illusion of real motion rather than a sequence of still 
pictures and so it is of great use to animation software. Animation software does not use 
real shutters and real film, so the motion blur must be faked, see Figure 1, below.

Figure 1. Figure 2. Figure 3.

You can activate Scene Motion Blur (SMB) to simulate a camera panning swiftly. 
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Samples

With SMB, intermediate images are calculated and overlapped in the corresponding 
frame with varying brightness. Choose the number of intermediate images for each 
frame using this drop-down list. The higher you set this value, the longer it takes to 
render.

If the motion is rapid, you may need to use a high setting to avoid a stroboscope effect 
(Figure 2, above).

If you use scene motion blur in your scene you may be able to reduce the amount of 
antialiasing. Stationary elements in the frame are antialiased perfectly, whereas moving 
elements are not antialiased. Usually, objects in motion do not require antialiasing 
— consider a 16-times motion blur where there are 16 intermediate frames; in this case, 
the missing antialiasing makes no visible difference. You can, of course, add antialiasing, 
although with a motion blur of 9-times or higher it is not necessary and does little but 
increase the rendering time.

Strength

Defines the strength of the motion blur effect. In Figure 3, above, the pictures were 
rendered with 25-times SMB with Strength set to (from left to right) 20%, 40%, 60%, 
80% and 100%.

Dithering

You can use this option to dither the scene motion blur. This helps you to avoid 
stroboscope effects and in addition you can often use a lower SMB setting. However, the 
dithering may create slight noise. You can reduce the memory requirements for rendering 
by disabling dithering (set the value to 0%).

Antialiasing Restriction

If this option is enabled, BodyPaint 3D automatically switches Antialiasing (Antialiasing 
page) from Best to Geometry if Samples is set to 9 Times or higher. This is because 
Geometry antialiasing is quicker to render and Best is rarely required when a high 
Samples value.

Camera Offset

BodyPaint 3D creates an antialiasing effect by offsetting the camera slightly for each 
intermediate image. This causes slight blurring. If you want to switch off this effect — for 
example, if you’re creating a picture for print — disable this option.
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Cel Renderer
Using this post effect, you can render pictures in a cartoon style.

Color disabled (left) and enabled (right). Illumination enabled (left) and disabled (right).

Outline enabled (left) and disabled (right). Edges disabled (left) and enabled (right).

Edge Color black (left) and white (right). Background Color white (left) and black (right).
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Color

 The render time increases linearly with the number of polygons.

If this option is disabled, objects will usually be rendered with black outlines on a white 
background. When Color is enabled, all objects will be rendered using a reduced color 
palette and black outlines on a black background. This gives the rendered subjects a 
cartoon-like feel:

Illumination

 This option has an effect only when Color is enabled.

If this option is enabled, the shading of objects will be affected by the illumination. 
Shadows will also be rendered cartoon-style. If Illumination is disabled, the average color 
value of the top texture layer (the right-most texture in the Object manager) will be used 
to render the objects. As a result, each object has a monotone color. Also, shadows will 
not be rendered with the option disabled.

Outline

 The outline is drawn around the silhouette of individual objects only. For example, if you 
have connected an object group to form an individual object, only the overall silhouette 
will be outlined. You can change the color of the outline using Edge Color.

When enabled, an outline will be drawn around the silhouette of objects. If both the 
Color option and the Outline option are disabled, all you will see is the background color. 
With Color enabled, the outline will bring out the individual objects and give them a 
cartoon-like feel.

Edges

If this option is enabled, all polygon edges will be outlined in black, creating a shaded 
wireframe feel. You can change the color of the edges using Edge Color.
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Edge Color

Use this to change the color used by Outline and Edges — even if the Color option is 
disabled.

Background Color

This setting changes the background color provided that Color is disabled. When Color is 
enabled, the option has no effect.

Color Correction

Use this post effect to change the gamma, contrast and brightness of the image.
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Options

Active Objects Only

If this option is enabled, only the selected objects will be included when you render the 
scene.

Auto Light

When enabled, if there are no lights in your scene, BodyPaint 3D uses its auto light (a 
standard light source) during rendering so that you can at least see the objects.

Log File

If this option is enabled, a render log will be recorded in “Renderlog.txt” in the 
BodyPaint 3D folder. The render log contains a complete history of the render process 
including system resource information. Check this log if you need to identify problems 
that occurred while rendering. The information in the log file is not overwritten by 
subsequent renders. Rather, new log information is appended. As a result, this file can 
grow to a fair size over time. You may wish to delete the file manually every now and 
then — a new file will be created the next time the log is recorded.

Textures 

Using this option, you can enable or disable textures when rendering. For example, you 
can disable the textures for a test render or when using the cel renderer. If this option is 
enabled, textures will be rendered. If Textures is disabled, the average color value of the 
top texture layer (the right-most texture in the Object manager) will be rendered for each 
object. 

Cancel If Texture Error

If BodyPaint 3D cannot find a texture when rendering the scene, an alert dialog will 
appear. If this option is disabled and you confirm the alert, the rendering continues 
without the missing texture. If you enable this option, rendering will be cancelled after 
the alert.
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Blurry Effects

Use this option to enable/disable the blur effect for the Reflection and Transparency 
material channels.

Volumetric Lighting

Enable this option if you want shadows to be cast in visible light. Since the effect is 
processor-intensive, you may want to speed up test-renders by disabling the option.

Ray Depth

The Ray Depth value determines how many transparent objects (or areas made invisible 
using the alpha channel) can be penetrated by the renderer. The lower you set the Ray 
Depth, the fewer the number of objects that can be seen through. Those areas that 
cannot be penetrated are rendered black.

A Ray Depth of 1 means that calculations are finished for a pixel once its ray hits 
something in the scene. Transparencies and alphas therefore will not be visible. A value of 
2 means that after a ray has hit a surface a second ray is calculated for the transparency. 
The higher the Ray Depth, the further rays are followed into the scene and the results 
rendered. The results shown above contain transparencies and alphas and have been 
rendered with ray depths of 2, 4 and 8. You can enter values up to 50.
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Reflection Depth

When a ray is sent into the scene, it can be reflected by reflective surfaces. With certain 
arrangements, e.g. two mirrors opposite each other, it is possible that a ray will be 
reflected forever, trapped between the mirrors, and the raytracer would never finish 
rendering the picture. In order to prevent this, you can set the maximum number of 
reflected rays.

You can also use Reflection Depth to limit the render time for the picture. Often, only the 
first generation of reflections is important. Further rays tend to add little to the image 
quality but increase the render time considerably.

A Reflection Depth of 1 means that calculations for a pixel are finished once a ray hits 
something in the scene. Reflections therefore will not be visible. A value of 2 means that 
after a ray has hit a surface a second ray is calculated for the reflection. The higher the 
Reflection Depth, the further rays are followed into the scene and the results rendered. 
The results shown above contain reflective objects and have been rendered with 
reflection depths of 2, 4 and 8.

Shadow Depth

Calculations are made to see if a surface point lies in the shadow of another object; 
additional shadow rays are sent from the surface in the direction of the light source.
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The value you enter for this setting determines for which generation of rays shadows are 
calculated. For example, if you reduce the value to 2, shadows will not be rendered for 
reflected, transparent or refracted rays. The results shown above contain reflective and 
transparent objects and have been rendered with shadow depths of 2, 4 and 8

Threshold

This value helps to optimize render time. With complex scenes, particularly those 
containing many reflective and transparent surfaces, 90% of the processed rays 
contribute less than 10% to the general picture brightness and color. With a threshold 
value of, for instance, 15%, the rays stop their movement from the camera into the scene 
as soon as their brightness falls below this critical value.

What exactly does this mean? When a ray hits a surface, the values for transparency and 
reflection are calculated. For example, if Threshold is set to 15% and the surface has a 
material with 10% reflection (Brightness slider), the material will not reflect. In order to 
render the reflection in this case, Threshold must be set to 9% or less, or the reflection of 
the material must be set to 16% or higher.

Sometimes it is useful to increase the Threshold value to prevent minor details being 
reflected. Although minor details are calculated correctly, too much detail in reflections 
can distract the viewer. However, if you want all rays to be calculated, set Threshold to 
0%.

Level of Detail

 If you render into a viewport, the viewport’s level of detail value (Display menu) is used in 
preference. The Level of Detail value here in the render settings is only used for rendering 
to the Picture Viewer.

This value influences all objects in the active scene that support a reduction in detail, 
such as primitives and HyperNURBS. However, objects that have their own Level of Detail 
setting  defined in a Display tag will continue to use their setting. If the value is set to 
100%, the objects will be rendered in full detail. If the value is set to 50%, the objects 
will be rendered with only half their usual detail.
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Multi-Pass
 If you want to try out various lighting setups for your rendering, multi-pass is the ideal 

solution. The setups will be rendered more quickly as a single multi-pass file than as 
separate projects.

Multi-pass rendering makes it easy for you to post-edit your renders in compositing 
software such as Adobe Photoshop. With multi-pass you can split the BodyPaint 3D 
rendering into separate layers such as shadows, reflections, highlights and each separate 
light source. You can save the layers in RLA, RPF, Photoshop (PSD) and BodyPaint 3D 
(B3D) format.

Suppose you render a complex picture and the reflections are too strong. With multi-
pass, there is no need to re-render the BodyPaint 3D scene. Instead simply reduce 
the opacity of the reflections layer in your compositing package. Or why not include 
alternative lighting setups in the same rendering? You will then be able to pick the best 
setup during post-editing.

Enable Multi-Pass Rendering

Use this option to enable or disable multi-pass rendering.

Channels

The Channels drop-down list displays the layers which may be included in the multi-layer 
rendering. It also contains various relevant commands. Use the Channels drop-down 
list to add layers to or remove layers from the selection list. The items in the Channels 
drop-down list are:
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Add Image Layers

Adds to the selection list all image layers that form the composite image. These layers 
are: Ambient, Diffuse, Specular, Shadow, Reflection, Refraction, Atmosphere and 
Atmosphere (Multiply). All the other image layers (see “The layers”, below) may be 
used for visual effects but are not actually part of the composite image. 

If you have the Advanced Render module installed, Radiosity and Caustics layers are 
also added to the selection list by this command.

Add Material Layers, Add All

These commands are useful to plugin developers only.

Remove Selected

 To select a layer, click on its name in the selection list. To add a layer to those already 
selected, Shift-click or Ctrl-click the layer’s name.

Removes the selected layers from the list.

Remove All

Empties the selection list.

Blend Channel

Creates a blended layer. For example, you can blend Shadow, Specular and Reflection 
as a single layer. After choosing this command a dialog opens: enable the channels you 
want to blend then click OK.

Object Buffer

This creates a mask layer for objects that use a specified ID number in their 
Compositing tags. After choosing this command, the Object Buffer dialog open. Enter 
the desired ID number then click OK.

 To assign an ID to an object, use a Compositing tag.

The sphere appears in both object buffers since its 
Compositing tag has two IDs (ID=1 and ID=2).
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The layers

RGBA Image. Shadow. Depth.

Reflection. Refraction. Specular.

The lower part of the Channels drop-down list shows the layers that you can add to 
the multi-pass rendering, a selection of which is illustrated above. These are RGBA 
Image, Ambient, Diffuse, Specular, Shadow, Reflection, Refraction, Radiosity, Caustics, 
Atmosphere, Atmosphere Multiply, Illumination and Depth (the remaining layers in the 
list — i.e. those whose names begin with “Material”, are of use to plugin developers 
only).

The Radiosity and Caustics layers contain the effects created by radiosity and caustics 
and are of use only if the optional Advanced Render module is installed.

The RGBA layer is the complete image — the same image as with normal rendering. 
An alpha channel will be included if Alpha Channel is enabled on the Save page of the 
render settings.

The Ambient layer shows the illumination generated by an Environment object if used.

Atmosphere adds a layer for environment fog and volumetric effects such as volumetric 
light. Atmosphere (Multiply) can be used optionally with Atmosphere to help conceal 
objects that are behind the volumetric effects (a multiplied atmosphere layer is used).

Illumination adds a layer for the color and brightness of surfaces illuminated by light 
sources.

Depth adds a depth map — object surfaces are shaded in grayscale according to their 
distance from the camera. The closer a surface is to the camera, the darker its shading 
in the depth map.
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The illustration above shows a Depth multi-pass channel rendered with Front Blur and 
Rear Blur enabled on the Camera’s Depth of Field page in the Attribute manager.

Depth multi-pass channel with Front Blur and 
Rear Blur enabled.

The Depth channel defines the distribution of depth in the scene. This information can 
be used in compositing applications to create visual effects. Black parts represent the 
focus (Target Distance on the Camera’s Depth of Field page in the Attribute manager).

 The contrast of the grayscale Depth channel is controlled by the camera’s blur settings. 
For full contrast, set the Start value for Front Focus to immediately before the object 
closest to the camera. Set the End value for Rear Focus to immediately after the object 
farthest from the camera. The easiest way to set these values is to drag the camera’s 
handles in the viewport.

Save Multi-Pass Image

 You can view specific layers using the Picture viewer’s Channels menu.

Enable this option if you want the multi-pass image to be saved when you render to the 
Picture viewer.

Multi-Layer File

 The image may look different when viewed in another application. For example, 
Photoshop has no true Add mode and so highlights may look washed out and need 
correcting. You may also notice differences between a normal picture and a multi-pass 
image when using a combination of colored lights, especially if the lights are brighter than 
100%.

If this option is enabled, all layers are saved in a multi-layer file. In addition, you must set 
Format on the Output page to Photoshop (PSD), RLA, RPF or BodyPaint 3D (B3D). If the 
option is disabled, BodyPaint 3D creates a separate file for each pass using the Format 
setting on the Save page. A suffix is added to each of the filenames to differentiate them.
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Shadow Correction

Enable Shadow Correction to prevent artefacts from appearing at the 
edges of objects.

When rendering multi-passes with shadows switched on, slight artefacts such as bright 
lines may appear at object edges due to antialiasing. To prevent these artefacts from 
appearing, enable this option.

Separate Lights

Use Separate Lights to choose which light sources have their own separate layers.

None

No separate layers.

All

Each light has separate layers.

Selected

Separate layers for all lights whose Separate Pass option is enabled (Details page).

Mode

Use Mode to control how the diffuse, specular and shadow information is layered for 
each light source that has its own layers.

1 Channel: Diffuse+Specular+Shadow

Adds one blended layer for Diffuse, Specular and Shadow.
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2 Channels: Diffuse+Specular, Shadow

Adds one blended layer for Diffuse and Specular, and one layer for Shadow.

3 Channels: Diffuse, Specular, Shadow

Adds one Diffuse layer, one Specular layer and one Shadow layer.

Path

This is where you set the save path for the file.

Format

Here, choose the file format. For a multi-layer file, choose Photoshop (PSD), RLA, RPF or 
BodyPaint 3D (B3D).

Options

This button is ghosted unless the format chosen has extra options. To access these, click 
Options.

Depth

Sets the channel depth to 8 bits or 16 bits.

Layer Name As Suffix

If your chosen format does not support multi-layers, each layer will be saved as a 
separate file. If this option is enabled, the name of the layer, such as “_diffuse” or          
“_refraction”, is added after the filenames. 

QuickTime VR
 This feature is only useful if you are using the BodyPaint 3D module with CINEMA 4D. 

Please see the CINEMA 4D reference manual for details.
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Most of the following menu entries activate a window or manager. If the window 
or manager is already open, the call brings it to the front. Otherwise the window or 
manager appears in a new, freestanding  window. To dock this into the interface, drag 
the window’s pin icon and drop it where you want the window to be docked. A black line 
appears while you drag to indicate the docking position.

Layout
In this menu you’ll find commands that enable you to modify the workspace to suit the 
way you like to work. See Chapter 3, Configuration, and Chapter 4, Workflow.

New Icon Palette
Opens a new, empty toolbar in its own window. You can populate this toolbar with icons 
from the Command manager. See Chapter 3, Configuration.

New Group Window
Opens a new group window. A group window is a window containing two or more 
managers whose shared border you can drag to resize. To place a manager inside the 
group window, drag the manager’s pin icon and drop it within the group window. A 
black line appears while you drag to indicate where the manager will be placed.

Load Toolbar
If you’ve saved a toolbar (aka command palette), you can load it using this command.

Edit Palettes
Enables the edit palettes mode and opens the Command manager. The icons are shown 
with blue edges to indicate that you can edit them. For example, you can drag icons from 
the Command manager and drop them onto any palette. To exit the edit palettes mode, 
close the Command manager or disable this option.

Load Layout
Use this command to load a saved layout.

19 Window Menu
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Reset Layout
This command resets your BodyPaint 3D layout to the original, preset layout. This is 
particularly useful if you need to call our support team since you and they then have 
a common interface from which to work. Your own customized layouts can increase 
your workflow enormously but when searching for an elusive problem a common, 
standardized layout is essential.

Save As Startup Layout
Save the visible working environment as the default layout (“layout.l4d”). When you next 
start BodyPaint 3D, this is the layout that will be used.

Save Layout As
This command lets you save the current layout. You can create as many layouts as you 
wish, such as one modeling and one for texturing. Layout files take the extension “.l4d”.

Command Manager

Opens the Command manager. In this manager you’ll find a list of all commands in 
BodyPaint 3D, including their icons and keyboard shortcuts. You can rearrange existing 
palettes, create your own palettes and change the short-cuts and hotkeys. See Chapter 3, 
Configuration.



338 • CHAPTER 19 WINDOW MENU • 339

Menu Manager

You can use this manager to rearrange BodyPaint 3D’s menus. You can revert to the 
original structure at any time by clicking the Revert To Original button.

Default Layouts
Below the Menu Manager command you’ll find a list of all layouts in the “library/layout” 
location within the program’s folder. To load one of these layouts, choose its name from 
the list.

Default Menus
At the bottom of the Window > Layout menu you’ll find a list of default main menus. 
The “Menu User X” entries are main menus which you can configure. BodyPaint 3D keeps 
track of which main menu you have selected for which layout and saves this information. 
Each time you start the program and choose a layout, the main menu you selected for it 
is loaded automatically.
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CINEMA 4D
Picture Viewer

This opens the Picture viewer. Most of the time you won’t need to use this command 
since the Picture viewer opens automatically when you choose the Render To Picture 
Viewer command.

Coordinate Manager

Opens the Coordinate manager, if it is not already open, and brings it to the front if it 
is hidden behind any other windows. This compact manager is useful for editing the 
position, scale and rotation of objects.
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Structure Manager

Opens the Structure manager, if it is not already open, and brings it to the front if it is 
hidden behind any other windows. Here you can view and edit the numerical data of 
points, polygons, UVW coordinates and vertex maps.

Console
The Console window is used for the output and control of C.O.F.F.E.E. programs. 
C.O.F.F.E.E. print commands are displayed here, as are errors. In the case of errors, the 
error number and the position of the error within the script are shown.

Global Status Bar
This opens the Global Status Bar, which displays information such as the render time, in a 
separate window. By default, this bar is docked at the bottom of the main window.

New View Panel
You can open as many view panels as you wish.

New Texture View
You can open multiple texture views.  If you click the lock icon in the top right corner of 
the Texture view, the current texture will remain displayed in the view even if you select 
other objects.
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Layer Manager

Most of the time you won’t need to use the Layer manager because its functions are now 
integrated into the Material manager.

Attribute Manager

You’ll use this manager frequently. Here you can edit all object properties.

Active Tool Manager
Many of BodyPaint 3D’s tools have settings that you can adjust in the Active Tool 
window. When using a tool for the first time, always check this manager to see if the tool 
has settings. Often these settings will enable you to use the tool more effectively. For 
example, here you can change the size of the selection brush for the Live Selection tool.
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Color Settings

Here you can choose the foreground and background colors for the active painting tool. 
See Chapter 6, Color.

Brush Presets

This command opens the brush presets. Here you can access the default brushes and well 
as your own saved brushes. You can also access the brush presets by clicking the brush 
preview in the top left corner of the Active Tool manager.
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Color Presets

This command opens the color presets. Here you can access the default colors and 
patterns as well as your own saved colors and patterns. You can also access the color 
presets by clicking the color preview in the top left corner of the Color manager.

Object Manager

Opens the Object manager, if it is not already open, and brings it to the front if it is 
hidden behind any other windows. Using this manager, you can select objects (even 
those that are not visible in the viewport), change the object hierarchy, add tags and 
expressions and much more.
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Material Manager

Opens the Material manager, if it is not already open, and brings it to the front if it is 
hidden behind any other windows. This holds all of the scene’s materials and textures. 
You can assign a material to an object using drag-and-drop; drag the material onto the 
name of the appropriate object in the Object manager or directly onto the object in the 
viewport.

Browser

Opens the Browser, if it is not already open, and brings it to the front if it is hidden 
behind any other windows. Use this to manage your projects and control your digital 
assets. Create catalog files of scenes, audio clips, textures and more, then quickly add 
them to your project via drag-and-drop. For example, to add model of a mug to the 
current scene, drag the thumbnail for the mug that you want to add and drop it within 
the Object manager.
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Other Scene Windows
BodyPaint 3D allows you to have multiple scenes loaded. At the foot of the Window 
menu you’ll find a list of all scenes that are currently open. To activate one of these 
scenes, choose its name from the list. Only one scene may be active and editable at 
a time (indicated by a check mark next to its name in the list). The order of the list is 
determined by the order in which you opened the scenes.



20 Help Menu
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MAXON Online
Get the latest BodyPaint 3D updates, news, support issues, tutorials and more using 
these links to the MAXON website. An Internet browser and Internet connection are 
required.

Help (BodyPaint 3D)
This opens the online manual copied to your hard drive during the standard installation 
process.

Personalize
 Your initial serial number will expire after three months of use, after which you will no 

longer be able to use the program. Please register at the earliest opportunity.

This opens the Registration dialog so you can enter the final serial number of 
BodyPaint 3D. You will receive your final serial number once you have registered your 
purchase with MAXON Computer or your local MAXON distributor. You can register by 
completing the registration card that was included with your MAXON software, or you 
can register online at register.maxon.net.

 Under Windows NT (SP4), Windows 2000 or Windows XP Professional, you must have 
Administrator privileges in order to properly install software, otherwise you will be 
prompted to enter the serial number each time you start BodyPaint 3D or one of its 
modules. Ask your system administrator for help if you need assistance.

Info
This opens the same info screen that appears while the program loads. Use this screen 
to check the version number of BodyPaint 3D — please quote this when contacting our 
Technical Support department. To close the window, click on it.

20 Help Menu
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The Object manager is the center of object administration in BodyPaint 3D. Here you 
can select objects, change object hierarchies and manipulate tags. On the left part of 
the manager you’ll find a list of all objects in the scene. Hierarchies are shown as a tree 
structure.

You can collapse and open hierarchies, just as you can on your computer desktop. You 
can use drag-and-drop to re-group or, by holding down Ctrl while you drag, copy 
objects. You can identify an object’s type (e.g. HyperNURBS) by its icon. Objects are 
discussed in the Objects Menu chapter, starting on page 127. To select multiple objects, 
Shift-click each object that you want to add to the selection.

The narrow column running down the center of the Object manager contains two 
visibility dots for each object. These control the viewport and render visibility of the 
object and are described detail later in this chapter. For generator and deformer objects 
such as HyperNURBS, this narrow column also contains an enable switch, which you can 
use to switch the generation or deformation on or off. The visibility dots and the enable 
switch are described in more detail later in this chapter.

21 Object Manager
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To the right of the dots are the object tags (e.g. Texture tag, Phong tag). You can use 
drag-and-drop to move or copy these tags to other objects. Again, the tags are described 
in detail later in this chapter.

Many commands can be reached in the Object manager, using the context menu. To 
access the context menu, right-click (Windows) or Command-click (Mac OS) an element 
such as a type icon, a tag or a visibility dot. The commands shown will depend on the 
type of element from which you selected the menu.

 When you load scenes from other programs such as LightWave, each object will 
probably have only have one tag: the Polygon tag. However, when you load scenes from 
CINEMA 4D, each object may have several tags which are not documented in this manual. 
Please ignore these tags — they have no function in BodyPaint 3D.

When you select a command in the Object manager, it is applied to the selected object or 
objects.

Drag-and-drop
Drag-and-drop is the technique of clicking on an object, holding down the mouse button 
and dragging the object to another position; when the target location is reached, you 
release the mouse button and the object will be dropped there. Depending on the target 
location, this may have different results.

Rearranging objects

There are many ways to re-arrange objects in the Object manager and these are 
described below. The icon on the left shows how the mouse pointer changes while doing 
the action described on the right.

Drag an object between two others or to the end of the list.

If you want drag to create a copy, use Ctrl-drag.

To change the object hierarchy, drag the object on top of an existing one in the 
list. This makes the dragged object a child of the other.

If you want to create a copy and make it a child of another object, use Ctrl-
drag and move the mouse pointer over an object.

You can also drag-and-drop tags. To transfer a tag from one object to another, 
drag the tag icon on to the line of the other object.

If you want to create a copy, use Ctrl-drag.

If an operation is not available, this icon appears.
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You can select multiple tags and move them all at the same time. However, note that for 
some tag types, only one tag may be used per object.  For example, an object may have 
one Phong tag only. These tags are known as “lone” tags. A lone tag will not be moved 
or copied if a tag of the same type exists for the destination object.

Each object in BodyPaint 3D, such as Polygon object, has a set of properties. To access 
an object’s settings, select the object and its parameters will be shown in the Attribute 
manager.

Mouse techniques

Function Action

Select object Click on the object.

Rename object Double-click on the object name (you can also rename the 
selected objects on the Basic Properties page of the Attribute 
manager).

Edit object Click on the object and edit its parameters in the Attribute 
manager.

Select tag Click on the tag.

Edit tag Click on the tag and edit its parameters in the Attribute 
manager.

Move selected object or 
tag

Drag-and-drop.

Copy selected object or  
tag

Ctrl-drag-and-drop.

Open/close object 
hierarchy

Click on the icon to the left of the object name.

Select previous / next 
object

Up / down cursor keys.

Context menu Right-click (Windows) or Command-click (Mac OS) on the 
name, the type icon, the visibility dot, the enable switch or 
the tag.

Select multiple objects or 
tags

Drag a frame around the objects or tags, or Shift-click each 
object or tag that you want to add to the selection.

Deselect object or tag Ctrl-click the object or tag to remove it from the selection.

Deselect all Click on an empty space within the Object manager.
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File Menu

New Tag
 For compatibility reasons, this menu contains all the tags that are available in CINEMA 4D. 

However, only some of these tags are actually useful in BodyPaint 3D. In these pages, 
you’ll find descriptions for all of these useful tags. Please ignore the following tags, 
however, which do nothing in BodyPaint 3D and are not documented in this manual: 
Achor Tag, Kinematic Tag, Metaball Tag, Motion Blur Tag, Restriction Tag, Stick Texture 
Tag, Stop Tag.

You can add a variety of properties to objects using tags. For example, you can add 
smoothing (Phong tag) or prevent an object from being edited accidentally (Protection 
tag). To add a tag to an object, select the object or objects that should receive the tag 
and choose the desired tag from this menu.

To display the tag’s settings in the Attribute manager, select the tag. 

Compositing Tag

This tag contains several options that affect rendering.

Cast Shadows, Receive Shadows

Sometimes it is useful to prevent objects from casting or receiving shadows, especially 
for technical illustrations. In such cases, disable these options.
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Seen By Camera, Seen By Rays

Normal object. Visible object. Invisible object.

Using these options, you can hide specific objects from reflections or have invisible 
objects cast shadows. There are many possible uses here. For example, you can have a 
hidden object block out light to cast shadows where you want them. Or perhaps you’re 
rendering an advert for a high performance sports car and you don’t want the 3D text to 
be reflected by the car or shiny floor.

Disable Seen By Camera to hide the object; disable Seen By Rays to hide its reflection.

You can combine the two options. For example, you can create a visible object which 
casts no shadow, receives no shadows, has no reflection and cannot be seen behind glass; 
or perhaps an invisible object which casts a shadow, can be reflected and can be seen 
behind glass.

Seen By GI

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see your CINEMA 4D reference manual for details.

Compositing Background

This option will cause the object to be self-illuminated yet still receive shadows.

 The object in question (in our example below, the floor) must have its own material.
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 Suppose you are creating a cartoon character for a website. The website uses a white 
background and you need to render the character so that it appears to cast a shadow 
onto the web page.

 

 You create a floor with a white material (with the RGB values matching the white color 
of the web page), but when you render the picture, the floor is not of the correct 
brightness. To remedy, add a Compositing tag to the Floor object and enable Background 
Compositing. The floor will now illuminate itself evenly and with full brightness while still 
receiving the character’s shadow.

Force Antialiasing, Min, Max, Threshold

 The Threshold value you enter here is used only if it is lower (i.e. more accurate) than the 
Threshold value in the render settings. Otherwise the value in the render settings is used. 
This ensures the object always uses the most accurate Threshold. Likewise, the best Min 
and Max values are used.

 The settings have an effect only if Use Object Properties is enabled in the Render Settings 
(Antialiasing page).

Antialiasing is defined globally in the render settings (Antialiasing page). To override the 
global settings on a per-object basis, enable Force Antialiasing and set Min, Max and 
Threshold to the desired values.

GI Accuracy

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see your CINEMA 4D reference manual for details.
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Add to Object Buffer

Use this page to specify up to six object buffer IDs for the object.

Display Tag

Display Mode, Backface Culling, Use Textures

Usually, objects use the display settings defined on the Display menu of the viewport. 
However, you can override these settings for specific objects by assigning them Display tags. 
These objects will then use the settings in their Display tags instead of those on the Display 
menu.

Display tags enable you to mix display modes within a viewport. For example, some 
objects may use Gouraud Shading, others Wireframe. The main reason for using Display 
tags is to prevent the viewport from slowing down — you can use a detailed mode such 
as Gouraud shading for the objects you’re currently interested in and have the other 
objects shaded with a less detailed mode such as wireframe.

Note that Display tags are used only if Use Display Property is enabled. You’ll find this 
option on the viewport’s Display menu. The option is enabled by default.
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Level Of Detail

 If the tag’s Level Of Detail option is enabled, it is always used in a viewport, even if Use 
Display Property is disabled on the viewport’s Display menu.

This has the same effect as the command of the same name in the project settings. You 
can use it to control the level of detail for generators and deformers. The tag’s value is 
used in preference to the value in the Project Settings. For example, you can set the Level 
of Detail in the Project Settings to 50% and assign a display tag with Level of Detail set 
to 100% to the object that you are currently working on. This will ensure the object is 
shaded in full detail while the other, currently less important objects use a reduced level 
of detail. This makes for faster redraw in the viewport.

Visibility

This parameter controls the visibility of the object when rendered. For example, if you 
set Visibility to 0%, the object will be invisible when rendered. With a setting of 50%, 
the object will be partially visible (50% opaque). At 100%, the object will be fully visible 
when rendered. Note that when you set Visibility to 0%, the object becomes invisible in 
the viewport.

HyperNURBS Weight Tag

This tag stores weighting information. It is created automatically when you weight a 
HyperNURBS object.
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Phong Tag

This tag gives objects a smooth appearance. The picture below shows a sphere before 
(left) and after (right) a Phong tag is applied. Look closely at the right sphere and you’ll 
notice straight lines around the silhouette. Phong shading does not increase the number 
of polygons. Rather, think of it as an illusion that loses its effect around the silhouette. To 
smooth the silhouette region, increase the subdivisions (perhaps try using a HyperNURBS 
object). To specify the maximum smoothing angle, enable Angle Limit and enter the 
desired angle into the text box. Use Edge Breaks influences the Phong shading for objects 
that have edge breaks.

No Phong tag (left), Phong tag applied (right).

The cylinders below demonstrate the effect of the smoothing angle. The left cylinder has 
smoothing with no angle limit specified (all angles are smoothed), the middle cylinder 
has an angle limit of 89.5° and the right cylinder has no smoothing.

No angle limit (left), 89.5 angle limit (center), no smoothing (right).

When BodyPaint 3D calculates the Phong shading, it assumes that the surface normals 
are aligned. If this is not the case, shading anomalies may appear. All primitive objects 
are aligned by default.
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Smoothing is a good way to reduce render time and save on memory. Without the 
Phong tag, an object would require a far greater number of polygons in order to appear 
smooth. Note that smoothing can only take place across connected surfaces (surfaces 
that share points).

How Phong shading works

Each surface has a normal (often called a “surface normal”) that is perpendicular to 
its surface. The color and brightness of a point is determined by the angles which the 
normal forms with the rays of the camera and the light sources. Without smoothing, two 
connected surfaces will have a hard transition, since each surface has its own normal. 
This will cause brightness bands.

 To see the normals, select their polygons. For example, create a sphere and choose Make 
Editable (this will convert the sphere to polygons). Select the Polygon tool from the left 
toolbar and select some polygons using one of the selection tools). The normals appear as 
thin, white lines perpendicular to the surface. To align normals, choose Align Normals.

If a Phong tag is activated, the normals will be interpolated. There will be a soft transition 
between one normal and the next (provided that the surfaces are connected). If a Phong 
tag is not applied, there will be no interpolation.

Figure 1. Figure 1a: light course. Figure 2. Figure 2a: light course.

Figure 1 shows three connected surfaces. The middle surface is not aligned to the other 
surfaces (you can tell by the direction of the normals). Figure 1a illustrates how the 
normals are interpolated for smoothing. The light bar shows the hard transition caused 
by the non-alignment.

Figure 2 shows the same three surfaces, but this time they are aligned. Notice how the 
interpolation (Figure 2a) is much smoother this time. The light bar is smoother as a result.

These pictures illustrate why it is important for surfaces to be aligned. The convention 
is that the normals should point outwards from the object. For example, if you have an 
apple, the normals should point outwards into the world, not inwards towards the core.

The normal direction plays an important part in decal mapping such as when you put 
labels onto bottles. All primitive objects are created with aligned normals (you do not 
need to edit their normals — they will be correct).
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Protection Tag

 The Protection tag prevents scaling with the object tool, but not with the model tool.

Use this tag to prevent accidental changes to an object. You’ll be unable to move, scale 
or rotate any object that has this tag. You’ll need to remove the tag before you can make 
any such changes.

Restriction Tag

You can use this tag to restrict a deformer’s effect to a selection of points. You can enter 
up to six selections for the tag and define the strength of the deformation in each case.

Texture Tag

 If a child object has no Texture tags applied to it, it uses the Texture tag(s) of its parent. 
However, there is an exception. If a light has no Texture tag and is a child of another light, 
it will not inherit its parent’s Texture tags. This is to prevent child lights receiving gels 
automatically.

This command creates a new texture geometry. Initially, no material is assigned. To assign 
a material, drag the material’s preview from the Material manager and drop it into the 
tag’s Material box on the Tag page of the Attribute manager. You can also select multiple 
Texture tags and assign a material to all of them at the same time.

You can assign as many Texture tags as you like to an object. This allows you to apply 
several texture layers to the same object. The texture priority increases to the right in the 
Object manager. In other words, the right-most texture is the top layer, the left-most 
texture is the bottom layer and the other textures are between these. The top layer will 
cover the object completely unless it is limited in size or has an alpha channel enabled.
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WWW Tag

You can assign a URL to an object. This is useful if you are creating VRML files for the 
Internet. These VRML files (.wrl) contain complete 3D scenes and can be viewed in web 
browsers provided that you have an appropriate VRML plugin. The viewer can click on a 
3D object that has a WWW tag in order to link to an Internet address.

URL contains the link address. Enter the complete address, including the prefix such as 
‘http://’, ‘ftp://’, or ‘https://’. Use Info to define the text that will appear when the mouse 
pointer is positioned over the object in the web browser.

C.O.F.F.E.E. Error Tag

You won’t find this tag listed on the New Tag menu. Rather, it appears automatically 
when you load a scene that uses plugin tags and you don’t have the plugin installed or 
when a C.O.F.F.E.E. error occurs (if you see C.O.F.F.E.E. errors, please contact the plugin’s 
author).

New Expression
These expressions have no function in BodyPaint 3D and are included for compatibility 
reasons. Please ignore them.

Restore Selection
This submenu displays a list of frozen selection for the active object. Click on the name 
of a selection to restore it. BodyPaint 3D will switch to the appropriate mode for the 
selection automatically (points mode, polygons mode or edges mode depending on 
which type of selection the tag stores).

You can also select this command, as well as others, on the Attribute manager’s Tag page 
provided that the Selection tag is selected.
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Load Object
You can use this command to load a file containing object information such as DXF, 
BodyPaint 3D, Illustrator path and so on. The objects and materials in the file will be 
loaded into the active scene.

Save Object As
This command saves the selected object. The system dialog for saving files will open, 
which you can then use to save the object to hard disk.

Display Tags
You can use this option to show or hide tags in the Object manager.

Close
This command closes the Object manager.
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Edit Menu
Undo
Undoes the last change, restoring the scene to its previous state. For example, if you 
accidentally move an object, choose Undo to restore the object to its correct position. 
Choose Undo repeatedly to undo the changes one by one.

Redo
Redo redoes a change. Select Redo repeatedly to continue restoring the changes. You can 
traverse the recent development stages of your scene by using Undo to move backwards and 
Redo to move forwards. 

Cut
Deletes the selected objects or elements from the current scene and copies them (including 
materials) to the clipboard. The objects can be copied back from the clipboard with the Paste 
command.

Copy
 You can copy and paste objects using drag-and-drop in the Object manager. Ctrl-drag 

one of the selected object’s names to a new position within the Object manager.

Copies the selected objects or elements (including materials) to the clipboard. The 
objects can be copied from the clipboard to the active scene with the Paste command. 
You can paste repeatedly to create additional copies.

Paste
Inserts the contents of the clipboard (i.e. the last objects that were cut or copied there) into 
the active scene.

Delete
Deletes the selected objects or elements from the current scene without copying them to 
the clipboard.

Select All, Deselect All
These commands select or deselect all objects.

Select Children
Adds the children of the selected object(s) to the selection.
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Objects Menu
Object Display
 You can also set the following properties on the Basic Properties page of the Attribute 

manager.

The items in this menu control the viewport and render visibility for the selected object. 
Alternatively, you can change the visibility using the visibility dots in the middle column 
of the Object manager:

Both dots are grey by default. The upper dot controls viewport visibility, the lower dot 
render visibility. Each dot has three states: grey, green and red.

 To apply a status to all child objects, Ctrl-click the parent object’s dot. The status will be 
transferred to all its child objects.

Editor Unchanged (upper dot gray)

The object adopts the viewport visibility of its immediate parent. If the object is on the 
top hierarchy level (i.e. has no parent), it will be displayed as normal. Editor Unchanged is 
the default setting for new objects.

Editor On (upper dot green)

The object will be visible in the viewport, even if the hierarchy parent is invisible (red).

Editor Off (upper dot red)

The object is hidden in the viewport, even if the hierarchy parent is visible (green).

Renderer Unchanged (lower dot gray)

The object adopts the render visibility of its parent. If the object is on the top hierarchy 
level (i.e. has no parent), it will be rendered as normal. This is the default setting for a 
new object.

Renderer On (lower dot green)

The object will be visible in the render, even if the hierarchy parent is invisible (red).

Renderer Off (lower dot red)

The object is not displayed in the render, even if the hierarchy parent is visible (green).

Object Activation

This option switches the selected HyperNURBS object on or off.



368 • CHAPTER 21 OBJECT MANAGER • 369

Edit Object
This command is only of use if the Attribute manager is closed. It opens the Attribute 
manager, where you can then edit the parameters of the selected object. You can also 
open the Attribute manager by double-clicking a type icon.

Don’t use this command if the Attribute manager is already open and you want to edit 
an object. Instead, in the Object manager, select the objects that you want to edit. Their 
parameters will then appear in the Attribute manager, where you can edit them.

Rename Object
You can use this command to change an object’s name. You can also call this command 
by double-clicking on the object’s name.

Group Objects
You can use this command to group objects in the Object manager. To group objects, 
select the objects that you want to group and choose Group Objects. A Null object is 
created and the selected objects (including their children) are placed inside the null. 
Existing hierarchies are preserved within the new group.

Expand Object Group
This command is the reverse of Group Objects. It removes all objects from the group 
and places them on the same hierarchy level as the group’s parent Null object. Existing 
hierarchies within the group are preserved.

Make Editable
See “Make Editable” on page 284.

Connect
Creates a single object from multiple seleceted polygon objects. Note that the original 
objects are preserved. Delete these if they are no longer required.

Select Children
Adds the children of the selected objects to the selection.
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Object Information

This command displays the following information about the selected object (including 
its children): size in KB, number of points, number of polygons and number of objects. 
If you see figures in brackets, these are the number of points and polygons that will be 
created if you make the object and its children editable.

Scene Information

This command displays the following information about the scene: size in KB, number 
of points, number of polygons and number of objects. You are not required to select an 
object before using this command.  If you see figures in brackets, these are the number 
of points and polygons that will be created if you make all objects in the scene editable.

Search First Active Object
When working with a complex scene that has hundreds of objects, it can take a while to 
find the object you want in the Object manager. In these cases you may find it quicker to 
click the object in the viewport and choose Search First Active Object. The selected object 
will then be shown in the Object manager. The manager will scroll and the hierarchy tree 
will be opened if necessary.

Fold All
This command collapses all hierarchies. In this state, objects take up the least amount of 
space in the Object manager.
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Unfold All
 Proceed with caution if your scene is very large. In these cases you may want to unfold 

the hierarchies by hand. Large projects often have more than 1,000 objects. The display 
speed will be just as slow as if 1,000 files were to be displayed hierarchically in your 
operating system’s window. You can find out the number of objects in your scene by 
choosing Objects > Scene Information.

This command is the reverse of Fold All (see above) — it expands all hierarchies. In this 
state, objects take up the most space in the Object manager. The advantage is that all 
objects will be visible (although you may need to use the scroll bar).
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Tags Menu
Edit Tag
This command is only of use if the Attribute manager is closed. It opens the Attribute 
manager, where you can then edit the parameters of the selected tag. You can also open 
the Attribute manager by double-clicking a tag.

Don’t use this command if the Attribute manager is already open and you want to edit 
a tag. Instead, in the Object manager, select the tag or tags that you want to edit. Their 
parameters will then appear in the Attribute manager, where you can edit them.

Copy Tag To Children
If you select this command, the selected tag will be copied to all child objects of 
the active object. If a child object already has a tag of the same type, its tag will be 
overwritten with that of the parent. There is one exception, the Texture tag. This tag is 
still copied, but the child will keep its own tag as well (an object can have more than one 
Texture tag).

Select Identical Child Tags
Using this command, you can select like child tags. For example, suppose you want to 
change the material used by a parent object and all its children. To do this the most 
efficient way, you first need to select all of these tags, and this command gives you a 
quick way to do this. Select the Texture tag of the parent and choose the command to 
select the Texture tags of the relevant children as well. You can now proceed to assign 
the new material to all the tags — drag the desired material from the Object manager 
and drop it into the Material box on the Attribute manager’s Tag page.
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Texture Menu
Generate UVW Coordinates
You can use this command to generate UVW coordinates. This is especially useful for 
imported objects that do not have UVW coordinates. UVW coordinates prevent a texture 
from ‘slipping’ when you deform the object. You generate UVW coordinates starting 
from a normal projection mode such as Flat.

To generate UVW coordinates

-  Create a texture, allocate it to the object and set the desired projection type such as 
Flat.

-  Generate UVW coordinates.

-  Deform the object.

The effect of UVW coordinates is demonstrated in the picture above. The object to the 
left uses Cubic mapping. The texture slips when the object is deformed. The texture for 
the object to the right does not slip since its original cubic mapping has been fixed in 
place with UVW coordinates. You may use more than one UVW geometry to texture an 
object. To do this, add a new Texture tag to the object  and set the desired projection 
type, such as flat mapping for a label. Next, choose Generate UVW coordinates. A new 
UVW geometry will be created and the selected Texture tag will switch over to UVW 
mapping so that the texture is fixed to the object’s surface.

Assign UVW Coordinates
 Selective UVW mapping is intended for you to optimize projection for a single texture. If 

you want to use more than one texture, use the Texture tag’s Selection parameter.

 If the object has no UVW coordinates (i.e. no UVW tag), new coordinates are created 
automatically.

This command enables you to texture an object with several different projection types 
using a single UVW geometry and a single Texture tag.
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To assign UVW coordinates

-  Create a sphere and convert it into a polygon object with Make Editable.

-  Create a new material with a texture, e.g. the Checkerboard shader, and allocate it to 
the sphere.

-  Change the projection type from UVW Mapping to e.g. Flat.

-  Select the Polygons tool from the left toolbar and select several polygons.

-  In the Object manager, choose Texture > Assign UVW Coordinates.

-  The selected polygons use Flat projection while the unselected polygons continue to 
use the normal UVW mapping. If you deform the object, the texture remains fixed in 
the selected region as well.

Lock UVW

This option is especially useful when you are working with scenes imported from other 
3D programs. It prevents you from accidentally making changes to the UVs by making 
them uneditable for as long as the option is enabled.

Fit To Object, Fit To Image, Fit To Region

Fit to Object. Fit to Image. Fit to Region.

Fit To Object

If you select this command, the texture will be made to cover the object completely 
— the texture will have a length of 100% in both the X and Y directions.
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Fit To Image

You must apply your texture with Flat projection if you want to use this command. Type 
the name of an image into the dialog. BodyPaint 3D calculates the image’s X and Y 
resolution and scales the texture image accordingly. You can use this command to ensure 
that your texture uses the correct proportions, thereby avoiding distortion.

Fit To Region

You must apply your texture with Flat projection if you want to use this command. Use 
the mouse to drag a box. BodyPaint 3D fits the projection to this box.

Adapt To Object Axis, Adapt To World Axis, Adapt To View

Adapt to Object Axis. Adapt to World Axis. Adapt to View.

Adapt To Object Axis and Adapt To World Axis rotate the texture axes in such a way that 
they are parallel to the object axes or world axes. Adapt to View rotates the texture axes 
so that the texture is perpendicular to the viewing perspective. For a 3D viewport, this is 
the camera plane; for all other viewports, it is the work surface.

Mirror Horizontally, Mirror Vertically

Mirror Horizontally. Mirror Vertically.

Mirror Horizontally flips the texture horizontally. This effect is the same as if you were to 
view the texture’s reflection in a real mirror. Mirror Vertically flips the texture vertically, 
effectively turning the texture upside-down.
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22 Objects 

© Benedict Campbell.

Objects aren’t just the objects you can see in the picture; they are all the element in 
the Object manager’s left column such as Phong tags, which control how objects are 
smoothed. Each type of object has a different set of properties. To display an object’s 
properties in the Attribute manager, click the object’s name in the Object manager. 
Properties are divided into three main pages (although some objects have further pages): 
Basic Properties, Coordinates and Object Properties.

Attribute manager settings

Basic Properties

All objects have the same Basic Properties apart from a few objects which lack the 
Enabled and X-Ray options (for these object types — such as the Null object — the 
options are irrelevant).

Name

Enter a name for the object.

Visible In Editor

Controls whether the selected objects are visible or invisible in the viewport.
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Visible In Render

Controls whether the selected objects are visible or invisible in the render.

Use Color

Determines whether the selected objects use their display color. Off switches off the 
display color so that material colors are used instead. Automatic means the display color 
is only used if the object has no materials. Always means the display color is always used, 
even if the object has materials.

Display Color

Defines the display color. Click the color box to access the system color chooser or click 
the small triangle to access BodyPaint 3D’s color chooser. Choose the desired color.

Enabled

Switches generators and deformers on/off.

X-Ray

If this option is enabled, the selected objects are semi-transparent. All points and edges 
can then still be seen when using a shaded display mode such as Gouraud shading.

Coordinates

The Coordinates page gives you access to the object’s position, scale and rotation in 
relation to the world system or — if the object is in a hierarchy — in relation to the 
parent system. P stands for position, S for scale and R for rotation.

Keep in mind that if you change the scale values, the object’s axis system is scaled rather 
than the surfaces — this is the same as scaling with the Object tool.

Object Properties
These properties and others that are object-specific are described throughout this chapter, 
object by object. 
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Null Object

The null object might well mutter to itself “I cannot do anything, I’m nothing”. And that’s 
right ... almost. If you call this command, BodyPaint 3D creates only an empty axis system 
in the 3D space. The object contains neither points nor surfaces and cannot be edited in 
the normal way.

So why use a null object? Well, the null object can have other objects placed within it. So 
it is useful for grouping matching elements of a scene. Null objects are also created by an 
automatic grouping in the Object manager.

The advantage? Well, normally if you move, say, the hand at the end of an arm of a figure 
by IK, the hand itself remains rigid. This is avoided by the use of such a dummy object at 
the end of the chain.

Let’s not forget one of the most frequently used applications of the null object; its use 
as a dummy object for accurate rotation of previously rotated objects. As long as the 
axes of an object lie parallel to those of its parent system (with newly created objects the 
parent is the world coordinates system), an object rotates around its Y-axis (a heading 
rotation). However, if the object, or its local object coordinate system, is already rotated 
(so that its axes are not parallel to those of its parent), the result often astonishes even 
the most experienced 3D designers.

Left: rotation with parallel axes systems, Right: with an already rotated object system (in each 
case the final rotation is through 90°).

The use of a null object gives the desired result. Here the null object and the object which 
is to be rotated lie on top of each other. The axes of the two objects have the same 
direction and — quite importantly! — the object in question is within the hierarchy of 
the null object.
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Correct rotation behavior through the use of a null object.

In addition, some actions that rely on a particular orientation of an object in 3D space 
(such as the duplicating of objects) profit from the use of a parental null object.

Attribute manager settings

Object Properties

These parameters enable you to change the shape that represents the null in the 
viewport, including its width and height as well as the general shape.

Display

Choose the shape that is used to represent the null in the viewport. Possible shapes 
include Point, Circle and Pyramid.

Radius

Defines the radius of the shape that represents the null (choose the shape from the Display 
drop-down list).

Aspect Ratio

Defines the shape’s height as a ratio of height : width. For example, to make the pyramid 
shape twice the height of its width, set Aspect Ratio to 2.

Orientation

Defines the orientation of the shape. Choose from Camera, XY, ZY and XZ.
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HyperNURBS
HyperNURBS is one of the most powerful sculpting tools available to the 3D artist. The 
HyperNURBS object uses an algorithm to subdivide and round the object interactively 
using a process called “subdivision surfaces”.

HyperNURBS are ideal for characters.
Image © Yoichi Mimura.

 Make the source object (cage) a child of the HyperNURBS object.

HyperNURBS object and cage both visible (left) and only cage visible (right).
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Attribute manager settings

Object Properties

Use this page to specify the subdivision level for shading within the editor (i.e. the 
viewport) and for the renderer. The higher you set the resolution, the smoother the 
object becomes but the more memory it uses and the slower it renders.

Figure 1: From left to right: source object, Subdivisions set to 1, 2 and 5.

Figure 2: Use point and edge weighting to further refine your HyperNURBS models.

In Figure 2, above, a cube (left) has been made a child of a HyperNURBS object to 
produce a sphere (center). Edge and point weighting has then been applied to produce 
a complex shape (right). Weighting enables you to refine HyperNURBS models without 
having to add new points and is especially useful for creating hard edges or points.
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Weighting HyperNURBS models
There are two ways to weight HyperNURBS models: interactively or manually using the 
Live Selection tool.

Interactive weighting
Select the  points, edges or polygons that you want to weight. Hold down the period 
key (“.”) and drag left or right to set the weighting for the selected elements. The more 
weight you apply, the harder the surface will try to reach it.

To set the minimum and maximum weighting that you can apply by dragging, select 
the Live Selection tool and, in the Active Tool manager, enter the desired values into the 
Interactive Min and Max boxes.

Three modes are available: Point, Edge and Polygon.

Point mode

Selected points. . + drag. . + Shift-drag. . + Ctrl-drag.

To weight selected points, hold down the period key (“.”) and drag. To weight selected 
points and all edges connected to them, hold down the period key and Shift-drag. To 
weight selected points and the edges between them, hold down the period key and Ctrl-
drag.

Edge mode

Selected edges. . + drag. . + Shift-drag. . + Ctrl-drag.

To weight selected edges, hold down the period key (“.”) and drag. To weight selected 
edges and all points connected to them, hold down the period key and Shift-drag. To 
weight selected edges and their shared points, hold down the period key and Ctrl-drag.
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Polygon mode

Selected polygon. . + drag. . + Ctrl-drag.

To weight all points and edges of the selected polygons, hold down the period key (“.”) 
and drag. To weight only the edges of the selected polygons, hold down the period key 
and Ctrl-drag.

Manual weighting

Select the elements (i.e. points, edges or polygons) that you want to weight. Select 
the Live Selection tool. You can now edit the HyperNURBS weighting parameters in the 
Active Tool manager.

Select the Live Selection tool and edit the HyperNURBS 
weighting parameters in the Active Tool manager.

To assign a specific weight to the selected elements such as 60%, set Mode to Set, set 
Strength to the desired value and click the Set button. To add or subtract weight, set 
Mode to Add or Subtract, set Strength to the amount that you want to add or subtract 
and click Set.
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Symmetry Object
The symmetry object is especially useful when modeling symmetrical (or nearly 
symmetrical) objects such as faces with polygons. Model just one half of the object and 
the other half is generated automatically for you. Once you’ve finished modeling one 
side you might want to make the Symmetry object editable to convert the generated 
half into polygons. You can then tweak either side separately to avoid the model looking 
unnaturally symmetrical. 

Try something simple: create a sphere, convert it to polygons with Make Editable and 
select the Points tool. Select the Rectangle Selection tool and, in the Front view, select 
the right half of the Sphere object’s points then delete them. Create a Symmetry object 
and, in the Object manager, make the sphere a child of the Symmetry object.

The right half of the sphere is generated and the sphere is complete once more. Note 
that only the left-hand side has points. Now edit some of the points on the left-hand 
side. Notice how the generated side updates automatically.

Attribute manager settings

Object Properties

Mirror Plane

Determines the plane which is used as the mirror. ZY is the default since it is used for 
objects with vertical symmetry (e.g. a face) in the front view.

Weld Points, Tolerance

If the Weld Points option is enabled, points at the mirror’s edge are welded automatically 
— two points become one. This joins your object smoothly, avoiding a seam along the 
middle. Enter the maximum weld radius in the Tolerance box. Points that are within this 
distance to each other will be welded together.

Symmetrical

Enable this option if you want to ensure that the welded points (Weld Points enabled) 
are placed exactly on the mirror axis. Otherwise, each welded point is placed midway 
between the points from which it was formed — this may or may not be on the mirror 
axis depending on whether the points are the same distance from the mirror axis.

 To mirror more than one object, group the objects that should be mirrored and make this 
object group a child of the Symmetry object.
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Cube

This command creates, by default, a cube whose sides are parallel to the coordinate axes 
of the world system. You can create many arbitrary cuboids by adjusting the various 
options. Rounded edges are optional.

Attribute manager settings

Object Properties

Size X, Size Y, Size Z

The values for Size X (width), Size Y (height) and Size Z (depth) define the size of the 
object.

Segments X, Segments Y , Segments Z

These values for width, height and depth reflect how finely the particular side of the 
object is subdivided. You must consider the segmentation if you intend to edit the 
primitive with other tools. The finer the subdivision, the softer later deformations will 
appear. In particular you should subdivide an object quite finely before using boolean 
operations on it — generally, though, only subdivide when necessary.

Separate Surfaces

If you enable this option then, during a later transformation of the parameter object into 
a polygon object, a separate object will be created for each side of the cube and all will 
be combined into a group. This is useful if you want to be able to process elements of the 
cuboid separately. You can only select this option if Fillet is disabled.
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Fillet, Fillet Radius, Fillet Subdivision

To fillet (i.e. round) the object’s edges, enable the Fillet option. Fillet Radius is the radius 
of the curvature, while Fillet Segments defines how finely the fillet appears. The more 
segments you specify, the smoother the fillet. To create a chamfer instead of a rounded 
fillet, set Fillet Segment to 1.

Different cube shapes.

The radius of the fillet can be no larger than half of the value of the smallest of the 
cuboid’s dimensions. If your cuboid possesses, say, a width of 100 units and a height and 
depth of 300 units each, a maximum of 50 can be chosen for the fillet radius.

Interactive editing
The cube has three handles. Drag handle 1 to change the width (X), handle 2 to change 
the height (Y) or handle 3 to change the depth (Z).

To re-size the cube interactively in the viewport, 
drag its handles.

Additional handles of the cube primitive appear 
when Fillet is enabled.

If you enable the Fillet option, three further handles appear. Drag handles 4, 5 or 6 to change 
the fillet radius.
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Cylinder

This command creates a cylinder, whose ends (caps) are aligned parallel to the XZ plane.

Attribute manager settings

Object Properties

Radius, Height

These values define the basic dimensions of the cylinder.

Height Segments

Changes the number of subdivisions of the object in the Y direction (cylindrical part 
only).

Rotation Segments

Defines the number of subdivisions of the object along its circumference. The greater this 
value, the smoother the cylinder will appear.

Cylinder with different Rotation Segments settings.

Orientation

Choose a value from this drop-down list to set the cylinder’s initial position in space. 
Using this you can turn it on its axis very simply and, above all, quickly.
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Caps

Caps

Enable this option to add caps to the top and base of the cylinder. Otherwise, the 
cylinder is hollow.

Caps enabled (left) and Caps disabled (right).

Cap Segments

Defines the number of subdivisions of the caps in a radial direction. The subdivision along 
a cap’s circumference is as defined by Rotation Segments (see above).

Fillet, Radius

Assuming that the cylinder has caps you can use this option to apply a fillet or chamfer to 
the join between the cylinder body and the caps. Enter the radius of the fillet.
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Fillet Segments

With Fillet selected you can choose the degree of the roundness with this option. The higher 
the value the smoother the join will appear; enter a value of 1 to achieve a chamfer. In the 
picture is a rounded cylinder. To the left is a chamfer, then a rough fillet and, on the right, a 
high-value, smooth fillet. The roundness can be set as high as the cylinder’s radius — the caps 
will then appear to be hemispheres.

From left to right: Fillet Segments set to 1 (a chamfer), 3 and 10.

Slice

Slice

Enable Slice to show a slice of the cylinder only. Enter the angles for this slice into the 
From and To boxes.
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Regular Grid

The Regular Grid option is only available when Slice is enabled. By enabling this option 
and entering a value into the Width box you can control the subdivisions within the plane 
of section of the sliced object. Small values produce a fine subdivision while larger values 
result in a coarse structure. This subdividing only affects the face (the plane of section) of 
the slice. Use this option only if you intend to process the object further after slicing it.

Interactive editing
The cylinder initially has two handles. Drag handle 1 to change the radius or handle 2 to 
change the height. If you enable Fillet, a further handle appears. Drag handle 3 to change 
the radius of the cap fillet.

The handles of the cylinder primitive. Additional handle of the cylinder primitive.
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Sphere

This command creates a sphere composed of triangles and squares.

Attribute manager settings

Object Properties

Radius

Use this to define the size of the sphere.

Segments

Defines the degree of the subdivision of the sphere. The sphere is divided along its 
latitude and longitude. However, until you convert a sphere into a polygon object with 
Make Editable, a sphere is always generated by calculation, no matter by how much you 
subdivide it.

On the left a sphere primitive divided into six 
segments, on the right the same object, this time 
converted to a polygon.
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Type

With this drop-down list you choose of which surfaces, and in which arrangement, a 
sphere is to be composed. With Standard the sphere surface is made up of triangles and 
squares, Hexahedron uses only squares and Icosahedron only triangles.

Render Perfect

If you enable this option, a perfect sphere is generated by the math (if the sphere was 
not already distorted or deformed). This type of sphere has the advantage that it looks 
truly round and smooth. In addition it renders more quickly than a polygon sphere.

 The Perfect Sphere stays perfect only as long as the object is not distorted (e.g. by scaling 
about an axis). If the Perfect Sphere is distorted it is converted into a polygonal object 
before rendering. It then uses the number of segments defined in the Properties dialog.

Interactive editing
The sphere has one handle only. Drag handle 1 to change the radius.

The handle of the sphere primitive.
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Plane

This command creates a quadrangle in the XZ plane, which is divided into further 
quadrangle surfaces.

Attribute manager settings

Object Properties

Width, Height

Defines the size of the plane.

Width Segments, Height Segments

You can set the level of subdivision separately for the width and height. This is especially 
useful when you intend to convert the plane to polygons and edit it further.

Differently subdivided, deformed planes.

Orientation

Choose a value from this drop-down list to set the plane’s initial position in space. Using 
this you can turn it on its axis very simply and, above all, quickly.
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Interactive editing
The plane has two handles. Drag handle 1 to change the width or handle 2 to change the 
height.

The handles of the plane primitive.
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Cone

This command creates a cone, whose base lies in the XZ plane (but see below). The Cone 
object is more useful than it first appears. For example, you can quickly create a drop of water 
by adjusting a few parameters.

Attribute manager settings

Object Properties

Top Radius, Bottom Radius

These values define the cone’s top radius and bottom radius The top radius is set to 0 by 
default, i.e. the top of the cone ends in a single point (see illustration, left). If this value is 
set higher than zero, a truncated cone is formed (center). If the top radius is equal to the 
bottom radius, you get a cylinder (right).

Height

This value defines the overall height of the cone.

Height Segments

Defines the number of subdivisions of the object in the Y direction.

Rotation Segments

Defines the number of subdivisions of the object along its length. The greater this value, 
the smoother the cone appears.
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From left to right: cone with Rotation 
Segments set to a low value (left), medium 
value (center) and high value (right).

Orientation

Choose a value from this drop-down list to set the cone’s initial position in space. Using 
this you can turn the cone on its axis very simply and, above all, quickly.

Caps

Caps

Enable this option to add caps to the cone’s top and base.

Caps enabled (left) and disabled (right).

Cap Segments

Sets the number of subdivisions of the caps in a radial direction. The subdivision along 
the circumference of the caps is set from the value defined in Rotation Segments.

Fillet Segments

If you have chosen to fillet the top or bottom of the cone, use Fillet Segments to define 
the degree of filleting. The greater the value, the finer (or more rounded) the fillet 
becomes. To chamfer, set Fillet Segments to 1. Below is a truncated cone whose upper 
extent has been filleted. To the left is a chamfer, in the center a rough fillet and, on the 
right, a fine fillet.
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From left to right: Fillet Segments set to 1 
(a chamfer), 3 and 10.

Top, Bottom, Radius, Height

Enable Top and/or Bottom according to where you want to apply the fillet or chamfer. Radius 
and Height define the shape of the rounding. If both values are the same, the rounding is 
circular; otherwise, the rounding is elliptical. The following illustration shows a few of the 
shapes you can quickly achieve with the cone primitive.

Slice

Slice

Enable Slice to show a slice of the cone only. Enter the angles for this slice into the From 
and To boxes.

Various From and To settings.
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Regular Grid, Width

The Regular Grid option is only available when Slice is enabled. By enabling Regular Grid 
and entering a value into the Width box you can control the subdivisions within the plane 
of section of the sliced object. Small values produce a fine subdivision while larger values 
result in a coarse structure. This subdividing only affects the face (the plane of section) of 
the slice. Use this option only if you intend to process the object further after slicing it.

Interactive editing
The cone initially has three handles. However, note that, at first, handle 1 (for the upper 
radius) and handle 3 (for the height) are in the same position. Drag handle 1 to change 
the upper radius, handle 2 to change the lower radius or handle 3 to change the cone’s 
height.

 Handles 1 and 3 initially lie in the same position. Drag the handles to change the height or 
Shift-drag the handles to change the upper radius (and thus separate the two handles at 
the same time).

The handles of the cone primitive. Additional handles of the cone primitive.

If you enable the fillet options, two further handles appear for controlling the upper and 
the lower rounding. Drag handles 4 or 5 to change the width of the fillet or drag handles 
6 or 7 to change the height of the fillet.
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Cameras

Camera Object
In addition to the default camera, you can add as many extra cameras as you need. When 
you create a new camera, the camera adopts the 3D view’s current position and focal 
length.

When placing and aligning a camera, BodyPaint 3D uses the camera’s coordinate system. 
The X-axis and Y-axis define the focal or film plane, and the Z-axis is the direction in 
which the camera is pointing; this view is shown in the viewport.

In the viewports, the camera is shown as a cuboid with two spools of film and a lens.

Attribute manager settings

Object Properties

Projection

By default, objects are shown from the viewpoint of a central perspective projection. 
Alternatively, choose other types of projection.

From left to right: Perspective, Gentleman, Dimetric, Isometric

Focal Length

BodyPaint 3D’s cameras simulate a lens system, like their real world counterparts. You 
can choose the focal length of this lens.
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 The camera model used in computer graphic programs corresponds to a pinhole camera 
with infinite sharpness. Therefore CG focal length is to be understood only as a simulation 
and corresponds in no way to a physical model.

Short focal lengths give a wide-angle view and are ideal for a good overview of the 
whole scene. They do, however, distort objects in the scene — a particularly striking 
effect is that of a very short focal length. Large focal lengths correspond to a telephoto 
lens, and display a small area of the scene since only a small angle can be captured.

The advantage of a telephoto lens is that you can capture detail with hardly any 
distortion. With an extremely high value used as a focal length, the perspective depth is 
lost completely as the perspective projection changes into a parallel projection.

Lens type Focal Length

Fish-eye 20 mm

Wide-angle 35 mm

Normal 50 mm

Portrait 85 mm

Telephoto 200 mm
Super telephoto 1000 mm

Aperture Width

The Aperture Width parameter corresponds to the size of the opening in a camera 
(the aperture) that allows light to pass through the lens onto the film. The ratio of the 
Aperture Width to the Focal Length determines how much of the scene (the viewing 
volume) can be viewed through the camera. For example, if you double both the Focal 
Length and the Aperture Width, the viewing volume is unchanged.

Field of View

A measurement for the camera’s angle of view. The greater the Focal Length, the smaller 
the Field of View.
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Zoom

For all camera projections except Perspective, by definition there is no focal length, so 
you may type a zoom factor into this box if required from 0.1 to 10000. Setting a zoom 
factor is the same as zooming with the Camera tool selected.

Show Cone

If this option is enabled, the viewing volume is shown in the 3D viewport as a green 
pyramid.

Depth Of Field

 

 If you own the separately available Advanced Render module, then when you output a 
Depth multi-pass channel, the Depth Of Field settings described here are used rather than 
Advanced Render’s Depth Of Field settings. This is because Advanced Render’s depth of 
field is a post-effect whereas these settings are part of the rendering process.

The Depth of Field settings enable you to specify which part of a picture will be out of 
focus. You have a choice of Front Blur or Rear Blur, depending on whether you require 
the objects at the front or the rear to be blurred. If neither Front Blur nor Rear Blur is 
enabled, all objects will be in focus.

Figure 1: The relationship between Front Blur, Rear Blur and Target Distance.

Target Distance

Determines the distance from the camera at which objects are perfectly sharp. 
Depending on which blur options you’ve enabled (Front Blur and/or Rear Blur), the blur 
increases in front of and/or behind the target distance.

Front Blur, Rear Blur

The settings determine the distance from the camera to the front and to the rear of the 
scene at which objects will become completely out of focus.
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Adjusting the camera interactively
You’ll frequently use cameras in your scenes. Although you can adjust the camera’s 
settings via the Attribute manager, the quickest way is to drag the camera’s handles in the 
viewport.

To try out the camera’s interactive handles:

-  Choose File > New to create a new, empty document.

-  Create a Camera object. On the Attribute manager’s Depth page, enable Front Blur and 
Rear Blur. Set the End value for Front Blur to 500 and the End value for Rear Blur to 
1000.

-  Now take a look at the camera object in the 3D viewport.

-  In the 3D viewport, choose Edit > Frame Scene. Hold down the 2 key and drag left to 
zoom out, then hold down the 3 key and drag left or right to rotate the camera until 
you can see the camera object fully, as illustrated in Figure 1.

Figure 1: Ensure that you can see all of the camera’s planes. The point that we’ve enclosed in a circle is the camera’s 
Target Distance. Drag this point — called a handle — to rotate the camera and/or change the Target Distance value.

-  To rotate the camera about its origin, drag the handle for the Target Distance (the one 
circled in Figure 1). By dragging this handle you can also adjust the Target Distance 
value itself.

-  On the same plane as the target point there are four further handles, each one midway 
along a side of the plane. This plane represents the camera’s Focal Length. Drag one of 
these handles to adjust the Focal Length interactively.

-  There are two further, optional, planes that run parallel to the focal length plane, one 
in front and one at the back. These two planes (or just one of them) are available only 
if you select a depth of field (Front Blur, Rear Blur). At the center of each plane you will 
see another orange handle. Use this handle to shift the depth of field plane interactively 
along the camera’s Z-axis. Again, you can see these realtime adjustments in the viewport.

-  You may also adjust the focal range i.e. the area that is shown in focus.
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If you Shift-drag the handles, the entire plane, rather than just the focal length, is moved 
along the camera’s Z-axis. As you see, interactive control of the camera is very easy. As 
mentioned earlier, you may create as many cameras as you wish.

Keep in mind that it is always the active camera that is used for rendering.

Cameras Menu
Scene Cameras
Each view may have its own camera. The editor camera is used by default but you may 
create and use your own cameras. When you create a camera, the camera is initially 
switched off, i.e. it isn’t used by the viewport. Position the camera as desired and, to 
switch it on for the viewport, choose the camera’s name from the viewport’s Cameras > 
Scene Cameras menu.

Link Active Object

You can view a scene through any object, not just through a camera. In the Object 
manager, select the object that you want to use as the viewport’s camera. In the desired 
viewport, choose Cameras > Link Active Object.

 When using an object as a viewport camera, the object’s Z-axis defines the viewing 
direction (as is the case with Camera objects).

Editor Camera

When you start a new scene, the viewports initially use the editor camera — an internal 
camera that you can’t see in the Object manager. If you’ve changed cameras to one of 
your own and want to switch back to the Editor Camera, use this command.

Target Camera
A target camera is the same as the standard camera described above, except that it has 
a Target Expression tag and a target object (a null). If you move the target object, the 
camera will rotate to follow it. Similarly, if you move the camera, the camera will rotate 
at the same time so that it continues to point at the target object.
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Lighting

Light Object

If there are no lights in the scene, a default light is used — called the auto light. To change 
the default lighting setup for future scenes, build a new scene that contains the lights 
that you require for your default lighting and save this scene within the BodyPaint 3D 
folder under the name “new.c4d”. This setup will be use each time you start a new scene.

Displaying lights in a viewport

The lighting within a scene can be easily previewed by turning on the Gouraud shading 
option. This option will update your lighting in realtime, even adjusting the lighting and 
updating your scene as you move the lights around. To rename a light, double-click the 
light’s name in the Object manager and enter the new name into the dialog that opens.

Attribute manager settings

General

Color

You can adjust the color of each of your lights using the slider controls and the text input 
boxes for each color element (RGB). You may change the color system (perhaps to HSV 
0...255) using the drop-down list below the Color box. You can also use the color sliders 
to achieve negative lighting, which is discussed later in this chapter.
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Brightness

Defines the brightness of the light source. By adjusting brightness values with the slider 
control you can simulate any type of light from the small glow of a candle to the extreme 
brightness of sunlight. In most cases the maximum slider value of 100% will suffice, but 
in extreme cases a value of up to 1000% can be manually typed into the adjacent text 
field. 

Type

Defines the light’s type, such as Spot, Tube or Parallel.

Shadow

Defines the type of shadow generated by a light source.

Visible Light

Defines the visibility of the light in a scene.

Noise

With this option you can make your lights exhibit irregularities in the visible light or on 
the surface lit by the light.

 Using the Noise effect, you can produce very interesting effects, such as a supernova, 
simply by setting the internal and external colors of the visible light to yellow and red.

No Light Radiation

If you need to see just the visible light and/or its lens effects without the light source 
actually illuminating objects, enable this option. Should you need your light sources 
for special effects (such as the exhaust gas of a jet engine) disable this box for faster 
rendering.

Show Illumination

If this option is enabled, a wireframe approximation of the light’s illumination range is 
shown in the viewports. This range can then be adjusted by dragging the handles of the 
wireframe representation.

Show Visible Light

Enable this option to show an approximation of the light’s visible range in the viewports, 
not to be confused with the illumination range. It may become confusing if both indicators 
are switched on in the viewport so this option is turned off by default. Again, this range 
can be interactively adjusted via its handles.
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Show Clipping

Enabling this option shows an approximation of the selected light’s clipping range (the 
restriction of the light range) in the viewports and can also be interactively adjusted with 
the wireframe’s handles.

Memory Requirement

This indicator shows the amount of memory needed for the selected light sources in your 
scene. Here is an overview of the memory requirements of light sources:

-  Hard shadows and area shadows need memory-intensive raytracing calculations.

-  As more objects are added to a reflection/refraction dependent scene, additional memory 
will be required.

-  A soft-shadowed visible light will need a shadow map of at least 250KB X-resolution by 
250KB Y-resolution.

-  Omni lights require six times as much memory for their shadow maps.

-  When used with textured transparencies (light maps), up to 20 times more memory 
may be needed.

Render Time

This indicator gives an approximate render time for the selected light source. Here is a 
short overview.

-  Soft shadows are calculated far more quickly than hard shadows, hard shadows being 
much faster to calculate than area shadows.

-  Making a light visible in a rendered scene adds a negligible amount to its render time. 
Using a volumetric light increases render time, sometimes substantially, according to 
the Sample Distance.

-  Noise adds to render time, with hard and soft turbulence requiring more calculations 
than basic noise, while wavy turbulence roughly doubles rendering time over that of 
basic noise.

-  Using a high sample radius will increase the render time of soft shadows.

-  Tube lights and area lights also increase render time, although not to the same extent 
as the processor-intensive volumetric light.
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Types of light

This section describes the types of light available on the General page.

Omni. Spot (round/square). Distant.

Parallel. Parallel spot (round/square). Tube.

Area.

Omni

An Omni light source acts like a real life light bulb — casting rays in all directions. Placing 
an Omni light in the center of your scene will illuminate your scene evenly.

Spot (round/square)

Spotlights cast their rays in one direction, which is along the Z-axis by default. Once 
created, they can be easily moved and rotated to light individual objects and parts of a 
scene. The spotlight can project a round or a square cone of light. Square cones are ideal 
for, amongst other things, the simulation of projectors which require a square picture to 
be cast onto a wall. Examples of round spotlights include car headlights and torches.
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Distant

 Owing to its characteristics, the distant light source itself cannot radiate visible light.

The Distant light type is so called because it mimics the light that is cast from an infinite 
distance. Using a Distant light would, for example, evenly illuminate the whole of a floor 
(provided the floor is flat). Since a Distant light is infinite, the light has no actual origin. 
Thus the exact position of a Distant light, near or far, has no effect on your scene’s 
objects. Only the actual direction in which the light is facing is important with this light 
source. Distant light sources are very suitable for the simulation of sunlight.

Parallel

 Like the Distant light, Parallel lights cannot be rendered as a visible light.

Parallel lights resemble a very distant light source. Unlike the Distant light source 
however, the Parallel light has an origin and simulates a large, single axis wall of light. 
By default, all Parallel lights when created will radiate light rays along the Z-axis. These 
lights take the appearance of an infinitely large surface, radiating parallel light in a single 
direction; anything behind the point of origin will not be illuminated.

Parallel spot (round/square)

Parallel spotlights resemble the regular spotlight but do not have light cones to define 
falloff or distance. Instead, light rays are cast along cylinders and/or bars. The origin is 
important in defining which objects in a scene will be affected by this light. The radius of 
the spotlight can also be modified using the adjustment handles.

Tube

 Tube lights are especially useful when you want objects to show long, drawn-out 
highlights.

Tube lights do not have a single point of origin, but a linear one. The Tube light is 
represented by a line, from which light is radiated in all directions. When used as a visible 
light, this is a very quick and easy way to make neon tubes. A classic example of the use 
of the Tube light is the laser sword.

Area

 As with the Distant and Parallel lights, an Area light cannot be rendered as a visible light 
source.

The light rays from an Area light expand from its origin outwards in all directions. A 
rectangular computer screen is a good example of such a light. The resultant lighting and 
specular effects are somewhat different from those of an Omni light; specular highlights 
are more angular and the surface illumination is richer. The closer the light source is to 
the object, the more apparent this becomes.

However, an Area light with a small radius that is placed far away in a scene will hardly 
seem to differ from an Omni light source.
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Types of shadow 

This section describes the different types of shadow you can select for the Shadow 
option on the General page.

Soft shadow. Hard shadow. Area shadow.

You can combine all light source types with all shadow types in BodyPaint 3D. For 
example an area light can cast not only area shadows, but hard shadows as well. And 
a parallel light can easily cast soft shadows. There are no restrictions to this mixing of 
lights and shadows.

None

Select None if your light is to cast no shadow. This is a very helpful option in a scene with 
many lights, allowing you to turn on shadow-casting for the main lights only. Any real 
world photographer will envy you this option and its possibilities.

Soft shadow

In reality all objects — whether they are trees growing in the wild, or a vase in a room 
— are lit by several partial light sources. The result of this is a gradual transition of light 
to shadow. This soft edge, or umbra, can be simulated in BodyPaint 3D by using a shadow 
map. A shadow map is a grayscale picture of the scene as viewed from the light source. 
Contained in this are all the objects lit by the light source.

During the render calculation the renderer will determine exactly which objects will fall 
into this shadow of the light source. The major advantage of this method is the high 
computing speed and the soft shadow’s natural appearance. However, the one downside 
to soft shadows is the memory needed. Depending on the size of the shadow map, a 
great deal of additional memory may be needed. So be careful in your allocation of 
shadow maps or you may find your scenes wasting precious memory.

Hard shadow

Traditionally in raytracers, genuinely raytraced scenes contained hard shadows. As this 
technique needed to compute many more additional rays, this method increases the 
render time dramatically. Hard shadows, because of their abrupt, sharp appearance, are 
of particular interest for technical illustrations. However, in other more natural pictures 
they look rather unrealistic because such hard, sharp shadow borders are rarely found in 
real world environments.
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Area shadow

Although Soft shadows are more natural than Hard shadows, they are still not perfectly 
natural. On careful examination you can see that the soft edge always has the same 
width. In nature this does not happen; the nearer an object is to a surface on which 
it casts its shadows, the sharper this edge will be. Area shadows simulate this effect 
perfectly.

BodyPaint 3D calculates the shadow at the origin of the light source outwards (for all 
lights, whether Omni, Spot or Area). Only a hard shadow is computed at this point. The 
softer Area shadow is the result of a virtual Area light source, which simulates the overlay 
of several light sources. This provides the natural scattering of light. However, as usual, 
this method comes with a price: high render times. The result, in many cases, does not 
justify the increased render time, since the Soft shadow will often be sufficient. Carefully 
assigned Area shadows, however, can produce very realistic shadows.

Types of visible light

This section describes the different types of visible lights you can select for the Visible 
Light option on the General page.

Visible. Volumetric. Inverse Volumetric.

In nature, light normally becomes visible only if small particles such as dust, insects, 
smoke or fog are present in the air. For example, if a car headlight shines in fog, you will 
see its cone of light quite distinctly. In BodyPaint 3D all light sources or the light cone 
emitted or both can be made visible. This kind of effect can be seen for instance in a 
smoky room. This effect is comparable to fog, which does not diminish light, but rather 
adds to its brightness. With Visible Light you can produce stunning effects including 
headlights, shimmering lights, laser beams and a host of atmospheric effects.

Visible

If the Show Visible Light option is enabled (General page), the light source will produce 
visible light that passes through all objects. So for example a visible light could be placed 
in the center of a planet’s sphere to simulate an atmosphere.
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Volumetric

A visible light does not affect objects which lie within its cone of light — the light rays 
penetrate objects unhindered, casting no shadow in the visible light’s beam. In order for 
a shadow to be cast by a visible light, volumetric lighting must be used. The parameters 
for the visible Volumetric light are taken from the light source’s shadow map values: 
Resolution X, Resolution Y, Sample Radius and Parallel Width.

Inverse Volumetric

Enabling the Inverse Volumetric function has the interesting effect of inverting your 
volumetric light — that is, the light is visible where the light cone would normally be in 
shadow. Imagine a company logo, behind which you have placed an Inverse Volumetric 
light source. This inverts the light’s volumetric effect, giving the impression that the light 
is radiating from the logo itself.

Types of noise

This section describes the different types of noise you can select for the Noise option on 
the General page.

Illumination Visibility Both

Effects such as fog or sun flares can be achieved using this feature without having to use 
potentially time consuming volume shaders. Note, though, that lights with a noise effect 
have a small price to pay in rendering time, as any light using the Noise feature is slower 
to calculate than one without.

Illumination

You can add irregularities to your light source in order to give it a realistic appearance. A 
light’s illuminated surface is very rarely evenly lit — particularly if dust or small particles 
are present.

Visibility

This option adds irregularities not to your lit surface, but to the visible light itself. With 
this you can simulate, for example, rolling fog, which is visible in the light cone.
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Both

Ensures that both the basic light and any visible light are provided with noise 
irregularities.

Details

Using the Details tab, you can access the individual properties of each of your light 
sources.

Use Inner, Inner Angle

Use Inner disabled. Inner Angle set to 0.

Depending on the type of light you use, this will adjust either the Inner Angle (for a 
standard Spotlight) or the Inner Radius (for a Parallel Spotlight) of the light. Within the 
Inner Angle area, the luminosity value of the light source is 100%. From the Inner to the 
Outer Angle the luminosity value falls from 100% to 0%.



414 • CHAPTER 22 OBJECTS • 415

If Use Inner is disabled, the luminosity of the light source in the entire light cone amounts 
to 100%, resulting in a hard cone of light. If the Inner Angle has a value of 0, the light 
source will have a soft transition spreading from the center of the light to the light’s 
edge.

Outer Angle

Adjusting this value will define how large the light will be in total. The Outer Angle value 
indicates the limits of the light source’s luminosity.

Aspect Ratio

Enables you to stretch and shear the shape of the light’s cone. The standard aspect 
ratio value is 1. For example, increasing the value to 2 will double the light cone’s height 
relative to its width. Similarly, decreasing the value to 0.5 will make the light cone only 
half as high as it is wide.

Brightness

This value controls the overall brightness of the light source. While this control may be 
seen as just a way of brightening/dimming your light source, it’s also capable of another 
interesting, and very useful, effect. Using a negative value with this option results in 
negative lighting. The color of your light source (set in the General tab) is important here. 
That color will not be added to the scene where a negative light source is in effect. With 
this technique you can artificially darken and shade specific areas of your scene.

This type of lighting works even better when used with carefully constructed 
environment lighting and falloff ranges.

Contrast

The intensity of a light source on an object is not dependent on the distance of the light 
from the object (unless you explicitly adjust its falloff), but rather on the angle at which 
its rays hit the object. If a ray hits a surface at an angle of 90°, the surface is illuminated 
with the light’s maximum intensity (taking any falloff into account). As this angle (called 
the angle of incidence) decreases, the strength of the illumination decreases as well. 
Therefore, in an average scene, a soft transition is normally seen on any lit surfaces. The 
Contrast value controls this transition.

Figure 1. Contrast set to 0%. Figure 2. Contrast set to a negative value.
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In Figure 1, above, a series of pictures of a planet is illustrated, towards which a light 
is directed. You can clearly see how little the planet’s front and sides are lit using 0% 
contrast. The transition on this lit surface is not very soft; this surface contrast is not 
natural for planets. If you look at photographs of a planet you will see that the transition 
of its lit surface to its shadowed edge is hard — as illustrated further to the right in the 
series of pictures. With the contrast control you can adjust how soft or hard you wish the 
lit surface transition to be. If you need a special over-soft look to your objects you may 
even enter negative values, as illustrated in Figure 2.

Falloff

 In previous versions, there was a bug with the falloff functions. This bug has now been 
fixed but if you are loading an old scene and you want the lighting to look the same as 
before, you will need to use the old “buggy” falloff functions (these are the ones marked 
“R7”). With the Inv. and Inv. Square functions, the light now starts to fall off from the 
Outer Distance value. 

A normal virtual light source will illuminate its surrounding environment with a continuous, 
linear brightness. However, this is not how all lights work in reality; real light sources will have 
their luminosity absorbed. Just as in nature, BodyPaint 3D light sources are able to have their 
luminosity reduced over any distance. To achieve this, several falloff functions are available 
from this drop-down list and are illustrated below.

Choose from six types of falloff. Falloff from top to bottom: None, Step, Inv., 
Inv. Square, Linear.

Inner Distance

Within the Inner Distance there is no falloff. Up to this point, the brightness of the light 
remains constant. Outside of this boundary is where the Inner Distance Falloff begins.
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Outer Distance

The range between the Inner Distance and the Outer Distance is where the brightness 
of the source light changes from 100% to 0%. This Outer Distance value indicates the 
maximum range that will be illuminated by the source light.

Ambient Illumination

Ambient illumination. Ambient illumination with Falloff enabled.

Normally the brightness of a surface is determined by the angle at which a ray of light 
hits it. The greater the angle between the ray and a tangent to the surface, the more the 
surface will be lit by the light. When Ambient Illumination is switched on, however, this 
physical law is waived. Here the angle does not matter. All surfaces are lit with the same 
intensity. This results in a much flatter look. Only the material color is considered in the 
lighting calculations.

With both Ambient Illumination and Falloff enabled for the light source, you can lighten 
specific regions of your scene in a similar way to how you darken them with Negative 
Lighting, explained earlier.

No Diffuse

No Diffuse disabled. No Diffuse enabled.

When No Diffuse is enabled, the color properties of an object are ignored by the light 
source; only specular surfacing is produced by the light. This can be useful for objects 
such as a golden signature, where you would like specular glints, but no lightening of the 
color properties.
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No Specular

This bottle is lit by two light sources, causing more 
highlights to develop than you’d normally want.

 No Specular option is enabled for one light source 
only. Now the highlights are fine.

When this option is enabled, the light source produces no specular highlights on your 
scene’s objects. Imagine you have a bottle on a table with two or more light sources in 
the scene. The bottle may show too many specular highlights, with the glass material 
looking too busy. To avoid this, enable No Specular for some of the light sources.

Separate Pass

If you enable this option, separate diffuse, specular and shadow layers will be created 
for the light source when you render (provided you have set the appropriate multi-pass 
parameters in the render settings on the Multi-pass page).

Colored Edge Falloff

Colored Edge Falloff disabled. Colored Edge Falloff enabled.

This option is only available when using a spotlight with Use Inner Color enabled. The 
normal behavior of the inner color is to spread in a linear direction along only the Z-axis 
of the spotlight, from its origin to the light source’s color (selected on the General page). 
If you select Colored Edge Falloff, however, the Inner Color will also radiate outwards 
from the Inner Angle through to the light source’s general color.
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Use Inner Color

In the illustration above, the light source is white and the Inner Color is red — the light 
shows a gradual  color change from red to white.

Independently of the light source’s color, which is defined on the General page, you may 
assign another color to the internal range of the light. When used, this Inner Color is 
the core color of the light source. Starting at 100% of its value, the Inner Color spreads 
outwards and gradually changes into the light source’s General color. For the Inner Color 
to be used, the Falloff function must be activated.

The Inner Distance of the Falloff determines the expansion of the Inner Color. Click on the 
color chooser to select the color properties of the internal color.

Near Clip

From = 90, To = 90. From = 90, To = 150.

Enable Near Clip to restrict the illumination and visible light (if present) radially with 
an Omni light and linearly with all other light types. The light source does not have to 
radiate light from its origin; the radiation may begin, for example, five meters from 
the light’s origin. The two values used for this effect are From and To and signify the 
distance for the clipping effect. The larger the difference in the two values, the softer the 
transition.

 If 10 m and 50 m are entered into the two fields, there will be no illumination from 
the light source between 0 and 10 m; from 10 m the luminosity begins, reaching full 
luminosity at 50 m.
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Far Clip

From = 300, To = 300. From = 220, To = 300.

Enable Far Clip to cut off the light source’s illumination abruptly. To use Far Clip, once 
again two values are needed. This time the From and To values denote where the cut 
off begins, and where the light source will fully vanish. Again, the larger the difference 
between these two values, the softer the transition.

Individual clipping ranges using an Omni light. 
1 = Near Clipping (from); 2 = Near Clipping (to); 
3 = Far Clipping (from); 4 = Far Clipping (to).
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Visibility

Use Falloff, Falloff

100% Falloff. 0% Falloff.

Falloff is the percentage reduction in the light’s density. The axial falloff of the visible 
light is set to a standard 100%. This means that from the origin of the light to its outer 
distance, the density of the visible light falls from 100% to 0%. So, if a value of 10% is 
entered into the Falloff box, the outside edge will be at 90% visibility. Enable or disable 
the Use Falloff option to switch falloff on or off.
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Use Edge Falloff, Edge Falloff

100 % Edge Falloff. 0 % Edge Falloff.

Edge falloff is relevant only with Spotlight sources. The Edge Falloff determines how 
quickly the light’s density decreases towards the edge of the light cone. If you enter a 
value of 0% (or disable Use Edge Falloff), you will produce a very hard visible light. A 
value of 100% gives a more gradual falloff from the inside of the light cone to its outer 
edge, until it reaches 0%.

Colored Edge Falloff

Colored Edge Falloff disabled. Colored Edge Falloff enabled.

This option is only available with Spotlight sources, and in addition, Use Edge Falloff must 
be enabled. Normally the Inner Color behaves in such a way that it travels along the Z-
axis of the Spotlight source linearly to the Outer Color. However, enabling Colored Edge 
Falloff will cause the Inner Color to also spread outwards radially from the Inner Angle to 
meet the Outer Color.

Inner Distance

Beneath this value the density of the visible light is always a constant 100%. The falloff 
begins only outside this distance.

Outer Distance, Relative Scale

Between the Inner Distance and the Outer Distance the density of the visible light 
changes from 100% to 0%. When using spotlights, modify the scale of the Outer 
Distance value along each axis using the three Relative Scale text boxes.
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Sample Distance

The Sample Distance is only relevant for visible volumetric lights. Adjusting this value 
defines how finely the visible light’s volumetric shadow will be computed. Larger values 
lead to a somewhat rough (but swift) calculation, while smaller values lead to a much 
finer, but more time-consuming, result.

 Take care with your Sample Distance values. Finding a happy medium (small for fine 
detail, but as large as possible for reducing render time) is the key here.

The value of this Sample Distance is measured in world units. This value thus determines 
how finely the shadows within a visible light will be sampled. Values will usually be from 
1/10th to 1/1,000th of the light source radius. By increasing the value your scene will 
render noticeably faster but certain parts of your scene will be sampled very roughly, 
resulting in sampling artefacts. To reduce these sampling artefacts requires a reduction in 
your sampling value too. The smaller the value, however, the higher the cost in rendering 
time.

BodyPaint 3D includes an integrated antialiasing technique for surface shine, ensuring 
even the roughest surfaces render smoothly, allowing you to set the Sample Distance 
value somewhat higher than without this feature.

Sample Distance tips

If you wish to produce fine shafts of light, like those produced when light beams radiate 
through cracks or from behind stone columns, you need to set your sample distance 
relatively small. On the other hand, a light that is completely covered and allows no 
beams of light to break through may be sampled at a much higher value. To clarify this, 
here’s a small example; the pumpkin in the pictures below has a radius of 150 units, the 
visible volumetric light a radius (Outer Distance) of 700 units.

Sample Distance: 10. 
Render time: 105 s. The 
pumpkin looks perfect.

Sample Distance: 20. 
Render time: 60 s. Here 
the rays emitting from 
the mouth and the right 
eye are showing the first 
signs of artifacts.

Sample Distance: 40. 
Render time: 35 s. You 
can clearly see now how 
the rays in the visible 
light are losing their fine 
edges.

Sample Distance: 80. 
Render time: 23 s. 
The picture has, quite 
literally, been rendered 
useless.

So why is volumetric lighting so time-consuming for the renderer?
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When a beam hits a light cone, it is not only the intensity of the light that needs to be 
computed. Additionally, for each part of the beam, BodyPaint 3D needs to look for other 
objects within the light cone that might be casting shadows. So for every part of the 
beam of light, an extra raytracer ray needs to be initiated and emitted. But as it is not 
possible to shrink segments in the fog below a certain length, an approximation has to 
be used; the length of the light cone is subdivided into equal parts.

Let’s say the raytracer ray hits the light cone and the distance between the entry and the 
exit points of the light cone is 1,000 units. So a sample distance of 50 units will mean 
that an intensity value and a shadow beam will have to be calculated 20 times (1,000 
divided by 50).

The shorter the sample distance, the longer the calculation is going to take. Even if you 
have only five subdivisions (so a sample distance of 200 in the above example) this will 
require a five-fold increase per raytracer ray and per contact with the light cone than 
without volumetric lighting. Using progressively finer subdivisions, the processing time 
involved will very quickly become astronomical.

Alas, this is an inherent problem with computer graphics which cannot be resolved or 
accelerated other than by throwing processor power at it. So why can’t you input a fixed 
value for the number of samples?

If the raytracer beam hits the light cone at its beginning, the distance between the entry 
and exit points might be, for example, 100 units. But if the beam hits the cone further 
from the light source, this distance might grow to 5,000 units or more. So if you used a 
fixed number of samples, at the narrow end of the cone a lot of unnecessary calculations 
would be made and later too few (which would result in unwanted artefacts).

Brightness

This value is the brightness of the visible light source.

Dust

Determines the darkness of the light cone. With a value above 0%, brightness is not 
added, but subtracted. To see the full effect, lower the light’s brightness accordingly. 
The difference between a normal bright light and a dusty light can be seen clearly in the 
picture above. To the left is a bright, visible light. To the right a dark, dusty light.
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Dithering

This produces irregularities in the visible light which, in certain cases, can help prevent 
unwanted banding or contouring in the visible light source.

 With certain combinations of light, such as overlapping visible lights, you may notice color 
banding even if your graphics card is displaying 24-bit color. To remove the banding, 
enable Dithering.

Custom Colors

With this option you can assign your own colors to the visible light — independently of 
the actual color of the light source (General page) and the inner color (Details page).

Outer Color, Inner Color

Use the color selector to define colors for the light’s outer edge and inner edge.

Additive

 This setting exists primarily for compatibility with CINEMA 4D R5, in which light sources 
were additive. Your light beam will look more realistic if this option is left disabled.

Additive enabled. Additive disabled.

Enable this option if you want to mix the light beam additively with other light sources.

Adapt Brightness

Adapt Brightness enabled. Adapt Brightness disabled.

This option prevents a light beam from being over-exposed. The brightness is reduced 
until the over-exposed effect disappears.
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Shadow

Use the parameters on this page to fine-tune your scene’s shadow maps.

Density

Adjusting this value will vary the intensity of your shadow. A value of 100% means the 
shadow has full intensity. With 50% your shadow will be half transparent and at 0% the 
shadow is invisible.

Color

Here you can change the shadow’s color. Since shadows in nature are rarely jet black, 
this setting is more useful than it first appears. Or you might want to set the shadow 
to include some of the complementary color of the subject, to emphasize the contrast 
between light and shade.



426 • CHAPTER 22 OBJECTS • 427

Transparency

Transparency enabled. Transparency disabled.

If you want the shadow maps to take transparency and alpha channels into account, 
enable this option. 

 The calculation of transparent soft shadows is memory-intensive. An Omni light 
source can sometimes use six times as much memory as a spotlight, as six shadow map 
calculations must be computed compared to the spotlight’s single shadow map.

Clipping Influence

If this option is enabled, the clipping settings on the Details tab are applied to shadow-
casting as well as to illumination.

Shadow Map

250x250 map size. 750x750 map size.

When using soft shadows, BodyPaint 3D initially sees the scene from the point of view of 
the light source and calculates the complete scene from this view. All objects seen in this 
view are interpreted as shadows for the scene. This results in Shadow Maps.

Shadow Map assigns memory for each shadow map. The smaller the memory 
assignment, the more pixelated the shadow will appear. This can result in a shadow with 
a jagged, staircase-like appearance at its edges. The more memory used for the shadow 
map, the smoother the shadow and its edges, but the higher the memory usage. By 
default, a standard size of 250x250 is used. Shadow map size can increase to 1,000 by 
1,000 if needed, but such extreme usage is rare and not recommended.
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In order to keep your shadow sharp and smoothly defined, your shadow map will need to 
increase in size. If you simply need to keep your shadow edge soft, you can increase the 
Sample Radius. Again, this will increase render time.

 Rather than use a map with a doubled Shadow Map size, you can achieve an equivalent 
soft edge by doubling the Sample Radius.

Sometimes when you have a small shadow map created by a very distant light source, a 
problem may appear with spherical objects casting rectangular shadows. You can remedy this 
by viewing the scene through your light source. A light source, like any other scene object, can 
be defined as a camera view. To do this make sure your light source is selected and from the 
viewport, choose Cameras > Link Active Object.

Resolution X

If the preset value of the map size is not giving you the desired result, you may optionally 
adjust the Resolution X manually. In general it is standard to set the manual Resolution X 
(width) to the same value as the Resolution Y (height)

Resolution Y

With a spotlight, you can also provide a non-square shadow map by manually entering a value 
for Resolution Y.

Memory Usage

BodyPaint 3D automatically calculates the maximum memory use for the shadow map, 
which is shown here. This helps you to estimate how much memory will be needed to 
calculate the light source’s shadow maps for your scene.

Sample Radius

Determines the accuracy of the shadow map. The higher the value, the more accurate the 
shadow is, at the expense of a higher render time. If, for some reason, you must use a 
small shadow map, selecting a higher value will improve the shadow quality. So you can 
trade off render time against memory usage.

Absolute Bias

In general, leave this option enabled. If you disable the option, the distance of the 
shadow from the object depends also on the distance of the light source from the object 
— called relative bias.

With relative bias, the farther the light source is from the object, the farther the shadow 
will be from the object. This behavior originated in CINEMA 4D R5 and is present for 
backward compatibility (i.e. for the loading of old scenes).
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Bias (Rel), Bias (Abs)

Because of the particular principle involved in the calculation of shadow maps (shadows 
do not begin at the object’s origin), you may at times find the need to adjust the 
shadow’s position using the Bias value. A value of 1 m will suffice for most scenes. 
However, sometimes an adjustment may be necessary.

 The smaller an object is and the more you zoom in with the camera, the smaller the 
Bias value must be set. This ensures no gap between object and shadow is visible. If the 
object is excessively large and unwanted self-shadowing occurs, increase the Bias value. 
Generally speaking, a value of 1 m is usually adequate for objects up to a size of 10,000 
m wide.

When zooming the camera on extremely small objects, this distance between object and 
shadow will become apparent (see Figure 1, below). Entering a lower value can correct 
this error (Figure 2). You may also at times have too small a Bias value (e.g. with very 
large objects), which can result in the object casting the shadow on to itself (Figure 3). In 
a case like this, set the Bias value somewhat higher.

Figure 1. Figure 2. Figure 3.

Parallel Width

This setting will only be active for Distant and/or Parallel lights. This is a visible light 
concept known as a light cube (or, more accurately, a light cuboid). This light cube has 
its length and width dimensions set to the Parallel Width value, the depth (Z-axis) of the 
light cube being infinite. Importantly, only objects within the cube can cast shadows.
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Outline Shadow

Using this option will result in your shadow being seen as just a thin outline instead of a 
full, darkened surface.

 When enabling this option, we recommended you use higher than usual values for the 
shadow map’s resolution and the sample radius.

Shadow Cone, Angle

One of the drawbacks of Omni light sources is that six shadow maps must be computed 
in total, which can sometimes produce small artefacts at the edges of shadows. If Shadow 
Cone is enabled, the shadow production is limited to a cone, thus generating a single 
shadow map which is free from artefacts. This also has the advantage of speeding up 
render times. Set the vertex angle of the shadow cone using Angle.

Soft Cone

Enable this option to give the shadow cone a softer edge. This ensures that any object 
only partially in the shadow cone area casts a soft, fading shadow.



430 • CHAPTER 22 OBJECTS • 431

Area Shadow Width

High Area Shadow Width value (300 m). Low Area Shadow Width value (50 m).

The area shadow is produced by a virtual Area light source (independently of the actual 
light source). The Area Shadow Width determines the size of this surface. The larger 
you set this value, the more the light is scattered and the softer the shadow becomes. 
However, as the value is increased, so too does the render time, sometimes substantially 
so.

Area Shadow Samples

If you lower this value, the quality of the area shadow is reduced, but it is calculated 
more quickly.

Caustics
 These settings will only be available if you are using the BodyPaint 3D module with 

CINEMA 4D and the Advanced Render module.

Advanced Render is an optional module that includes global illumination (radiosity), 
caustics, enhanced depth of field, enhanced glow and a highlights filter.

The caustics feature improves the realism of scenes that use reflective or transparent 
objects that are curved in some way. Place marbles or a glass on a table and patterns 
of light appear on the tablecloth.  For added realism, with Advanced Render you can 
recreate these effects with ease.
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Noise

Type

Noise produces dark and bright areas. Chose from four types, including three types of 
turbulence that change the characteristics of the noise by adding cloud-like effects.

Noise. Soft Turbulence.

Hard Turbulence. Wavy Turbulence.

Octaves

Only relevant for the Turbulence types above. The Octaves value determines the 
graininess of the noise. The higher the value, the grittier the appearance.
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Velocity

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Sets the speed of the irregularities.

Brightness

Using this you can raise the overall brightness of the irregularities. You may also enter a 
negative percentage to reduce the brightness.

Contrast

Higher values increase the contrast of the noise, lower values reduce it.

Local

Enabling this option ensures that the local coordinates of the light source are nailed 
down. If the light source is moved now, the turbulence/noise will move also. For normal 
use, leave this option disabled, since dust and particles in the real world move due to the 
forces of nature, not simply because the light itself moves.

Visibility Scale

These values determine the size of the irregularities in the X, Y and Z directions in 
relation to the scene’s absolute Cartesian coordinates. If the noise effect is too severe, try 
reducing these values.

Illumination Scale

The general intensity of the noise.

Wind, Wind Velocity

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Here you define the wind properties for the noise, This will add realism to your animation 
since wind will appear to blow the dust. The three Wind values define the vectors of the 
wind direction in absolute Cartesian coordinates (and/or local coordinates if the Local 
option is enabled). Use the Wind Velocity value to change the wind’s strength.

Lens Effects

 Owing to the way QuickTime VR panoramas are calculated, lens effects cannot be 
displayed in them.
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BodyPaint 3D is a powerful tool when it comes to producing the aberrations of real-
world camera lens systems. Basic sunbeams are brought to life with a solar corona or a 
halo. A lens reflection of a low-quality camera lens can be easily simulated, as rainbow 
colored circles develop and run diagonally across the screen. A welcome flaw in an 
otherwise all too perfect virtual world...

 Why not build a library of lens effects? You can produce many types of light sources 
with different effects that can then be saved as individual objects in the Object manager. 
When you require one of these specific lights for your scene simply load it from your light 
source library.

You may recall that on the General page you have the option to disable light radiation 
(No Light Radiation). If this option is enabled then the light source will no longer 
illuminate the objects in the scene, but all lens effects of the light will still be visible. This 
is handy, for example, in a scene in which your objects are already illuminated as you 
want and adding another light source for a lens flare will result in over-lighting the scene.

 Try not to overuse lens effects; they can soon become distracting. Also keep in mind that 
in the real world the cameraman will try to avoid them.

The parameters for these lens effects are many and varied and take up two separate 
pages. With a step-by-step approach you will soon become acquainted with all of the 
possible lens effects and their various options. On the Attribute manager’s Lens page 
you can define the basic effect, choosing both Reflexes and Glows separately from each 
other. Use the Glow editor and Lens editor to refine almost any detail of the lens effect. A 
preview window updates the adjustments as you make them.
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Glow

To change the overall shape of the light’s glow, select a glow element from this menu of 
predefined light source glows.

Default. CINEMA 4D R4. Wide-angle. Zoom.

Hi-8. Camcorder. Searchlight. Artefact.

Star 1. Star 2. Star 3. Purple.

Flashlight. Sun 1. Sun 2. Grey.

Blue 1. Blue 2. Red. Yellow-green 1.



434 • CHAPTER 22 OBJECTS • 435

Yellow-green 2. Candle.

Brightness

Controls the global brightness of the glow. To increase the brightness, enter a value 
above 100%. To reduce the brightness, enter a value below 100%.

Aspect Ratio

Modifying this value allows you to change the aspect ratio of the glow. At its default size of 
1 the glow appears circular. Smaller or larger values shrink or stretch the glow’s aspect to a 
horizontal or vertical ellipse.

Edit

Click the Glow Edit button to open the Glow editor.

Reflexes

Select the desired reflexes from this menu of presets.

Brightness

Controls the global brightness of the reflexes. Values below 100% reduce the brightness 
of the effect; values greater than 100% increase the brightness.

Aspect Ratio

At the default size of 1 the reflexes appear circular. Smaller or larger values shrink or stretch 
the reflexes to a horizontal or vertical ellipse.

Edit

Click the Reflexes Edit button to open the Lens editor.

Scale 

This value adjusts the size of the entire lens effect (rays, glows and reflexes). This saves 
you from adjusting each effect individually.

Rotation

Use this value to rotate the lens effect to any angle.
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Reference Size

With this setting you can adjust the distance value with which the glow and reflex effects 
are calculated. The lower the value the more distant, thus smaller, the effect appears. 
Increasing the value makes the effect appear closer, thus larger.

Lens reflexes normally have a constant size no matter how far removed from the camera 
they are. However, if for example you want a spaceship model to fire torpedoes under 
the camera, the lens reflexes and glows must become larger as the torpedoes near the 
camera.

Use Light Parameters

If this option is enabled, the properties defined on the light’s General page also affect 
the glow/reflex effects. For example, if the light source color is red then the glow/reflex 
effect also appears red.

Fade If Near Border

Enabling this option will make the lens effect fade the nearer it is to the edge of the 
image. When at the center of the screen, the lens effect will have maximum intensity. 
This corresponds to a light’s physical behavior in the real world.

Fade If Behind Object

Enabling this option will determine whether light sources that lie behind objects are 
still to produce their effects or not. Lens flares do not occur if light sources are behind 
objects, but glows or radiation can produce pleasing effects.

Fade If Approaching Object

Normally, if a light source with a lens effect starts to disappear behind an object, the 
effects are still at maximum strength until the light source origin is fully behind the 
object. With this option enabled, the effect’s strength gradually fades as the light source 
approaches the object.

 A good example of this effect is the gradual fading of a sun behind a planet, complete 
with atmosphere.

Glow Distance Scale

If this option is enabled, the glow effect is scaled according to its distance from the 
camera. The farther away the glow is from the camera, the smaller the glow.

Reflex Distance Scale

The same as Glow Distance Scale only for reflexes. If this option is enabled, the reflexes 
are scaled depending on their distance from the camera. The farther away the reflexes 
are from the camera, the smaller they are shown.
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Glow editor
To open the Glow editor, on the Attribute manager Lens page (with a light source 
selected in the Object manager), click the Edit button in the Glow pane.

Glows are a type of over-exposure to light. When the light intensity is sufficient, this 
exposure bloom includes film grain in the areas surrounding a bright light, even though 
those areas are not illuminated. The rings around a glow (sometimes called halos) are 
also caused by over-exposure, but with added color distortions caused by the diffraction 
of the film grain.

Use the Glow editor to edit glow properties such as rings, the colors of beams and the 
number of beams. There are four main areas in Glow Editor dialog: one area for the glow 
itself (top left), one for the surrounding ring (center left), one for beams (bottom left) 
and one for the type and appearance of the beams (top right).

Glow properties

Glow

Glows consist of separately editable elements. Select which element to edit. 
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Type

Choose a type of glow type for the currently selected element. This defines the 
distribution of brightness for the element.

Size

Here you set the overall size of the glow element as a percentage of the screen’s size. 
A value of 100% represents the distance from the center of the screen to the edge of 
the screen.

Color

To set the color for the glow element, click the box to the right of Size. The system 
color chooser opens. Select the desired color.

R

This value defines the aspect ratio for the glow. A value of 1 results in a circular glow, 
whereas values greater or less than 1 produce a horizontal or vertical ellipse.

Ring properties

Ring

Choose one of the following Ring settings from the drop-down list: Inactive (no ring), 
Ring (set the ring’s color using the color box next to Size) or Rainbow Ring (multi-
colored ring).

Size

Here you set the overall size of the ring element as a percentage of the screen’s size. 
A value of 100% represents the distance from the center of the screen to the edge of 
the screen.

Color

To set the color for the ring element, click the box to the right of Size. The color picker 
for your operating system will open. Pick the desired color.

R

This value defines the aspect ratio for the ring. A value of 1 results in a circular ring, 
whereas values greater or less than 1 produce a horizontal or vertical ellipse.

Beam properties

Beams

Beams consist of separately editable elements. Use the drop-down list to choose 
which element you want to edit.
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Type

Choose a beam type for the element from the drop-down list. This defines the 
distribution of brightness for the element.

Size

Here you set the overall size of the beam element as a percentage of the screen’s size. 
A value of 100% represents the distance from the center of the screen to the edge of 
the screen.

Color

To set the color of the beam element, click the box to the right of Size. The system 
color picker opens. Pick the desired color.

R

This value defines the aspect ratio for the beam element. A value of 1 results in a 
circular shape, whereas values greater or less than 1 produce a horizontal or vertical 
ellipse.

Angle

To rotate the beam element to a particular angle, enter the value for the angle here.

Other properties

Thickness

Defines the width of beams as a percentage. The lower the value, the narrower the 
beams will appear.

Beams

Defines the total number of beams. Up to 200 beams are allowed per light source.

Breaks, Width

You can add breaks to the beams by entering the number of breaks into the Breaks 
box. The breaks will be added to the gaps that already exist between beams. Use the 
Width parameter to control the size of the breaks.

Random Distribution

For a random arrangement of beams, enable this option.

Random Beam Length

Enable this option if you want the beams to vary in length.
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Star-like

To have the beams arranged in a star-like pattern, enable this option. The beams will 
thicken towards the center. For a realistic star, use a low number of thick beams.

Lens editor
To open the Lens editor, on the Attribute manager Lens page (with a light source selected 
in the Object manager), click the Edit button in the Reflexes pane.

Lens reflections, the technical term for which is “reflexes”, are caused by the focal image 
of poor quality lenses. The colored shape produced is an artefact of the lens surface, the 
shape resulting from the shape of the lens. Large apertures produce small reflections, 
small apertures produce larger ones. Use the Lens editor to change the reflexes as 
desired. The small preview shows the Lens Type while the large preview shows the entire 
lens effect.

Element, Add, Rem

Choose which reflex you want to edit.

To add or remove reflexes, click the Add or Rem buttons. You can use up to 40 reflexes.

Lens Type

Defines the shape of the reflexes. Only in the rarest case, if at all, should different reflex 
types be used in the same scene. For example, apply only circular or only hexagonal types 
in the same scene. Keep in mind that your scene is shot through one simulated real-world 
lens — these lens reflections depend upon that lens system, not on your existing scene 
lights. Here are some examples:
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Position

This value sets the positioning of the element on the screen. The axis on which all 
reflections lie travels through two points; the light source and the center of the screen 
(which is also the center of the lens). Here the following values apply.

   0% = light source
50% = screen center
100% = 2 x distance light source center

Negative values place the reflections behind the light source.

Size

This value determines the size of the element. The radius is shown as a percentage, where 
100% is the distance from the center of the screen to the edge.

Color

Select the color for the element.

Scene
Use the Scene page to switch the light on or off for specific objects. In other words, using 
this page you can control exactly which objects receive light. Drag the desired objects 
from the Object manager into the Objects box.
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Mode

If the light should illuminate specific objects only, set Mode to Include and drag the 
names of the objects that should receive the light from the Object manager into the 
Objects box. If the light should be switched off for specific objects, set Mode to Exclude 
and drag the names of these objects from the Object manager into the Objects box.

Objects box

Click the icons alongside any object in the Objects box to enable or disable illumination, 
specularity and shadows for that object. Enable the right-most icon if the object’s 
children should also be affected by the inclusion or exclusion.

From left to right: Object icon, Illumination, 
Specularity, Shadows and Include Entire Hierarchy.

To switch off specularity, shadows and illumination for the 
cube on the left in Figure 1, Mode has been set to Exclude and 
all icons in the Objects box have been enabled.

PyroCluster Illumination, PyroCluster Shadow Casting

 These settings apply only to the optional PyroCluster module. See your PyroCluster 
manual, or for more details about PyroCluster please contact your local MAXON 
representative or visit maxon.net.
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Target Light
This command creates a null object and a light that automatically points at the null 
thanks to a target expression. Move the null to the desired position — the light will keep 
pointing at the null.

Turbo Squid
This command gives you access the world’s largest online collection of digital assets. 
Turbo Squid is now home to a CINEMA 4D community where you can buy and sell assets 
including fully-textured and ready-to-use 3D models in the native C4D format.
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Keep in mind that the Material manager offers several display 
modes and may look different to the picture above.

Good materials are every bit as important to photorealism as good modeling. Using the 
Material manager, you can accurately recreate any type of material.

The Material manager is where all the materials in the scene are stored. A thumbnail and 
name is shown for each material. The Material manager can also display the textures 
(including layers) for each material. In addition, here you can choose which materials and 
material channels should be painted. 

The thumbnail preview shows how the material looks when placed on a sphere in front 
of a striped background. You can change the size of the thumbnails using the following 
commands on the Material manager’s Edit menu: Mini Icons, Small Icons, Medium Icons 
and Large Icons. When you select an object in the Object manager, the thumbnails of 
materials it uses are indented in the Material manager.

To apply a material to an object, drag the material’s thumbnail from the Object manager 
and drop it onto the desired object in the Object manager or viewport. If you drop a 
material on to a Texture tag, this material replaces the previous one. If instead you drop 
a material onto an object name or onto an object in the viewport, a new Texture tag is 
created.

23 Material Manager
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An object may have multiple Texture tags, in which case the textures are layered one on 
top of the other. The right-most Texture tag in the Object manager is the top layer.

In addition to any materials that are active, you can also select materials. The names 
of selected are highlighted in red. The Material manager’s commands operate on the 
selected materials only. To select a material, click its thumbnail. To add a material to the 
selection, Shift-click its thumbnail. You can also select materials by dragging a frame over 
them.

To edit a material, double-click its thumbnail. This opens the Material Editor window, 
which has its own preview picture. You can also edit the selected materials using the 
Attribute manager.

You can access many of the commands for materials via the context menu. To access 
this menu, right-click (Windows) or Command-click (Mac OS) a thumbnail. To delete a 
material, click its thumbnail and press the Backspace or Delete key. Texture tags that used 
this material will then display the following icon.

Even after the material is deleted, the mapping data for the Texture tag is preserved.



448 • CHAPTER 23 MATERIAL MANAGER • 449

Painting Modes

Layer Manager (compact) mode

1
2

3

5

6

12 13
4

7

8

9

10

11

1. Multi channel mode on/off, 2. Linked layers, 3. You can paint on these layers, 4. These layers are hidden, 5. Layers, 6. 
Background layer, 7. This materials is active for painting, 8. You cannot paint on this material, 9. Texture is not loaded or 
is missing, 10. Folded layers, 11. Unfolded layers, 12. You can paint on this layers, 13. Active layer.

 Alpha channels and layer masks are not displayed in this mode.

The top part of the Material manager works in the same way as the top part of the Color 
manager (see Chapter 6, Color). They both control the same settings; changes you make 
in one manager are applied automatically to the other manager.

You can also choose which channels are active for painting or editing. For example, the 
move layer tool will only move layers with a colored pencil icon.

The slider controls the opacity of the active layer, the drop-down list defines the blending 
mode.

Below these controls, you’ll find a row of material channels. These represent all the 
material channels you have defined (or, if you have defined material groups, only the 
active groups). The button on the left lets you switch multi channel mode on or off. The 
pencils indicate which material channels are active for painting.
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On the left you’ll see thumbnail previews for your materials. To the right of each 
thumbnail, a colored pencil icon means the material is active for painting, a grayed 
out pencil means the material is loaded in RAM but not active for painting, and a cross 
means the material is not loaded in RAM.

To choose which material is active for painting, click the grayed out pencil icon or cross 
icon (clicking on the cross icon loads the material into RAM). You’ll see a colored pencil 
icon appear. To activate multiple materials for painting, shift-click each material that you 
want to paint on.

To the right of the material names, you’ll see a triangle for each material that has layers. 
Click a triangle to display the material’s layers. Click the triangle again to hide the layers 
once more. When the layers are hidden, they are internally flattened and displayed as a 
single, combined preview.

The right part of the Material manager is used for displaying the material channels and 
layers. If these are not displayed, you must first create a texture from the Texture menu.

The bhodiNUT Fusion shader (described later in this chapter) lets you combine multiple 
textures. You can access these textures here also, as well as any textures you have created 
using the Add User Data command.



450 • CHAPTER 23 MATERIAL MANAGER • 451

Hiding layers

The eye icons enable you to hide the layers to the right. Click an eye icon to hide or 
display the layers. Note that you cannot paint on hidden layers.

The pencil icon

The pencil icon tells you whether any of the layers to its right are active for painting. A 
red frame around a layer means the layer is active for painting.

Linking layers

You can move or transform linked layers as one. You can only link layers if they belong 
to the same material. To link a layer, click on the area where the pencil icon is usually 
displayed. You’ll see a link icon appear. To unlink the layer, click the link icon once more.

 You can import Photoshop files with linked layers intact.

Active layers and channels

Each active layer and channel is indicated by a red frame.

1 Frame around the material channel (here, around the Color channel). Indicates which 
material channel is active.

2 Bright red frame around a layer. Active layer of the active material channel. This means:

- The layer is active for painting.

- The layer’s texture is displayed in the Texture view.

- The settings for the layer/texture are displayed in the Attribute manager.

- This color is displayed in the Color manager and in the active channel preview in the 
left toolbar.

3 Dark red frame around a layer. Layer is active for painting. Suppose you want to paint 
on seven material channels at the same time. Each of these channels has several layers. 
You can activate a layer for painting by clicking on the layer. This layer’s frame will only 
turn bright red when you select the next layer that has a dark red frame. Thus you can 
quickly tell which layers are being manipulated.

Context menu for layers

To open a layer’s context menu, right-click (Windows) or Command-click (Mac OS) on the 
layer.
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Layer Manager (expanded/compact) mode

This mode works in the same way as the compact mode (see above) except that:

1 The layers and channels are arranged differently. In particular, there is more emphasis 
on vertical arrangement, to allow space for layer masks. This is the mode for you if you 
often work with layer masks or alpha channels.

2 Alpha channels and layer masks are displayed.

3 You can drag and drop layers (provided they belong to the same material).

Creating an alpha channel

Select some pixels and in the Material manager, choose Texture > New Alpha Channel. 
You’ll see an alpha channel named “Selection Mask” appear in the active material 
channel of the active material, right at the bottom.

To switch the alpha channel on or off, click the black circle icon. If the icon is active, all 
black parts are cut out, white parts remain visible and gray parts are semi-transparent 
(the darker the gray, the more transparent it is). Provided the alpha channel is active, you 
can paint it directly in the 3D view or in the Texture view. Colors you paint on the alpha 
channel are converted to grayscale.
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To create a selection from the alpha channel, choose Selection From Layer from the 
context menu or from the Material manager’s Texture menu.

You can convert alpha channels to normal channels via drag-and-drop.

 An alpha channel defines which parts of a material channel are visible. Note that you 
cannot use the alpha channel to store a selection.

When an alpha channel (or layer mask) is active, the layer modes change and only two 
options are available:

Straight, Premultiplied

When you render a picture with an alpha channel, both the bitmap and the alpha 
channel are antialiased. If you load this bitmap and its alpha channel into BodyPaint 3D 
and you are using the Straight mode, the bitmap and alpha channel are multiplied. This 
causes the transition from the object’s color to the background color to be calculated 
twice and this may cause an unwanted seam at the edge. Use premultiplied mode 
instead to avoid the seam.

Creating a layer mask

To create a layer mask, do one of the following:

-  In the Material manager, choose Texture > Add Layer Mask. If pixels are selected when 
you call the command, the unselected pixels will be masked.

-  Drag a layer that belongs to the same material and drop it to the right of another layer. 
As soon as you drop the layer, it is converted to a layer mask.

As with alpha channels, you can switch the layer mask on or off by clicking the black 
circle icon. Also, you can convert the layer mask to a normal layer via drag-and-
drop. To delete a layer mask, click it to select it and in the Material manager, choose 
Texture > Delete Layer.

 A layer mask defines which parts of the layer are visible.

For details on the other display modes for the Material manager, see “Display Modes” on 
page 456.
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File Menu

New Material
This command creates a new material with default values (white with specularity). The 
new material is placed at the start of the material list.

bhodiNUT Volume
Use this menu to create bhodiNUT volume (3D) shaders.

Shader
This menu lists the built-in material shaders. Material shaders are complete materials 
in their own right, as opposed to channel shaders which can be loaded into various 
channels of a material via the Material Editor or Attributes manager.

Load Materials
This command loads materials, adding them to any materials already in the scene. You 
can also import materials from another scene by loading the scene file.

A word of caution regarding textures: when BodyPaint 3D renders the scene, it must 
find all the textures. BodyPaint 3D will look for the textures in the scene’s folder and in 
a sub-folder called “Tex”. In addition, you can specify up to 10 alternative texture paths 
in the preferences on the Texture Paths page. When the scene is to be used on another 
computer (perhaps by a colleague) we recommend that you save the scene using the 
Save Project command. This will save all of the textures used by the scene in a “Tex” sub-
folder.

Save Materials As, Save All Materials As
These commands save the selected materials or all materials. The save dialog will open. 
To reload the materials later on, use the Load Materials command.

Close
Closes the Material manager.
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Edit Menu

Undo, Redo
Undo undoes the last change, restoring the last change you made to a material. Choose 
Undo repeatedly to undo the changes one by one. Redo redoes a change. Select Redo 
repeatedly to continue restoring the changes. 

Cut
Cut deletes the selected materials from the Material manager and copies it to the 
clipboard. You can use the Paste command to retrieve the material from the clipboard, 
even if you have changed the active scene (i.e. you can paste between scenes).

Copy
 You can quick-copy materials by using drag-and-drop with the Ctrl key held down. Drop 

the copy and drop it at the desired position in the material list. The first copy will be called 
“name.1”, the second copy will be called “name.2” and so on.

Deletes the selected materials and copies them to the clipboard. The materials can be copied 
back from the clipboard with the Paste command.

Paste
Inserts the materials that are stored in the clipboard (i.e. the last materials that were cut or 
copied there) into the active scene.

Delete
Deletes the selected materials without copying them to the clipboard. Alternatively, press 
the Backspace or Delete key.

Select All, Deselect All
These commands select or deselect all materials.
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Display Modes
Material

This is the original display mode used in previous versions of BodyPaint 3D. Textures and 
layers are not shown.

Material List

Displays the materials as a vertical list. Textures and layers are not shown.

Layer Manager (compact)

This is the default mode. Textures and layers are shown, but alpha channels and layers 
masks are not. See also “Painting Modes” on page 449.
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Layer Manager (expanded/compact)

In this mode, textures and layers are displayed as a vertical list. Alpha channels and layer 
masks are shown (see “Painting Modes” on page 449).

Layer Manager (expanded)

The multi channel palette is not displayed in this mode. Also, texture previews are only 
shown for materials that are open.
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Layer Manager (active texture)

This mode differs from the others in that it only displays the textures and layers that 
belong to the active material channel of the active material (Texture tag selected in the 
Object manager).

If you are working with a bitmap in the Texture view that has not yet been assigned to 
a material (for example, if you are simply using BodyPaint 3D as a 2D image editor), the 
Material manager will display the bitmap together with its layers, layer masks and alpha 
channels.

In such cases you may wish to use the Layer manager instead, which works in the same 
way as this mode except it does not display the multi channel palette. To open the Layer 
manager, choose Window > Layer Manager from the main menu.

Icon Size
Mini Icons, Small Icons, Medium Icons, Large Icons
Here you can choose the size of the material thumbnails. Note that mini icons and small 
icons are the same size if the Material manager is set to Material display mode. Also, you 
may notice pixels when using medium icons depending on which graphics card you are 
using.
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Function Menu

Edit
This command opens the Material Editor if it is not already open and makes the Material 
Editor the active window. You can use the Material Editor to change the properties of 
the selected material. You can also open up the Material Editor by double-clicking on a 
material’s thumbnail.

You can also edit materials using the Attribute manager. The advantage of the Attribute 
manager is that you can edit multiply-selected materials at the same time. For example, 
if you have several similar wood materials and want to set their specular properties all to 
the same values, select all the wood materials and change the specular values as desired. 
The settings will be applied to all the selected materials.

Apply
Creates a Texture tag for each selected object. Each of these tags is assigned the selected 
material. You can also apply materials using drag-and-drop. If you drop the material on 
to an existing Texture tag ...

... the tag’s previous material is replaced by the new one. However, if you drop the 
material onto the object name, a new Texture tag is created for the material.

Rename
Use this command to change the name of the selected material. You can also rename a 
material by double-clicking on its name, which is just below the material’s thumbnail, or 
by selecting the material and entering the new name on the Basic Properties page of the 
Attribute manager.

Select Materials Of Active Objects
Use this command to select the materials used by the selected objects or Texture tags. 
The Material manager will scroll if necessary in order to show these materials.

Find First Active Material
Shows the first selected material in the Material manager.
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Select Texture Tags/Objects
Selects the objects and texture tags that use the selected materials.

Render Materials, Render All Materials
 To abort the rendering of the thumbnails, press the Esc key.

These commands redraw the thumbnails of the selected materials or all materials. Most 
of the time you won’t need to use this command since new materials are rendered 
automatically. However, when you save a scene, the thumbnails are compressed to 
reduce the scene’s file size. When you load a scene, you may notice artefacts in some 
of the thumbnails. In such cases, use this command to redraw the thumbnails. You’ll 
also need to use this command when importing foreign data formats such as DXF and 
3D Studio R4.

If you render the materials and only the base color is shown, it probably means that 
BodyPaint 3D was unable to find the textures. The best way to avoid missing textures 
when moving scenes from one computer to another is to use the Save Project command. 
This saves all of the textures used by the scene in a “Tex” folder within the scene’s folder.

Sort Materials
Arranges the material list in alphabetical order. You can also sort materials manually 
using drag-and-drop.

Material Groups
You can arrange materials into material groups and choose which groups are displayed 
in the Material manager. This helps you to quickly find the materials that you want to 
access, especially when your scene contains dozens of materials. A tab for each material 
group is shown at the top of the Material manager.

 The material group tabs are only displayed if you have created at least one material group. 
See “New Material Group”, below.

Click a group tab to display its materials or Shift-click a tab to display the tab’s materials 
as well as those already shown. You can assign a material to one group only (the 
exception is the All group, which is automatically assigned all textures in the scene).

To move a material from one group to another, drag the material onto the tab of the 
target group. After a short delay, you’ll see the target group’s materials appear. Drop the 
material in the desired position.

 When you delete a material from a group, the material is deleted from the All group as 
well, i.e. it is deleted completely.
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You can cut, copy and paste within the same group only. You cannot cut or copy a 
material in one group and paste it into a different group.

When a material group’s name is red, it means the group contains materials that are 
selected.

New Material Group
This command creates a new material group. A dialog will open which lets you name the 
material group. Type in a name for the group and click OK. The new group will appear as 
a tab at the top of the Material manager. If this is the first group you have created, you’ll 
see three groups appear as tabs: the group you have just created, the All group (contains 
all materials) and the Others group (contains all materials not assigned to your own 
material groups).

You can rename your material groups but you cannot rename the All and Other groups. 
To rename a material group, double-click its name, enter the new name into the dialog 
that opens and click OK.

Remove Material Group
Deletes the selected material groups and moves their materials to the Others group (the 
materials themselves are not deleted). You cannot remove the All and Others groups. 
They will be deleted automatically if you remove your own groups.

Remove Unused Materials
Deletes all unused materials.

Remove Duplicate Materials
Deletes all materials of the same name that have identical parameters.
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Texture Menu
Some of the commands on this menu are described in Chapter 10, Image Menu, 
and Chapter 11, Layer Menu. Please see the appropriate chapter for details on these 
commands.

Texture Channels
The Texture Channels menu enables you to create new material channels and delete 
existing material channels for the selected material. If you want to create a new material 
channel, open the menu and choose from the list that appears. Once you have made your 
choice, a window opens in which you can define the channel’s parameters (See “New 
Texture” on page 155). Once you have set the parameters and clicked OK, the window 
closes and a small checkmark appears next to the channel’s name in the Channels menu. 
To delete the channel, select it from the menu once more.

You can create and assign textures to the following material channels: Color, Diffusion, 
Luminance, Transparency, Reflection, Environment, Bump, Alpha, Specular Color, 
Displacement.

The Shading Mode supports the following material channels: Color, Diffusion, 
Luminance, Bump, Specular Color 

 Although Shading Mode does not support transparency and reflection, you can display 
the textures for these material channels directly on the object by enabling the Display 
Selected Channel option (main menu: Edit > Display Selected Channel).

The raybrush mode supports the following material channels: Color, Diffusion, 
Luminance, Transparency, Reflection, Bump, Specular Color.

The remaining channels can still be edited, but you must render if you want to see their 
effect.

Load Textures, Unload Textures
These commands enable you to load and unload textures to and from RAM for the 
selected materials.

Unloading textures frees up RAM and prevents you from accidental painting these 
materials (you can also prevent accidental painting by clicking the pencil icon to gray it 
out).

A cross icon next to the material’s preview means the material’s textures are not loaded. 
To load the material’s textures, click the cross icon.
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The Material Editor

The Material Editor enables you to edit the properties of the materials used in your 
scene. To open the Material Editor, double-click a thumbnail in the Material manager. 
The Material Editor is a non-modal window. In other words, there is no need to close 
it before you can edit another material. Simply click once on another material in the 
Material manager and its settings will appear in the Material Editor.

 You can also edit material properties in the Attribute manager.

The Material Editor is divided into panes. The material’s preview is shown in the top left 
corner. There are also 14 pages of parameters, the settings of which are combined to 
form the material. You’ll find a list of these parameter pages — known as channels — in 
the left part of the dialog. Most of the time you won’t need to use all the channels. Use 
the option boxes next to the channel names to choose which channels (i.e. properties) 
are used by the material. To access a parameter page, click the desired channel’s name. 
Each page operates in a similar way and the control elements are in the same place.

Additional Attribute manager settings
The following commands are available in the Attribute manager only. They are not 
available in the Material editor.
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Assignments

This is a list of all objects in the scene that use 
the selected material. Right-click (Windows) or 
Command-click (Mac OS) on an object name to 
open a context menu that contains the following 
commands:

Remove

Removes the material from the selected object (i.e. 
the Texture tag is deleted).

Remove All

Removes the material from all objects.

Show In Manager

...

Delete Tag

You can select this command only if a Texture tag 
is selected in the list. It deletes the tag. This has the 
same effect as the Remove command (see above).

Select Object, Select Tag

Selects the object or tag and displays its settings in 
the Attribute manager.

Color pane
See “Units” on page 77.

Property What it controls

Color Surface color

Diffusion Irregularities in 
surface color (works 
by brightening and 
darkening the color 
channel)

Luminance Luminescent color 
(light-independent 
color)

Transparency Transparency 
(including refraction 
index)

Reflection Ability to reflect other 
objects

Environment Environment 
reflection (simulates 
reflection)

Fog Fog effect

Bump Virtual bumps on a 
surface

Alpha Localized texture 
invisibility

Specular Highlight

Specular Color Highlight color

Glow Halo around an object

Displacement Authentic bumps on a 
surface

Illumination Radiosity, caustics, 
illumination model
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Texture pane
Use the Texture pane to select a two-dimensional picture or shader. Your selection will 
be used as a texture. BodyPaint 3D recognizes these formats: JPEG, IFF (ILBM), TIFF, TGA, 
BMP, PICT, Photoshop PSD, MOV, AVI. If QuickTime is installed on your system, other 
formats will also be available via QuickTime. You can also select a texture that you have 
created in BodyPaint 3D from the triangle button’s Bitmaps menu.

Once you have selected a texture, its preview appears to the right with three numbers 
shown immediately below. These are the width, height and color depth of the texture. 
If you click within the preview picture, the color of the pixel that you clicked is copied to 
the Color pane.

Image

 You cannot reload a texture while it is in use (e.g. during rendering).

Use the Image button to load a texture into the Texture pane. Use the system dialog 
to load an image file from either your scene’s folder, your scene’s “Tex” sub-folder or a 
texture path that you have specified in the preferences. A dialog warns if the image file is 
not in a search path and asks if you want to copy the image to the document’s folder or, 
if your scene doesn’t have its own folder yet, to the BodyPaint 3D root folder.

Once you have loaded a texture, its path name appears in the input box. To the right you 
can see the texture’s preview picture.

 BodyPaint 3D searches for textures in the BodyPaint 3D’s “Tex” folder, the scene’s folder, 
the scene’s “Tex” folder and the texture paths specified in the preferences (including sub-
folders). If BodyPaint 3D cannot find a texture when rendering, a message will appear to 
tell you which textures are missing and which materials use these textures. You can still 
render the scene without the missing textures by clicking OK.

To load a shader into the Texture pane, click the triangle right of the image text box and 
choose the desired channel from the drop-down list that appears. On this drop-down 
list, you’ll also find two commands called Copy Channel and Paste Channel. Use these 
when you want to copy and paste shader settings from one material channel to another.

This works only for channels that accept textures and shaders. You can also use the 
drop-down list to reload the image. This is useful if you have changed the texture in an 
image editor and you want to update the preview. To reload the image, choose Reload 
Image. The following commands are also available from the triangle’s menu:

Edit Timing

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see the CINEMA 4D reference for details.

Edit Image

Opens the image in your computer system’s default image editor.
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Reload Image

 This command is useful if you have changed the texture in an image editor and you want 
to update the preview.

 You cannot reload a picture while it is in use such as while the scene is being rendered.

Copy Channel, Paste Channel

You can use these commands to copy and paste shader settings from one material 
channel to another.

Bitmaps

Here you’ll find a list of all pictures currently in RAM. Choose a picture from the list to 
load in into the Texture pane. This gives you a quick way to load pictures that you have 
just pained into materials.

Shader

BodyPaint 3D offers a wealth of procedural shaders. To load a shader, choose the 
desired shader from the list.

bhodiNUT Channel, Shader

To access shaders, including the bhodiNUT channels, click the triangle right of the image 
text box and choose the desired shader from the drop-down list that appears (bhodiNUT 
Channel or Shader sub-menu).

Sampling

Use Sampling to change how the texture’s pixels are interpolated. MIP and SAT are 
the best choices for animation and for objects in still pictures that extend towards the 
horizon such as floors. Square, Alias 1, Alias 2 and Alias 3 should, in general, be used for 
still pictures only — they generate crisp, sharp textures but are too sharp for animation 
and are extremely flicker-prone. MIP and SAT, on the other hand, blur the texture slightly 
to allow flicker-free animation.
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Example texture. None. Circle.

Square. Alias 1. Alias 2.

Alias 3. MIP. SAT.

None

When the sampling type is set to None, the original texture values are used without 
interpolation. This method is fast but often produces poor results. Textures tend 
to become pixelated. You can try to compensate for the pixelation by using a high 
antialiasing setting. Generally, avoid using this sampling type unless you are sure you 
need to use it.

Circle

Circle sampling uses a circle of texture pixels (those that surround the intermediate 
value). Textures that are enlarged at render time tend to look more natural with this type 
than with the None type. However, as the picture above demonstrates, straight lines are 
problematic and appear to be frayed. In addition, the texture is very jagged near the 
horizon. Circle sampling is, however, a good choice for very small textures (e.g. 3 x 3 
pixels), since it helps the pixels to blend softly.
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Square

Square uses a square of texture pixels (those that surround the intermediate value). This 
leads to a softer transition between texture pixels than with None. The picture quality is 
good. 

Alias 1, Alias 2, Alias 3

Alias 1, Alias 2 and Alias 3 blend the texture more strongly than Circle and Square. Alias 
3 blends the most, Alias 1 the least. In the example above, the texture is difficult to 
recognize with Alias 3 because it is so small (16 x 16). Alias 3 can give smoother results 
than Alias 1, but it also takes longer to calculate. Note that even Alias 3 cannot prevent 
jaggies near the horizon.

MIP, SAT

 Enable MIP Falloff to enhance the MIP/SAT mapping effect for bump maps. This will 
reduce the strength of the bump map with increasing distance from the camera.

MIP stands for “multum in parvo”, which is Latin for “many things in a small place”. 
When many texture pixels effectively lie within a single screen pixel, an approximation 
is made based on the (known) texture pixel values. This results in very smooth blending. 
MIP is the default sampling type.

SAT is short for “summed area tables” and it does an even better approximation than MIP 
mapping. As with MIP mapping, the approximation is based on the texture pixels that lie 
within a single screen pixel. SAT is the highest-quality sampling type.

 SAT mapping works with textures up to 4,000 x 4,000 pixels. BodyPaint 3D switches to 
MIP mapping automatically if you try to use SAT mapping with larger textures.

MIP and SAT mapping are especially important for high-quality animation and for 
objects in stills that extend towards the horizon such as seas. MIP mapping is the default 
sampling type. The two pictures demonstrate MIP/SAT mapping. Figure 1 was rendered 
with the antialiasing set to Always with 2 x 2 oversampling. The tiled texture used Circle 
sampling. Although the quality is generally good, the quality rapidly deteriorates towards 
the horizon. This unwanted effect is the result of perspective distortion. Each screen pixel 
representing the floor near the horizon contains perhaps hundreds or even thousands of 
texture pixels.

MIP and SAT mapping approximate a value using these pixels. Only an approximation 
is made, since calculating the exact value would increase render time greatly. Figure 2 
shows Edge antialiasing with 2 x 2 oversampling. The material used SAT sampling. The 
image quality is much improved, including the reflection shown on the sphere.
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Figure 1: Rendered with MIP sampling. Figure 2: Rendered with SAT sampling.

The downside of MIP and SAT mapping is that they require extra memory. MIP mapping 
needs an extra byte of memory per texture pixel, SAT mapping requires and extra 12 
bytes per texture pixel. Although SAT mapping gives you higher render quality than MIP 
mapping, MIP mapping uses much less RAM and hence is the default interpolation type. 
As a rule of thumb, use MIP mapping initially and switch over to SAT mapping if required. 
BodyPaint 3D’s shaders use SAT mapping automatically without consuming additional 
memory.

MIP and SAT mapping affect the render time. On the one hand, MIP and SAT mapping 
take slightly longer to render. On the other hand, you may be able to reduce the 
antialiasing setting.

O (Blur Offset), S (Blur Strength)

 With floors, try a positive blur strength of about +20%. Floors tend to suffer most from 
perspective distortion, so they require special treatment.

The blur offset (O) can be used to soften a texture.

The blur strength (S) fine tunes the strength of the MIP/SAT mapping.
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MIP and SAT mapping only approximate the optimum computation, since a precise 
computation would increase the render time greatly. SAT mapping is more accurate 
than MIP mapping. But sometimes these approximations can make a texture too blurred 
or too sharp. So the O and S options enable you to blur or sharpen the mapping. O 
(Blur Offset) softens a texture. S (Blur Strength) fine-tunes the strength of the MIP/SAT 
mapping. A positive value increases the blur; a negative value weakens it. A strong value 
blurs detail but helps prevent flickering during animation. A weaker value brings out 
more detail but increases the risk of flickering.

Mix

Use this to mix the color and texture panes using one of four modes. The default mode 
is Normal, apart from the Environment page which uses Multiply as the preset. Not all 
pages have Mix settings. If you load a texture or a 2D shader, it is placed on a layer above 
the color (i.e. the texture is placed on top of the color). Enter a value into the text box or 
drag the slider to set the mixing proportion between the texture and color panes.

Normal

In normal mode, the value in the text box sets the opacity of the texture. If the value is 
set to 100%, you see the texture only (remember, the texture is the top layer so if it is 
opaque you will not see the color underneath). If the value is set to 70%, the result is 
70% of the texture and 30% of the color.

For example, if a texture pixel of RGB 255/0/0 (red) is used with a color value of RGB 255/
255/0 (yellow) with the Mix value set to 50%, the resultant color is 255/128/0 (orange).

Add

The texture’s RGB value is added to the color’s RGB value. Color channel values cannot 
exceed the maximum of RGB 255. So if a texture pixel of RGB 0/255/255 (cyan) is added 
to a color value of 255/255/0 (yellow), the result is 255/255/255 (white).

Subtract

The color’s RGB value is subtracted from the texture’s RGB value. Thus if a texture pixel 
is RGB 255/255/255 (white) and the color value is 255/0/0 (red), subtracting with the Mix 
value set to 100% gives the result 0/255/255 (cyan).

Multiply

The RGB value of the texture is multiplied by the RGB value of the color. Multiply takes as 
its result the lowest R value, the lowest G value and the lowest B value of the texture and 
color. For example RGB 255/128/0 (orange) multiplied by RGB 0/255/0 (green) results in 
RGB 0/128/0 (dark green).

Edit

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D. Please see the CINEMA 4D reference manual for details.
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Color

The settings on this page define the basic color of the material such as RGB 255/0/0 for 
red. If you want to create a more complicated material such as a checkered pattern that 
uses several colors, use the Texture pane. The texture is layered above the color. If you 
want to see the color only and not the texture, set the Mix value to 0%.

Texture

 See “Texture pane” on page 465.

 If you set the Mix value to 0%, the texture is not loaded into memory since no calculation 
is required.
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Diffusion

The Diffusion page lets you darken and lighten the material in specific areas using a 
diffusion map. One reason for using a diffusion map is to dirty-up materials — a must for 
photorealism. You can use either a normal texture or a shader as the diffusion map. (If 
the texture is colored, it will still be treated as a grayscale map.) The darker a pixel in the 
diffusion map, the darker the corresponding region of the material.

Affect
Enable the Luminance option if you want the diffusion map to affect the luminance 
property. The darker a pixel in the diffusion map, the darker the corresponding region 
of the luminance. This helps you add irregularities to the luminance to achieve a more 
natural look.

If the Specular option is enabled, the diffusion map is applied to the specular property as 
well. This will reduce the material’s specular values where the diffusion map is dark. This 
option is enabled by default since it adds to the realism considerably.

Enable Reflection if you want to apply the diffusion map to the reflection and 
environment properties for an even more natural look. The darker a pixel in the diffusion 
map, the darker the corresponding region of the reflection.

Texture

 See “Texture pane” on page 465..
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Luminance

A luminescent object can be seen even when there are no lights in the scene. It is self-
illuminated.

Texture

 See “Texture pane” on page 465.

You can use the Image button to load an image that is to act as a luminance map. The 
brighter a pixel in the luminance map, the more luminescent the corresponding region 
of the material. If you have chosen a Luminance Color and loaded a texture (luminance 
map) as well, the color will be added at 100% strength to the texture. If you want to see 
the result without the chosen color, set Mix to 0%.

Luminescent materials are used to help simulate objects that seem to be self-illuminated 
in the real world, such as the windows of an office block at night, neon writing or a TV 
screen.
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Transparency

On this page you can set the material’s transparency settings. If the material also has 
a color, the color is automatically reduced with increasing transparency. The equation 
is: color percentage + transparency percentage = 100% . So a white material with 0% 
transparency is white (100%). A white material with 50% transparency is 50% white 
(gray). A white material with 100% transparency has no color.

Refraction
If the Additive option is enabled, the color strength is not reduced automatically and 
unless you take care the material will look unnatural (see Figure 1, below). Transparency 
has an effect similar to a light filter; black lets no light through, white lets all light pass.
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Figure 1: If you enable the Additive option, the color 
strength is not reduced automatically and unless you 
take care the material will look unnatural.

Figure 2: Transparency may be controlled either by a 
transparency map (Texture) or by the Transparency 
Color.

You can simulate the refractive index of a material by setting the n value in the Refraction 
pane. Objects that are not closed (such as a hemisphere without a cap) can give 
unexpected results with refraction (sees Figure 3 to 5, below). When a ray hits a closed 
surface (Figure 3) with transparency and refraction, the ray is bent to simulate refraction. 
The bent ray is considered to be inside the object. When the ray reaches another surface 
of the object (the exit side), it is bent back as in real life. However, if the object is open, 
the ray may not hit a second surface of the object (Figure 4). Thus the ray may not be 
bent back and the refractive effect may be inaccurate. For this reason, ensure that the 
transparent surfaces used in your scene are closed (Figure 5).

Figure 3. Figure 4. Figure 5.

If you enable the Fresnel option, the viewing angle — the angle between the camera and 
the surface — will be taken into account. If you observe a real pane of glass with your 
eyes parallel to the pane (i.e. with a 90 degree viewing angle), you’ll notice that the pane 
barely reflects, almost all light passes through.

However, look at the pane from a narrow viewing angle and you’ll see that it reflects 
much more of its surroundings. The transparency and reflection values are dependent on 
the viewing angle. The Fresnel option simulates this phenomenon for you.

For example, if you set transparency with RGB values of 80%, 80%, 80%, the material 
is 80% transparent and 0% reflective when the viewing angle is 90 degrees. With a very 
low viewing angle, the material is approximately 0% transparent and 80% reflective. If 
you have entered a reflection value in addition to transparency, the reflection value is 
added to the angle-dependent reflection. If Fresnel is disabled, the transparency and 
reflection values are used as they are, irrespective of the viewing angle.
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Useful refraction values

Acrylic glass1.491 Diamond 2.417 - 2.419 Onyx 1.486 - 1.658
Agate 1.544 - 1.553 Emerald 1.576 - 1.582 Quartz 1.550
Air 1.000 Flint glass 1.613 Ruby 1.760 - 1.770
Amber 1.550 Glass 1.440 - 1.900 Sapphire 1.760
Amethyst 1.544 - 1.553 Ice (H2O) 1.310 Sugar 1.560
Benzene 1.501 Jade 1.660 - 1.680 Topaz 1.620 - 1.627
Common 
salt

1.544 Jasper 1.540 Vacuum 1.000

Crown glass 1.510 Obsidian 1.480 - 1.510 Water 1.333

Texture

 See also ‘Texture pane’ on page 465.

You can use a texture as a transparency map. The brighter a pixel in the transparency 
map, the more transparent the corresponding region of the material. A transparency 
texture is similar to a photographic slide. Red parts of the slide allow only red light 
to pass through; white parts allow all the light through. With black, no light can pass 
through the slide.

You can use a transparent material with a light source to create a light map or ‘gel’. If a 
transparent texture is assigned to a light source, the light will be filtered according to the 
texture’s coloration, just like a real gel. You can use this effect to simulate disco lights, 
the light cast from a monitor and so on.

Blur
Use these settings to blur the transparency.
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Dispersion

Dispersion set to a low value (left) and high value (right).

Defines the strength of blur for the transparency. 0% means no blur. Increase the value to 
increase the strength of blur.

Accuracy

 Increasing the Accuracy value gives a more accurate blur but a longer render time also.

Affects the accuracy of the blur effect by controlling the number of samples per shading 
point. With a value of 100%, the number of samples defined under Max Samples will be 
used. Lower the value to reduce the number of samples used.

Min Samples / Max Samples

 Increasing Min Samples and/or Max Samples gives a higher quality blur, but a longer 
render time also.

BodyPaint 3D uses samples to create the blur effect. Rather than take samples at even 
distances, the samples are concentrated where they are most needed. Max Samples 
defines the number of samples used for the most critical areas. Min Samples defines the 
number of samples used for the least important areas.

 If you see black areas when rendering overlapping transparency objects, increase the Ray 
Depth value on the Options page of the render settings. If you can’t see weak reflections 
in the render, ensure that Threshold is set to 0%. You’ll also find this parameter on the 
Options page of the render settings.
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Reflection
 If there are lots of reflective objects in your scene you may notice that, with some of 

them, shadows do not appear in the reflections. To make the shadows appear, increase 
the Shadow Depth value of the Render Settings. Similarly, you may notice that subtle 
reflections are missing. In this case set the Threshold value in the Render Settings to 0.

Use the Reflection page to set a material’s ability to reflect. The color that you set 
determines the color of the reflection. You can also use a colored texture in the texture 
pane — this is known as a reflectivity map. The color of a pixel will affect the color that is 
reflected from the corresponding area of the material.

Figure 1, below, illustrates some reflectivity effects including a reflectivity map. The flask 
has a simple reflective material. Note how the reflection of the rod is distorted as you 
would expect in real life. Look closely and you will see that the flask itself is reflected on 
the tiles. Look even more closely and you should see that the flask is reflected on the tiles 
but not on the joints, even though the tiles and joints are part of the same tiled material.
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Figure 1: Some reflectivity effects including a 
reflectivity map.

Figure 2: Blur Dispersion values of 85% (left), 0% 
(back) and 65% (right).

This effect was created by using a grayscale reflectivity map. The reflectivity map was 
based on the original tile and joint texture. In the areas covered by a tile the reflectivity 
map is white. In the joint areas the reflectivity map is black. The resultant map means 
that only the tiled areas, not the joints, are reflective. This is just one example of how you 
can combine several properties to create more realistic materials.

Texture

 See ‘Texture pane’ on page 465.

Blur
Use these settings to blur reflections.

Dispersion

This defines how diffusely the object reflects. In other words, this defines how blurred 
reflections are. 0% means no blur. Increase the value to increase the strength of the blur 
effect (see Figure 2, above).

Accuracy

 Increasing the Accuracy value gives a more accurate blur but a longer render time also.

This affects the accuracy of the blur — it works by controlling the number of samples 
used per shading point. If you enter a value of 100%, the number of samples defined 
under Max Samples will be used. Lower the value to reduce the number of samples used.

Min Samples / Max Samples

 Increasing Min Samples and/or Max Samples gives a higher quality blur, but a longer render 
time also.
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BodyPaint 3D uses samples to create the blur effect and, rather than take samples at even 
distances, it concentrates the samples where they are most needed. Max Samples defines 
the number of samples used for the most critical areas. Min Samples defines the number 
of samples used for the least important areas.
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Environment
 Environment reflections are rendered very quickly, since the raytracing mode is not 

required.

The Environment page uses a texture to simulate reflection. Here, in contrast to the other 
pages, the Color and Texture are multiplied by the Mix mode instead of being added. So 
why would you want to use the environment property instead of reflection? One reason 
is that your scene may not have enough objects to produce good results when reflected. 
Another reason is that the environment property renders more quickly than the reflection 
property.

Environment reflections are especially useful for 
simulating metallic surfaces, which typically have soft 
transitions from black to white.

The reflections on the BNC connectors were simulated 
using the environment property only.

The environment property is independent of the projection type of the material. The 
environment is always placed spherically around the object, parallel to the world axis. 
Use Tiles to set the number of tiles in the X and Y directions. Note that these tile settings 
are used instead of the Texture tag’s tile options in the Attribute manager.
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Texture

 See “Texture pane” on page 465.

Exclusive

If this option is enabled, the environment reflections will be excluded from areas where 
there are real reflections.
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Fog
 Fog uses the refractive index defined on the Transparency page (Refraction pane) and 

disables the transparency. Fog and transparency are thus never rendered together. You 
can render either fog or transparency, but not both for the same material.

With these parameters you can simulate fog or gas clouds. Objects with such materials 
are translucent but weaken the light that shines through them, according to their density. 
If a light ray penetrates into the fog, it is weakened. You can control this weakening with 
Distance. The larger this value, the thinner the fog. Distance indicates at which distance a 
light ray is completely weakened.

You can color the fog and this also affects its visibility. The further you look into the fog, 
the less the objects are visible and the more the fog color becomes visible. The fog color 
therefore also depends on the distance value. If you choose, say, a Distance of 500 units, 
a light ray of originally 100% intensity has an intensity of 50% after a distance of 250 
units and is extinguished completely after a further 250 units. The shorter the distance, 
the thicker the fog appears. In addition to this effect, after 250 units half the fog color is 
added to the light and after 500 units the full fog color is added.

This foggy effect was created by applying a fog 
material to a cube.



484 • CHAPTER 23 MATERIAL MANAGER • 485

Use fog materials with closed objects only. Fog is a volume effect applied to the inside 
of an object. For non-closed objects, BodyPaint 3D cannot determine the inside and the 
outside of the object so, if you use a fog material on such an object, strange things may 
happen.
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Bump
 You can enter values up to 500%. High values are especially useful when using MIP or 

SAT mapping, since these interpolation types tend to flatten the surface slightly.

The settings on this page enable you to simulate bumps for your material. You must use a 
texture with this channel since it is only from the grayscales in this image that the bump 
map (a height or relief map) is calculated.

Bump
You can change the strength of the bump map with the Strength slider. The higher the 
value, the rougher the surface. If you move the slider to the left, you can choose negative 
values, in which case the effect of the bump map is reversed; bright pixels then cause the 
material surface to indent while darker pixels elevate the height of the surface.

Texture

 See “Texture pane” on page 465.

Figure 1, below, shows an even surface viewed from the side. The surface has a uniform 
brightness. However, if you use a bump map for the same surface, BodyPaint 3D 
interprets the brightness values of the picture as height values for the surface (Figure 2).
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Figure 1. Figure 2.

These height values are converted into a profile, whose height affects the inclination of 
the normal vectors. Although the surface is actually smooth, through the change in the 
normal vectors an apparently three-dimensional surface with a bump-like structure is 
created at render time; this is shown in Figure 3, below. You can strengthen the MIP/SAT 
mapping effect when using bump mapping by enabling MIP Falloff. The bump mapping 
is then reduced the further the surface is from the camera.

Figure 3: MIP Falloff disabled (left) and enabled (right).
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Alpha
 Many of BodyPaint 3D’s shaders have built-in alpha channels.

An alpha channel enables you to use an image to mask out particular areas of your 
material, allowing any background to show through. This is very useful for faking detail 
in 3D. Often a texture will suffice to give the illusion of detail, especially if it is applied to 
an object that is not the focus of attention or is some distance into the scene; you can 
then use BodyPaint 3D’s Alpha material channel to improve the realism.

The idea is to define areas of your material that effectively become non-existent so that 
any underlying materials or objects show through. A classic example would be a 3D tree. 
Rather than modelling the individual tree, a picture of a tree can be added to an object 
and an alpha used to cut out the shape of the tree.

Alpha Color

 Clipping is often attempted with texture images that are antialiased; this produces a 
bright border around an object caused by the antialiasing of colours between the main 
texture and the alpha color; you can remove this border by adjusting the deviation sliders.

 The simple clip mapping does not work with MIP and SAT mapping; only if you work with 
alpha channels can you use MIP and SAT mapping.

You can use clip mapping (also sometimes called “genlocking”), to mask particular 
areas with a color value. Using this method you pick the colour from the selected image 
that you wish to become transparent. The downside is that often the areas you wish 
to become transparent contain several colors and the resulting alpha can leave a seam 
around the object. However, by setting values for dr (delta red), dg (delta green) and db 
(delta blue) you can define extra color deviations which can reduce the seam.
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 Use alpha channels built in to the texture to mask areas softly and more accurately (see 
“Image Alpha” below).

Texture

 See “Texture pane” on page 465.

Soft

This enables you to fade textures and materials from one to another, which gives you 
even more ways of creating realistic-looking objects. With Soft enabled (the default 
setting) the color and delta sliders lose their meaning. The texture map is now used to 
decide which ranges should be faded. A white texture pixel within the image means 
that here the material is to be 100% opaque. If the texture pixel is black the underlying 
material shines through 100%.

Image Alpha

 If you notice black areas when rendering objects that have multiple alpha materials, 
increase the Ray Depth value on the Options page of the render settings.

 If you apply a material with a BodyPaint 3D Alpha channel to an object and the object 
has no underlying material, the object will be non-existent at the points where the alpha 
allows the underlying material to show through.

With Image Alpha enabled, you can use any existing alpha channel of the loaded image. 
Alpha channels of the TIF, TGA, PICT, Photoshop PSD and QuickTime MOV image formats 
are supported (as well as all QuickTime supported formats). If no alpha channel is present 
in the image, the option Image Alpha will be ignored. Use the Invert function to invert 
the alpha channel without having to rework the texture in your image editor.

Invert

This option simply inverts the alpha, so transparent and solid areas are reversed. This 
works for both clipped images and images with built-in alpha channels.

Premultiplied

Enable this option if you are using a texture with a premultiplied alpha channel. Certain 
graphics applications only produce this type of alpha channel.

Example
Let’s say that you want to place a scanned picture of a tree into a scene. Firstly, you 
should create a material, enable the Color channel, choose a picture of a tree as the color 
texture/image and then assign this material to, perhaps, a rectangular polygon.

If you render this scene you should see the tree on the rectangle polygon. However the 
area around the tree is probably not transparent but may well be blue if the scanned 
picture has a blue sky background (Figure 1, below).
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Now edit your tree material, enable the Alpha channel, switch to the Alpha page and 
load the tree texture there as well. Firstly, use clipping to mask out the tree. Use the 
mouse to choose the color which you want to mask; in our case, the blue sky around the 
tree (Figure 2). BodyPaint 3D sets the color sliders to this color and masks according to 
the picture. The tree is now shown without the surrounding background (provided that 
you have Gouraud Shading or Quick Shading on).

Figure 1 Figure 2 Figure 3

You can now select a slightly different color on the Alpha page and see the effect 
immediately. However, some background may be left around the leaves, branches and 
the trunk. So the result is not quite right yet. For a more accurate result, create an alpha 
channel in your image editor and integrate this into your tree image; for details on how 
to do this, consult you image editor’s documentation. Load this picture from the Alpha 
page and enable Soft and Image Alpha. The texture is now masked cleanly (Figure 3).

Below, two materials have been used: a reflecting gold and a matt wood. To make 
the wood visible, one of the two colours was cut out from a scanned black-and-white 
picture.
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Specular
 You can enter a Height value up to 1,000%. High values can be very  effective in Metal 

mode.

Here you can adjust the width, height and falloff of highlights on the material. For a matt 
surface, use broad and low specular values; for shiny surfaces, narrow and high values 
are appropriate. Three modes are available: Plastic, Metal and Colored.

Plastic lighting model. Metal lighting model. Colored lighting model.

With Plastic, the color of the highlights is independent of the material’s color and will be 
white unless you define a different color on the Specular Color page. Use Plastic mode 
for materials such as plastics, glass or wood, all of which tend to have white highlights. 
For matt metal surfaces such as brass, silver and gold, the Metal mode is the best setting. 
The color of highlights is then based on the material’s color. With the Colored mode, you 
influence the specular diffusion. You can adjust the shape of the falloff curve using the 
Falloff slider. Needle, bell and even rectangular shapes are possible. In addition, the Inner 
Width slider enables you to define an area inside the specular that has no brightness 
falloff.
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Falloff set to 10 (left) and 90 (right).



492 • CHAPTER 23 MATERIAL MANAGER • 493

Specular Color

Here you can select the color of the highlights. The strengths of the colors on the Color 
page and the Specular Color page are added together. The total color here is multiplied 
with the normal color of the highlight. For example, if you have a white plastic highlight, 
you can define its color here directly.

With metallic effects in particular, any highlight color other than white greatly adds to 
the realistic appearance of the material as demonstrated by this spaceship.

Texture

 See “Texture pane” on page 465.

The intensity of the specular is affected by any chosen texture image (color or grayscale); 
click the Image button to load a texture. The brighter a pixel in the image, the more 
evident the highlight is at that point.
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Glow
 Glows cannot be seen through transparent objects, nor in reflections. The glow you 

specify here does not act as a light; other parts of the scene will not be lit by the glow, 
nor will any shadows be cast.

This page enables you to create a soft glow. Inner Strength specifies the intensity of the 
glow above the material surface; Outer Strength is the intensity of the glow at the edges 
(see Figure 1, below). The Radius determines how far the glow extends from the surface. 
This value is rendered relative to the distance of the object from the camera. The further 
the object is, the smaller the glow and vice versa.

 Glows are restricted to a maximum image resolution of 4,000 x 4,000 pixels.

Figure 1. Figure 2.
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If a random percentage is defined, the intensity of the glow in each animation frame is 
increased and decreased in a random pattern, as follows:

   0% No change
   100% Maximum change

Frequency specifies how often the glow changes. The amplitude of the change is given 
by the Random value.

 The Frequency setting only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

   1Hz The glow reaches a new random value after 1 second
   25Hz The glow has a new value for each frame (for 30 fps), which causes a flicker

If Use Material Color is enabled, the glow is calculated on the basis of the material color 
rather than the color specified here. If the option is disabled, the object and glow colors 
are mixed. For example, green objects will appear yellowish under a red glow.

Figure 2 illustrates two examples of using glow. The glowing areas of the burning coals 
were created with Use Material Color enabled. For the neon sign, only an outer glow was 
used. 

 When using object motion blur, glow applied to lights may cause colors to overlap.
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Displacement
 Since the displacement map displaces points, the object must be a polygon object and 

finely subdivided. Displacement mapping has no effect on parametric objects.

Displacement is similar to Bump, the difference being that here the object is actually 
(not just apparently) deformed. This difference is best seen at the edges of objects. In 
Figure 1, below, the left half of the sphere uses bump mapping while the right half uses 
displacement mapping. Displacement mapping works much better in the areas near the 
edges, whereas in these areas, the bump map loses its effect. Figure 2 shows an second 
example of displacement mapping. 

Figure 1. Figure 2.

Adjust the strength of the displacement with the Strength slider. Use Maximum Height 
to specify a distance from the object surface which may not be exceeded whatever the 
Strength. Experiment with objects that have different subdivisions.
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Texture

 See “Texture pane” on page 465.
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Illumination
 The radiosity and caustics settings on this tab only have an effect if you are using 

BodyPaint 3D with the Advanced Render module. Please see the Advanced Render 
manual for details.

Illumination Model
While radiosity is often considered to be the keystone of photorealism, many texture 
painters feel that life-like texturing is just as important. BodyPaint 3D provides you with 
two illumination models, in addition to the default Phong shading, that enhance the 
realism of your materials: Blinn and Oren-Nayar.

The Blinn model is similar to Phong, except that Blinn’s highlights are much more 
accurate. This makes Blinn a better choice for metals and other materials where you 
need accurate highlights. Oren–Nayar, on the other hand, is the model you should use 
for rough surfaces such as cloth, sand, concrete and plaster. On this page you’ll also find 
settings that adjust the diffuse falloff, level and roughness. Some of these parameters 
apply to Oren-Nayar only and will be grayed out when you use Blinn or Phong.

Model

© Rui Batista.
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Choose the illumination model for the material. For a shiny material, choose either Phong 
or Blinn. Blinn is for shiny materials that need accurate highlights, whereas Phong is 
better for plastics. For rough materials like paper, cloth or a car tire, choose Oren-Nayar.

Diffuse Falloff

Use this parameter to adjust the falloff of diffuse reflection. The default value of 0% 
means normal falloff.

Diffuse Level (Oren-Nayar only)

You can use this parameter to alter the strength of diffuse reflection for Oren–Nayar. The 
default of 100% means normal diffuse reflection — enter a lower value to reduce the 
amount of reflection.

Roughness (Oren-Nayar only)

Adjust this value to match the roughness of your material. The default setting is 50%.

Preview Size

This setting controls the resolution of textures in the viewport. You can choose values 
from 64x64 pixels to 2,048x2,048 pixels (the Default setting corresponds to 256x256 
pixels). The higher you set this value, the more detailed the texture will be in the 
viewport, but keep in mind that it will also use more RAM and may slow down OpenGL 
shading.
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The Shaders
 If you want to paint on to a shader, you must first convert the shader to a bitmap. To 

convert a shader to a bitmap, apply the shader to a plane, render the plane and save the 
render. Now load the bitmap into the material in place of the shader.

 BodyPaint 3D’s shaders only work in CINEMA 4D and BodyPaint 3D. They cannot be used 
in other programs such as 3ds max, LightWave and Maya. They will be lost on export.

Shaders (also known as procedural textures) are more sophisticated than conventional 
textures. Shaders are computed using mathematical formulae whereas conventional 
textures are pixel-based. One advantage of shaders is that they do not become pixelated 
when viewed close-up.

BodyPaint 3D distinguishes between two-dimensional and three-dimensional shaders. 
3D shaders take an object’s volume into account, whereas 2D shaders and standard 
textures are simply applied to the object’s surface. 3D shaders are independent of the 
object’s geometry and the texture projection type.

Channel shaders
To open a channel shader, click the arrowhead that is to the right of the Image text box 
in the Texture pane and choose the desired shader from the drop-down list that opens 
(Shader submenu). To edit a shader, click the Edit button in the Material editor. Its 
settings will then appear in the Attribute manager.
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Brick (2D)
 You change the number of bricks using the texture tiling.

This shader generates brick patterns. The Brick shader has an alpha channel which you 
can use within the Material editor on the Alpha page. Color 1 determines the color of the 
brick. Color 2 determines the color of the joints. Joint is the width of the joint relative 
to the size of the brick. Ramp defines the width of the sloping edge between joint and 
brick, as a percentage of the brick’s width; this gives a fuzzy edge to the brick.

Checkerboard (2D)

This shader creates checkerboard patterns. Color 1 and Color 2 determine the colors of 
the two tiles. U Frequency and V Frequency determine the size of tiling, the fineness of 
the structure, in two independent directions. Higher values result in a smaller tiles and 
vice versa. If you use unequal values instead of square tiles, such as U=1 and V=2, you’ll 
get rectangular ones.
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Cloud (2D)
 Effective Cirrus-like clouds can be created with asymmetrical UV parameters (e.g. 0.25, 1).

This shader simulates simple cloud structures. The Cloud shader has an alpha channel 
which you can use within the Material editor on the Alpha page. The gradient determines 
the color of the clouds. U Frequency and V Frequency determine the fineness and shape 
of the structure. Thus U=1 and V=2 results in rather regular cloud structures, U=1 and 
V=0.25 gives rather rectangular clouds and the higher the value, the finer (less wispy) 
the clouds. Clouds affects the number of clouds in the sky.

The Compatibility Mode option ensures that scenes loaded from older versions of 
BodyPaint 3D using this shader look the same.

Color (3D)

This colorful shader uses sine functions to cycle through the RGB color range. The 
Frequency values specify the behavior of the colors in the X, Y and Z directions. A high 
value means more detail in that direction.
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Cyclone (2D)
 The Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

This shader simulates a cyclone. The Cyclone shader has an alpha channel which you can 
use within the Material editor on the Alpha page. Use the gradient to define the color 
of the cyclone. Frequency defines the timing of the cyclone rotation, the strength of the 
storm. Rotation determines the effective density of the cyclone, the higher the value the 
more spirals in the storm. Level affects the number of clouds in the cyclone.

Earth (3D)

This simulates an Earth-like planet with mountains. Sea Level determines the color for 
areas which have a height of less than zero. Land Level is the color for middle-height 
terrain. Mountain Level is the color for high terrain. You can increase the Frequency 
value to break up the land masses. Level controls the ratio of sea to land. A value of 0% 
generates mostly sea, 50% results in equal parts of land and sea, while 100% creates 
mostly land.
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Fire (2D)
 The T-Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

 The wall of flame stretches infinitely in the U direction. Good flame materials can be 
created by using this shader both in the Alpha channel and the Transparency channel (in 
the Alpha channel, dr/dg/db should be set relatively high, to approximately. 30%).

This shader simulates a wall of flame, whose color you can define using the gradient. 
The Fire shader has an alpha channel which you can use in the Material editor on the 
Alpha page. U Frequency and V Frequency determine the fineness of the structure. Thus 
U=1 and V=1 results in regular flames, U=1 and V=0.25 gives rather elongated flames. 
T Frequency affects the speed of the flicker, how quickly the flames change — the higher 
the value, the faster the flicker. Turbulence determines how violently the flames break up 
in a notional wind. A setting of 2 doubles the wind; a setting of 0 suppresses all wind.
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Flame (2D)
 The T-Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

This shader simulates a single flame, whose color you can define using the gradient. 
The Flame shader has an alpha channel which you can use within the Material editor 
on the Alpha page. T Frequency is a scaling factor that affects the speed of flicker, how 
quickly the flame changes. Turbulence determines how violently the flames break up in a 
notional wind. A setting of 2 doubles the wind; a setting of 0 suppresses all wind.

Galaxy (2D)

This shader simulates a galaxy with spiral arms, whose color you can define using the 
gradient. The Galaxy shader has an alpha channel which you can use within the Material 
editor on the Alpha page. Angle is the degree of rotation of the spiral arms. Spiral Arms 
is the number of spiral arms.
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Gradient (2D)
 The Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

This shader generates a soft gradient between any number of colors. Mode sets the type 
of gradient such as 2D Radial or 2D Box. Angle defines the orientation of the gradient. 
If the texture geometry is tiled, the Cycle option ensures the gradient is tiled also. 
Turbulence adds a distortion to the gradient. Octaves defines the amount of detail for the 
turbulence. Scale defines the size of the turbulence pattern. Frequency is important for 
animation only and defines the speed of the turbulence pattern. If the Absolute option is 
enabled, the gradient is used for the turbulence pattern only, not for the entire texture.

Cycle disabled (left) and enabled 
(right).

Turbulence set to a low value (left) 
and a high value (right).

Octaves set to a low value (left) 
and a high value (right).

Scale set to a low value (left) and a 
high value (right).

Absolute disabled (top) and 
enabled (bottom).
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Marble (3D)

This shader generates 3D marble structures. Use the gradient to choose the color of 
the marble. The Frequency values define the marble’s level of detail in the X, Y and Z 
directions. Turbulence changes the overall complexity of the marble.

Metal (3D)

This shader simulates metallic surfaces. The gradient specifies the color of the metal. 
Increase the Frequency for finer detail.
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Noise (2D)

This shader creates a random pattern that can be used, for example, for sun surfaces 
and stone reliefs. By overlapping several Noise shaders with different amplitudes and 
frequencies, you can create masses of interesting patterns (this is like signal synthesis). 
The gradient determines the color of the noise effect. U Frequency and V Frequency 
determine the fineness of the structure. For example, U=1 and V=1 results in a radial-
like pattern, U=1 and V=0.25 gives a rather elongated shapes. The higher the value, the 
greater the detail in that direction.

Planet (2D)
This shader is effectively four shaders in one: Saturn, Saturnring, Uranus and Neptune. 
Choose the desired shader from the Type drop-down list.

Saturn

 Because of its fast rotational speed, Saturn has an elliptical shape. For an accurate 
representation of the planet, you will need to flatten the sphere to which this shader is 
applied — its Y-axis should be scaled to about 0.85.

Simulates the planet Saturn with its typical coloring and cloud structure. The texture is 
cyclic in the U direction.
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Saturnring

 Saturn is approximately one third as wide as the width of the ring structure. So that stars 
shine through between the rings, you should activate the alpha channel of any material 
to which this is applied. You may want to make the rings quite transparent since in reality 
these rings are millions and millions of tiny rock and ice particles which allow the light 
from beyond to shine through.

Simulates the rings around Saturn — the D, C, B, A, F and G rings, with the Cassini and 
Encke gap. The Saturnring shader has an alpha channel which you can use within the 
Material editor on the Alpha page.

Uranus, Neptune

These shaders simulate the planets Uranus and Neptune with their typical coloring and 
cloud structure.
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Rust (3D)

This shader simulates rust on metal surfaces. You choose the colors for the metal and rust 
using the gradient. Rust specifies how much of the material is rusty. Increase Frequency 
for smaller rust patches.

Spectral (2D)

The Spectral shader is ideal for prismatic or iridescent effects such as the bright colors of 
a CD or pearls. The calculation of this effect takes the camera perspective and the angle 
between the light source and surface into account. In general, the Spectral shader should 
be used in the Specular Color material channel only.
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Variation set to 1 (left) and 2 (right). Width set to a high value (left) and a low value (right).

From left to right: W Factor set to 1.5, 1 and 0.7.

Diffuse Intensity set to 0.3 (left) and 0.8 (right). Diffuse Variation set low (left) and high (right).

Intensity

The Intensity parameter controls the overall brightness of the color reflexes. A value of 
0 means no effect at all while bigger values result in brighter color reflexes. Variation 
defines how many times the gradient is repeated within the defined range.

Out of Range Type

In combination with the Variation parameter, the Out Of Range Type drop-down list 
controls if and how the gradient is repeated. Experiment with the Stop, Mirror and Tiling 
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parameters to see the effect. With Stop, the gradient is applied once only and the last 
color is used for the outer areas which are out of range. With Mirror, the gradient is 
mirrored when it is repeated to avoid seams. If the Tiling setting is used, the gradient is 
repeated according to the Variation value.

Spectrum

The Spectrum gradient defines the colors for the spectral reflexes.

CD Effect

If you enable Use CD Effect, the shader is optimized for cylindrical surfaces and you can 
render wedge-shaped, prismatic color effects such as those seen on the surface of CDs.

Width

Width defines how far the gradient spreads out.

Peak

Normally the entire rainbow colored spectrum is visible only if the angle between the 
light source and the camera forms a straight line. Increasing Peak value allows you to 
generate a larger color spectrum.

W Factor

W Factor defines the starting point of the prismatic effect, based on the center of the 
surface. A value of 1 makes the gradient start from the exact center of the surface. Values 
above 1 offset the gradient from the center and values below 1 shift it more towards the 
center.

Diffuse Intensity

Diffuse Intensity controls the intensity of the actual spectral effect. Increasing the value results 
in overblown colors.

Diffuse Variation

Diffuse Variation scatters the spectral effect by bringing in random colors from the 
gradient.

Front Side

With the Front Side drop-down list you define how the spectral gradient should be 
projected onto the surface, with reference to the object coordinate system. If you can’t 
see the CD effect immediately, you probably need to adjust this parameter.
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Starfield (2D)
 The stars are always computed with a continually varying size. In addition, the brightness 

of the stars varies. Thus you should have the impression that some stars are closer than 
others.

This shader has no dialog and simulates a starry night. The number of stars can be 
controlled by tiling the texture.

Stars (2D)

This shader creates a star-filled wallpaper. Color 1 is the color of the wallpaper. Color 2 is 
the color of the stars. Streaks is the number of star tips or points. Inner Radius and Outer 
Radius determine the dimension of each star, given as a percentage of a UV unit. Stars is 
the average number of stars per UV unit.

Although we use the term UV unit above accurately, you may want to think of the 
preview as an element that is one UV unit in each direction — this will help you visualize 
the changes you make.
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Sunburst (2D)
 The T Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

This shader generates sun flares and eruptions. The gradient determines the color of 
the sunburst. The Sunburst shader has an alpha channel which you can use within the 
Material editor on the Alpha page. R Frequency determines the radial frequency; a value 
of 0 yields an attractive aurora. A Frequency gives the angular disturbance; 0 gives 
individual layers. T Frequency defines the speed of the sunburst; 2 doubles it, 0 prevents 
all movement. Turbulence changes the appearance of the eruption; the higher the value, 
the more fragmented this region appears. Radius defines where the eruption begins, as a 
percentage of the overall size. Height defines the width of the eruption region relative to 
the radius.
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Turbulence (2D)

This shader creates colored, fractal turbulence. The gradient determines the colors of 
the turbulence. U Frequency and V Frequency determine the fineness of the structure. 
U=1 and V=1 creates a radial-like pattern, while U=1 and V=0.25 elongated shapes. 
The higher these values, the greater the detail (or frequency) in the relevant direction. 
Octaves is the number of iteration steps for generating this fractal turbulence. The more 
octaves, the more added detail you obtain. With a setting of 1, the Turbulence shader is 
almost identical to the Noise shader; there is no point in setting this value too high since 
only a certain amount of detail can be added.

Venus (3D)

This shader simulates a gaseous planet with cloud structures that are whirled around by 
the Coriolis stream. The gradient determines the colors of the clouds and the background 
sky. Increase the Frequency values for finer details in the X, Y and Z directions. Rotation 
determines the degree of whirl or turbulence caused by the Coriolis stream.
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Water (2D)
 The T Frequency setting only has an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

This shader generates water surfaces and is ideal for use in a material’s Bump channel for 
simulating water surfaces perturbed by wind. It can simulate slight turbulences (ripples) 
and more significant ones (waves). Using the gradient, you can change the color of the 
effect. U Frequency and V Frequency determine the fineness of the structure. U=1 and 
V=1 creates radial-like wave patterns, while U=1 and V=0.25 give rather elongated 
wave fronts. The higher the values, the higher the effective wave detail in that direction. 
T Frequency is the speed with which the water moves in the U direction (0 means no 
movement, 2 doubles the speed of movement). Wind specifies the amplitude of a wind 
that breaks up the water — the higher this value the more the wind disturbs the water’s 
surface.
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Wood (3D)

This shader simulates wood patterns. Using the Type drop-down list you can choose the 
wood type from Custom, Walnut, Mahogany, Jacaranda and Pinewood. The gradient 
determines the color of the wood. Increase the Frequency values for finer details in the X, 
Y and Z directions. Turbulence determines the degree of growth irregularity (0% = even 
concentric annual rings, 100% = a more natural, uneven ring appearance).

Material shaders
Most of BodyPaint 3D’s shaders are channel shaders, i.e. shaders that you can load 
into material channels such as Color and Bump. However, BodyPaint 3D also offers two 
shaders — Fog and Terrain — that are materials in their own right, and these cannot be 
loaded into material channels. To create a Fog or Terrain material, choose Fog or Terrain 
from the Material manager’s File  > Shader submenu.

Fog (3D)

This shader simulates volumetric fog.
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Color

Color is the color of the fog.

Samples

Samples defines the average number of samples that will be computed per raytracing ray. 
The higher this number, the greater the quality of the fog but the longer the calculation 
time.

 Start with low numbers such as 6 or 8. Increase this value only if you get disturbing 
artefacts or if the detail is not high enough. After a certain point (depending on the 
scene) higher sample values will not produce better images.

Volumetric

Volumetric adds greatly to render time. If the option is disabled, the basic color of the 
fog is all pervading. Light sources have no effect. This is normally sufficient to simulate 
fog in a fractal valley. With Volumetric enabled, all light sources will be taken into 
account. If the light sources cast soft shadows and there are objects in the beam, these 
will cast shadows in the fog.

Frequency

Increase Frequency for finer detail in the X, Y and Z directions.

Type

Set Type to the desired falloff for the fog: Linear, Exponential or No Decrease. Linear 
decreases the fog intensity along the Y-axis of the texture axes. Exponential decreases 
the fog intensity along the Y-axis of the texture axes. No Decrease means constant fog 
density.

Thickness

The lower the Thickness value, the thinner the fog. Decrease controls the volume (or 
depth) of the fog that is generated.

Turbulence

Turbulence specifies the degree of swirl within the fog (0 = no turbulence).

Amplitude

Amplitude specifies the average size of the rotating turbulence cells  (rolling fog).

T-Frequency

 This setting only has an effect if you are using the BodyPaint 3D module with CINEMA 4D.

T Frequency controls the speed of the swirling fog (0 = no movement).



518 • CHAPTER 23 MATERIAL MANAGER • 519

Terrain (3D)

This shader generates virtual, fractal landscapes featuring mountains and valleys. Using 
the Type drop-down list you can choose the terrain type from Custom, Mountain, Mars, 
Moon, Desert and Polar. Use the gradient to define the colors of the terrain. The left-
most color is the color of the lowest regions while the right-most color is the color of the 
peaks.

Height scales the terrain in the Y direction of the texture axes. For example, with a value 
of 50, the fractal would take up half of the object (provided that the texture geometry 
has been adapted to the object).

The Terrain shader is not infinitely large. Its maximum size is determined by the size of 
the texture geometry. If this is smaller than the object on which the shader is used, the 
shader does not fill the object. If necessary fit the texture geometry to the object using 
the Fit To Object command.
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The bhodiNUT Shaders
The bhodiNUT shaders, collectively known as Smells Like Almonds, allow you to create 
textures that simply are not possible with texture maps or other methods. Things like 
anisotropic surfaces, multiple specular highlights, volumetric woods and more are just 
not achievable any other way. Although they can be complex, with a little practice and 
study you should be creating new materials on your own using the shading engines very 
soon.

The shaders included in Smells Like Almonds are procedural, meaning that the color you 
see is calculated by a program based on the location in space and other factors in the 
scene. This allows them to do things not possible with texture maps because the shader 
knows things like light intensity, direction of the surface, where the camera is etc. so it 
can use these things to change the surface. Shaders can also do things to change the way 
BodyPaint 3D would normally render a surface by changing illumination, surface normals 
and more.

Figure 1. Figure 2.

Figure 3. Figure 4.

The shaders in Smells Like Almonds give you control of the attributes of a surface that 
they affect through their parameters. You edit the parameters in the dialog boxes that 
come up when you double-click the material or click Edit in the Material editor. Most 
of the shaders have similar controls for the usual attributes of a surface. There are two 
types of shaders in this package, volume (3D) and channel (2D).  Channel shaders work 
similarly to image maps. You load them by choosing a shader in a channel (such as color, 
transparency etc.) of the Material editor by clicking on the pop down menu beside the 
Image text box (see Figure 1, above).
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Channel shaders calculate a color based on position on the surface which is then used 
just like a color from an image map. To edit the parameters of a channel shader click the 
Edit button at the bottom of the channel Texture group next to the MIP settings (Figure 
2).

Volume shaders completely replace the standard BodyPaint 3D materials and create all 
aspects of a material algorithmically. Thus a Volume shader can control Diffuse color, 
Specular, Bump and any other aspect of surfacing in materials. To use a volume shader 
just choose one from under the file menu in the material manager of BodyPaint 3D 
(Figure 3). Then just double-click on the new material icon to open the shader dialog and 
edit its parameters (Figure 4).

Common User Interface Elements 
There are a few elements that are commonly used among all or several of the shaders in 
this package that are otherwise not found in the BodyPaint 3D interface that you need to 
be aware of to use the shaders to their full potential.

Shader Previews
All shaders have a preview in the editing dialog that updates as you change the 
parameters to give you feedback about the changes you are making to how the shader 
will render. You should see a preview like this in every Smells Like Almonds shader. The 
image is a representation of what the shader will look like when it renders. The check 
box turns on and off antialiasing of the preview. If you are editing a complex shader or 
are on a slower computer you may want to turn off antialiasing to get a faster preview. 
The combo box allows you to choose from several different preview types including 2D 
previews for the channel shaders, Sphere, Cube, Cylinder, Plane and a Torus.

Title Bar
If you click on the title bar the About screen will open. You get some interesting 
info about the shader and those who were of help to us. Also you can access this 
documentation by clicking on the Help button. 

Color Gradients
Several of the bhodiNUT shaders use of a color gradient. All of the color gradients 
look and behave in the same way and have the same options. Below is a picture of a 
bhodiNUT shader color gradient.
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The color gradient at the bottom is similar to gradients in other applications that you 
have probably seen before. The knots or handles on the bottom of the gradient are used 
to set the color and position of colors in the gradient.

To add a knot just click in an empty area below the gradient and a knot of the color at 
that position will be added. To remove a knot just click on it and drag it away from the 
gradient. To change the color of a knot double-click on it and the system color chooser 
will open. The handles on the top of the gradient are bias handles and they pull the 
interpolation of the color knots from side to side for more control over how the gradient 
changes.

Interpolation

Cubic Knot

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots). 

Cubic Bias

Uses a Bézier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control). 

Smooth

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value. 

Linear

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value. 

None

Uses the color of the knot to the left of the sample point.

Position

The position of the currently selected knot or bias handle on the gradient. You can type a 
value in the edit text field or drag the up/down arrows at the right to move the currently 
selected knot or bias handle.

Keyboard short-cuts

• Cmd / Ctrl - I: Inverts the order of the color knots.
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• Cmd / Ctrl - Arrow: Changes the currently selected knot or bias handle to the nearest 
one in the direction pressed.

• Shift - Left or Right Arrow: Moves the selected knot or bias handle in the left or right 
direction.

• Cmd / Ctrl - D: Doubles the current gradient by duplicating it and shrinking it to half 
and making another copy directly adjacent.

• Option / Alt - Mouse Drag: Duplicates the currently selected knot or bias handle under 
the mouse cursor.
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2D Noise

2D Noise is a channel shader that produces 30 types of noise for use in your texturing. 

Animate Preview

Turns on and off animation of the preview noise in the dialog.

Scale

Global, U, V

These scale the size of the noise.

Noise

Type

Choose from 30 noise types in the noise type combo box. Later in this chapter you will 
find pictures of each noise type.
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Animation Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Rate at which the noise animates in cycles per second.

Detail Attenuation

Used for antialiasing. For most applications it should be left at 100%. If you are 
animating and are getting a lot of texture flicker then try setting this higher. If you are 
rendering a still and want crisp detail then set it lower.

Octaves

Octaves of detail in the noise. 

Delta

Delta is a scaling factor to use in sampling the noise for evaluating slope to be used in 
the bump channel. This allows you to get very sharp bump with minute detail that is not 
possible with the standard bump delta. 

Color

Color 1, Color 2

Color 1 is the color of the noise at value 0, Color 2 at 100%

Absolute

On makes the value of the noise absolute, causing it to fold about its midpoint. 

Cycles

Number of cycles the noise makes between zero and one. 

Low Clip, High Clip

Low Clip controls the bottom clipping value of the noise; any value less low clip will be 
clipped to zero. High Clip controls the top clipping value of the noise; any value greater 
than High Clip will be clipped to 100%. 

Brightness

Brightness controls the overall brightness or value of the noise. Values greater than zero 
increase brightness and values less than zero decrease brightness.
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Contrast

Contrast controls the overall contrast or range of the noise. Values greater than zero 
increase contrast of the noise and values less than zero decrease contrast.
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3D Noise

3D Noise is a special kind of channel shader. Just like 2D Noise it produces 30 types of 
noise, however the noise is calculated in 3D space instead of UV. The advantage of this is 
that you don’t have to worry about mapping or seams in the texture.

Animate Preview

Turns on and off animation of the preview noise in the dialog.

Use As Environment

Causes the noise to be calculated as if it were an environment around the object being 
reflected. 

Project Environment

Causes the 3D Noise environment to be calculated based on a UV environment 
projection. 
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Scale

Global, X, Y, Z

These change the size of the noise.

Noise

Type

Choose from 30 noise types in the noise type combo box. See ‘Types of Noise’ on 
page 310. 

Octaves

Octaves of detail in the noise. 

Animation Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Rate at which the noise animates in cycles per second. 

Detail Attenuation

Used for antialiasing. For most applications it should be left at 100%. If you are 
animating and are getting a lot of texture flicker then try setting this higher. If you are 
rendering a still and want crisp detail then set it lower.

Space

What space to calculate the noise in.

Texture

The Noise is calculated in object space and remains the same regardless of object 
position or orientation and takes into account the projection modifications of the 
Texture Tag.

World

The Noise is calculated in world coordinates and is not affected by the objects 
orientation or position. This allows the object being shaded to move through the 
Noise.

Object

The Noise is calculated in object space and remains the same regardless of object 
position or orientation but does not use the attributes of the Texture Tag.
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Camera

The Noise is calculated in the space of the camera and will stay oriented relative to the 
camera. The object can move through the Noise and camera moves will also affect the 
Noise.

Screen

The Noise is calculated in the space of the screen including Z depth. The object can 
move through the Noise and camera moves will also affect the Noise.

Raster

The Noise is calculated in the space screen pixels and has no depth information so no 
matter how far the object moves away, the texture is calculated the same. The object 
can move through the Noise and camera moves will also affect the Noise. 

Hard Bump

If activated when the noise is in the bump channel, a different algorithm is used for 
calculating the bump slope that results in a harder bump result. 

Delta

Delta is a scaling factor to use in sampling the noise for evaluating the slope that is to 
be used in the bump channel. This allows you to get very sharp bump with minute detail 
that is not possible with the standard bump delta.

Movement

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Allows the Noise to constantly move through 3D space based upon the vector created by 
X, Y, and Z.

X, Y, Z

These define the translation to be applied to the noise per second.

Speed

The Speed parameter is multiplied with the movement vector to allow the user to alter 
the speed of translation with minimal effort. This allows for things such as water and fire 
effects.

Color

Color 1, Color 2

Color 1 is the color of the noise at value 0, Color 2 at 100%
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Absolute

On makes the value of the noise absolute, causing it to fold about its midpoint. 

Cycles

Number of cycles the noise makes between zero and one. 

Low Clip, High Clip

Low Clip controls the bottom clipping value of the noise; any value less low clip will be 
clipped to zero. High Clip controls the top clipping value of the noise; any value greater 
than High Clip will be clipped to 100%. 

Brightness

Brightness controls the overall brightness or value of the noise. Values greater than zero 
increase brightness and values less than zero decrease brightness.

Contrast

Contrast controls the overall contrast or range of the noise. Values greater than zero 
increase the contrast of the noise and values less than zero decrease the contrast.
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Types of Noise

Blistered Turbulence Box Noise Buya Cell Noise Cell Voroni

Cranal Dents Displaced Turbulence Displaced Vornoi FBM

Hama Luka Mod Noise Naki Noise

Nutous Ober Pezo Poxo Random

Sema Sparse Convolution Stupl Turbulence VL Noise

Voronoi 1 Voronoi 2 Voronoi 3 Wavy Turbulence Zada
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Banj

Banj allows you to gather illumination from the back face of an object. This gives the 
ability to create translucency effects with backlighting such as rice paper or a thin leaf lit 
from the opposite side complete with shadowing.

The most likely place to use Banj is in the Luminance channel so you can have 
backlighting and the normal color channel can be used for front face illumination.

Color

This is the diffuse color of the backlit surface.

Algorithm

This is the illumination algorithm to be used. Internal is BodyPaint 3D’s internal 
illumination model, Oren-Nayar is an alternative illumination model that is meant to look 
more like a rough surface. 
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Illumination

Maximum illumination intensity. 

Roughness

Only applies to the Oren-Nayar illumination algorithm. The higher the value the rougher the 
surface appears.

Shadow Intensity

The opacity of the shadow. At 0 there is no shadow and at 100% the shadow is full opacity 
with no illumination.

Contrast

Contrast is applied to the illumination to make it break sharper or falloff more smoothly.
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Brightness Contrast

The Brightness Contrast shader is a filter that is used to adjust another shader or image. 
It allows you to adjust the brightness and contrast of the texture and also adds clipping 
of the value.

Brightness

Brightness controls the overall brightness or value of the image. Values greater than 0 
increase brightness and values less than 0 decrease brightness. A value of -100% is totally 
black and 100% is totally white. 

Contrast

Contrast controls the overall contrast or range of the image. Values greater than zero 
increase the contrast of the image and values less than zero decrease contrast. A value of 
-100% is totally neutral grey with no contrast and 100% is fully contrasted between full 
saturation and no saturation. 

Low Clip, High Clip

Low Clip controls the bottom clipping value of the image; any color less in saturation 
than low clip will be clipped to zero saturation. High Clip controls the top clipping value 
of the image; any color greater in saturation than high clip will be clipped to 100% 
saturation.
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Texture
The texture group at the bottom of the dialog is a standard BodyPaint 3D texture 
channel. This is the source image or shader to affect with the Brightness Contrast filter. 
You can bring in and affect any image or 2D shader available to BodyPaint 3D.
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Colorizer

Colorizer takes the value of an input channel and remaps it based on a color spline. This is 
very useful for colorizing shaders such as noise.

Input

The aspect of the input texture to remap. You can remap input Luminance, Hue, 
Saturation, Lightness, red, green or blue channels.

Interpolation

Is the interpolation type of the gradient knots. 

Cubic Knot

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots). 

Cubic Bias

Uses a Bézier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control). 

Smooth

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value. 

Linear

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value. 
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None

Uses the color of the knot to the left of the sample point.

Position

This is the position of the currently selected knot or bias handle on the gradient. You can 
type a value in the edit text field or drag the up/down arrows at the right.

Texture
The texture group at the top of the dialog is a standard BodyPaint 3D texture channel. 
This is the source image or shader to remap with the colorizer gradient. You can bring in 
and affect any image or 2D shader available to BodyPaint 3D. 
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Distorter

Distorter takes the value of an input channel and distorts it using the value from another 
texture channel.

Type

This is the distortion algorithm to be used.

Directional

The value of the distortion channel is added to the sample coordinate of the texture. 

Bi-Directional

The value of the distortion channel is added to the sample coordinate of the texture if 
the value is between 50-100% and is subtracted if the value is between 0-50%. 

Flow Field

The distortion value is determined by evaluating the flow direction of the distortion 
texture and then the flow direction vector is used to offset the sample coordinate of 
the texture.
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Wrap

If enabled then distorted coordinates greater than 1 or less than 0 are wrapped around 
to the other side. For example 1.1 would become 0.1. If not enabled then values are 
clamped between 0 and 1 and the edge of the texture is just repeated.

Amount

Global distortion amount. 100% means that distortion values go from 0 to 1 in UV and 0 
to 10 in 3D.

X, Y, Z

X is the distortion amount in U for 2D and X for 3D. Y is the distortion amount in V for 2D 
and Y for 3D. Z is the distortion amount in Z for 3D.

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
the bump channel. This allows you to get very sharp bump with minute detail that is not 
possible with the standard bump delta.

Step

Relative step size to be used in evaluating the flow direction in Flow Field distortion type. 

Texture
The texture group on top is a standard BodyPaint 3D texture channel. This is the source 
image or shader to distort with the Distorter texture group. You can bring in and affect 
any image or 2D shader available to BodyPaint 3D.

Distorter
The texture group at the bottom of the dialog is used to distort the texture in the top 
group. The value of the distorter image or shader is used in the distortion algorithm to 
offset the sampling of the texture.
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Falloff

Falloff calculates the falloff between a custom vector and the surface normal. When the 
vector is the same as the surface normal the value is 1 and when it points completely 
away the value is 0. Falloff then remaps the value using a color gradient.

Vector X, Y, Z

The vector to falloff from in 3D space. 

Space

The space to calculate the falloff in.

Object

The vector is specified in object coordinates and the falloff is affected by the object’s 
orientation. In this way the falloff sticks to the object as it changes rotations.

World

The vector is specified in world coordinates and is not affected by the object’s 
orientation. This is the most common setting as it allows the object to move and have 
the falloff stay oriented in a consistent direction. 

Camera

The vector is specified in coordinates relative to the orientation of the camera. In this 
way, up in the camera view for example is always up regardless of camera or object 
orientation.

Use Bump

If enabled the bump normal is used to calculate the falloff. If off then the bump normal is 
ignored.
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Interpolation

Is the interpolation type of the gradient knots.

Cubic Knot

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots). 

Cubic Bias

Uses a Bézier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control). 

Smooth

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value. 

Linear

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value. 

None

Uses the color of the knot to the left of the sample point.

Position

This is the position of the currently selected knot or bias handle on the gradient. You can 
type a value in the edit text field or drag the up/down arrows at the right.
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Fresnel

The Fresnel shader is used in any of the channels of a material. It has no effect upon the 
bump channel or the displacement channel unless utilized as a secondary channel within 
bhodiNUT Fusion or something similar.

The shader calculates the falloff of the surface normal in world space from the incoming 
surface ray which is also in world space. Then it utilizes the parameters of the shader to 
attenuate the output.

Preview Type

You can change the preview type and turn on and off antialiasing for the rendered 
previews using the combo box and the check box under the preview. 

The Gradient

The gradient is a standard implementation of a color gradient. To change the color of a 
knot double-click it. To invert the order of knots, press Ctrl+I (Windows) or Command+I 
(Mac OS). You are currently limited to 50 knots. 

Use Bump

Dictates whether the output of the bump channel will be used in the calculation of the 
falloff. 

Render

Front Only

Calculates the falloff for the front of the object and then sets the back of the object to 
black if it can be seen. 
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Front Only - Trans

Calculates the falloff for the front of the object and then sets the back of the object to 
white if it can be seen (good for use in the transparency channel). 

Back Only

Calculates the falloff for the back of the object and then sets the front of the object to 
black if it can be seen. 

Back Only - Trans

Calculates the falloff for the back of the object and then sets the front of the object to 
white if it can be seen. 

Front & Back

Calculates the falloff for all surfaces intercepted. 

Interpolation

Is the interpolation type of the knots.

Cubic Knot

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots). 

Cubic Bias

Uses a Bézier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control). 

Smooth

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value. 

Linear

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value. 

None

Uses the color of the knot to the left of the sample point.
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Position

This is the position of the currently selected knot or bias handle. You can type a value in 
the edit text field or drag the up/down arrows at the right.   
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Fusion

Fusion allows you to combine two textures with a mask using the blending modes 
standard in photo editing applications, as if they were layers. Using a blend you can 
set the opacity of the Blend channel to mix with the Base channel and also modify the 
mixing with the Mask channel.

Mode

The blend mode that it used to combine Blend channel with the Base channel.

Normal

Normal blending, the Blend channel is just mixed with the Base channel.

Multiply

The value of the Blend channel and Base channel are multiplied together.

Screen

Lightens the Base channel by multiplying the inverse of the Blend and Base colors. The 
result is a color that is the same as, or a lightened version, of the Base color.

Overlay

If the Base channels’s color value is less than half of the maximum value, the Multiply 
blend mode is used. If the color value is greater than or equal to half the maximum 
value, the Screen blend mode is used. This shows patterns or colors of the Blend 
channel while preserving the shadows and highlights of the Base channel.
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Hard Light

If the Blend channel’s color value is less than half of the maximum value, the Multiply 
blend mode is used. If the Blend channel’s color value is greater than or equal to half 
the maximum value, the Screen blend mode is used. This mode is generally used to add 
highlights or shadows.

Soft Light

If the Blend channel’s color value is less than half the maximum value, the Burn blend 
mode is used. If the Blend channel’s color value is greater than the or equal to half the 
maximum value, the Dodge blend mode is used. This mode is generally used to add 
soft highlights or shadows.

Dodge

The lightness values of the colors in the Blend channel lighten the colors of the Base 
channel, lightening the image. Light colors produce the most lightening effect and 
black has no effect.

Burn

The lightness values of the colors of the Blend channel reduce the lightness of the Base 
channel darkening the image.

Darken

Only values of the Blend channel that are darker than the Base channel are mixed.

Lighten

Only values of the Blend channel that are lighter than the Base channel are mixed.

Add

The Blend channel is added to the Base channel.

Subtract

The Blend channel is subtracted from the Base channel.

Difference

Subtracts the Blend channel’s color from the color of the Base channel, depending on 
which is lighter.

Exclusion

Similar to Difference mode, but the effect is softer. This mode is the equivalent of 
Screen - Multiply.
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Hue

The hue of the Blend channel is applied to the Base channel.

Saturation

The saturation of the Blend channel is applied to the Base channel.

Color

The hue and saturation of the Blend channel is applied to the Base channel.

Luminance

The luminance of the Blend channel is applied to the Base channel. 

Levr

The value of the Blend channel is used to apply contrast to the Base channel and is 
affected by the Blend amount.

Blend

The opacity level of the Blend channel to be applied to the Base channel.

Use Mask

Enables the Mask channel. 

Invert Mask

If enabled, the Mask channel value is inverted so that black becomes white and vice-
versa. 

Blend Channel
The texture group at the top of the dialog is a standard BodyPaint 3D texture channel. 
You can bring in and affect any image or 2D shader available to BodyPaint 3D. This 
channel is the top layer in the fusing.

Mask Channel
The texture group in the middle of the dialog is used as a mask when combining the 
Blend channel with the Base channel. 

Base Channel
The texture group at the bottom of the dialog is the bottom layer in the fusing. The Blend 
channel is combined with the Base channel at the opacity set in Blend and modified by 
the Mask channel.
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Gradient

Gradient allows you to create gradients of many different types in both 2D and 3D space.

Type

The type of gradient to be created.  

U

2D gradient in U from zero to one.

V

2D gradient in V from zero to one.

Diagonal

2D gradient diagonally in UV.

Radial

2D gradient radially around the 0.5, 0.5 in UV.

Circular

2D circular gradient from the center out.

Box

2D gradient linearly from the center to each edge in U and V.

Star

2D gradient linearly from the corners in UV.
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Four Corner

2D gradient where the first 4 gradient knot colors are used as the colors at the UV 
corners.

Linear

3D gradient linearly from start point to end point.

Cylindrical

3D gradient cylindrically around the vector defined by start and end point of radius.

Spherical

3D gradient spherically around the start point of radius.

Cycle

If turned on, this causes a 3D gradient to cycle its gradient after it passes the end or 
exceeds the radius. 

Start X, Y, Z

For 3D gradients this defines the start point of the gradient. For cylindrical this is the 
start of the center vector.

End X, Y, Z

For 3D gradients this defines the end point of the gradient. For cylindrical this is the end 
of the center vector. 

Radius

For 3D gradients spherical and cylindrical this is the radius of the gradient from the 
center. 

Space

For 3D gradients this defines space that the gradient is calculated in.

Texture

The gradient is calculated in object space and remains the same regardless of object 
position or orientation and takes into account the projection modifications of the 
Texture tag.

Object

The gradient is calculated in object space and remains the same regardless of object 
position or orientation but does not use the attributes of the Texture tag.
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World

The gradient is calculated in world coordinates and is not affected by the objects 
orientation or position. This allows the object being shaded to move through the 
gradient.

Camera

The gradient is calculated in the space of the camera and will stay oriented relative to 
the camera. The object can move through the gradient and camera moves will also 
affect the gradient.

Screen

The gradient is calculated in the space of the screen including z depth. The object can 
move through the gradient and camera moves will also affect the gradient.

Raster

The gradient is calculated in screen pixels and has no depth information so no matter 
how far the object gets away the texture is calculated in the same way. The object can 
move through the gradient and camera moves will also affect the gradient. 

Interpolation

Is the interpolation type of the gradient knots. 

Cubic Knot

Interpolates the knots with a CatMull - Rom interpolation while using the bias handles 
to offset the interpolated value (good for several knots). 

Cubic Bias

Uses a Bézier interpolation algorithm to interpolate between the knot previous to the 
sample point, a weighted bias to the left, a weighted bias to the right, and the knot to 
the right of the sample position (good for few knots and accurate control). 

Smooth

Uses a SmoothStep function to weight an interpolation between the knot to the left of 
the sample point and the knot to the right of the sample point. It uses the bias handles 
to offset the interpolated value. 

Linear

Uses a BoxStep function to weight an interpolation between the knot to the left of the 
sample point and the knot to the right of the sample point. It uses the bias handles to 
offset the interpolated value. 
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None

Uses the color of the knot to the left of the sample point.

Position

This is the position of the currently selected knot or bias handle on the gradient. You can 
type a value in the edit text field or drag the up/down arrows at the right.
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Hue

The Hue shader is really a filter that is used to adjust another shader or image. It allows 
you to adjust the Hue, Saturation and Lightness of the texture in a similar way to many 
photo editing applications. 

Hue

Adjusts the hue angle of the texture around the color wheel. 

Saturation

Adjusts the overall saturation of the colors in the texture. 

Lightness

Adjusts the lightness of the texture. 

Colorize

If enabled, the image is turned to grayscale and colorized based on the hue angle.

Texture
The texture group at the bottom of the dialog is a standard BodyPaint 3D texture 
channel. This is the source image or shader to affect with the Hue filter. You can bring in 
and affect any image or 2D shader available to BodyPaint 3D. For more information on 
texture groups please see ‘Texture pane’ on page 254.
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Lumas
Lumas is an illumination shader. It is useful in combination with Fusion and other channel 
shaders or images. This includes three specular highlights with anisotropic scratches.

Diffuse page

Diffuse Color

R, G, B, Brightness

Sets the base diffuse color of the surface.

Diffuse Attributes

Algorithm

Specifies which illumination model Lumas will use. The drop-down list provides for 
two choices including Internal which is the standard Lambertian model and the Oren-
Nayar model which provides for a roughness variable allowing the user to go from 
simple surfaces (0 Roughness, identical to Lambertian), to complex rough surface (1+ 
Roughness which provides a surface like linen or dirt).

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter when 
the value is closer to 100% or above).

If you are utilizing the Oren-Nayar illumination algorithm you may want to bump up the 
illumination about 10% to 20% because it renders darker usually. Appropriate values are 
between 0% to 200%.  
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Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 

Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages
The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 
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Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar)) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for size is 0.001% - 
200%. 

Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection utilized to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also defines the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object. Experimentation is absolutely required to understand 
these parameters. 
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Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
the current normal. 

Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to the current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).

Anisotropic Specular Roughness 

X Roughness

Scales the highlights in the X direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same, the standard 
internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same, the standard 
internal specular algorithm is used. 

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
algorithm.
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Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the sample’s angle to the camera 
and the distance from the camera. The larger the values the greater the attenuation, 
causing less scratching (better for animation), the smaller the value the greater the detail 
(better for still images). The appropriate range is 0% - 10,000%. 

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches.
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Posterizer

The Posterizer shader is really a filter that is used to adjust another shader or image. 
It allows you to adjust the number of levels per color channel of the texture for 
posterization effects.

Levels

Number of levels of color, between zero and maximum intensity.

Filter Width

Adjusts the softness of the posterization by widening and smoothing the edges between 
levels.

Texture
The texture group at the bottom of the dialog is a standard BodyPaint 3D texture 
channel. This is the source image or shader to affect with the Posterizer filter. You can 
bring in and affect any image or 2D shader available to BodyPaint 3D.
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Projector

Projector allows you to alter the projection of a shader or image. This is useful for 
having different mappings in separate channels of a material especially when used in 
conjunction with other shaders such as NUKEI or Fusion. 

Texture
The texture group at the top of the dialog is a standard BodyPaint 3D texture channel. 
This is the source image or shader to be projected. You can bring in and project any 
image or 2D shader available to BodyPaint 3D. 

Texture Transformation
This group contains the settings of the texture projection. This should look very familiar 
as it is basically the same as the projection options available in BodyPaint 3D’s Texture 
tags.  

Projection

The projection type to use. The following list are the types available to choose and are 
functionally the same as BodyPaint 3D’s normal projections of the same name: Spherical, 
Cylindrical, Flat, Cubic, Frontal, and Shrink Wrap.

Offset X, Y

Offset of the 2D texture in UV. 
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Position X, Y, Z

Offset of the 3D texture space. 

Length X, Y

Scaling of the 2D texture in UV.

Size X, Y, Z

Scaling of the 3D texture space. 

Tiles X, Y

Tiling of the 2D texture in UV. 

Rotation H, P, B

Orientation of the 3D texture space. 

Tile

If enabled the 2D texture will tile in UV the number of times specified in the Tiles 
parameter. 

Seamless

If tiling is enabled then enabling Seamless causes the tiles to be mirrored so that they tile 
seamlessly. 

Copy Tag

Pressing the Copy Tag button causes the settings of the currently selected Texture tag in 
the Object manager to be copied into Projector’s parameters. This makes it easier for you 
to create a projection and then just copy it in. 
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Proximal

Proximal allows you to select an object in the scene and the shader will calculate the 
luminance based on how close that object’s axis (or each single point — see below) is to 
the surface of the object being shaded.

Effector

Search

Type the name of the object in the Object manager you want to Proximal to find. 
Proximal will use all objects with the chosen name in the current document.

Object

Name of the object that will be used to calculate Proximal.

Exclude Parent Object

If Include Subobjects is enabled and Exclude Parent Object is checked then the parent 
object is disregarded in the Proximal calculations.

Include Subobjects

If enabled, the children of the found object will be included in the proximal calculations. 

Use Vertices

Allows the user to specify that the sampling points for the Proximal shader to use are 
defined by the vertices of the named polygon object. This allows for effects such as one 
object passing through another object. The object must be a polygon object.
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Polygon Radius

Is similar to Use Vertices except it uses the center of each polygon and makes the 
maximum distance (End Distance at 100%) the radius of the polygon. This helps with the 
problem of vertices being spread unevenly and gaps happening when an object passes 
through another.

Falloff

Function

Falloff function to be used to calculate the Proximal intensity.

Linear

Intensity is 100% of the Intensity value at Start Distance, 0% at End Distance and falls 
off linearly in between.

Square

Intensity is 100% of the Intensity value at Start Distance, 0% at End Distance and falls 
off by the square of the distance in between.

Cubic

Intensity is 100% of the Intensity value at Start Distance, 0% at End Distance and falls 
off distance cubed in between. 

Step

Intensity is 100% of the Intensity value between Start Distance and End Distance and 
0% everywhere else.

Inverse

Intensity is 100% of the Intensity value at Start Distance and falls off as the inverse of 
distance and is clamped to 0% at End Distance. 

Inverse Square

Intensity is 100% of the Intensity value at Start Distance and falls off as the inverse of 
distance squared and is clamped to 0% at End Distance. 

Inverse Cubic

Intensity is 100% of the Intensity value at Start Distance and falls off as the inverse of 
distance cubed and is clamped to 0% at End Distance. 

Soft

This gives a smoother falloff when using Proximal for bump mapping or displacement.
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Start Distance

The distance at which the object causes 100% luminance.

End Distance

The distance at which the object no longer affects the surface luminance. A value of 
100% means 100 m. However, when using Polygon Radius the percentage value is the 
same as the polygon radius, which of course can be different for each polygon. 

Blend Mode

Allows for different possibilities when blending each sampled point together. For 
instance the Add type of blend makes very blown out values, necessitating the user to 
tweak the values to achieve a good result. The modes Lighten, Screen, Difference and 
Exclusion increase the ease of achieving the desired effect. The Screen blend type is in 
most cases the best choice, as it yields aesthetically pleasing results. 

Intensity

Maximum intensity that each object / particle adds. 
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Tiles

Tiles is a channel shader used to generate tiles and patterns. 

Grout Color

Color between the tiles.

Tile Color 1, 2, 3

The colors to be used for tiles. 

Pattern

This is the pattern type. (Later in this chapter you will find pictures of each pattern type.)

Grout Width

Grout width as a percentage of the tile.

Bevel Width

Width of the tile bevel as a percentage of the tile inside the grout. 

Smooth Bevel

If enabled, the bevel has a smooth step applied, if not then the bevel is linear.
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Randomize Color

If activated the tile color becomes a random mix of the three tile colors. 

Orientation

Orientation of the tile pattern in U or V. 

Global Scale

Scaling of the tile pattern. 

U Scale

Scaling in the U direction.

V Scale

Scaling in the V direction.

Radial Scale

Scaling radially for the patterns that are radial types of patterns such as radial lines etc. 

Delta

Delta is a scaling factor to use in sampling the texture for evaluating the slope to be used 
in the bump channel. This allows you to get very sharp bump with minute detail that is 
not possible with the standard bump delta.
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Types of Tile Pattern

Brick 1 Brick 2 Circles 1 Circles 2 Circles 3

Hexagons Lines 1 Lines 2 Parquet Planks

Radial Lines 1 Radial Lines 2 Rings 1 Rings 2 Sawtooth 1

Sawtooth 2 Scales 1 Scales 2 Spiral 1 Spiral 2

Squares Triangles 1 Triangles 2 Triangles 3 Waves 1

Waves 2 Weave
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BANJI

BANJI was created to fill a couple of different needs in texturing. First BANJI allows the 
rendering of translucent lighting from the back side of a surface complete with shadows. 
The other main use of BANJI is the creation of good refractive, transparent materials such 
as glass.

Diffuse page
BANJI has separate diffuse color and illumination settings for both the front surface and 
the volume of an object to allow for translucency and backlighting effects.

Front Surface tab

R, G, B, Brightness

Sets the base diffuse color of the surface.
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Algorithm

Specifies which illumination model BANJI will use. The drop-down list provides for two 
choices including Internal which is the standard Lambertian model and the Oren-Nayar 
model which provides for a roughness variable allowing the user to go from simple 
surfaces (0% Roughness, identical to Lambertian), to complex rough surfaces (100%+ 
Roughness which provides a surface like linen or dirt). 

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter when 
the value is closer to 100% or above). If you are utilizing the Oren-Nayar illumination 
algorithm you may want to bump up the illumination about 10% to 20% because it 
renders darker usually. Appropriate values are between 0% and 200%. 

Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 

Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Volume tab
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Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). If you are using the Oren-Nayar illumination 
algorithm you may want to bump up the illumination about 10% to 20% because it 
renders darker usually. Appropriate values are between 0% and 200%. 

Shadow Opacity

This parameter is used to scale the shadow opacity. Keep in mind that this changes the 
shadow opacity for every surface intercepted by the ray meaning that going through the 
surface twice causes the shadow to be twice as dark. 

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes 

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 
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Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar)) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 
200%. 

Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Transparency page

Surface Opacities

Front Opacity

The opacity of the front surface. A value of 0% allows for no diffuse color or surface to 
show through (unless Roughness Intensity is not equal to zero). Values greater than zero 
allow the surface color to show through (which is the diffuse color). 

Back Opacity

Is the back surface opacity. The back surface works the same as the front surface opacity. 
Keep in mind that the back surface is affected by shadows also. 
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Edge Opacity

This causes the edges of an object that points further away from the camera to be more 
opaque. 0% creates no effect while values greater than zero add to the edge opacity.

Transparency Attributes  

Index Of Refraction

The refractive index for the material.

Internal Reflection

Allows refracted rays to reflect when appropriate. 

Solid Object

Makes the object a completely dense object instead of one surface. Disallows 
illumination, reflection, and environment to be evaluated for the second surface 
intercepted of the object.

Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface and add to the opacity as well, based on the brightness of the 
reflection.

Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 



570 • CHAPTER 23 MATERIAL MANAGER • 571

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 

Reflection Depth Attenuation

Causes reflections to fall off based on how many times a ray has been reflected off of 
other surfaces. 

Color tab

The Reflection Color pane defines the base color used to attenuate the reflection sample 
in tandem with the reflection Intensity parameter. Utilizes the Falloff parameter to 
mix with Reflection Edge Color. The Reflection Edge Color pane defines the edge color 
used to attenuate the reflection sample in tandem with the reflection Edge Intensity 
parameter. Utilizes the Falloff parameter to mix with Reflection Color.

Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample.



572 • CHAPTER 23 MATERIAL MANAGER • 573

Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 

Environment Convolution

This group of parameters allows the blurring of environments when the Anisotrophy 
channel is checked. It doesn’t support radial convolutions because very similar effects can 
be achieved by blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy channel parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The appropriate 
range is 0% -100%. 



572 • CHAPTER 23 MATERIAL MANAGER • 573

Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 

Color tab

The Environment Color pane defines the base color used to attenuate the reflection 
sample in tandem with the reflection Intensity parameter. Utilizes the Falloff parameter 
to mix with Environment Edge Color.  The Environment Edge Color pane defines the edge 
color used to attenuate the environment sample in tandem with the environment Glare 
parameter. Utilizes the Falloff parameter to mix with Environment Color.
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Ambient page

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to affect your surface at all.

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide 
for more Intensity while larger values provide more Edge Intensity. The appropriate range 
is 0% - 500%.
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Roughness page
Used to add bump or grit to the material. 

Roughness tab

Function

The noise function utilized to calculate the bump and the grit. You can review the noise 
types very easily in the 2D or 3D Noise channel shaders to get a feel for what they are. 
Experimentation is very necessary.

Octaves

Defines the number of octaves utilized by the noise function defined within the Function 
drop-down list. This field will only be active if the noise function being used utilizes more 
octaves than one. Octaves is similar to Detail in many other shaders. 

Scale

Scales the surface point used in the noise evaluation. 

Amplitude

Scales the amplitude of the bump algorithm. The appropriate range is 0.0001% to 
1,000%. 

Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Animation speed of the noise in percentage of cycles per second.

Attenuation

Defines how much the noise algorithm will reduce the detail of the noise when the 
surface is far away or facing away from the camera. Appropriate values are 0% for stills 
and 100% to 1,000% for animation (it is primarily used to reduce flicker in animations).
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Hard Bump

Utilizes an implicit algorithm to calculate the bump, producing more realistic dented 
surfaces. Often used when creating steel doors with anisotropic highlights to create large 
dents. 

Absolute

Whether or not to fold the noise about its mid level by taking the absolute value of it. 

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail that is 
not possible with the standard static bump delta. 

Bump Clamping

The noise is calculated in a range of 0% - 100%. These values clip that range to provide 
for bumps with plateaus (like certain stuccos). Low Clip defines the low boundary for 
the clip (no bump under this value). High Clip defines the high boundary for the clip (no 
bump over this value).

Color tab

R, G, B, Brightness

Sets the color used as a base to attenuate (multiply by) the specular, diffuse, reflection, 
environment and ambient results. Negative values invert the grit application. The 
appropriate range is -200% - 200%, 
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Roughness Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).

Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object. Experimentation is absolutely required to understand 
these parameters. 

Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction; uses a separate algorithm for projecting the 
scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
the current normal. 
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Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to the current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).

Anisotropic Specular Roughness

X Roughness

Scales the specular highlights in the X direction defined by the Scratch Projection 
algorithm. The appropriate range is 0.1% to 10,000%. If the X & Y roughness are the 
same the standard internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used.

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the sample’s angle to the camera 
and the distance from the camera. The larger the values the greater the attenuation, 
causing less scratching (better for animation); the smaller the value the greater the detail 
(better for still images). The appropriate range is 0% - 10,000%. 
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Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches.

Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this channel to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are enabled by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set 
the strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents 
normal strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 

Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The Receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect.
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Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together.

Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.

Esoterica page

Shadow Attributes

Global Shadow Opacity

This parameter is used to scale the shadow opacity. Keep in mind that this changes the 
shadow opacity for every surface intercepted by the ray meaning that going through the 
surface twice causes the shadow to be twice as dark.
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BANZI

BANZI was created for the generation of volume rendered woods and allows for endless 
variation on the types of woods you can simulate. 

Wood page

Wood Color Gradient
Colorizes the ring and grain function. Experimentation is required to fully understand 
and use this control.

Wood Attributes

Ring Intensity

Reduces or increases the prominence of the annual rings. While the parameter can go 
negative, its useful values are between 50% and 150%. 
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Ring Turbulence

Stirs the annual rings so they may have a more natural look. Turbulence Scale — simply 
scales the noise used for the ring turbulence. 

Core Variance

Disturbs the origin of the rings so it looks as if the tree the wood came from did not 
grow perfectly straight. 

Radial Variance

Causes the rings to become non-symmetrical around their origin. Trees rarely grow 
perfectly circular rings because they are rarely perfectly round. This parameter allows for 
the natural deformation of the annual rings. 

Grain Intensity

Amplifies the grain pattern within the wood. A percent value of zero removes the grain 
totally while a value of 100 gives a very amplified grain pattern (this also affects bump). 

Ring Scale

Scales the rings of the wood before being stirred by the turbulence function. 

Variance Scale

Scale of the noise used to disturb the origin of the rings.

Radial Variance Scale

Scales the noise used for the Radial Variance.  

Grain Scale

Scales the grain.

Ring Variance

Varies the width of the rings without changing their respective positions. 

Attenuation

Is the amount of detail reduction caused by the function becoming smaller (whether 
being scaled or being further away from the camera) and facing away from the camera. 
For still imagery it is good to keep this value low (often we use zero), but keep it high for 
animation (anywhere between 100% to 1,000%+).
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Diffuse page

Diffuse Color

R, G, B, Brightness

Sets the diffuse color used to tint the surface.

Diffuse Attributes 

Algorithm

Specifies which illumination model BANZI will use. The drop-down list provides for 
two choices including Internal which is the standard Lambertian model and the Oren-
Nayar model which provides for a roughness variable allowing the user to go from 
simple surfaces (0 Roughness, identical to Lambertian), to complex rough surfaces (1+ 
Roughness, which provides a surface like linen or dirt). 

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). Illumination can go negative. When it does 
it multiplies the illumination for the surface with the surface color (gradient color). If 
you are utilizing the Oren-Nayar illumination algorithm you may want to bump up the 
illumination about 10% to 20% because it renders darker usually. Appropriate values are 
between 0% and 200%. 

Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 
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Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 

Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar)) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 
200%. 
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Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface.

Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 
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Color tab

Reflection Color

The controls in this group define the base color used to attenuate the reflection sample 
in tandem with the reflection Intensity parameter. Utilizes the Falloff parameter to mix 
with Reflection Edge Color. 

Reflection Edge Color

The controls in this group define the edge color used to attenuate the reflection sample 
in tandem with the reflection Edge Intensity parameter. Utilizes the Falloff parameter to 
mix with Reflection Color.

Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample. 
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Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 

Environment Convolution

This group allows the blurring of environments when the Anisotrophy group is checked. 
It doesn’t support radial convolutions because very similar effects can be achieved by 
blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy group parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The appropriate 
range is 0% - 100%. 
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Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 

Color tab

Environment Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Environment Edge Color. 

Environment Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
environment sample in tandem with the environment Glare parameter. Utilizes the Falloff 
parameter to mix with Environment Color.

Ambient page
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Ambient Color

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to affect your surface at all.

Ambient Attributes

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide 
for more Intensity while larger values provide more Edge Intensity. The appropriate range 
is 0% - 500%.

Roughness page

Roughness tab

Amplitude

Intensity of the bump caused by the grain and rings in the wood pattern. 
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Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail. 

Bump Clamping

Low Clip defines the low boundary for the clip (no bump under this value). High Clip 
defines the high boundary for the clip (no bump over this value).

Color tab

Roughness Color

The controls in this group of parameters set the color used as a base to attenuate 
(multiply by) the specular, diffuse, reflection, environment and ambient results. Negative 
values invert the grit application. The appropriate range is -200% - 200%, 

Roughness Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).
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Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object. Experimentation is absolutely required to understand 
these parameters. 

Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
current normal. 

Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).
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Anisotropic Specular Roughness 

X Roughness

Scales the highlights in the X direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same, the standard 
internal specular algorithm is used.

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
algorithm.

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length, rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the samples, angle to the 
camera and the distance from the camera. The larger the values the greater the 
attenuation, causing less scratching (better for animation); the smaller the value the 
greater the detail (better for still images). The appropriate range is 0% - 10,000%. 

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches.
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Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this page to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are switched on by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set 
the strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents 
normal strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 

Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The Receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect. 

Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together. 
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Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.
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CHEEN

Gradients page

Color Gradient
Is used to alter the base color of the object based on the angle between the camera and 
the surface normal (the left side of the gradient is the edge of the object while the right 
side of the gradient is the center of the object). 

Opacity Gradient
Causes the opacity of the object to change according to the angle between the camera 
and the surface normal. White is opaque while black knots are transparent. Knots at the 
left side of gradient affect the edge of the object while knots at the right side of the 
gradient affect the middle of the object.
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Diffuse page

Diffuse Color

R, G, B, Brightness

Sets the base diffuse color of the surface.

Diffuse Attributes 

Algorithm

Specifies which illumination model CHEEN will use. The drop-down list provides for 
two choices including Internal which is the standard Lambertian model and the Oren-
Nayar model which provides for a roughness variable allowing the user to go from 
simple surfaces (0 Roughness, identical to Lambertian), to complex rough surfaces (1+ 
Roughness which provides a surface like linen or dirt).

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). Illumination can go negative. When it does 
it multiplies the illumination for the surface by the surface color (gradient color). If 
you are utilizing the Oren-Nayar illumination algorithm you may want to bump up the 
illumination about 10% to 20% because it renders darker usually. Appropriate values are 
between 0% and 200%. 

Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 
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Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 

Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 200%. 
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Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more.

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%.

Transparency page

Transparency Attributes

Index Of Refraction

Defines the refractive index of the material.

Internal Reflection

Allows refracted rays to reflect when appropriate. 

Solid Object

Makes the object a completely dense object instead of one surface. Disallows 
illumination, reflection, and environment to be evaluated for the second surface 
intercepted of the object.
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Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface.

Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 

Color tab
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Reflection Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Reflection Edge Color. 

Reflection Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
reflection sample in tandem with the reflection Edge Intensity parameter. Utilizes the 
Falloff parameter to mix with Reflection Color.   

Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample.

Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 
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Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 

Environment Convolution

This group of parameters allows the blurring of environments when the Anisotrophy 
group is checked. It doesn’t support radial convolutions because very similar effects can 
be achieved by blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy group parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The 
appropriate range is 0% to 100%. 

Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 
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Color tab

Environment Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Environment Edge Color. 

Environment Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
environment sample in tandem with the environment Glare parameter. Utilizes the Falloff 
parameter to mix with Environment Color.

Ambient page

Ambient Color

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to affect your surface.
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Ambient Attributes

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide 
for more Intensity while larger values provide more Edge Intensity. The appropriate range 
is 0% - 500%.

Roughness page
Used to add bump or grit to the material. 

Roughness tab

Function

The noise function utilized to calculate the bump and the grit. You can review the noise 
types very easily in the 2D or 3D Noise channel shaders to get a feel for what they are.

Octaves

Defines the number of octaves utilized by the noise function defined within the Function 
drop-down list. This field will only be active if the noise function being used utilizes more 
octaves than one. Octaves is similar to Detail in many other shaders. 
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Scale

Scales the surface point used in the noise evaluation. 

Amplitude

Scales the amplitude of the bump algorithm. The appropriate range is 0.0001% to 
1,000%. 

Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Animation speed of the noise in percentage of cycles per second.

Attenuation

Defines how much the noise algorithm will reduce the detail of the noise when the 
surface is far away or facing away from the camera. Appropriate values are 0% for stills 
and 100% to 1,000% for animation (it is primarily used to reduce flicker in animations).

Hard Bump

Utilizes an implicit algorithm to calculate the bump, producing more realistic dented 
surfaces. Often used when creating steel doors with anisotropic highlights to create large 
dents. 

Absolute

Whether or not to fold the noise about its mid level by taking the absolute value of it.

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail that is 
not possible with the standard static bump delta. 

Bump Clamping

Set the Low Clip value to clip the noise to black that will be used in the bump calculation. 
Set the High Clip value to clip the noise to white.
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Color tab

Roughness Color

The controls in this group of parameters set the color used as a base to attenuate 
(multiply by) the specular, diffuse, reflection, environment and ambient results. Negative 
values invert the grit application. The appropriate range is -200% - 200%, 

Roughness Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).
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Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object.  Experimentation is absolutely required to understand 
these parameters.

Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
the current normal. 

Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to the current normal.  

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).
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Anisotropic Specular Roughness 

X Roughness

Scales the highlights in the X direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used.

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the samples, angle to the 
camera and the distance from the camera. The larger the values the greater the 
attenuation, causing less scratching (better for animation), the smaller the value the 
greater the detail (better for still images). The appropriate range is 0% - 10,000%. 

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches.
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Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this page to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are switched on by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set 
the strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents 
normal strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 

Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect.

Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together. 
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Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.

Esoterica

Shadow Attributes

Shadow Opacity

This parameter is used to scale the shadow opacity. Keep in mind that this changes the 
shadow opacity for every surface intercepted by the ray meaning that going through the 
surface twice causes the shadow to be twice as dark.
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DANEL

DANEL was conceived to allow users the ability to create surfaces that include metallic, 
gloss, painted, and anisotropic materials.

Diffuse page

Diffuse Color

R, G, B, Brightness

Sets the base diffuse color of the surface.
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Diffuse Attributes

Algorithm

Specifies which illumination model DANEL will use. The drop-down list provides for two 
choices including Internal which is the standard Lambertian model and the Oren-Nayar 
model which provides for a roughness variable allowing the user to go from simple 
surfaces (0 Roughness, identical to Lambertian), to complex rough surfaces (100% + 
Roughness which provides a surface like linen or dirt).

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter when 
the value is closer to 100% or above). If you are utilizing the Oren-Nayar illumination 
algorithm you may want to bump up the illumination about 10% to 20% because it 
renders darker usually. Appropriate values are between 0% and 200%. 

Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 

Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.



612 • CHAPTER 23 MATERIAL MANAGER • 613

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 

Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% and 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 
200%. 

Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface. 
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Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 

Distance Falloff

Turns on or off distance falloff for reflections. Doing so does slow the shader down about 
20% because the reflections rays are calculated by customized algorithms. 

Min

If the distance of the reflected surface is less than or equal to the Min distance the 
reflection will be 100%. The Distance Falloff check box must be checked for this value to 
be utilized or available. 
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Max

If the distance of the reflected surface is greater than the Min distance and less than the 
Max distance then the reflection intensity of the sample will be attenuated by a value 
produced by retrieving the parameterized distance of the intercepted position relating to 
the Min and Max distances ((intercepted_Point - min_Point) / (max_Point - min_Point)). 
If the distance of the intercepted surface is greater than the Max parameter then the 
surface has 0% intensity. 

Reflection Convolution

This collection of parameters was added because of numerous requests from users. It is 
not fast, and requires large sampling rates to provide acceptable results. Distance Falloff 
will effect blurred reflection samples, producing very beautiful results in many cases. 

Utilize Anisotropic Scratches

This check box is only active when the Anisotrophy group is checked. It allows the 
reflection to take into account the scratch directions when evaluating blurred reflections. 
Very effective for milled machinery. Anisotropic scratches are only convoluted along one 
axis so they require far fewer samples than does the radial convolution algorithm.

If this check box is inactive, the Blur radius is greater than 0% and Samples is greater 
than 1 the radial convolution algorithm is used (this is what the majority would consider 
Blurred Reflections). 

Blur

This defines the radius of the convolution (blur) that will be used during the evaluation 
of blurred reflections. If Utilize Anisotropic Scratches is checked it will use the scratch 
direction defined by the parameters in the Anisotrophy group, otherwise it will use a 
radial convolution algorithm to sample the reflections. Appropriate value range is 0% 
- 100%. 

Samples

Sets the number of samples taken when the Blur radius percentage is greater that 0%. 
When Utilize Anisotropic Scratches is checked it is good to start with a value equal to the 
Blur radius. If Utilize Anisotropic Scratches is not checked then you should usually double 
the Blur radius, sometimes having to go as large as 100 to 200 samples (very slow). 

Jitter

Defines the maximum random offset of the reflection convolution associated with the 
anisotropic scratch convolution algorithm. This parameter is only active when Utilize 
Anisotropic Scratches is checked because the radial convolution is a completely stochastic 
function (jitters 100% all the time to the boundary of the radius). Jittering is very similar 
to dithering in effect. Appropriate value range is 0% - 100%. 
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Color tab

Reflection Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Reflection Edge Color. 

Reflection Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
reflection sample in tandem with the reflection Edge Intensity parameter. Utilizes the 
Falloff parameter to mix with Reflection Color.

Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample.
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Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 

Environment Convolution

This group of parameters allows the blurring of environments when the Anisotrophy 
group is checked. It doesn’t support radial convolutions because very similar effects can 
be achieved by blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy group parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The 
appropriate range is 0% to 100%. 
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Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 

Color tab

Environment Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Environment Edge Color. 

Environment Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
environment sample in tandem with the environment Glare parameter. Utilizes the Falloff 
parameter to mix with Environment Color.

Ambient page
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Ambient Color

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to affect your surface at all.

Ambient Attributes

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide 
for more Intensity while larger values provide more Edge Intensity. The appropriate range 
is 0% - 500%.

Roughness page
Used to add bump or grit to the material. 

Roughness tab

Function

The noise function utilized to calculate the bump and the grit. You can review the noise 
types very easily in the 2D or 3D Noise channel shaders to get a feel for what they are.
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Octaves

Defines the number of octaves utilized by the noise function defined within the Function 
drop-down list. This field will only be active if the noise function being used utilizes more 
octaves than one. Octaves is similar to Detail in many other shaders. 

Scale

Scales the surface point used in the noise evaluation. 

Amplitude

Scales the amplitude of the bump algorithm. The appropriate range is 0.0001% to 
1,000%. 

Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Animation speed of the noise in percentage of cycles per second.

Attenuation

Defines how much the noise algorithm will reduce the detail of the noise when the 
surface is far away or facing away from the camera. Appropriate values are 0% for stills 
and 100% to 1,000% for animation (it is primarily used to reduce flicker in animations).

Hard Bump

Utilizes an implicit algorithm to calculate the bump, producing more realistic dented 
surfaces. Often used when creating steel doors with anisotropic highlights to create large 
dents. 

Absolute

Whether or not to fold the noise about its mid level by taking the absolute value of it. 

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail that is 
not possible with the standard static bump delta. 

Bump Clamping

The noise is calculated in a range of 0% - 100%. These values clip that range to provide 
for bumps with plateaus (like certain stuccos). Low Clip defines the low boundary for 
the clip (no bump under this value). High Clip defines the high boundary for the clip (no 
bump over this value).
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Grit tab

Grit Color

The controls in this group of parameters set the color used as a base to attenuate 
(multiply by) the specular, diffuse, reflection, environment and ambient results. Negative 
values invert the grit application. The appropriate range is -200% - 200%, 

Grit Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).

Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object.
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Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
the current normal. 

Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to the current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).

Anisotropic Specular Roughness 

X Roughness

Scales the highlights in the X direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used.

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 
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Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the samples, angle to the 
camera and the distance from the camera. The larger the values the greater the 
attenuation, causing less scratching (better for animation); the smaller the value the 
greater the detail (better for still images). The appropriate range is 0% - 10,000%. 

Affect Channel

These check boxes specify which specular channels will be effected by the anisotropic 
scratches.

Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this page to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are switched on by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set 
the strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents 
normal strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 
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Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The Receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect.

Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together. 

Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.
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MABEL
 Each channel except Veining and Illumination is made up of two surfaces: Surface 1 and 

Surface 2. Choose which surface’s parameters are displayed using the drop-down list that 
is just above the channels list in the left part of the dialog.

MABEL was conceived to allow users the ability to create marbled stone textures that 
generally consist of a body and a vein surface. 

Veining page

The veining channel controls the size and mixing of the two vein surfaces. You also can 
change the relative color variance and turbulence of the veins as well. There is only one 
veining group that is shared by both surfaces.

Veining
This group of parameters contains attributes of the veining function. The function 
is basically an alternating gradient on the Y axis that can be perturbed using a noise 
function. 

Function

Noise function used to perturb the veins (see ‘Types of Noise’ on page 310).
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Octaves

Octaves of fractal detail used in the stirring function. 

Stirring

Amount of distortion applied to the veins.

Size

Size of the veins (Surface1) to the body (Surface 2).

Scale

The scale of the stirring noise function. 

Contrast

Contrast applied to the veins to make them blend smoothly or separate distinctly. 

Variance
This group of parameters contains attributes of a second noise to add variance to the 
blend of the veins and body caused by the veining function. 

Function

Noise function used to vary the veining.

Octaves

Octaves of fractal detail used in the variance function. 

Amplitude

Amount of variance applied to the veins.

Scale

The scale of the variance noise function. 

Contrast

Contrast applied to the variance noise.
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Diffuse page

The Diffuse group applies to the currently selected surface in the surface combo box 
below the preview.

Diffuse Color

R, G, B, Brightness

Sets the base diffuse color of the surface.

Diffuse Attributes

Algorithm

Specifies which illumination model MABEL will use. The drop-down list provides for two 
choices including Internal which is the standard Lambertian model and the Oren-Nayar 
model which provides for a roughness variable allowing the user to go from simple 
surfaces (0 Roughness, identical to Lambertian), to complex rough surfaces (100% + 
Roughness which provides a surface like linen or dirt). 

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter when 
the value is closer to 100% or above). If you are utilizing the Oren-Nayar illumination 
algorithm you may want to bump up the illumination about 10% to 20% because it 
renders darker usually. Appropriate values are between 0% and 200%. 

Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 
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Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 

Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 
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Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 
200%. 

Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface. 

Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 
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Color tab

Reflection Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Reflection Edge Color. 

Reflection Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
reflection sample in tandem with the reflection Edge Intensity parameter. Utilizes the 
Falloff parameter to mix with Reflection Color.

Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample. 
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Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 

Environment Convolution

This group of parameters allows the blurring of environments when the Anisotrophy 
group is checked. It doesn’t support radial convolutions because very similar effects can 
be achieved by blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy group parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The 
appropriate range is 0% to 100%. 
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Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 

Color tab

Environment Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Environment Edge Color. 

Environment Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
environment sample in tandem with the environment Glare parameter. Utilizes the Falloff 
parameter to mix with Environment Color.
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Ambient page

Ambient Color

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to effect your surface at all.

Ambient Attributes

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide for 
more Intensity while larger values provide more Edge Intensity. The appropriate range is 0% 
- 500%.
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Roughness page
Used to add bump or grit to the material. 

Roughness tab

Function

The noise function utilized to calculate the bump and the grit. You can review the noise 
types very easily in the 2D or 3D Noise channel shaders to get a feel for what they are. 
Experimentation is very necessary.

Octaves

Defines the number of octaves utilized by the noise function defined within the Function 
drop-down list. This field will only be active if the noise function being used utilizes more 
octaves than one. Octaves is similar to Detail in many other shaders. 

Scale

Scales the surface point used in the noise evaluation. 

Amplitude

Scales the amplitude of the bump algorithm. The appropriate range is 0.0001% to 
1,000%. 

Attenuation

Defines how much the noise algorithm will reduce the detail of the noise when the 
surface is far away or facing away from the camera. Appropriate values are 0% for stills 
and 100% to 1,000% for animation (it is primarily used to reduce flicker in animations).

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail that is 
not possible with the standard static bump delta. 
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Hard Bump

Utilizes an implicit algorithm to calculate the bump, producing more realistic dented 
surfaces. Often used when creating steel doors with anisotropic highlights to create large 
dents. 

Absolute

Whether or not to fold the noise about its mid level by taking the absolute value of it. 

Bump Clamping

The noise is calculated in a range of 0% - 100%. These values clip that range to provide 
for bumps with plateaus (like certain stuccos). Low Clip defines the low boundary for 
the clip (no bump under this value). High Clip defines the high boundary for the clip (no 
bump over this value).

Grit tab

Grit Color

The controls in this group of parameters set the color used as a base to attenuate 
(multiply by) the specular, diffuse, reflection, environment and ambient results. Negative 
values invert the grit application. The appropriate range is -200% - 200%, 

Grit Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).
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Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object. Experimentation is absolutely required to understand 
these parameters. 

Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
the current normal. 

Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to the current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).
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Anisotropic Specular Roughness 

X Roughness

Scales the highlights in the X direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used. 

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the samples, angle to the 
camera and the distance from the camera. The larger the values the greater the 
attenuation, causing less scratching (better for animation); the smaller the value the 
greater the detail (better for still images). The appropriate range is 0% - 10,000%. 

Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches. 
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Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this page to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are switched on by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set the 
strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents normal 
strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 

Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The Receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect.

Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together. 
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Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.
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NUKEI
 Each channel except Veining and Illumination is made up of two surfaces: Surface 1 and 

Surface 2. Choose which surface’s parameters are displayed using the drop-down list that 
is just above the channels list in the left part of the dialog.

NUKEI was conceived to allow users the ability to create surfaces that include rusted and 
weathered materials that generally have two distinct surfaces with different attributes. 

Fusing page
The fusing channel controls the mixing of the two surfaces and the attributes of the 
interface between them. There is only one Fusing channel that is shared by and controls 
both Surface 1 and Surface 2.

Texture tab
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FUSER Texture

Utilizes a standard BodyPaint 3D texture group for the Fusing of the two surfaces.

Texture Transformation

This group of parameters contains the settings of the texture projection. This should 
look very familiar as it is basically the same as the projection options available in 
BodyPaint 3D.  

Projection

The projection type to use. The following are available to choose from and are 
functionally the same as BodyPaint 3D’s normal projections: Spherical, Cylindrical, Flat, 
Cubic, Frontal and Shrink Wrap.

Overide Time

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

If enabled then the Time in seconds is overridden and can be keyframed in the 
CINEMA 4D Timeline.

Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

If Overide Time is enabled then the time entered here overrides the CINEMA 4D time and 
can be keyframed. If Overide Time is not enabled then you can enter a Speed scaling to 
scale time used for animating the texture / shader. 

Offset, Length, Tiles

Offset is the offset of the 2D texture in UV. Length is the scaling of the 2D texture in UV. 
Tiles is the tiling of the 2D texture in UV. 

Tile

If enabled, the 2D texture will tile in UV the number of times specified in the Tiles X and 
Y values. 

Seamless

If Tiles is enabled then enabling Seamless causes the tiles to be mirrored so that they tile 
seamlessly. 

Position, Size, Rotation

Position is the offset of the 3D texture space. Size is the scaling of the 3D texture space. 
Rotation is the orientation of the 3D texture space. 
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Copy Tag

Pressing the Copy Tag button causes the settings of the currently selected Texture tag in 
the Object manager to be copied into NUKEI’s parameters. This makes it easier for you 
to create a projection using Real Time Texture Mapping and then just copy it in to use in 
NUKEI. 

Attributes tab

Falloff

The falloff of the edge mix between Surface 1 and Surface 2. Large values cause the 
surfaces to blend together over a larger range, while smaller values cause a sharper break 
between the two surfaces.

Offset

Offsets the boundary between the two surfaces causing more of one surface or the 
other. 

Edge Shadow Intensity

A darkening of the surfaces near the edge to give the appearance of shadowing caused 
by peeling and flaking. 

Edge Shadow Falloff

Controls the width of the edge shadowing. 

1 Bump Amplitude, 2 Bump Amplitude

The amplitude of the bump caused by the FUSER Texture in Surface 1 and Surface 2.
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1 Edging Width, 2 Edging Width

The width of the edging around the interface between Surface 1 and Surface 2 that 
protrudes into Surface 1 and Surface 2. 

1 Edging Bump Amplitude, 2 Edging Bump Amplitude

The bumping of Surface 1 and Surface 2 around the interface between Surface 1 and 
Surface 2.

Diffuse page

The Diffuse channel applies to the currently selected surface in the surface combo box 
below the preview.

Diffuse Color

R, G, B, Brightness

Sets the base diffuse color of the surface.

Diffuse Attributes

Algorithm

Specifies which illumination model NUKEI will use. The drop-down list provides for two 
choices including Internal which is the standard Lambertian model and the Oren-Nayar 
model which provides for a roughness variable allowing the user to go from simple 
surfaces (0 Roughness, identical to Lambertian), to complex rough surfaces (100% + 
Roughness which provides a surface like linen or dirt).

Illumination

Scales the Diffuse Color to produce attenuation in the illumination of the surface (this 
simply means it makes the color darker when the value is close to zero and brighter when 
the value is closer to 100% or above). If you are utilizing the Oren-Nayar illumination 
algorithm you may want to bump up the illumination about 10% to 20% because it 
renders darker usually. Appropriate values are between 0% and 200%.  
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Roughness

Dictates how rough the Oren-Nayar illumination model will be. Zero is no roughness 
while 100% or greater is very rough. Experimentation is required to fully understand this 
parameter. This option is only available if Oren-Nayar is selected in the Algorithm drop-
down list. 

Contrast

Provides contrast for the result of the diffuse sample color. Zero causes no effect, 0.0% 
- 100% causes standard contrast, above 100% causes a wrap contrast (the values that go 
above 100% wrap around to 0% again, utilized to create the Candy materials), negative 
values provide an inverse contrast that simulates materials that seem luminescent such as 
Silver. Appropriate values are -500% to 500%.

Specular pages

The three specular highlights controlled in the Specular channels are additive to the color 
of the surface. All three Specular channels share the same parameter set described below.

Specular Color

R, G, B, Brightness

Sets the base specular color for the first specular component.

Specular Attributes

Intensity

Scales the Specular Color to produce attenuation in the specular reflection of the surface 
(this simply means it makes the color darker when the value is close to zero and brighter 
when the value is closer to 100% or above). The appropriate range is 0% - 1,000%. 
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Glare

Works with Specular Intensity by using the edge falloff (multiplied by the Falloff scalar) 
to change the intensity of the specular reflection. This can be used to add a glare to 
the surface when a light is reflecting more on an edge or specular effects to reduce the 
specular reflection when a light causes a reflection closer to the edge. Appropriate values 
run between 0% - 200%. 

Size

Sets the size of the specular reflection. Appropriate value range for Size is 0.001% - 
200%. 

Falloff

Utilized to vary the falloff of the center of the object to the edge to affect the Glare 
intensity. Smaller values cause the specular reflection to reflect the Intensity value more 
while larger values make the surface use the Glare scalar more. Experimentation is 
required to fully understand this parameter. 

Contrast

Provides contrast for the result of the specular sample color. Implements a standard 
contrast function. Appropriate values are 0% - 100%. 

Reflection page
The reflection controlled in the two reflection tabs (Attributes and Color) are additive to 
the color of the surface. 

Attributes tab

Intensity

Scales the Reflection Color before it is mixed with the Edge Intensity and Reflection Edge 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 
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Edge Intensity

Scales the Reflection Edge Color before it is mixed with the Intensity and Reflection 
Color result to create the final reflection color sample that will be used to attenuate the 
reflection sample taken by BodyPaint 3D internally. Appropriate values are 0% - 200%. 

Falloff

Mixes the results of the Reflection Color x Intensity and Reflection Edge Color x Edge 
Intensity. Smaller values provide for more Reflection Color while larger values provide 
more Reflection Edge Color. The appropriate range is 0% - 500%. 

Color tab

Reflection Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Reflection Edge Color. 

Reflection Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
reflection sample in tandem with the reflection Edge Intensity parameter. Utilizes the 
Falloff parameter to mix with Reflection Color.
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Environment page

Image tab

Utilizes a standard BodyPaint 3D texture group to be used for the environment sample. 

Attributes tab

Intensity

Scales the Environment Color before it is mixed with the Glare and Environment Edge 
Color result to create the final environment color sample that will be used to attenuate 
the environment sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Glare

Scales the Environment Edge Color before it is mixed with the Intensity and Environment 
Color result to create the final environment color sample that will be used to attenuate 
the reflection sample provided by the Environment Texture texture group. Appropriate 
values are 0% - 200%. 

Falloff

Mixes the results of the Environment Color x Intensity and Environment Edge Color x 
Glare. Smaller values provide for more Environment Color while larger values provide 
more Environment Edge Color. The appropriate range is 0% - 500%. 
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Environment Convolution

This group of parameters allows the blurring of environments when the Anisotrophy 
group is checked. It doesn’t support radial convolutions because very similar effects can 
be achieved by blurring the environment map (it is also much, much faster). 

Utilize Anisotropic Scratches

Tells the group to become active allowing the shader to take multiple samples of the 
Environment Texture texture group along the axis of the scratch direction defined by the 
Anisotrophy group parameters. 

Blur

Defines the radius for the convolution. Larger values equate to more blur. The 
appropriate range is 0% to 100%. 

Samples

Defines how many samples will be taken by the convolution. If you enter 1, no 
convolution will occur. The value should be similar to your Blur radius value. The 
appropriate range is 2 - 50. 

Jitter

Defines the maximum random offset per sample of the convolution function. This rids 
the blurred environment of the stepping effect when you can see multiple images 
layered. The appropriate range is 0% - 100%. 

Color tab

Environment Color

The controls in this group of parameters define the base color used to attenuate the 
reflection sample in tandem with the reflection Intensity parameter. Utilizes the Falloff 
parameter to mix with Environment Edge Color. 
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Environment Edge Color

The controls in this group of parameters define the edge color used to attenuate the 
environment sample in tandem with the environment Glare parameter. Utilizes the Falloff 
parameter to mix with Environment Color.

Ambient page

Ambient Color

R, G, B, Brightness

Defines the base ambient color used to attenuate (multiply by) the scene ambient color 
provided by BodyPaint 3D. You must have an Environment object active in your scene for 
this to affect your surface at all.

Ambient Attributes

Intensity

Scales the Ambient Color before it is mixed with the Edge Intensity result to create the 
final ambient color sample that will be used to attenuate the ambient sample taken by 
BodyPaint 3D internally. Appropriate values are 0% - 100%. 

Edge Intensity

Mixes with Intensity to scale the Ambient Color to create the final ambient color sample 
that will be used to attenuate the ambient sample taken by BodyPaint 3D internally. 
Appropriate values are 0% - 100%.

Falloff

Mixes Intensity and Edge Intensity to attenuate the Ambient Color. Smaller values provide 
for more Intensity while larger values provide more Edge Intensity. The appropriate range 
is 0% - 500%.  
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Roughness
Used to add bump or grit to the material. 

Roughness tab

Function

The noise function utilized to calculate the bump and the grit. You can review the noise 
types very easily in the 2D or 3D Noise channel shaders to get a feel for what they are.

Octaves

Defines the number of octaves utilized by the noise function defined within the Function 
drop-down list. This field will only be active if the noise function being used utilizes more 
octaves than one. Octaves is similar to Detail in many other shaders. 

Scale

Scales the surface point used in the noise evaluation. 

Amplitude

Scales the amplitude of the bump algorithm. The appropriate range is 0.0001% to 
1,000%. 

Speed

 This feature only has an effect if you are using the BodyPaint 3D module with 
CINEMA 4D.

Animation speed of the noise in percentage of cycles per second.

Attenuation

Defines how much the noise algorithm will reduce the detail of the noise when the 
surface is far away or facing away from the camera. Appropriate values are 0% for stills 
and 100% to 1,000% for animation (it is primarily used to reduce flicker in animations).
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Hard Bump

Utilizes an implicit algorithm to calculate the bump, producing more realistic dented 
surfaces. Often used when creating steel doors with anisotropic highlights to create large 
dents. 

Absolute

Whether or not to fold the noise about its mid level by taking the absolute value of it. 

Delta

Delta is a scaling factor to use in sampling the texture for evaluating slope to be used in 
evaluating the bump. This allows you to get very sharp bump with minute detail that is 
not possible with the standard static bump delta. 

Bump Clamping

The noise is calculated in a range of 0% - 100%. These values clip that range to provide 
for bumps with plateaus (like certain stuccos). Low Clip defines the low boundary for 
the clip (no bump under this value). High Clip defines the high boundary for the clip (no 
bump over this value).

Grit tab

Grit Color

The controls in this group of parameters set the color used as a base to attenuate 
(multiply by) the specular, diffuse, reflection, environment and ambient results. Negative 
values invert the grit application. The appropriate range is -200% - 200%, 
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Grit Intensity

Mixes between the grit sample and Vector (1) to allow varying degrees of grit (think of it 
as an opacity control for grit). If the grit value is less than or equal to the Low Clip value 
it becomes 0 (Grit Color). If the grit value is greater than or equal to the High Clip value it 
becomes 1 (the surface color).

Anisotrophy page

Anisotropic Projection

Scratch Projection

The type of projection is used to define the anamorphic (disproportional) scaling of the 
specular highlights. It can also define the scratch direction to be used with the reflection 
and environment convolution groups. The projections are transformed by the Texture tag 
used to apply them to an object. Experimentation is absolutely required to understand 
these parameters. 

Planar

A flat XY planar projection.

AutoPlanar

Automatically projects on a plane parallel to the current normal. 

Shrink Wrap

A spherical projection for scaling direction, but uses a separate algorithm for projecting 
the scratches.

Radial

Creates a radial scratch pattern originating at the center of a plane that is parallel to 
current normal. 
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Radial Pattern

Creates a multi-origin radial scratch pattern that is parallel to current normal. 

Projection Scale

Scales the scratch algorithms that have an actual pattern (Radial Pattern is the only 
current algorithm of this type to which scale applies).

Anisotropic Specular Roughness 

X Roughness

Scales the specular highlights in the X direction defined by the Scratch Projection 
algorithm. The appropriate range is 0.1% to 10,000%. If the X & Y roughness are the 
same the standard internal specular algorithm is used. 

Y Roughness

Scales the highlights in the Y direction defined by the Scratch Projection algorithm. The 
appropriate range is 0.1% to 10,000%. If the X & Y roughness are the same the standard 
internal specular algorithm is used.

Anisotropic Scratch Attributes

Amplitude

Scales the effect of the scratch of the specular highlights. The higher the value the more 
scratched the speculars will look. The appropriate range is 0% - 100%. 

Scale

Scales the scratch pattern itself. This applies to all scratch algorithms. 

Length

Defines the scratch length in the space of the scratch pattern. Smoother milled surfaces 
would use a higher scratch length and rougher surfaces would use smaller values. The 
appropriate range is 1% - 1,000%. 

Attenuation

Scales the amount of detail of the scratches based upon the samples, angle to the 
camera and the distance from the camera. The larger the values the greater the 
attenuation causing less scratching (better for animation); the smaller the value the 
greater the detail (better for still images). The appropriate range is 0% - 10,000%. 
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Affect Channel

These check boxes specify which specular channels will be affected by the anisotropic 
scratches.

Alpha page

Opacity

The opacity for the surface. With Alpha you can layer NUKEI over other shaders and 
textures.

Illumination page
 These settings only have an effect if you are using the BodyPaint 3D module with 

CINEMA 4D.

Use this page to control aspects of material illumination. Here, you can switch on/off 
radiosity and caustics for the material (both are switched on by default).

Global Illumination 

Generate

When the option is enabled, the material will generate radiosity. Use the input box to set 
the strength of the radiosity - you can enter values from 0 to 10,000%. 100% represents 
normal strength. 

Receive

If this option is enabled, the material will receive radiosity. The value in the input box 
defines the strength of the radiosity effect. 
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Caustics

Generate

 The material must be transparent and/or reflective in order to create a caustics effect. 

Use this option to enable the generation of caustics by the material. The input box 
defines the strength of the caustics generated.

Receive

 The Receive option has no effect for volume caustics. 

This enables or disables the reception of surface caustics by the material. Use the input 
box to set the strength of the effect. 

Sample Radius

In order to calculate the brightness of the caustics effect, photons within a certain 
distance of the pixel to be rendered are interpolated to calculate the brightness. The 
Sample Radius defines this distance. Sample Radius = 1; individual photons can be seen 
as points of light because they are not interpolated together. 

Samples

This defines the maximum number of photons within the Sample Radius that are used 
for calculating the effect. For example, if you enter a value of 100, up to 100 photons 
will be evaluated - any photons beyond this number are ignored. Samples and Sample 
Radius both affect the quality of the effect. To summarize: more samples per sample 
radius means a more accurate image. Increasing the sample radius means more blur, but 
a longer render time also.
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Texture Mapping
You can apply a texture to an object in the following ways:

-  Drag the desired material from the Material manager and drop it on to the name of 
the object in the Object manager. The texture settings will appear in the Attribute 
manager. The mouse pointer will change during this process to indicate the add state:

-  Select the object in the Object manager and select the material in the Material 
manager. In the Material manager, choose Function > Apply.  The texture settings will 
appear in the Attribute manager.

-  You can drop a new material on to an existing Texture tag. The new material will 
replace the old one but will inherit the existing texture settings.

Texture tag settings
When you assign a material to an object, a Texture tag is created and the tag’s settings 
appear in the Attribute manager. These texture settings define how the texture is 
mapped (i.e. placed) onto the object’s surface. For example, you may want the texture 
to be tiled (i.e. repeated) or you may want to place the texture on a specific part of the 
object. You can also have the texture mapped on one side only (decal mapping). In this 
chapter we will explain all the texture settings.

Attribute manager settings

Basic Properties

Name

Here you can enter a new name for the Texture tag. This is especially useful when you 
want to animate tags (and their materials), since the tag’s name will appear in the 
Timeline. Always give your Texture tags meaningful names.



656 • CHAPTER 23 MATERIAL MANAGER • 657

Tag Properties

Material

To choose which material the Texture tag uses, drag the desired material from the Object 
manager and drop it into this box. If multiple Texture tags are selected, the material will 
be applied to all of them. If you click the arrowhead that is to the right of the Material 
box, a menu opens:

Clear

Removes the Texture tag’s material.

Show In Manager

Shows the Texture tag’s material in the Material manager.

Select Channel

Selects the Texture tag’s material in the Material manager.
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Selection

Selection enables you to use different materials on different parts of the same object. 
This is a convenient way to add, for example, labels to objects. First of all you need a 
Selection tag:

-  Select the object, select the Polygons tool and select the Live Selection tool.

-  Select several polygons (if you selected a primitive object, you must first convert it to 
polygons using Make Editable).

-  Choose Select Polygon > Set Selection to create a Polygon Selection tag.

-  On the Basic Properties page of the Attribute manager, enter a meaningful name for 
the Polygon Selection tag.

-  If the object does not yet have a texture, apply a new texture (drag the material from 
the Material manager and drop it on to the name of the object in the Object manager). 
The Texture tag’s settings appear in the Attribute manager. Enter your settings such as 
the projection type and tiling then enter the name of the selection into the Selection 
box.

 When you are positioning a texture on a selection you may find it helpful to hide the 
unselected surfaces. You can hide them using Select Polygon > Hide Unselected.

Projection

The Projection setting determines how the texture is projected or mapped onto a surface. 
The projection surface is independent of the real surface of the object, although often it 
has the same basic shape. UVW mapping fixes the projection on to the surface points of 
an object so that when the object surface is deformed (like a flag would be in the wind), 
the texture deforms with it. The best mapping type to use depends on the shape of the 
object to which you apply it.
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Side (decal mapping)

Figure 1 Figure 2 Figure 3 Figure 4

Suppose that you project a texture onto a tube with Flat mapping. If you move the 
camera around to look at the other side of the surface, you will still see the texture, but 
it will be the wrong way round. You can solve this problem by using a decal — a material 
that is projected on one side of the surface only. The direction of the surface normals for 
each polygon plays a pivotal role in deciding on which side the texture is mapped. Front 
is in the direction of the surface normals and Back means in the opposite direction to the 
surface normals (see Figure 1, above).

With Flat projection, a texture is projected from the front through to the back of an 
object. As a result, the texture is also visible where it is not wanted — in this case, on 
the front as well as on the back of the tube (Figure 2). You can avoid such problems with 
decal mapping. Change Side from Both to Front. Now render the tube again. This time 
the label is visible on the front side only (Figure 3). If the viewing angle (i.e. the camera 
angle) and the surface normal form an angle of less than 90° to each other, the polygon 
is a front polygon; otherwise it is a back polygon (Figure 4).

The only exceptions are for Flat and Spatial mapping. Here there is an additional criterion: 
the direction of the texture projection’s Z-axis. If the texture’s Z-axis points in the 
opposite direction to the surface normal and if the viewing angle and surface normal 
form an angle of less than 90° to each other, the polygon is a front polygon; otherwise it 
is a back polygon.

Both

The texture is projected in the direction of the surface normals and also in the opposite 
direction.

Front

You see the texture where the surface normals point towards the camera, otherwise the 
material is invisible.

Back

You will see the texture only where the surface normals point in the opposite direction 
to the camera. The material is otherwise invisible.



658 • CHAPTER 23 MATERIAL MANAGER • 659

Offset, Length

The Offset and Length settings define the position and size of the texture in the X and Y 
directions on the texture envelope. For example, if Length X and Length Y are both set to 
100%, the texture covers the envelope completely.

Tiles

The Tiles values are the number of times the texture fits onto the texture envelope in the 
X and Y directions. Hold on a moment, isn’t that the same as changing the length? Yes, 
exactly. You can change the length either in terms of tiles (Tiles) or as a percentage of the 
texture envelope (Length). Either way, changing one will cause the other to change. Note 
that the texture will only be repeated (tiled) if the Tile option is enabled.

BodyPaint 3D calculates the size of an individual tile from the current texture size. For 
example, if you have scaled the texture so that it has a length of 25% in the X direction 
and 50% in the Y direction, the texture fits four times in the X direction (1, 0.25) and 
twice in the Y direction (1, 0.5) on the surface. If you change the Tile X or Tile Y settings, 
the Length settings change automatically. For example, if you change the number to 3, 
the texture shrinks from 50% to 33.33%. 

Mix Textures

If this option is enabled, the material will be mixed with the underlying materials.

Tile

 If you enable the Tile option for a 2D or 3D shader it is not, strictly speaking, tiled, but 
instead fills the entire object seamlessly. There may or may not be a repeating pattern 
depending on the programming of the shader.
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If this option is enabled, the texture picture will be repeated endlessly on the surface. The 
effect becomes visible when you scale down the texture or when the texture geometry 
has not yet been fitted to the object using the Fit To Object command. Otherwise, the 
texture map fills the texture geometry once.

If this option is disabled, the texture map will not be repeated on the surface. Any 
materials that are underneath will show through in the parts not covered by the texture 
tile.

Seamless

 Seamless is generally of little use for photographic textures, although you can generate 
interesting patterns. The option is best suited to pictures with a pattern, such as wood, 
stone or marble.

If the Seamless option is enabled, tiles are mirrored to prevent visible seams. However, 
this sometimes leads to a butterfly pattern.

Coordinates

P, S, R (Position, Scale, Rotation)

On this page of the Attribute manager, you’ll find the settings that control the texture’s 
position, scale and rotation. You can also change these values interactively in the 
viewports (with the Texture Axis tool selected). Figures 1 and 2 demonstrate the 
difference between the Texture tool and the Texture Axis tool. Both pictures demonstrate 
a movement in the X direction. In Figure 1 the texture is moved about the texture 
envelope (Texture tool, Offset). In Figure 2 the texture geometry itself is moved (Texture 
Axis tool, Position).
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Figure 1: The texture has been 
moved about the texture envelope.

Figure 2: The texture geometry 
itself has been moved.

Figure 3: Texture geometry can be 
shown either as a texture grid or as 
a realtime texture.

Types of mapping
To choose how a material is placed onto a surface, set Projection to the desired mode. 
The modes available are demonstrated below and explained in the following pages.

Spherical applied to a plane. Spherical applied to a cylinder. Spherical applied to a sphere.

Cylindrical applied to a plane. Cylindrical applied to a cylinder. Cylindrical applied to a sphere.

Flat mapping applied to a plane. Flat mapping applied to a cylinder. Flat mapping applied to a sphere.

Cubic applied to a cuboid. Frontal applied to a cuboid. Flat (left) and Spatial (right).



662 • CHAPTER 23 MATERIAL MANAGER • 663

UVW Mapping. Difference between flat and UVW. Shrink Wrapping.

Spherical

Spherical mapping projects the texture on to the object in a spherical form. Spherical 
projection is rarely suitable for flat objects. There is distortion with cylindrical objects 
also.

Cylindrical

This mapping type projects the texture on to the object in a cylindrical shape. Cylindrical 
projection is rarely suitable for flat objects. It also leads to distortion when used with 
spherical objects. Notice how the pixels near the top and bottom of the texture map are 
pulled inwards on the caps. You should apply separate textures to the caps.

Flat

Flat mapping projects the texture on to the object in a planar direction. Flat projection 
tends to be used with flat objects only. The texture is soon distorted when applied to a 
sphere or cylinder, as the examples demonstrate.

Cubic

Cubic mapping projects the texture onto all six sides of a texture cube.

Frontal

The texture is projected from the camera position onto the object. You can create 
engaging special effects using Frontal mapping. You can even perform compositing 
directly in BodyPaint 3D. You have probably seen science fiction films where characters 
or spaceships gradually disappear into the background or are only partially visible. Use 
Frontal mapping for such effects.

Spatial

Spatial mapping is similar to Flat projection. However, with Spatial mapping, the texture 
is pulled up and to the right as it passes through the object. Spatial mapping does, 
however, cause some distortion and as such it is not suitable for photographic images. 
Spatial mapping is more suitable for structural textures such as plaster and marble.



662 • CHAPTER 23 MATERIAL MANAGER • 663

UVW Mapping

UV mapping is by far the most important mapping type in BodyPaint 3D -- it is the type 
of mapping that most of your objects should use. With BodyPaint 3D’s powerful UV 
editing tools, you’ll find that you can make your textures fit any shape of object.

If an object has UVW coordinates, you can select them as the projection type. In this 
case, the texture geometry is fixed to the object surface and is subject to all subsequent 
movement and deformation applied to the object. An example of UVW mapping is the 
page of a book as it is being turned. First you must fix the texture (e.g. ornate text and a 
pretty picture) to the page using UVW mapping. Next, animate the turn of the page with 
a deformation. The texture bends with the page.

All of BodyPaint 3D’s primitive objects have UVW coordinates. If you apply a new texture 
to these objects, the projection type in the Texture tag will default to UVW mapping. 
All Polygon objects with UVW coordinates display a UVW coordinates icon in the Object 
manager.

Primitive objects have internal UVW coordinates and do not display a UVW icon in the 
Object manager. You can still use UVW mapping with these objects. If you convert a 
Primitive object to a Polygon object, a UVW coordinates icon will appear in the Object 
manager.

You may be wondering why there are three coordinates (UVW). What is the third 
coordinate for? Conventional textures have two coordinates, one for the horizontal 
position X and one for the vertical position Y. In order to make it clear that the 
coordinates refer to a texture, X is renamed U, and Y is renamed V. Two coordinates 
(U and V) would be sufficient were it not for 3D shaders. These are three dimensional 
textures and as such they require a third coordinate (W) in order to be fixed to the object.

You can apply more than one UVW texture geometry to an object. Create a new Texture 
tag for the object, then set the projection you require such as Flat mapping for a label 
texture. Next, create new UVW coordinates for the active texture by choosing Generate 
UVW Coordinates from the Texture menu in the Object manager. The selected Texture 
tag will be set to UVW mapping and will deform together with the object. 
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What is the structure of UVW coordinates? Imagine a grid divided into a U direction and 
a V direction (see Figure 1, below). The UV range starts at 0, 0 and ends at 1, 1. For an 
upright polygon, 0, 0 describes the top left; 0, 1 the bottom left; 1, 0 the top right and 
1, 1 the bottom right. A texture is stretched out between these four coordinates (Figure 
2).

Figure 1. Figure 2.

But where is the W coordinate in this system? Recall that conventional textures are two-
dimensional — the W coordinate is created only when needed. Once created, the W 
coordinate behaves in the same way as the UV coordinates.

Selective UVW Mapping

BodyPaint 3D lets you to assign texture projections to polygon selections (rather than 
to the whole object as described above). Selective UVW mapping allows you to apply 
a different projection type to several regions of the object using the same texture 
geometry. Proceed as follows:

-  Create a sphere and convert it into a polygon object using Make Editable.

-  Create a new material with a texture, e.g. the checkerboard shader and set the 
projection to Flat.

-  Select the Polygons tool and select several polygons in various locations.

-  In the Object manager, choose Texture > Generate UVW Coordinates.

The selected polygons use Flat projection while the unselected polygons continue to use 
the normal UVW mapping. If you deform the object, the texture remains fixed in the 
selected region.
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Shrink Wrapping

With this projection type, the center of the texture is fixed to the north pole of a sphere 
and the rest of the texture is stretched over it. The advantage of this mapping type is 
that the texture meets itself at the south pole only. This avoids a seam running between 
the poles. Only a circular section of the texture is used, with the center of the circle 
corresponding to the center of the picture. The remainder of the picture is discarded.

Different materials for the hull, caps and rounding
You can apply different materials to the hull, the caps and the rounding of an object. 
You can either convert the object into polygons with Structure > Make Editable, or you 
can use the invisible selections. For example, you can use Extrude NURBS imported from 
CINEMA 4D to create marble letters with a golden, rounded or bevelled edge.

 You can use existing invisible selections for the caps and rounding of a NURBS object 
created in CINEMA 4D. For example, you can apply a material to the start cap by using 
the Selection function. You should type in ‘C1’ to apply the material to the start cap (you 
must use a capital C). The options are:

 C1 = Start Cap (Cap 1)
C2 = End Cap (Cap 2)
R1 = Start Rounding (Rounding 1)
R2 = End Rounding (Rounding 2)
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1. Parameter group tabs.
2. Lock/unlock Attribute manager.
3. Open new Attribute manager (right icon).
4. Selected parameter.
5. Navigation buttons..

The Attribute manager gives you quick access to almost any parameter in BodyPaint 3D, 
including the parameters for object, tags, materials, shaders and nodes. Changes that you 
make in the Attribute manager are carried out in realtime in the viewport. Although only 
one Attribute manager appears in the default layout, you can open additional Attribute 
managers. To open a new Attribute manager, click the icon that’s immediately to the right 
of the lock icon (see point 3 in the illustration above).

By default, the Attribute manager shows the parameters of the currently selected elements 
(objects, tags, materials etc.). This means that you need to select an element before you 
can edit its parameters. If your scene has an object that you frequently need to edit, create 
a new Attribute manager and lock it to always show that object’s parameters no matter 
which elements are currently selected. You’ll then be able to edit the object’s parameters 
without first having to select it, saving you time.

To lock an Attribute manager to specific elements, select the desired elements then click 
the lock icon (near the top right corner of the Attribute manager — see Figure 1, point 2). 
To unlock, click the lock icon once more.

Unlocked Locked

24 Attribute Manager

1 2

3

4

5
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Editing parameters
To edit a parameter in the Attribute manager, do one of the following:

-  Enter the new value into the parameter’s text box.

-  Next to the parameter’s text box you’ll find two arrowheads, one pointing up and 
the other pointing down. Drag these arrows up or down to increment/decrement the 
value.

-  Position the mouse pointer on the parameter’s text box and rotate the mouse wheel to 
increment/decrement the value.

Navigating the Attribute manager

Near the top of the Attribute manager you’ll find tabs that represent the parameter 
groups of the selected elements. To show the parameters of a parameter group, click 
the group’s tab to select it. The parameters will then appear below the tabs, ready for 
editing.

To show the parameters of several groups, right-click (Windows) or Shift-click (Mac OS 
and Windows) the tab of each group that you want to access. To remove a tab from the 
selection, right-click or Shift-click the tab again. Selected tabs are highlighted with a bright 
color.

You can also activate parameter groups in the following ways:

-  Drag, say, a material from the Material manager and drop it onto the parameter group 
tab for a Texture tag. The tab will be activated if it isn’t already.
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-  Click and hold down the mouse button and drag the pointer over the parameter 
groups that you want to activate.

If there is not enough display space to show all parameters on-screen at the same time, 
scroll bars appear. To scroll the parameters, drag the scroll bars or drag from an empty part 
within the window.

Drag from an empty part within the Attribute manager to scroll 
the parameters.

Navigation buttons

Above the parameter group tabs you’ll find three navigation buttons: a left arrow, a 
right arrow and an up arrow. BodyPaint 3D keeps track of which elements (objects, tags, 
materials, etc.) have already been displayed in the Attribute manager.

Using the arrow buttons, you can navigate through these elements to display their 
settings again.

Click the left or right arrow button to move back or forward one element respectively.

Click the up arrow button to move up by one hierarchy level. This also works with 
shaders. For example, suppose you have created a material and loaded the bhodiNUT 
Fusion shader into its color channel. You have also loaded shaders into the Fusion shader 
itself, i.e. you have shaders within shaders. Using the up arrow button, you can display 
the settings that are on the next level up.
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The Attribute manager’s context menu
To access the Attribute manager’s context menu, right-click (Windows) or Command-
click (Mac OS) a parameter.

User Interface
This sub-menu appears when only one parameter is selected. Depending on the type of 
parameter, you are able to change its interface. For an existing parameter, you mostly 
have a choice between a numeric text box (Float), a slider (Float Slider — No Edit Field) or 
both (Float Slider).

Normal text box for Subdivision Renderer. Text box and slider for Subdivision Renderer 
(User Interface > Float Slider chosen).

To control the minimum and maximum values of sliders, choose the Edit Entry command 
and in the dialog that appears, set Min and Max to the desired values.
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Show Subchannels
Some elements such as color fields can also be displayed numerically.

Show Subchannels disabled. Show Subchannels enabled.

Copy, Paste
Use these commands to copy values between parameters. First select the parameters 
whose values you want to copy. Choose Copy. Now select the parameters that should 
receive the copied values and choose Paste.

Paste Identical
Suppose there are two cylinders in your scene. You select one of the cylinders, select its 
Radius and Height parameters in the Attribute manager and choose Copy to copy these 
two values. If you then select the other cylinder and choose Paste Identical, the two 
values will be pasted to the same parameters — Height and Radius — regardless of which 
parameters are currently selected. This is in contrast to the Paste command which pastes 
to the selected parameters.

Select All, Deselect All
Selects and deselects all parameters.

Edit Entry, Remove Entry
These commands are only of use if you have loaded a CINEMA 4D scene into BodyPaint 
3D that contains User Data (created with CINEMA 4D’s Add User Data command). Choose 
Edit Entry if you want to edit the appearance of the selected User Data. For example, you 
can change the minimum and maximum values of sliders. Choose Remove Entry if you 
want to delete the selected User Data.

If you’ve used the Attribute manager’s Add User Data command (User Data > Add User 
Data) to create your own sliders or other GUI elements, use Edit Entry to edit these GUI 
elements. For example, you can change the minimum and maximum values for sliders. 

Load Data, Save Data
The Save Data command enables you to save the values of the selected parameters. This 
is especially useful for saving complex spline graphs.
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To add a spline graph as user data, in the Attribute manager choose User Data > Add 
User Data and in the dialog that opens, set Data Type to Spline and click OK. The spline 
graph appears below the existing parameters.

To load saved data, select the parameters that should receive the data and choose Load 
Data. Use your system’s file selector to choose the data file. Note that the saved data and 
the selected parameters must be of the same data type. For example, you cannot load 
real values into parameters whose data types are set to Integer.

Multiple selection
BodyPaint 3D now enables you to select multiple objects. When different types of object 
are selected at the same time only the common parameter groups’ tabs are shown

When you see a parameter box shaded, this means that the parameter has different 
values for the selected elements. To assign the same parameter to all selected elements, 
enter the desired value into the shaded input box.

In the example above, two spheres have been selected to show their parameters in the 
Attribute manager. The shaded Radius box indicates that the spheres have different 
radius values. To set them to the same radius, enter the desired value into the shaded box 
for Radius. The box turns white to indicate that the parameter is now the same value for 
both spheres.

The Attribute manager’s menu
These commands enable you to choose the Attribute manager’s display mode, copy and 
paste parameter values, add your own sliders and more.

Mode

Lock Element, New Attribute Manager
By default, the Attribute manager shows the parameters of the currently selected 
elements (objects, tags or materials etc.). This means that you need to select an element 
before you can edit its parameters.

If your scene has an object that you frequently need to edit, create a new Attribute 
manager and lock it to always show the object’s parameters no matter which elements 
are currently selected. You’ll then be able to edit the object’s parameters without first 
having to select it, saving you time.

To create a new Attribute manager, choose New Attribute Manager.
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To lock the new Attribute manager to a specific object (or objects), in the Object 
manager select the desired object to load its settings into the new Attribute manager. 
Then, in the new Attribute manager, choose Lock Element. The new Attribute manager 
now displays the parameters of the object permanently, even when other objects are 
selected in the Object manager.

To unlock the Attribute manager so that it once again shows the parameters of the 
currently selected elements, choose Lock Element again.

 You can also create a new Attribute manager or lock/unlock the Attribute manager using 
the two icons near the top-right corner of the Attribute manager. Click the lock icon to 
lock/unlock. Click the icon to the right of the lock to create a new Attribute manager.

 

Choosing the display mode

 The Node, Timeline and F-Curve display modes are only of use if you are using the 
BodyPaint 3D module with CINEMA 4D.

Suppose you’ve selected an object and a Texture tag. Should the Attribute manager 
display the object’s parameters or the tag’s parameters? Choose Mode > Object to show 
the object’s parameters or Mode > Tag to show the tag’s parameters. The following 
modes are available: Object, Tag, Material, Shader, Node, Timeline and F-Curve. The 
Attribute manager changes the display mode automatically each time you select an 
object to ensure that you can always see the parameter groups of the most recently 
selected element.

Configure Modes

Choose this command to open the Select Modes dialog. In this dialog, enable or disable 
the various options to choose which element types the Attribute manager is able to 
display. For example, if you want the Attribute manager to show object parameters only, 
disable all options apart from Object.



676 • CHAPTER 24

Edit

Copy, Paste
Use these commands to copy values between parameters. First select the parameters whose 
values you want to copy. Choose Copy. Now select the parameters that should receive the 
copied values and choose Paste.

Select All
Selects all parameters.

Deselect All
Deselects all parameters.

User Data
This feature is only of use if you are using the BodyPaint 3D module with CINEMA 4D. 
Please see the CINEMA 4D reference manual for details.

Exception: 

In the Material manager, click on a material to display its parameters in the Attribute 
manager. Choose Add User Data and in the dialog that opens, set Data Type to Texture 
and click OK. Click on the User Data tab and you’ll see a Data box and a button with 
three dots appear. Click on the button and use the file selector that opens to choose a 
bitmap. The bitmap will now be displayed in the Material manager as a texture in the 
color channel, in an extra column.
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With BodyPaint 3D, you can render your scene directly in the viewport or you can render 
it to the Picture Viewer. Rendering in the viewport is useful if all you need is a quick 
render to check how your scene is progressing. But if you want to actually save the 
rendered picture, you’ll need to render to the Picture Viewer instead.

If you want to save the picture when rendering to the Picture Viewer, first set the save 
path in the render settings. When you then render to the Picture Viewer, the picture 
will then be saved automatically using this path. Other render properties such as 
antialiasing and softness must also be set in the render settings before you render to the 
Picture Viewer.

To render to the Picture Viewer

-  From the main menu, choose Render > Render To Picture Viewer.

The Picture Viewer will open if it isn’t already open and you’ll see the picture or 
animation appear as it is being rendered by BodyPaint 3D.

Move and Scale Icons

Move icon (left)
and Scale icon.

You’ll find these two icons in the top-right corner of the Picture Viewer. Drag the move 
icon to move the picture. Click-drag the scale icon to zoom in or out of the picture.

25 Picture Viewer
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File Menu

Open
Opens an image file and displays the image in the Picture Viewer. All 2D image formats 
supported by BodyPaint 3D can be opened (see Appendix).

Save Picture As

Format, Options

 The list of file formats may vary depending on the QuickTime codecs installed.

Specifies the file format for the picture. If the selected file format supports extra options, 
access these by clicking the Options button.

Depth, DPI

 Some file formats support 16 bits per channel, i.e. 48-bit color.

Sets the bit-depth for each channel in the file and the dots-per-inch resolution of the 
picture.

Save Multi-Passes

Enable this option if you have rendered a multi-pass image and you want to save all 
layers.

Alpha Channel

If this option is enabled, the alpha channel will be saved with the image, provided the file 
format you have chosen supports alpha channels.
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Stop Rendering 
 You can also stop the rendering by pressing Esc.

Aborts rendering. When you next render, the picture will be rendered from the beginning 
again.

Close 
Closes the Picture Viewer. 

Edit Menu 
Copy
Copies the image in the Picture Viewer to the clipboard. You can then paste the image 
into another application such as an image editor.

Channels Menu
Use this menu to control which image channels are shown in the Picture Viewer. The 
menu lists all channels contained in the image — layers are listed also if you have 
rendered a multi-pass image.

Multi-Layer Display
If this option is enabled, you can enable as many of the channels in the Channels menu 
as you like; these enabled channels are combined to form a composite image in the 
Picture Viewer. If Multi-Layer Display is disabled, you can enable (and see) one channel at 
a time only.

Image
If this option is enabled, the composite image is shown in the Picture Viewer.
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Alpha 
This option appears only if the image has an integrated alpha channel. If the option is 
enabled, the Picture Viewer displays the image’s alpha channel instead of the image 
itself.
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Components Menu

Red, Green, Blue 
BodyPaint 3D renders all images using the RGB color system. With these three options 
you can filter out the separate colors. This allows you to check the red separation of a 
render without needing to launch a separate image editor. 

Grayscale 
If you enable this option, the image will be displayed not in color but in grayscale. This 
function is useful for checking aspects of the render such as contrast, which is generally 
much easier to judge in a grayscale image than in a color image.

View Menu
Fit To Size 
If this option is enabled, the image is fitted automatically to the size of the Picture Viewer 
window, assuming the window is smaller than the image itself. The aspect ratio is kept 
constant.

Zoom Factors
You can display the image in different predefined zoom factors from 12.5% to 800%. At 
100% the image is displayed actual size. 

Zoom In, Zoom Out 
Use these commands to zoom in or out of the image, stepping through the predefined 
zoom factors.

Show Renderline
The renderline is a white line that appears during rendering to indicate the progress of 
the render. Use this option to switch the renderline on and off.t
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 Data is shown only if the selected object is editable. To make a primitive editable, select 
the primitive and choose Make Editable.

Like a spreadsheet, the Structure manager processes data directly within cells that are 
divided into rows and columns. You can edit data numerically for points (including spline 
points), polygons, UVW coordinates or vertex maps. The Structure manager shows the 
data for these items of the selected object. Choose which type of data is shown from the 
View > Mode menu.

Choose whether the Structure manager 
shows the data for points, polygons, UVW 
coordinates or vertex maps.

If you want to edit data for a UVW map or a vertex map and the object has more than 
one of these maps, in the Object manager select the desired map to show its data in the 
Structure manager.

26 Structure Manager
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Values in the cells can be edited directly, lines can be moved by means of drag-and-drop 
and cut, copy, paste are supported. Larger quantities of data can be processed rapidly, 
even if the object has a large number of points or polygons. The selection frame (a red 
frame around an active box) shows you which data you are working on; navigating 
around the table is thus very simple.

Navigating the Structure manager
Selection
To select a row, click the row’s left column (the Point or Polygon column). To select 
multiple rows, click the first row that you want to select then Shift-click the remaining 
rows that you want to select. To remove a row from the selection, Shift-click the row 
again.

Selection frame
To select a cell, click it. You can also change which cell is selected using the cursor keys or 
the Tab key and Shift-Tab. Press Home to change the selection to the first row or End to 
change the selection to the last row (the same column will be selected).

 If you have a small Apple USB keyboard with no End key, press the “+” key on the 
numeric keyboard instead to change the selection to the last row.

To move the selection up or down a page, press the Page Up or Page Down key. To select 
a cell and enter edit mode, double-click the cell. Once in edit mode, you can move cells 
while still in edit mode using Tab, Shift-Tab and the cursor keys. To enter a value while in 
edit mode, enter the desired value and press Return. If you make a change and press Esc 
before pressing Enter to apply the change, the previous value is restored.

Drag-and-drop
You can drag elements within the Structure manager to a new position to change their 
order. While you drag, a red frame indicates where the dragged element will be placed if 
you release the mouse button in this position.

To copy the content of one cell to another, hold down Shift and drag the cell of the value 
that you want to copy and drop this onto the cell which you want to receive the copied 
value.
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File Menu

New Line
A new line is inserted into the table below the selection frame.

If you are in the point mode (default), a new point is added to the object. This is created 
at the world origin (X=0, Y=0, Z=0). By entering suitable X, Y and Z coordinates, you can 
change the spatial position of the point.

If you are in the polygon mode, New Line adds a new polygon to the object. The new 
polygon will not be visible yet, since it has not been allocated suitable points (see Mode). 
You must do this point allocation by hand. If you are in UVW mode, New Line creates 
a new UVW coordinate. Since BodyPaint 3D assigns UVW coordinates to primitives 
automatically and UVW coordinates can be created easily using the Generate UVW 
Coordinates command, you may find little use for this command.

Import ASCII Data
Using this command, you can import points, polygons or UVW coordinates into the 
Structure manager. The imported data must be an ASCII file in the following format.

Point X Y Z

1 <coordinate> <coordinate> <coordinate>
2 <coordinate> <coordinate> <coordinate>
3 <coordinate> <coordinate> <coordinate>

Here’s a real Point mode example for a cube:

Point X Y Z

0 -100 -100 -100
1 -100 100 -100
2 100 -100 -100
3 100 100 -100
4 100 -100 100
5 100 100 100
6 -100 -100 100
7 -100 100 100



690 • CHAPTER 26 STRUCTURE MANAGER • 691

The ASCII file must start with a header (the “Point X Y Z” in the example above) and each 
row must start with the point number. The values within each line may be separated 
with a TAB character, a comma, a semicolon or a combination of these. Each line must 
end with the ASCII LF (linefeed) character or the CR (carriage return) character, or a 
combination of both. Thus the ASCII file can be created on a Macintosh, Windows or Unix 
computer.

If data already exists in the Structure manager, the imported data is inserted before the 
line containing the selection frame

Export ASCII Data
You can export the data shown in the Structure manager as an ASCII file — perhaps for 
export to another 3D application. In Point mode, the X, Y and Z coordinates of each point 
are exported. In polygon mode, the edge data for each polygon is exported. In UVW 
mode the UVW coordinates of each polygon (defined so far) are exported.

Close
Closes the Structure manager.
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Edit Menu

Undo, Redo
Undo undoes the last change to the object’s structure. The previous values are restored 
to the cells. The undo level (i.e. how many changes are remembered) is set on the 
Document page of the preferences. Redo undoes (i.e. cancels) the last undo. The redo 
level is the same as the undo level set on the Document page of the preferences.

Cut, Copy, Paste, Delete
Cut removes the selected row(s) from the table and copies this to the clipboard. Copy 
copies the selected row(s) from the table into the clipboard, without deletion. Paste 
inserts any data copied or cut into the clipboard back into the table, below the selection 
frame. Deletes the selected rows.

Select All, Deselect All, Invert All
These commands select all rows, deselect all rows and inverts the selection.

Select Area
The mouse pointer changes into a crosshair and you can draw a selection area with the 
mouse. All lines within the area you draw are selected. If some of the rows that you want 
to select are out of view, drag above or below the Structure manager window up or 
down. The window will then scroll until you drag within the window once more.

View Menu
Jump Last Selection, Jump Next Selection
These commands move the selection frame to the previous or next selected row.

Jump Page Up, Jump Page Down
These commands move the selection frame up or down a page.
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Jump Home, Jump End
Use these commands to move the selection frame to the first column of the first row 
(Jump Home) or last row (Jump End).
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Mode Menu
 All modes operate independently of the tool that you are using in the viewport. For 

example, you can process points in the Structure manager while working on polygons in 
the viewport. If you want the elements selected in the Structure manager to be shown 
in the viewport also, you must change to the appropriate tool. For example, if points are 
shown in the Structure manager, select the points tool from the left toolbar. 

Points
In point mode, the coordinates of the selected object’s points are shown in the Structure 
manager. No units are displayed; the unit of measurement is selected in the preferences 
and is assumed here. The display is organized as follows:

X Y Z  show the coordinates of the respective point in the world system.

<-X <-Y <-Z is the position of the end of any left tangent.

X-> Y-> Z is the position of the end of any right tangent. 

Polygons
 If C and D are identical, BodyPaint 3D interprets the polygon as a triangle.

If you are in Polygon mode, the number of each defining point is displayed, as follows. A, 
B, C, D correspond to the respective point numbers of the three (or four) corner points of 
the polygon.

UVW
In UVW mode, the UVW coordinates of the polygons of the object are displayed as 
follows:

U[A], U[B], U[C], U[D] are the U coordinates of the corner points of a polygon.

V[A], V[B], V[C], V[D] are the V coordinates of the corner points of a polygon.

W[A], W[B], W[C], W[D] are the W coordinates of the corner points of a polygon .
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 You can set the position, scale and rotation of objects here, in the Coordinate manager, or 
in the new Attribute manager.

The Coordinate manager allows you to manipulate objects numerically. It displays 
information relating to the tool you are using. For example, if you are using the move 
tool, the position, size and rotation values of the selected element are shown. Once you 
have made changes to the values, apply the changes by clicking on Apply.

You can use the drop-down list in the bottom left corner to determine how the 
values are interpreted. If the menu is set to Object, all the values relate to the object’s 
(immediate) parent system. If the menu is set to World, the position and rotation values 
are converted to world coordinates. The rotation values always use the HPB System.

The drop-down list below the middle coordinates column specifies which object size is 
shown. Size shows the size of the object (not including child objects). Size+, on the other 
hand, shows the size of the active object including all child objects. Scale shows the axis 
length for each axis of the object coordinate system — the default values are 1/1/1. The 
size or scale is also specified in world coordinates, although along the local axes. For 
example, if a cube with a side length of 100 lies askew in 3D space, it still has a size of 
100 units in world coordinates.

You can also enter relative values. BodyPaint 3D has a parser which enables you to 
include mathematical operators. For example, you can append +100 to an existing 
position value. The active element will then move 100 units relative to its initial position. 
BodyPaint 3D supports many other functions — see the Appendix for a complete list of 
valid operators, functions and constants.

As previously mentioned, the type of information displayed in the Coordinate manager 
depends on the active tool. For example, if the Camera tool is active, you can enter 
the focal length for the lens instead of its scale. Some values must be entered as 
relative, such as for the rotation of points. This is because points do not have their own 
independent coordinate system, so BodyPaint 3D cannot keep track of previous rotations.

Note that you may be changing the axes of child objects unintentionally when you 
change the axes of the parent.

27 Coordinate Manager
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Formulae
You can type in a formula for the Formula spline primitive and the Formula time curve. 
In fact, you can type in a formula wherever BodyPaint 3D accepts a value, e.g. in the 
Coordinate manager. This appendix lists all the units, operators  functions and constants 
that you may use in your formulae. You may enter values using any of the units listed 
below (examples in brackets) - regardless of the basic units defined in the preferences 
(BodyPaint 3D will convert the units for you).

Units Abbreviation Examples

kilometers km 23 km, 0.125 km
meters m 13.23 m, 1000 m
centimeters cm 11.5 cm, 

328.275 cm
millimeters mm 14 mm
micrometers um 678 um
nanometers nm 3.867 nm
miles mi 12.5 mi
yards yd 17.9 yd
feet ft 512 ft
inches in 0.125 in
frame number F 0 F

If you change the basic units in the preferences, e.g. from metres to millimeters, only the 
measurement units are changed, not existing numerical values. For example, if an object 
has a width of 10 metres, but you then change the basic units to millimeters, the object 
will then have a width of 10 millimeters. If you wish to scale the objects to reflect the 
change in units, group all the objects and scale the group using the Coordinate manager.

 Function arguments must be bracketed. The number of open brackets must equal the 
number of close brackets. Functions may be nested: sin(sqr(exp(pi)))

 The argument of a trigonometric function is always interpreted in degrees. sin(2*pi) does 
not mean the computation of sin 180 degrees, but approx. sin 6.283 degrees.
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The function parser has the most important arithmetic operators built in. You can 
combine operations freely, for example: 2km + exp(sin(4mm*pi)) / ((sin(14cm))̂ 2 + 
(cos(14cm))̂ 2).

Operator Abbreviation Examples

addition + 144 + 14
subtraction - 144 - 14
multiplication * 144 * 2
division / 144 / 12
modulus mod 123 mod 4
power ^ 12 ^ 2
brackets ( ) 3 + (4 * 2)
absolute value abs abs(-123)
sine sin sin(30)
cosine cos
tangent tan
arc sine asin
arc cosine acos
arc tangent atan
sine hyperbola sinh
cosine hyperbola cosh
tangent hyperbola tanh
logarithm to base 10 log10 log10(100)
logarithm to base e log log(e)
exponential 
function

exp exp(5)

square root sqrt sqrt(144)
square sqr sqr(12)

Two of the most important constants have been built 
in:

Pi pi 3.142

Euler’s number e 2.718
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Programming plugins
The built-in XPresso node editor gives you extensive control over how BodyPaint 3D 
objects interact with one another. In addition to XPresso, BodyPaint 3D provides you with 
a powerful programming language that enables you to produce plugins that can extend 
the core functionality of BodyPaint 3D.

The COFFEE programming language 
COFFEE, the plugin language for developing BodyPaint 3D/ CINEMA 4D plugins, is not 
based on macros or scripts but is a complete and powerful programming language in its 
own right. It closely resembles C++ and Java so that if you are already familiar with these 
languages you will immediately feel at home with COFFEE; you simply have to learn the 
various functions implemented by BodyPaint 3D/CINEMA 4D.

To start programming you will need to get hold of the SDK (Source Development Kit) 
directly from MAXON; this can be obtained from www.plugincafe.com.

What is the advantage of writing plugins in COFFEE as opposed to using C++? Well, 
apart from the ease of integrating new functionality into BodyPaint 3D, as you know, 
BodyPaint 3D/CINEMA 4D is a multi-platform program. Writing plugins in COFFEE means 
that your new function will work immediately on all those platforms, with no annoying 
re-compilation or reprogramming.

So that BodyPaint 3D/CINEMA 4D can find its COFFEE programs and load them 
automatically, they must be placed in the Plugins folder which should be in the root 
BodyPaint 3D or CINEMA 4D folder. However, you can also store COFFEE programs 
elsewhere on your hard disk. To load such a plugin, just use the File > Open menu 
command — a file stored outside the Plugins folder cannot be automatically integrated 
into BodyPaint 3D’s menu structure.

How do you create a plugin? Simply write your COFFEE programs in any text editor or 
word processor and save it as a regular ASCII text file; BodyPaint 3D/CINEMA 4D will 
happily process regular text, with no high-ASCII characters.

The API
Perhaps you do not want to use COFFEE as your programming language? As usual, 
BodyPaint 3D/CINEMA 4D allows you the flexibility to do it the way you want to; if you 
like, you can write your applications with any C or C++ compiler. Here you have access 
to the functionality of BodyPaint 3D/CINEMA 4D through pre-defined interfaces. These 
interfaces are in the form of an API (Application Programming Interface) library which 
is part of the BodyPaint 3D/CINEMA 4D SDK. Note, however, that if you use an external 
compiler (as opposed to COFFEE) this will be platform dependent and you will need to 
re-compile your program for each platform on which you want your plugin to work. You 
may also need to do some reprogramming.
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COFFEE support
Support for BodyPaint 3D/CINEMA 4D developers is available exclusively on MAXON 
Computer’s Plugin Café website: plugincafe.com. Here you will find, among other 
things, the SDK. This contains the COFFEE compiler and detailed descriptions of 
the programming language and the interface libraries. It is, of course, possible for 
commercial plugin manufacturers to keep their source code secret and proprietary. Our 
developer support is not static; the interfaces to BodyPaint 3D/CINEMA 4D and their 
functionality are constantly being extended. You should always, therefore, pay attention 
to the relevant announcements on the Internet. 

File Formats
While working with BodyPaint 3D there will be occasions when a particular graphic 
format will not load or a 3D file will prove difficult to convert. There are so many formats 
and sub-formats for images, animations and 3D files that BodyPaint 3D cannot even 
dream of coping with all of them. The following sections contain summaries of all 
formats that BodyPaint 3D supports. If you need more detailed information, you should 
refer to the relevant technical information for that format.

Image Formats
TIFF

Bit depths Compressors

1, 4, 8, 24, 32 Uncompressed
RLE compressed

Only Baseline TIFF is supported. Exotic formats such as CMYK images are not supported, 
nor are files that have been LZW compressed (this is due to licence rights). It is of course 
not possible to give an exhaustive list of non-supported formats, since such a list in a 
sense could never be definitive. With QuickTime installed LZW compressed images and 
other variants are also imported.

IFF

Bit depths Compressors

1, 4, 8, 16, 24 Uncompressed
RLE compressed
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IFF images are read only if they conform to the Commodore/Electronic Arts 
specifications. EHB, HAM-6 and HAM-8 modes are supported.

TARGA

Bit depths Compressors

24, 32 Uncompressed

Only TGA-1 is supported. With QuickTime installed other variants are also imported.

PICT

Bit depths Compressors

4, 8, 16, 24, 32 Uncompressed
RLE compressed

With QuickTime installed all PICT variants are imported (if the QuickTime compressors are 
available).

BMP

Bit depths Compressors

1, 4, 8, 16, 24 RLE-4, RLE-8

JPEG

Bit depths Compressors

24 n/a

Grayscale JPEGs and progressively compressed JPEGs are not supported.

PSD

Bit depths Color formats

1, 8, 24, 48 Indexed color
RGB
not CMYK

For writing, alpha channels are supported.
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QuickTime

Bit depths Color formats

Various Various

With QuickTime installed, all QuickTime formats are supported i.e. PNG, SGI and 
QuickTime image. 

B3D

Bit depths Color formats

8, 24 n/a

B3D is the native file format of the BodyPaint 3D module. Layers, layer masks and 
channels are supported. 

RLA, RPF
Save your multi-pass files in RLA or RPF format if you want to post-edit in compositing 
programs like After Effects and Combustion. RPF is an extension of the older RLA 
format. RPF supports all the channels listed below (RLA supports the channels from Z to 
Coverage):

– Z
Information on camera <-> object distance. Useful for depth-of-field effects.

– Object
Enables different materials to be used in post-editing.

– UV Coordinates
Information on UV coordinates so that new textures can be mapped correctly during 
post-editing.

– Normal
Direction information regarding objects and textures.

– Non-Clamped Color
Information on object color. Can extend beyond RGB gamut.

– Coverage
Antialiasing information for object edges.

– Object ID (RPF only)
Enables the clear identification of objects.

– Color (RPF only)
Object color information.



706 • APPENDIX APPENDIX • 707

– Transparency (RPF only)
Object transparency information.

– Subpixel Weight
Information on the color of subpixels.

– Subpixel Mask
Information that links subpixels to their objects.

HDRI
HDRI images are converted to RGB upon loading.

Animation Formats
AVI

 This format can be read and written only under Windows. Using QuickTime, AVI 
animations can also be used on the Macintosh, depending on the codec.  When using AVI 
animations as textures, only the first video track is evaluated; all others (e.g. music) are 
ignored. If the first video track contains data other than images these are also ignored.

Only 24-bit formats are supported. If you have selected AVI System and the message 
“Unable to write file” appears it is most probably caused by a codec which does not 
support 24-bit data (such as Microsoft RLE).

QuickTime

 When using QuickTime animations as textures, only the first video track is evaluated; 
all others (e.g. music or QuickTime VR) are ignored. If the first video track contains data 
other than images these are also ignored.

All codecs that are installed in the operating system are supported. Alpha channels 
are integrated directly into the animation only if the compressor supports this. For the 
QuickTime format these are the compressions Animation and None (i.e. uncompressed). 
In both cases, the number of colors must be set to Millions of Colors+.

3D Formats
DXF
BodyPaint 3D offers complete support for DXF files written by AutoCAD (up to and 
including version 12) or by the export filters of other applications, provided they are 
100% compatible.



708 • APPENDIX APPENDIX • 709

LightWave
Although BodyPaint 3D can convert LightWave files and scene descriptions completely 
(including PSD animations and bone structures), it is sometimes necessary to post-
edit light source settings and texture placements. UV coordinates are supported from 
LightWave version 6 and higher.

3D Studio Import

 The 3DS transparency texture is the exact opposite of the transparency mode in 
BodyPaint 3D. In 3DS, materials are more transparent the darker a texture pixel, whereas 
in BodyPaint 3D they are more transparent the lighter the pixel.

– These files are loaded: 3DS (regular 3DS files), PRJ (3DS project files), MLI (3DS 
materials libraries).

– The object hierarchy is copied 1:1, referenced objects are duplicated in BodyPaint 3D.

– The following material channels are imported: environment light, specular color, 
specular settings (which are recalculated), transparency, luminance, color texture, 
specular texture, transparency texture, environment texture, relief (bump) texture, 
luminance texture.

– UV mapping is copied.

– Animation.

– Position, scaling, rotation and light sequences are adjusted to suit BodyPaint 3D.

– Textures can be renamed automatically on loading.

– So-called target objects loaded from 3DS (from cameras and light sources) become 
axes (null objects) and are given the extension ‘t’, which is added to their object name.

– 3DS files are binary files and are not recognized by their extensions but by their 
identifier.

3D Studio Export

 Regrettably, 3D Studio can cope only with filenames consisting of eight characters plus a 
three-letter extension. Therefore texture filenames will be truncated to conform with this 
restriction.

 3D Studio accepts only one UV coordinate per point. Therefore texture mapping may 
appear different after exporting in this format.

– All polygon objects, light sources and cameras are exported, NURBS objects are 
transformed into polygon objects.

– Material export: color, luminance, transparency, environment, specular, specular color, 
relief (bump), all with any defined textures. The mean value of the texture channel is 
exported with the shader.
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QuickDraw3D Import
– Light source and camera information cannot be read.

– The following objects are ignored:
Torus, TriMesh (new with QD3D v1.5); NURBS can cause problems in certain cases.

– References (both internal and external) are not read.

– UV coordinates are not read.

– Textures are not read.

QuickDraw3D Export

 QuickDraw 3D accepts only one UV coordinate per point. Therefore texture mapping may 
appear different after exporting in this format.

– Light source and camera information cannot be written.

– Texture export is supported.

– ASCII 3DM files cannot be written, only binary.

DEM Landscape Import
– BodyPaint 3D does not support the DEM-SDTS format.

– The VistaPro DEM format (binary) is supported.

– Files to be imported need to have the extension “.DEM” because the file itself contains 
no information about its origin. DEM files without this filename extension cannot be 
read by BodyPaint 3D.

Direct3D Export

 For all scenes to display properly with a Direct3D Viewer it is necessary for all textures to 
have an edge length of a power of 2 (i.e. 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024, …).

– Typical extension *.x, ASCII Format, MESH and FRAME format.

– Zoom factor for entire scene, automatic indenting.

– Rename texture name to any extension.

– Texture information (UV coordinates and texture names)

– Texture channels: color, luminance, specular, specular color, transparency, environment.

VRML V1.0c and 2.0 Import

 Object names in VRML files must not contain any special characters (not even +, –, *, /). 
This may be the only reason that BodyPaint 3D is refusing to load a file!
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– ASCII format.

– All basic objects (cuboid, sphere, cone, cylinder).

– Polygon objects of any size and number of vertices (n corners are triangulated).

– Perspective cameras, light sources (direct, point, spot).

– Material tags:
ambient color, diffuse color, specular color, emissive color, shininess.

– WWW Links are created as a BodyPaint 3D attribute (WWW tag).

– WWW Inline Nodes are not supported.

VRML 2.0 Import
– Animation import, scenes in a line (references to scenes are automatically loaded).

VRML1.0c and 2.0 Export

– ASCII format (optionally formatted).

– Hierarchical saving of all objects: NURBS are converted to polygon objects.

– Object names are converted, special characters are filtered/converted.

– Textures:
If there are any textures, the program looks for the color texture, the luminance texture 
and the environment texture (in that order). Color textures, even inline textures, are 
saved as files.

– WWW links and addresses are saved: when an object is selected in the web browser, 
the program branches to that link.

VRML 2.0 Export
– Additional available animation export option.

Wavefront OBJ Import
– ASCII format.

– Polygon objects are loaded.

– Objects are given a dummy material.

– UV mapping is supported.

– No object hierarchy can be created.
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– Files to be imported need to have the extension “.OBJ” because the file itself contains 
no information about its origin. OBJ files without this file name extension cannot be 
read by BodyPaint 3D.

Wavefront OBJ Export
– ASCII format.

– Polygon objects; NURBS are converted to polygon objects, UV coordinates.
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Support 
What can you do when you are stuck and the manual does not appear to help? You may 
want to contact technical support. MAXON, and its distributors worldwide, will help 
you with any technical problems you encounter. So that we can help you as efficiently as 
possible, please keep in mind the following:

Please contact us (or your local distributor) in writing if possible, preferably by 
email.

We have telephone lines, of course, but problems with a package as complex as 
BodyPaint 3D may take time to solve — it is not always possible to solve the problem 
while you are on the phone. With email, however, our technicians can consult with 
colleagues for assistance — even the programmers if necessary — and get back to you as 
soon as possible. Email is also convenient for attaching an example of the problem and, 
likewise, it may be helpful for us to send you a scene.

Please keep support enquiries separate to other enquiries, orders etc.

Orders are dealt with by our busy Sales staff, so your support question is unlikely to be 
passed onto a support technician.

Please allow for a reasonable response time.

We operate on a queuing system basis only. Our customers are equally important and we 
will respond to you at the earliest opportunity.

Please supply your telephone number and times when we may contact you on that 
number.

Occasionally, we may need to contact you for further details.

Please send an example scene to demonstrate the problem, if applicable.

“When I click this button, I get a mess”. It is difficult to solve problems with such limited 
detail and sometimes we need to examine the problem scene. After all, we and our hard-
working beta testers, have tested the functions many-a-time without finding a fault.

Please keep any example scenes as small and as relevant as possible.

For example, if only an alloy wheel is required to demonstrate the problem, please delete 
the rest of the car — it merely gets in the way. This saves our time and in turn we can 
respond to your problem sooner.

Please supply us with a complete description of the relevant steps leading up to the 
problem.

Ideally, we would like a little recipe that generates the problem consistently. Please keep 
this concise.

Include rendered images if relevant.
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Please tell us which settings you used.

Please tell us which programs you have running at the same time as BodyPaint 3D. 
If you are using Mac OS, please let us know which system extensions are loaded.

Sometimes, another program or a system extension (Mac OS) may cause a problem 
indirectly.

Please include details of your hardware configuration.

“I have a Macintosh/PC” is of little help on its own. Also, please let us know which 
version of BodyPaint 3D you are using (choose Help > Info from the main menu; the 
version number is shown at the foot of the splash screen which appears; to close the 
splash screen, click it). If you have Internet access, please use the support form on our 
website (www.maxon.net). Tell us what other programs and system extensions you are 
running concurrently with BodyPaint 3D.

If the program crashes, it will display an error message. Please let us know the 
exact message.

If you are using Windows, you will see many other details listed. Please ignore these 
extra details — they are as enlightening as the infamous Macintosh message “Application 
Unknown has quit unexpectedly because of error -1”... Please let us know BodyPaint 3D’s 
message.

If you have Internet access, please check the FAQs on our website before you 
contact technical support.

Often, you will find the answer in the FAQs.

Our service is limited to technical support only. We cannot undertake 
subcontracting.

“Can you build my spaceship model, please?”

We must concentrate our resources on helping customers with genuine problems that 
are within the bounds of technical support. However, there are numerous web addresses 
where you can find additional help. Please visit our website (www.maxon.net) for links to 
these valuable resources.
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